
Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Denne veiledningen beskriver konfigurasjonen og driften av ILME-FR7 / ILME-FR7K Interchangeable Lens Digital
Camera.

Se denne håndboken og bruksanvisningen for relaterte enheter etter behov.

Oversikt

Vanlige bruksområder

Systemkonfigurasjon

Kontrollere én enkelt enhet ved hjelp av den medfølgende infrarød-fjernkontrollen

Kontrollere én enkelt enhet ved hjelp av nettbrett eller datamaskin

Kontrollere én enkelt enhet ved hjelp av en ekstern fjernkontroll

Kontrollere flere enheter ved hjelp av ekstern fjernkontroll

Delenes plassering og funksjon

Sett forfra

Sett bakfra

Kontaktblokk

Sett fra siden

Sett ovenfra

Sett fra undersiden

Objektivstøtte

Plassering og funksjon for infrarød-kontrollens deler (følger med)

Web App-skjermbildet

Oversikt over Web App-skjermbildet

Struktur for fellesområde på skjermbilder

Struktur for skjermbildet for direkte betjening

Struktur for skjermbildet for betjening av avspilling

Struktur for skjermbildet for innstillinger

1



Forberedelse

Kamerameny

Kameraets skjermvisning

Montere enheten

Montering oppreist på et fast sted

Montering oppreist på et høyt, fast sted

Montering i tak

Sette på / fjerne objektiver

Forsiktighetsregler når du fester/fjerner et objektiv

Kontrollere objektivbryterne

Forsiktighetsregler når du bruker et zoomobjektiv

Hvordan sette på et objektiv

Fjerne et objektiv

Tilkoblingskabler

Koble enheten til en nettverksenhet via kablet tilkobling

Koble til en strømforsyning

Bruk av nettstrøm

Bruke PoE++-strøm

Tilbakestille Pan/Tilt

Konfigurering før opptak

Initialisere enheten ved hjelp av Web App

Få tilgang til Web App fra en nettleser

Initialisere enheten

Konfigurere grunnleggende drift

Klargjøre minnekort

Minnekort som støttes

Sette inn minnekort

Løse ut et minnekort
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Opptak

Formatere (initialisere) minnekort

Kontrollere gjenværende opptakstid

Gjenopprette minnekort

Grunnleggende drift

Starte/stoppe opptak

Bytte mellom minnekort

Kontrollere lyden

Angi tidsdata

Gå gjennom opptaket (Rec Review)

Justere rammene

Skjermbilde for justering av rammer

Opptaksretningen

Justere opptaksretningen ved hjelp av Web App

Angi driftshastigheten for Pan/Tilt

Angi driftsakselerasjonen for Pan/Tilt

Justere opptaksretningen ved hjelp av den medfølgende infrarød-fjernkontrollen

Justere zoomen

Angi zoomtype

Justere zoomen ved hjelp av Web App

Angi driftshastigheten for zoom

Justere zoomen ved hjelp av den medfølgende infrarød-fjernkontrollen

Lagre/gjenopprette kameraets pan/tilt/zoom-posisjon (forhåndsinnstilte posisjon)

Kalibrere et E-festeobjektiv

Lagre/gjenopprette pan/tilt, zoomposisjon og fokusinnstilling ved hjelp av Web App

Gi nytt navn til forhåndsinnstillinger for posisjoner ved hjelp av Web App

Erstatte en lagret forhåndsinnstilt posisjon med en ny posisjon ved hjelp av Web App

Slette en lagret forhåndsinnstilt posisjon ved hjelp av Web App

Synkronisering av Pan/Tilt-drift og Zoom/Focus-drift ved gjenoppretting av en forhåndsinnstilt en posisjon

3



Endre overgangshastigheten (Pan-Tilt/Zoom/Focus) når du gjenoppretter en forhåndsinnstilt posisjon

Lagre/gjenopprette pan/tilt og zoomposisjon ved hjelp av den medfølgende infrarød-fjernkontrollen

Opptak/avspilling med funksjoner for kamera-framing (PTZ trace)

Opptak med funksjoner for kamera-framing med bruk av Web App

Avspilling med funksjoner for kamera-framing med bruk av Web App

Slette kameraopptak av framing-funksjoner ved hjelp av Web App

Opptak med funksjoner for kamera-framing med bruk av medfølgende infrarød-fjernkontroll

Avspilling med funksjoner for kamera-framing med bruk av medfølgende infrarød-fjernkontroll

Justere fokus

Skjermbilde for justering av fokus

Justere fokus manuelt (manuell fokus)

Justere manuelt ved hjelp av Web App

Justere manuelt ved hjelp av den medfølgende infrarød-fjernkontrollen

Fokusering ved å angi en fokusposisjon (Spot Focus)

Bruke autofokus midlertidig (Push Auto Focus (AF))

Bruke autofokus for enkeltbilde (Push Auto Focus (AF-S))

Justere fokus automatisk (autofokus)

Justere automatisk ved hjelp av Web App

Justere automatisk ved hjelp av den medfølgende infrarød-fjernkontrollen

Stille inn autofokusområde/-posisjon (Focus Area)

Raskt skifte av fokusområde (Focus Setting)

Flytte rammen for fokusområdet ved hjelp av berøringsfunksjon (berøringsfokusområde)

Justere autofokusfunksjonen (AF-overgangshastighet, AF-følsomhet for motivendring)

Angi autofokusmålet manuelt (AF Assist) ved hjelp av Web App

Fokusere manuelt under autofokus ved hjelp av den medfølgende infrarød-fjernkontrollen

Bruke manuell fokus midlertidig under autofokus (Push Manual Focus)

Sporing med ansikts-/øyedeteksjon (Face/Eye Detection AF)

Sporing av et spesifisert motiv (Realtime Tracking AF)

Justere lysstyrken
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Nyttige funksjoner

Skjermbilde for justering av lysstyrke

Angi basisfølsomheten

Stille inn målnivået for automatisk justering av lysstyrke

Justering av iris

Automatisk justering av iris

Manuell justering av iris

Justere forsterkningen

Automatisk justering av forsterkningen

Manuell justering av forsterkningen

Justere lukkeren

Automatisk justering av lukkeren

Manuell justering av lukkeren

Justere lysnivået (ND-filter)

Om ND-filteret

Justering i forhåndsinnstilt modus

Justere automatisk i variabel modus

Justere manuelt i variabel modus

Justere for naturlige farger (hvitbalanse)

Skjermbilde for justering av hvitbalanse

Justere hvitbalansen automatisk

Justere hvitbalansen manuelt

Kjøre automatisk hvitbalanse

Konfigurere lyden til opptak

Skjermbilde for lydkonfigurasjon

Velge enheten for lydinngang

Justere nivået for lydopptak automatisk

Justere nivået for lydopptak manuelt

Bruk av hurtigmenyen
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Knapper som kan tilordnes

Sakte og rask bevegelse

Opptak av video med jevne mellomrom (intervallopptak)

Opptak av cachet-bilder (Picture Cache Rec)

Ta opp på minnekort A og B samtidig (opptak med to spor)

Videosignalskjerm

Klippflagg

Pust-kompensering

Proxy-opptak

Oversikt over proxy-opptak

Spille inn en proxy

Ta bilder med ønsket utseende

Oversikt over utseende

Velge et utseende

Importere et ønsket basisutseende

Tilpasse et utseende

Lagre et utseende

Slette et basisutseende

Fotografering med utseendejustering i postproduksjon

Fotografering med utseendejustering i postproduksjon

Bruke en LUT på HDMI-utgang og -strømming

Bytte LUT

Endre fordelingen av mørke og lyse områder i bildet som er tatt

RAW-opptak

Hvordan ta opp RAW-video

Ta opp RAW-video i modus for sakte og rask bevegelse

Justere Bokeh (Bokeh Control Function)

Slå Bokeh-kontrollfunksjonen av/på
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Nettverksfunksjoner

Miniatyrbildeskjerm

Kamerameny og detaljerte innstillinger

Justere graden av Bokeh

Lagre og laste inn konfigurasjonsdata

Oversikt over lagring og innlasting av konfigurasjonsdata

Lagre en ALL-fil

Laste inn en ALL-fil

Overføre filer

Om filoverføring

Registrere en filoverføringsdestinasjon

Velge en fil og laste opp

Laste opp en proxy-fil på et minnekort fra miniatyrbildeskjermen

Laste opp en originalfil på et minnekort fra miniatyrbildeskjermen

Kontrollere filoverføringsstatusen

Opplasting ved hjelp av sikker FTP

Konfigurere strømming

Om strømming

Angi strømmeformatet

Angi videokodek for strømming

Angi lydkodek for strømming

Starte/stoppe strømming

Miniatyrbildeskjerm

Spille av klipp og andre klippoperasjoner

Spille av innspilte klipp

Betjening av innspilte klipp

Konfigurasjon av kameramenyen

Betjene kameramenyen

Betjene kameramenyen
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Skrive inn en tegnstreng

User-meny

User

Edit User-meny

Edit User

Shooting-meny

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project-menyen

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Paint/Look-meny

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt-meny

P/T Acceleration

TC/Media-meny

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring-meny

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio-menyen
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Audio Input

Audio Output

Thumbnail-menyen

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical-menyen

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network-meny

Wired LAN

File Transfer

Maintenance-menyen

Language

Clock Set

Hours Meter

Shooting-meny, innstillinger og standardverdier

ISO/Gain-innstillinger og standardverdier
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Nettmeny og detaljerte innstillinger

AGC Limit -innstillinger og standardverdier

Bildekvalitetsinnstillinger lagres for hver opptaksmodus

Konfigurasjon av nettmeny

Betjening av nettmeny

Shooting-meny

Focus

Project-menyen

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look-meny

Base Look

Pan-Tilt-meny

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring-meny

Output Format

Output Display

Audio-menyen

Audio Input
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Audio Output

Technical-menyen

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network-meny

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 til 3

SSL

Referer Check

Brute Force Attack Protection

Strømmemeny

Stream

Video Stream

Audio Stream

Maintenance-menyen

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Tilkobling av ekstern enhet

Tillegg

Service

EULA

Software

Koble til eksterne skjermer og opptaksenheter

Koble til en RCP/MSU (valgfritt)

Koble til en RCP/MSU

Én-til-én-tilkobling mellom enheten og en RCP

Bruke enheten i et multikameramiljø med en MSU/programvare for kamerafjernkontroll

Liste over støttede funksjoner

Betjening ved hjelp av en RM-IP500-fjernkontroll (alternativ)

Om betjening ved hjelp av en RM-IP500-fjernkontroll (alternativ)

Koble til en RM-IP500-fjernkontroll

Synkronisering med en ekstern enhet

Om synkronisering med en ekstern enhet

Synkronisere fasen av videosignalet (Genlock)

Låse tidskoden til andre enheter

Koble til en ekstern mikrofon eller ekstern lydenhet

Administrere/redigere klipp ved hjelp av en datamaskin

Sende ut et optisk fibersignal

Koble til et tellesignal

Sende ut tracking-data (free-d)

Koble til en objektivkontroller

Justering av zoom med objektivkontroller

Forsiktighetsregler ved bruk

Utdataformater og -begrensninger

Feilsøking

Feil-/varselmeldinger
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5-041-958-83(1) Copyright 2022 Sony Corporation

Liste over menyelementer

Lagrede elementer for forhåndsinnstilt posisjon

Blokkdiagram

Oppdatere programvare for objektiv med E-fatning

Feste dekselet til utløserknappen for objektivet

Lisenser

Spesifikasjoner

Varemerker
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Systemkonfigurasjon

Denne enheten kan kombineres med eksterne enheter for å danne forskjellige systemkonfigurasjoner.

E-festeobjektiv1.

LA-EA3/LA-EA4-A-festeadapter2.

Infrarød-fjernkontroll (følger med)3.

CFexpress type A-minnekort / SDXC-minnekort4.

CFexpress type A-kortleser / SD-kortleser5.

ECM-680S, ECM-678*, ECM-674* mikrofon6.
EC-0.5X3F5M 3-pinners → 5-pinners XLR-adapterkabel kreves.*

Strømadapter (følger med)7.

Videoskjerm8.

RM-IP500-fjernkontroll9.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrollere én enkelt enhet ved hjelp av den medfølgende infrarød-fjernkontrollen

Du kan kontrollere én enkelt enhet eksternt ved hjelp av den medfølgende infrarød-fjernkontrollen.

 Videosignal
 Signalflyt

5-041-958-83(1) Copyright 2022 Sony Corporation

Infrarød-fjernkontroll (følger med)1.

Videoskjerm2.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrollere én enkelt enhet ved hjelp av nettbrett eller datamaskin

Du kan koble et nettbrett eller en datamaskin til enheten og deretter kontrollere enheten ved hjelp av en nettleser.

 Videosignal
 Fjernkontrollsignal

  Signalflyt

5-041-958-83(1) Copyright 2022 Sony Corporation

Videoskjerm1.

Nettbrett2.

Datamaskin3.

Aksesspunkt4.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrollere én enkelt enhet ved hjelp av en ekstern fjernkontroll

Du kan kontrollere enheten eksternt ved hjelp av en fjernkontroll.

 Videosignal
 Fjernkontrollsignal

  Signalflyt

5-041-958-83(1) Copyright 2022 Sony Corporation

Videoskjerm1.

RM-IP500-fjernkontroll2.

19



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrollere flere enheter ved hjelp av ekstern fjernkontroll

Du kan kontrollere opptil 100 enheter eksternt ved hjelp av én enkelt fjernkontroll.

 Videosignal
 Fjernkontrollsignal
 Telle-/kontaktsignal

  Signalflyt

5-041-958-83(1) Copyright 2022 Sony Corporation

Videoskjerm1.

Videosvitsj2.

Ethernet-hub3.

RM-IP500-fjernkontroll4.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sett forfra

Dette emnet beskriver plasseringen og funksjonen til deler på forsiden av enheten.

Hint

Denne beskrivelsen refererer til illustrasjonen av enheten uten et tilkoblet objektiv.

Kamerahode

Merknad

Kamerahodet må ikke utsettes for kraftige støt.

1.

Opptaks-/tellelampe
Når den er konfigurert som en opptakslampe, lyser lampen rødt når du tar opp til et minnekort. Lampen blinker når
den gjenværende ledige plassen på opptaksmediet er liten eller når det oppstår en feil.

2.
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Hvis du vil ha mer informasjon, se "Feil-/varselmeldinger".

Når den er konfigurert som en tellelampe, lyser lampen rødt eller grønt i henhold til det eksterne tellesignalet.

Hvis du vil ha mer informasjon, se "Koble til et tellesignal".
Bildesensor

Merknad

Ikke ta på med hendene.

3.

Utløserknapp for objektivet
Trykk for å fjerne objektivet.

Hvis du vil ha mer informasjon, se "Fjerne et objektiv".

4.

Kontakter for linsesignaler

Merknad

Ikke ta på med hendene.

5.

POWER-lampe6.

NETWORK-lampe
Enhetens tilstand angis av kombinasjonen av displayets farge og belysningsstatus (lyser, blinker, lyser ikke) for
POWER-lampen og NETWORK-lampen.

7.

POWER-
lampe

NETWORK-
lampe Enhetens status

Lyser
grønt*1

Lyser grønt Strøm på (nettverk tilkoblet)

Lyser ikke Strøm på (nettverk ikke tilkoblet)

Blinker
grønt

Lyser ikke Strøm på-prosess pågår

Lyser
oransje

Lyser ikke Strøm i standby-modus

Blinker gult Lyser ikke Programvareoppdatering pågår

Blinker
oransje
sakte*2

Blinker grønt
sakte*2

Enheten kan ikke fungere normalt. Hvis du vil ha mer informasjon, kan du vise
systemloggen. Hvis problemet vedvarer selv etter at du har satt enheten i standby-
modus eller slått av strømmen og deretter på igjen, kontakter du
servicerepresentanten for Sony.

Blinker
oransje
raskt*3

Blinker grønt
raskt*3

Det oppstod en feil i enheten. Kontakt servicerepresentanten for Sony.

Blinker grønt når en kommando mottas fra den medfølgende infrarød-fjernkontrollen.*1

Blinker sakte: Blinker én gang i sekundet*2

Blinker raskt: Blinker fire ganger i sekundet*3

Sensor for infrarød-fjernkontroll
Mottar kontrollsignalet fra den medfølgende infrarød-fjernkontrollen.

8.
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Beslektet emne

Feil-/varselmeldinger

Koble til et tellesignal

Fjerne et objektiv

5-041-958-83(1) Copyright 2022 Sony Corporation

Luftinntak

Merknad

Luftstrømmen må ikke blokkeres. Det kan føre til funksjonsfeil.

9.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sett bakfra

Dette emnet beskriver plasseringen og funksjonen til deler på baksiden av enheten.

Beslektet emne

Sett fra siden

5-041-958-83(1) Copyright 2022 Sony Corporation

Låsespak for kamerahode
Låser kamerahodets bevegelse fremover/bakover.

Merknad

Sett alltid i låseposisjon når du ikke skifter objektivet.

Ved transport av enheten, fjern alltid objektivet og sett i låseposisjon.

Slå av strømmen til enheten og lås kamerahodet horisontalt ved hjelp av låsespaken for pan/tilt før du bruker låsespaken for
å unngå personskade på grunn av klemte fingre. Hvis du vil ha mer informasjon om pan/tilt-låsespaken, se "Pan/tilt-låsespak"
i "Sett fra siden".

1.

Skyvebunn2.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontaktblokk

Dette emnet beskriver plasseringen og funksjonen til kontaktblokken for enheten.

 (jord)-tilkobling
Koble til jord ved å koble til jordingsterminalen på et strømuttak eller til en jordingsstang.

1.

DC IN-kontakt (standard likestrømplugg)
Koble til en strømadapter.

Merknad

Ikke bruk andre strømadaptere enn den som følger med. Tilkobling av en annen adapter kan forårsake brann eller
funksjonsfeil.

2.

 LAN-kontakt (nettverk) (RJ-45)
Koble til en nettverkskabel (kategori 5e eller høyere) for nettverkskommunikasjon og PoE++*-strømforsyning.

Status for LED-display for hastighet
Angir hastigheten på nettverkstilkoblingen.

3.

PoE++: Power over Ethernet Plus Plus. Samsvarer med IEEE802.3bt (type 4, klasse 8). Du finner mer informasjon om tilkobling i
bruksanvisningen for strømforsyningsenheten.

*
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Status for LED-display for kobling/aktivitet
Angir status for nettverkstilkoblingen.

Merknad

Ved tilkobling av dette produktet til Internett, kobler du til via et system som har en beskyttelsesfunksjon, som for eksempel en
ruter eller en brannvegg. Hvis produktet kobles til uten slik beskyttelse kan det medføre sikkerhetsproblemer.

Skjerm Tilkoblingshastighet

Lyser ikke
10 Mbps forbindelse

100 Mbps forbindelse

Lyser oransje 1000 Mbps forbindelse

Skjerm Forbindelsesstatus

 Lyser ikke Ingen kobling

Blinker grønt Kobling opprettet, aktive data

Lyser grønt Aktiv kobling

TC IN-kontakt
Inngang for eksternt referansetidskodesignal.

Hvis du vil ha mer informasjon, se "Låse tidskoden til andre enheter".

4.

HDMI-kontakt
Sender ut videoen fra enheten som et HDMI-signal.

Hvis du vil ha mer informasjon, se "HDMI-kontakt (type A-kontakt)" i "Koble til eksterne skjermer og
opptaksenheter".

5.

Monteringsskrue for HDMI-kabelens festeplate
For å forhindre at HDMI-kabelen fjernes, fester du den medfølgende HDMI-kabelens festeplate ved hjelp av den
medfølgende monteringsskruen (M2.6×6). Fest HDMI-kabelen ved hjelp av et kommersielt tilgjengelig kabelfeste eller
-bånd.

Hvis du vil ha mer informasjon om hvordan du fester HDMI-kabelens festeplate, se "Tilkoblingskabler."

6.

OPTION-kontakt
Brukes til å koble til et tellesignal fra en ekstern enhet eller en objektiv-kontrollenhet.

Hvis du vil ha mer informasjon, se "Koble til et tellesignal" eller "Koble til en objektivkontroller".

7.

Ledningsklemme
Brukes til å feste strømadapterledningen.

8.

RESET-bryter
Trykk i minst 5 sekunder med spissen av en penn eller lignende gjenstand for å tilbakestille innstillingene til enheten
til fabrikkstandardverdiene.
Du kan velge om du bare vil tilbakestille innstillingene for nettverkstilkoblingen eller alle innstillingene ved hjelp av
SETUP-bryter 1.

9.

OPTICAL-utgangskontakt
Sender ut et SDI-signal konvertert til optisk format når en SFP+-modul (alternativ) er koblet til.

10.
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Hvis du vil ha mer informasjon, se "Sende ut et optisk fibersignal."
SETUP-brytere

Konfigurerer følgende innstillinger.
Bryter 1: Angir hvilke innstillinger som tilbakestilles når RESET-bryteren trykkes ned.

Bryter 2: Angir om strømforsyningen på +48 V (fantomstrøm) slås av/på når en enhet for lydinngang kobles til.
Innstillingen brukes umiddelbart.
Denne funksjonen er aktivert når [Audio] > [Audio Input] > [AUDIO IN Select] er satt til [MIC] i kameramenyen.

Merknad

Hvis du setter bryter 2 i ON-posisjon og kobler til en mikrofon som ikke er kompatibel med en +48 V-kilde, kan det skade den
tilkoblede enheten. Kontroller innstillingen før du kobler til enheten.

Bryter 3: Aktiverer/deaktiverer VISCA over IP-kommunikasjon. Innstillingene brukes når kameraet slås på.
Sett til ON-posisjon for å bruke enheten når den er koblet til en fjernkontroll (RM-IP500).

Merknad

Hvis administratorpassordet ikke er konfigurert, deaktiveres VISCA over IP-kommunikasjon, uavhengig av bryterinnstillingen.
Hvis du vil ha mer informasjon om hvordan du konfigurerer administratorpassordet, se "Initialisere enheten".

Bryter 4: Endrer hastigheten på pan/tilt-betjening som sendes fra infrarød-fjernkontrollen. Innstillingen brukes
umiddelbart.

11.

Innstilling Beskrivelse

OFF
(standard)

Tilbakestiller bare innstillingene for nettverkstilkobling. Nettverksinnstillingene,
sikkerhetsinnstillingene og brukerinformasjonen (brukernavn og passord) for enheten tilbakestilles.

ON Tilbakestiller alle innstillinger til fabrikkinnstillingene.

Innstilling Beskrivelse

OFF
(standard)

Ikke tilfør strøm på +48 V (fantomstrømforsyning). Konfigurer denne innstillingen når du bruker en
ekstern lydenhet (for eksempel en mikser), dynamisk mikrofon eller mikrofon med et innebygd
batteri.

ON
Tilfør strøm på +48 V (fantomstrømforsyning) til en fantomstrømkompatibel mikrofon som er koblet
til AUDIO IN-kontakten (CH-1 eller CH-2).

Innstilling Beskrivelse

OFF (standard) Svarer ikke VISCA over IP-kommandoer.

ON Godtar VISCA over IP-kommandoer.
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Beslektet emne

Låse tidskoden til andre enheter

Koble til eksterne skjermer og opptaksenheter

Tilkoblingskabler

Koble til et tellesignal

Koble til en objektivkontroller

Sende ut et optisk fibersignal

Initialisere enheten

Synkronisere fasen av videosignalet (Genlock)

Koble til en ekstern mikrofon eller ekstern lydenhet
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Innstilling Beskrivelse

OFF (standard) Fungerer med normal hastighet.

ON Fungerer med maksimal hastighet.

SDI OUT-kontakt
Sender ut videoen fra enheten som et 12G/6G/3G/HD-SDI-signal.
Enheten kan også konfigureres for RAW-signalutgang.

Hvis du vil ha mer informasjon, se "SDI OUT-kontakt (BNC-type)" i "Koble til eksterne skjermer og
opptaksenheter".

12.

 Sensor for infrarød-fjernkontroll (bak)
Infrarød-sensor for den medfølgende infrarød-fjernkontrollen.

13.

Vifte/luftuttak
Avgir varme fra innsiden av enheten.

Merknad

Ikke dekk over luftutløpet. Det kan føre til funksjonsfeil.

Merk deg at området i nærheten av luftuttaket kan bli varmt.

14.

GENLOCK-kontakt
Brukes som inngang for eksternt synkroniseringssignal.

Hvis du vil ha mer informasjon, se "Synkronisere fasen av videosignalet (Genlock)".

15.

AUDIO IN-kontakt (5-pinners kontakt av XLR-typen)
Brukes som inngang for signalet fra en ekstern mikrofon eller lydenhet.
Den fungerer som en AUDIO IN CH-1-kontakt eller AUDIO IN CH-2-kontakt.

Hvis du vil ha mer informasjon, se "Koble til en ekstern mikrofon eller ekstern lydenhet".

16.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sett fra siden

Dette emnet beskriver plasseringen og funksjonen til deler på siden av enheten.

Hint

Denne beskrivelsen refererer til illustrasjonen av enheten uten et tilkoblet objektiv.

Pan/tilt-låsespak
Låser enhetens pan/tilt-mekanisme. Brukes i følgende tilfeller.

Ved transport eller pakking av enheten.
Når du fester eller fjerner et objektiv. Hvis du vil ha mer informasjon, se "Hvordan sette på et objektiv" eller "Fjerne
et objektiv".
Når du bruker et objektiv som ikke støtter pan/tilt-betjening (for eksempel Sony-objektivene
SEL100400GM/SEL200600G/SEL400F28GM/SEL600F40GM).
Ved transport av enheten, fjern alltid objektivet og sett i låseposisjon.

1.
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Beslektet emne

Hvordan sette på et objektiv

Fjerne et objektiv

Sette inn minnekort

Få tilgang til Web App fra en nettleser

5-041-958-83(1) Copyright 2022 Sony Corporation

Hint

Pan/tilt-bevegelsen kan festes i følgende vinkler.

Skyvebunn2.

Skruehull for eksterne enheter (4 steder)
For M3-skruer med lengde på opptil 6 mm.

Merknad

Ikke bruk skruer som er lengre enn 6 mm. Det kan føre til funksjonsfeil.

3.

Tilgangsindikator A4.

Tilgangsindikator B
Indikatoren lyser eller blinker når opptaksmedier settes inn.

Hvis du vil ha mer informasjon, se "Sette inn minnekort".

5.

Kortspor for CFexpress type A/SD (A)6.

Kortspor for CFexpress type A/SD (B)
Brukes til å sette inn opptaksmedier.

Hvis du vil ha mer informasjon, se "Sette inn minnekort".

7.

QR-kode for nettverkstilkobling
Brukes ved konfigurering av innledende innstillinger.

Hvis du vil ha mer informasjon, se "Få tilgang til Web App fra en nettleser".

8.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sett ovenfra

Dette emnet beskriver plasseringen og funksjonen til deler på oversiden av enheten.

Hint

Denne beskrivelsen refererer til illustrasjonen av enheten uten et tilkoblet objektiv.

5-041-958-83(1) Copyright 2022 Sony Corporation

Skruehull for eksterne enheter (2 steder)
Kompatibel med 1/4-20 UNC-skruer for et stativ.
Maksimal lengde på 6 mm.

1.

ɸ (Imager-merke)
Imager-merket er på samme plan som bildesensoren.
Hvis du vil måle avstanden mellom enheten og motivet nøyaktig, bruker du dette Imager-merket som et
referansepunkt.

2.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sett fra undersiden

Dette emnet beskriver plasseringen og funksjonen til deler på undersiden av enheten.

Hint

Denne beskrivelsen refererer til illustrasjonen av enheten uten et tilkoblet objektiv.

Skruehull for montering av takbrakett (6 steder, 5,5 mm (7/32 tommer) effektiv gjengedybde)
Når du monterer enheten i et tak eller en hylle på et høyt sted, fester du braketten for huset (alternativ) til bunnen av
enheten ved hjelp av de seks monteringsskruene for hovedenhetsbraketten i disse skruehullene.

Hvis du vil ha mer informasjon om montering, se "Montering oppreist på et høyt, fast sted" og "Montering i tak".

1.

Monteringsskruer for stativ (2 steder)
Brukes ved montering av enheten på et kamerastativ (alternativ, 1/4--20 UNC-skruer med lengde på opptil 5,5 mm
(7/32 tommer)).

Merknad

2.
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Beslektet emne

Montering oppreist på et høyt, fast sted

Montering i tak
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Ikke bruk skruer som er lengre enn 5,5 mm (7/32 tommer). Det kan føre til funksjonsfeil.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Objektivstøtte

Dette emnet beskriver plasseringen og funksjonen til objektivstøtten for enheten.

Hint

Denne beskrivelsen refererer til illustrasjonen av enheten uten et tilkoblet objektiv.

Objektivstøttestang (2)
Støtter objektivet.
Kan også brukes til montering av generelt tilbehør for Ø15-stang.

1.
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Objektivstøtteenhet
Objektivstøtten kan gli fremover/bakover i henhold til objektivet og deretter festes.

2.

Festeskrue for objektivstøttens sokkel
Festes til objektivstøttens sokkel. Du kan justere skruen opp/ned slik at den samsvarer med høyden på
objektivstøttens sokkel.

3.

Objektivstøttestangens klemmespak (2 steder)
Fester forover/bakover-posisjonen til objektivstøtteenheten.

4.

Klemmespak for festeskrue for objektivstøttens sokkel
Fester den vertikale posisjonen til festeskruen for objektivstøttens sokkel.

Hint

Hvis en klemmespak er i en posisjon som gjør den vanskelig å dreie, løsner du klemmespaken og roterer den til en vinkel
som gjør betjeningen enklere. Når den er i ønsket posisjon, fester du klemmespaken.

A: Klemmespak for festeskrue for objektivstøttens sokkel
B: Objektivstøttestangens klemmespak

Merknad

For å hindre at objektivstøtteenheten forstyrrer pan/tilt-betjening, flytter du objektivstøtteenheten opp mot kamerahodet når du
ikke bruker objektivstøtteenheten, og flytter festeskruen for objektivstøttens sokkel til høyeste posisjon (nærmest objektivet).

5.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Plassering og funksjon for infrarød-kontrollens deler (følger med)

Dette emnet beskriver plasseringen og funksjonen til infrarød-kontrollens deler (følger med).

Knappen REC● (START/STOP opptak)
Trykk for å starte eller stoppe opptak.

1.

MENU-knapp
Trykk for å vise eller skjule kameramenyen.

2.

GUI-kontrollknapper
Trykk for å utføre operasjoner i kameramenyen, i meldingsdialogbokser som inneholder knapper og andre
skjermvisningsfunksjoner.

3.

CANC./BACK-knapp
Trykk for å avbryte en innstilling eller gå tilbake til forrige skjermbilde på kameramenyen på enheten.

4.
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Batteri for infrarød-fjernkontroll

Infrarød-fjernkontrollen trenger to AA-batterier (LR6).
Sett batteriene inn i infrarød-fjernkontrollen som vist i følgende diagram.

Pan/tilt-kontrollknapper
Trykk på pilknappene for å kontrollere pan/tilt for kameraet. Trykk på HOME-knappen for å snu retningen på
kameraet slik at det vender mot fronten.

5.

Kontrollknapper for forhåndsinnstilt posisjon
Trykk og hold inne PRESET-knappen og trykk på én av de 1 til 3 knappene for å lagre status for kameraretning, zoom
og fokusjustering i tallknappen som trykkes ned.
Trykk på en tallknapp med lagrede innstillinger for å tilbakekalle den lagrede tilstanden.

6.

Fokuskontrollknapper
Brukes til å justere fokus.
Hvis du vil justere fokus automatisk, trykker du på AF-knappen.
Hvis du vil justere fokus manuelt, trykker du på MF-knappen og trykker på knappen F (Far) for å fokusere på
fjernmotiver eller knappen N (Near) for å fokusere på nærmotiver.

7.

Knappene 1 til 3 som kan tilordnes
Utfører funksjonene som er tilordnet de knappene som kan tilordnes ved hjelp av kameramenyen.
Hvis du tilordner funksjonen [Direct Menu] til en knapp som kan tilordnes, kan du justere eksponeringen, hvitbalansen
og andre innstillinger ved hjelp av GUI-kontrollknappene.

Hvis du vil ha mer informasjon om tilordning ved hjelp av kameramenyen, se "Knapper som kan tilordnes".

Hvis du vil ha mer informasjon om hurtigmenyen, se "Bruk av hurtigmenyen".

8.

 (strøm)-knapp
Trykk på for å slå på enheten eller for å sette strømforsyningen i standby-modus.

9.

THUMBNAIL-knapp
Viser miniatyrbildeskjermen som viser klippene som er tatt opp på minnekortet til enheten.

Hvis du vil ha mer informasjon om miniatyrbildeskjermen, se "Miniatyrbildeskjerm".

Du kan velge klipp og kontrollere avspilling på miniatyrbildeskjermen ved hjelp av GUI-kontrollknappene.

Hvis du vil ha mer informasjon om hvordan du velger klipp og kontrollerer avspilling, se "Spille av innspilte klipp"
og "Betjening av innspilte klipp".

10.

SLOT SEL (valg av minnekortspor (A)/(B))-knapp
Når to minnekort er satt inn, trykker du på knappen for å bytte mellom minnekortene for opptak.
Trykk på denne knappen mens miniatyrbildeskjermen vises for å bytte mellom minnekortene som skal vises.

11.

P/T RESET (tilbakestilling av pan/tilt)-knapp
Tilbakestiller pan/tilt-funksjonene. Trykk på knappen når POWER-lampen og NETWORK-lampen blinker samtidig,
eller når knappen [Execute Pan-Tilt Reset] vises i kontrollpanelet for rammer i Web App.

12.

Zoomkontrollknapper
Trykk på knappen T (Telephoto) for å zoome inn.
Trykk på knappen W (Wide) for å zoome ut.

13.
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Merknad

Ikke bruk andre batterier enn manganbatterier eller alkaliske batterier, da de kan sprekke.

Kast brukte batterier i henhold til landets eller regionens lover og forskrifter.

Beslektet emne

Knapper som kan tilordnes

Bruk av hurtigmenyen

Miniatyrbildeskjerm

Spille av innspilte klipp

Betjening av innspilte klipp

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Oversikt over Web App-skjermbildet

Ved å koble til et nettbrett eller en datamaskin kan du bruke pan/tilt, zoome, ta opp, spille av videoopptak og konfigurere
enheten fra en nettleser (heretter kalles denne funksjonen "Web App").

Hvis du vil ha mer informasjon om hvordan du starter Web App, se "Få tilgang til Web App fra en nettleser".

Merknad

Web App støtter ikke lydutdata fra kameraet.

Når Web App startes, vises følgende skjermbilde for direkte betjening.

Skjermbilde for direkte betjening

Hvis du vil ha mer informasjon om skjermbildet for direkte betjening, se "Struktur for skjermbildet for direkte
betjening".
Knapper og ikoner som er felles for skjermbildet for direkte betjening og skjermbildet for betjening av avspilling, vises
øverst på skjermen.

Hvis du vil ha mer informasjon om fellesområdet for skjermbildene, se "Struktur for fellesområde på skjermbilder".
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Du kan bytte mellom skjermbilder ved å trykke på vekslefanene for skjermbilder i fellesområdet.

Skjermbilde for betjening av avspilling

Trykk på fanen [Playback] for å vise skjermbildet for betjening av avspilling.

Hvis du vil ha mer informasjon om skjermbildet for betjening av avspilling, se "Struktur for skjermbildet for betjening
av avspilling".

Skjermbilde for innstillinger

Trykk på fanen [Settings] for å vise skjermbildet for innstillinger (heretter kalt nettmenyen).
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Merknad

I nettmenyen brukes ikke innstillingene før du trykker på [OK]-knappen. Hvis du endrer innstillinger på en side som har en [OK]-
knapp, må du passe på å trykke på [OK]-knappen.

Hvis du vil ha mer informasjon om skjermbildet for innstillinger, se "Struktur for skjermbildet for innstillinger".
I Hjelpveiledning blir skjermbildet for innstillinger av Web App kalt nettmenyen.

Beslektet emne
Få tilgang til Web App fra en nettleser

Struktur for skjermbildet for direkte betjening

Struktur for fellesområde på skjermbilder

Struktur for skjermbildet for betjening av avspilling

Struktur for skjermbildet for innstillinger

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur for fellesområde på skjermbilder

Dette emnet beskriver strukturen for fellesområdet på skjermbilder.

Kameranavn
Viser navnet på kameraet.
Du kan endre navnet ved hjelp av [Network] > [Camera Name] i nettmenyen.
Bakgrunnsfargen endres i henhold til det eksterne tellesignalet.

1.

Strømbryter
Når enheten er slått på, vises [Power ON]. Du kan trykke på bryteren og velge [Power Standby] for å sette enhetens
strømforsyning i standby-modus.
Når [Power Standby] vises, kan du trykke på bryteren og velge [Power ON] for å slå på enhetens strømforsyning.

2.

Vekslefaner for skjermbilde for betjening
Trykk på en fane for å vise det tilsvarende skjermbildet for betjening.
[Live]-fane: Vise skjermbildet for direkte betjening.
[Playback]-fane: Vise skjermbildet for betjening av avspilling.
[Settings]-fane: Vise skjermbildet for innstillinger (nettmenyen).

3.

Varslingsmerke
Når det kommer en melding, endres merkeindikasjonen som vist nedenfor.

 (Medinger På)
Utfør den nødvendige handlingen i henhold til meldingen som vises i kamerabildepanelet.

Merknad

Meldinger vises ikke når [Monitoring] > [Output Display] > [HDMI/Stream] er satt til [Off] i nettmenyen. Sett til [On] for å
kontrollere innholdet i meldinger.

4.

 (Kamerastatus)-knapp
Trykk på knappen for å vise informasjon om bilde tatt av kamera / utgangsbildesignal, objektivinformasjon, og
objektivkontrollerstatus (valgfritt) på en separat skjerm.

5.
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Når objektivkontroller (valgfritt) relatert varsling inntreffer, endres indikasjonen som vist nedenfor.

Låsebryter for betjening av skjerm
(Betjening Lås opp): Sett bryteren i venstre posisjon for å kontrollere betjening på skjermbildet for direkte

betjening og skjermbildet for betjening av avspilling.
(Betjening Lås): Sett bryteren i høyre posisjon for å låse for betjening på skjermbildet for direkte betjening og

skjermbildet for betjening av avspilling for å forhindre utilsiktet feilbetjening.

6.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur for skjermbildet for direkte betjening

Dette emnet beskriver strukturen for skjermbildet for direkte betjening.

Kontrollpanel for forhåndsinnstilt posisjon
Viser den registrerte posisjonen til en forhåndsinnstilling ved hjelp av et miniatyrbilde. Dobbeltklikk på miniatyrbildet
for å gå tilbake til posisjonen som er lagret i forhåndsinnstillingen.

Hvis du vil ha mer informasjon om forhåndsinnstilt posisjon, se "Lagre/gjenopprette pan/tilt, zoomposisjon og
fokusinnstilling ved hjelp av Web App".
Hvis du vil ha mer informasjon om PTZ trace, se "Opptak med funksjoner for kamera-framing ved hjelp av Web
App."

1.

Kameraets bildepanel
Viser gjeldende kamerabilde og statusen for enheten.
Det viser det samme bildet som HDMI-utgangen.
Følgende status vises over bildet. En rød ramme eller grønn ramme vises også rundt bildet i henhold til det mottatte
eksterne tellesignalet.

2.
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[Display]-knapp
Trykk på denne knappen for å vise kamerainformasjon på bildet.
Trykk en gang til mens kamerainformasjonen vises for å skjule kamerainformasjonen.

I tillegg til markører, vises enkelte autofokus-relaterte indikatorer og meldinger i henhold til status, og disse kan ikke
skjules ved å trykke på [Display]-knappen.

Hvis du vil ha mer informasjon om kamerainformasjonen som vises, se "Kameraets skjermvisning".

Stoppknapp for sanntidssporing i AF
Trykk på knappen for å stoppe sporingen av et motiv.

Nr. Skjerm Beskrivelse

2-
1

Indikator for fokusmodus Se "Indikator for fokusmodus" i "Kameraets skjermvisning".

2-
2

Opptaksmodus, spor A/B, indikator for
opptaksintervall ved intervallopptak

Se "Opptaksmodus, spor A/B, indikator for opptaksintervall ved
intervallopptak" i "Kameraets skjermvisning".

2-
3

Statusindikator for strømming
Vises under strømming (når [Stream Setting] er satt til [RTMP]
eller kun [SRT-Caller]).

2-
4

Driftsstatusindikator for RAW-utdata
Viser ut-status for RAW-signalet. Hvis du vil ha mer informasjon
om RAW, se "Hvordan ta opp RAW-video".

2-
5

Indikator for gjenværende mediekapasitet
Se "Indikator for gjenværende mediekapasitet" i "Kameraets
skjermvisning".

2-
6

Indikator for zoomposisjon
Se "Indikator for zoomposisjon" i "Kameraets skjermvisning".
Når en objektivkontroller (valgfritt) er tilkoblet, vises . Hvis det
oppstår en feil i objektivkontrolleren (valgfritt), vises .

2-
7

AE-modus/AE-nivåindikator Se "AE-modus/AE-nivåindikator" i "Kameraets skjermvisning".
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Se "Sporing av et spesifisert motiv (Realtime Tracking AF)" for å få mer informasjon.
Opptak START/STOP-knapp
Trykk på knappen for å starte opptak. Under opptak lyser START/STOP-knappen for opptak rødt.
Trykk på den under opptak for å stoppe opptaket.
Du kan sette Hold-bryteren i Hold-tilstand for å forhindre feilbetjening av START/STOP-knappen for opptak.

3.

Kameraets panel for grunnleggende konfigurasjon
Viser innstillinger for grunnleggende funksjoner som kreves for opptak via knapper. Trykk på en knapp for å vise det
tilsvarende oppsettskjermbildet for hver funksjon i kameraets panel for justering av grunnleggende konfigurasjon (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Hvis du vil ha mer informasjon, kan du se beskrivelsen av hver funksjon.

4.

Funksjon Referanse

FPS "Sakte og rask bevegelse"

ISO/Gain
"Angi basisfølsomheten", "Automatisk justering av forsterkningen" og "Manuell justering av
forsterkningen" i "Justere forsterkningen"

Exposure
Index

"Angi basisfølsomheten" og "Endre fordelingen av mørke og lyse områder i bildet som er tatt"

Shutter "Automatisk justering av lukkeren" og "Manuell justering av lukkeren" i "Justere lukkeren"

Iris "Automatisk justering av iris" og "Manuell justering av iris" i "Justering av iris"

ND Filter "Om ND-filteret" i "Justere lysnivået (ND-filter)"

Scene File "Oversikt over utseende" og andre emner i "Ta bilder med ønsket utseende"

Base
Look/LUT

"Fotografering med utseendejustering i postproduksjon"

White
Balance

"Skjermbilde for justering av hvitbalanse"

Knapper som kan tilordnes / Kameraets panel for justering av grunnleggende konfigurasjon5.
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Viser knapper som kan tilordnes under normal drift. Trykk på panelknappene for grunnleggende konfigurasjon av
kameraet (element 4) for å vise de tilsvarende oppsettelementene. Trykk på [X]-knappen eller trykk på knappen for
kameraoppsettpanelet igjen for å gå tilbake til visningen for knapp som kan tilordnes.

Hvis du vil ha mer informasjon om knapper som kan tilordnes, se "Knapper som kan tilordnes".
Hvis du vil ha mer informasjon om kameraets panel for justering av grunnleggende konfigurasjon, kan du se
beskrivelsen av hver funksjon.

Kontrollpanel for rammer / GUI-kontrollpanel
Veksle mellom kontrollpanel for rammer / GUI-kontrollpanel ved hjelp av fanene øverst.
Du kan trykke på  (Lukk)-knappen øverst til høyre på skjermen for å skjule kontrollpanelet for å forhindre utilsiktet
bruk. Hvis kontrollpanelet ikke vises, trykk på knappen  (Åpne) for å vise det.
Bruk kontrollpanelet for rammer til å justere rammene. Trykk på fanen  (Pan/tilt/zoom)-fanen for å vise
kontrollpanelet for rammer.

Hvis du vil ha mer informasjon om betjening, se "Justere rammene".

Hint

Styrespakdelen av vinkelen på kontrollpanelet for rammer vises som vist nedenfor når pan/tilt-betjening er deaktivert og når
pan/tilt-initialisering er nødvendig.

Når pan/tilt-betjening er låst ved hjelp av pan/tilt-låsespaken

Når pan/tilt-betjening ikke er initialisert

6.
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Når pan/tilt-betjening må tilbakestilles

Når pan/tilt-betjening er deaktivert

Når pan/tilt-operasjon ikke er initialisert eller må tilbakestilles, kan du raskt få tilgang til  (Pan/tilt tilbakestill)-knappen i
kamerakontrollpanelet ved å trykke på meldingen som vises under styrespaken.

Bruk GUI-kontrollpanelet til å betjene kameramenyen, klippavspilling og andre funksjoner. Trykk på  (Kam
GUI)-fanen for å vise GUI-kontrollpanelet.

Hvis du vil ha mer informasjon om betjening, kan du se "Betjene kameramenyen" og "Spille av innspilte klipp".
Kameraets kontrollpanel
Brukes til å konfigurere funksjonene som kreves for å betjene kameraet.
Veksle mellom skjermbildene som skal vises ved hjelp av fanene øverst.
Du kan trykke på  (Lukk)-knappen øverst til høyre på skjermen for å skjule kontrollpanelet for å forhindre utilsiktet
bruk. Hvis kontrollpanelet ikke vises, trykk på knappen  (Åpne) for å vise det.

7.
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Hvis du vil ha mer informasjon, se beskrivelsen av hver funksjon.

  (Main)-fanen
Viser oppsettelementene for ofte brukte funksjoner.
Funksjonene til øverste og nederste glidebryter kan endres ved å trykke på [▼]-knappen og velge fra listen som
vises. Følgende funksjoner kan velges.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

  (Focus)-fanen
Viser oppsettelementene som gjelder fokus.

  (Audio)-fanen

Viser oppsettelementene som gjelder lyd.

Vist i henhold til menyinnstillingene.*
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 (Stream)-fanen
Viser oppsettelementene som gjelder strømming.
Elementene som vises, varierer avhengig av innstillingen for strømmeformat.
Når den er satt til [RTMP] eller [SRT-Caller], kan strømming startes/stoppes på dette skjermbildet.

Hvis du vil ha mer informasjon, se "Om strømming" og andre emner i "Konfigurere strømming".
Feilinformasjon vises hvis en tilkoblingsfeil inntreffer. For mer informasjon og feilinformasjon, se
"Feil-/varselmeldinger".

 (Others)-fanen
Viser oppsettelementene som gjelder andre funksjoner.
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Beslektet emne

Lagre/gjenopprette pan/tilt, zoomposisjon og fokusinnstilling ved hjelp av Web App

Opptak med funksjoner for kamera-framing med bruk av Web App

Kameraets skjermvisning

Hvordan ta opp RAW-video

Sporing av et spesifisert motiv (Realtime Tracking AF)

Sakte og rask bevegelse

Angi basisfølsomheten

Automatisk justering av forsterkningen

Manuell justering av forsterkningen

Endre fordelingen av mørke og lyse områder i bildet som er tatt

Automatisk justering av lukkeren

Manuell justering av lukkeren

Automatisk justering av iris

Manuell justering av iris

Om ND-filteret

Oversikt over utseende

Fotografering med utseendejustering i postproduksjon

Skjermbilde for justering av hvitbalanse

Knapper som kan tilordnes

Spille av innspilte klipp

Betjene kameramenyen

Om strømming

Feil-/varselmeldinger

5-041-958-83(1) Copyright 2022 Sony Corporation

Ved å trykke på [Full Screen Display]-knappen åpnes det en ny fane i nettleseren som viser kamerabildepanelet i
fullskjerm.
Bare bildevisning forekommer; berørings-AF og andre funksjoner er ikke tilgjengelige.

Merknad

Live-operasjonsskjermen på den originale fanen fortsetter å fungere. Det anbefales at du lukker fanen for å redusere antallet
samtidige tilkoblinger hvis ingen operasjon kreves.

Trykk på  (initialiser objektivkontroller)-knappen for å initialisere objektivkontroller (valgfritt, fra
tredjepart). Denne knappen er kun aktivert når [Technical] > [Lens Controller] > [Zoom] > [Setting] er satt til [On] i
nettmenyen.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur for skjermbildet for betjening av avspilling

Dette emnet beskriver strukturen for skjermbildet for betjening av avspilling.

Kameraets bildepanel
Viser avspillingsbildet og relatert informasjon. Når avspillingen er stoppet, vises skjermbildet for kamerabilde.

1.
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1-1 Dato og klokkeslett for opptak
1-2 Statusindikator for avspilling
1-3 Indikator for avspillingsformat (bildestørrelse)
1-4 Indikator for avspillingsformat (kodek)
1-5 Visning av klippnavn
1-6 Klippnummer / totalt antall klipp
1-7 Visning av LUT-navn
1-8 Statusindikator for strømming
1-9 Indikator for avspillingsformat (rammefrekvens og skannemetode)
1-10 Indikator for opptaksutseende

Kontrollpanel for avspilling

Viser kontrollknappene for avspilling.

[Display]-knapp
Trykk for å veksle mellom skjermbildevisningen på bildet.
[Thumbnail]-knapp
Viser klippene som er tatt opp på minnekortet i kamerabildepanelet som miniatyrbilder.

2.

Knapp Funksjon

(Spill av / Pause)-knapp Spiller av et klipp. Setter klippet på pause under avspilling.

(Spol fremover)-knapp,  (Spol
bakover)-knapp

Spiller av et klipp i høy hastighet. Når du trykker på knappen, endres
avspillingshastigheten i tre trinn.

(Neste)-knapp,  (Forrige)-
knapp

Hopper til starten av klippet eller det forrige/neste klippet.

(Stop)-knapp Stopper avspillingen.
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Beslektet emne

Miniatyrbildeskjerm

Knapper som kan tilordnes

Spille av innspilte klipp

5-041-958-83(1) Copyright 2022 Sony Corporation

Når du trykker på [Thumbnail]-knappen under visning av miniatyrbildeskjermen, lukkes miniatyrbildeskjermen og går
tilbake til kamerabildet.

Hvis du vil ha mer informasjon om miniatyrbildeskjermen, se "Miniatyrbildeskjerm".

[Slot Select]-knapp
Veksler mellom målavspillingsmediene.

Knapper som kan tilordnes
Viser knappene som kan tilordnes som er tilordnet funksjonene til enheten.

Hvis du vil ha mer informasjon om knapper som kan tilordnes, se "Knapper som kan tilordnes".

3.

GUI-kontrollpanel
Bruk GUI-kontrollpanelet til å betjene kameramenyen, klippavspilling og andre funksjoner.

Hvis du vil ha mer informasjon om betjening, kan du se "Betjene kameramenyen" og "Spille av innspilte klipp".

4.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur for skjermbildet for innstillinger

Bruk skjermbildet for innstillinger til å konfigurere de forskjellige oppsettelementene til enheten, inkludert innledende
innstillinger, nettverksinnstillinger og opptaks-/avspillingsinnstillinger, ved hjelp av nettmenyen.

Merknad

I nettmenyen, som en generell regel, brukes ikke innstillingene før du trykker på [OK]-knappen. Hvis du endrer innstillinger på en
side som har en [OK]-knapp, må du passe på å trykke på [OK]-knappen.

Hvis du vil ha mer informasjon om skjermbildet for innstillinger, se "Nettmeny og detaljerte innstillinger".

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kamerameny

Trykk på [Menu]-knappen i kontrollpanelet for grafisk brukergrensesnitt på skjermbildet for direkte betjening eller
avspillingsdrift for å vise kameramenyen i kamerabildepanelet.

Du kan konfigurere innstillingene som kreves for opptak og avspilling ved hjelp av kameramenyen.
Trykk på [Menu]-knappen mens kameramenyen vises for å skjule kameramenyen.
Kameramenyen betjenes ved hjelp av GUI-kontrollpanelet.

Hvis du vil ha mer informasjon om kameramenyen, se "Kamerameny og detaljerte innstillinger".

Merknad

Når [Monitoring] > [Output Display] > [HDMI/Stream] er satt til Off i nettmenyen (deaktiverer informasjonsoverlegg på
skjermbildevisningen), vises ikke kameramenyen lenger i kamerabildepanelet. Vær imidlertid oppmerksom på at
menyoperasjoner i GUI-kontrollpanelet fremdeles er aktive. Hvis du vil unngå utilsiktet betjening, må du passe på at du ikke
utfører noen menyoperasjoner ved hjelp av GUI-kontrollpanelet når [HDMI/Stream] er satt til Off.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameraets skjermvisning

Du kan vise statusen og innstillingene for enheten som er lagt over på utdatabildet fra kameraet. Du kan angi utdataene
som skjermvisningen er aktivert for ved hjelp av [Monitoring] > [Output Display]i nettmenyen.
Du kan vise/skjule informasjonen ved hjelp av [Display]-knappen. Selv om den er skjult, vises den når du utfører
betjening av hurtigmenyen.
Du kan vise/skjule elementer individuelt ved hjelp av [Monitoring] > [Display On/Off] i kameramenyen.

Informasjon som vises på skjermen under opptak

Indikator for opplasting / indikator for gjenværende filer

Hvis du vil ha mer informasjon om overføring av filer, se "Om filoverføring" og andre emner i "Overføre filer".

1.

Indikator for fokusområde
Viser fokusområdet for autofokus.

Hvis du vil ha mer informasjon om autofokus, se "Justere automatisk ved hjelp av Web App" og andre emner i
"Justere fokus automatisk (autofokus)".

2.

Opptaksmodus, spor A/B, indikator for opptaksintervall ved intervallopptak

Hvis du vil ha mer informasjon om intervallopptak, se "Opptak av video med jevne mellomrom (intervallopptak)".

3.

Skjerm Betydning

●Rec Opptak

Stby Pause i opptak

Indikator for feltdybde4.

Indikator for bildeskannemodus5.
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Det vises et -merke (uoverensstemmelse) hvis det ikke er samsvar mellom bildesirkelstørrelsen på objektivet og
innstillingen som er i bruk for bildeskannemodus for bildestørrelse.
Når bildeskannemodus er satt til FF, vises et C-merke i moduser med smalere visningsvinkel (beskåret).
Beskjæring skjer i følgende moduser:

Når opptaksformatet er 3840×2160 og S&Q Motion-rammefrekvens er 100 fps eller 120 fps
Når [Codec] er satt til RAW eller RAW & XAVC-I og RAW-utdataformatet er 3840×2160
Hvis du vil ha mer informasjon om bildeskannemodusen, se "Angi bildeskannemodusen" i "Konfigurere
grunnleggende drift".

Driftsstatusindikator for RAW-utdata
Viser ut-status for RAW-signalet.

Hvis du vil ha mer informasjon om RAW, se "Hvordan ta opp RAW-video".

6.

Indikator for opptakets rammefrekvens for sakte og rask bevegelse

Hvis du vil ha mer informasjon om sakte og rask bevegelse, se "Sakte og rask bevegelse".

7.

Fokusposisjonsindikator

Viser fokusposisjonen.

8.

Indikator for fokusmodus

AF for ansikts-/øyedeteksjon

Hvis du vil ha mer informasjon om AF for ansikts-/øyedeteksjon, se "Sporing med ansikts-/øyedeteksjon
(Face/Eye Detection AF)".

9.

Skjerm Betydning

Focus Hold Focus Hold-modus

MF MF-modus

AF AF-modus

 (Sanntids sporing i AF-modus) Sanntids sporing i AF-modus

Skjerm Betydning

 (AF for ansikts-/øyedeteksjon) Angir at AF for ansikts-/øyedeteksjon er aktivt

 (kun AF for ansikt/øye) Angir at kun AF for ansikt/øye er aktiv

 (lagret sporingsansikt) Angir at et sporingsansikt er lagret

 (AF satt på pause) Indikerer at AF ble satt på pause*

Vises når det ikke finnes noen lagret ansiktssporing og et ansikt ikke oppdages, eller når det finnes en lagret ansiktssporing, men det
lagrede ansiktet ikke blir oppdaget.

*

Indikator for zoomposisjon
Viser zoomposisjonen i området 0 (vidvinkel) til 99 (telefoto) (hvis et objektiv som støtter zoomposisjonsvisning er satt
på).
Du kan også endre indikatoren til en stolpevisning eller brennviddevisning ved hjelp av innstillingen [Technical] >
[Lens] > [Zoom Position Display] i kameramenyen.
Følgende elementer legges til visningen når Clear Image Zoom er aktivert.

10.
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Hvis du vil ha mer informasjon om zoom, se "Angi zoomtype" og andre emner i "Justere zoomen".

Skjerm Betydning

 (Clear Image Zoom er aktivert) Clear Image Zoom er aktivert

Forstørrelsesverdi Ved bruk av Clear Image Zoom

Indikator for bildestabiliseringsmodus11.

Statusindikator for SDI-utgang/HDMI-utgang for REC Control
Viser ut-status for REC Control-signalet.

Hvis du vil ha mer informasjon, se "Koble til eksterne skjermer og opptaksenheter".

12.

Fokusindikator

Hvis du vil ha mer informasjon, se "Bruke autofokus for enkeltbilde (Push Auto Focus (AF-S))" i "Justere fokuset".

13.

Indikator for gjenværende mediekapasitet
Det vises et  (beskyttelses)-ikon hvis minnekortet er skrivebeskyttet.

14.

Indikator for hvitbalanse-modus15.

Skjerm Betydning

 (ATW) Auto-modus

 (ATW Hold) Auto-modus er satt i pause

W:P Forhåndsinnstilt modus

W:A Minne A, modus

Ekstern lås-indikator/tidsdatavisning for tidskode
Viser "EXT-LK" når den er låst til tidskoden fra en ekstern enhet.

Hvis du vil ha mer informasjon om tidskode, se "Angi tidsdata".

16.

ND-filterindikator

Hvis du vil ha mer informasjon om ND-filtre, se "Justere lysnivået (ND-filter)".
Hvis du vil ha mer informasjon om Bokeh-kontroll, kan du se "Justere Bokeh (Bokeh-kontrollfunksjon)".

17.

Skjerm Betydning

 (A) Auto-modus

 (B) Bokeh-kontrollmodus

Scenefil-indikator

Hvis du vil ha mer informasjon om scenefiler, se "Oversikt over utseende" og andre emner i "Ta bilder med ønsket
utseende".

18.

Irisindikator
Viser irisposisjonen (F-verdi) (hvis et objektiv som støtter irisinnstillingsvisning er satt på).

19.
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Hvis du vil ha mer informasjon om iris, se "Automatisk justering av iris" og "Manuell justering av iris".
Varselindikator for videonivå20.

Forsterkningsindikator
Viser EI-verdien i Cine EI/Cine EI Quick-modus.

Hvis du vil ha mer informasjon om forsterkningen, se "Automatisk justering av forsterkningen" og "Manuell
justering av forsterkningen".
Hvis du vil ha mer informasjon om Cine EI/Cine EI Quick -modusen, se "Angi opptaksmodusen" i "Konfigurere
grunnleggende drift".

21.

Skjerm Betydning

 (A) Auto-modus

L Forhåndsinnstilt L-modus

 (Midlertidig justeringsmodus) Midlertidig justeringsmodus

 (B) Bokeh-kontrollmodus

Visning av klippnavn
Viser navnet på klippet som tas opp eller skal tas opp påfølgende.
Hvis den blinker er det en uoverensstemmelse mellom siste klippnavn på opptaksmediet og [Camera ID]- eller [Reel
Number]-innstillingene. Hvis du vil ha mer informasjon, kan du se [Clip Name Format] > [Auto Naming]-beskrivelsen.

22.

Lukkerindikator

Hvis du vil ha mer informasjon om lukkeren, se "Automatisk justering av lukkeren" og "Manuell justering av
lukkeren".

23.

AE-modus/AE-nivåindikator

Hvis du vil ha mer informasjon om automatisk eksponering, se "Stille inn målnivået for automatisk justering av
lysstyrke".

24.

Spritlibelle
Viser det horisontale nivået i trinn på ±1° opp til ±15°.

25.

Lydnivåmåler
Viser lydnivået for hver kanal.

26.

Videosignalskjerm
Viser en kurve, vektorskop og et histogram.
Den oransje linjen angir innstillingsverdien for markøren for lysstyrkenivå.
I Log-opptaksmoduser vises skjermmålets LUT-type over displayet.

Hvis du vil ha mer informasjon, se "Videosignalskjerm".
Hvis du vil ha mer informasjon om Log shooting-moduser, se "Angi opptaksmodusen" i "Konfigurere
grunnleggende drift".

27.

Base Sensitivity-indikator/Base ISO-indikator
I Custom modus viser den basisfølsomheten som er satt ved hjelp av knappen [ISO/Gain / Exposure Index] i
kameraets panel for grunnleggende konfigurasjon eller [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] i
kameramenyen.
I modusen Log shooting viser den Base ISO-følsomheten som er satt ved hjelp av knappen [ISO/Gain / Exposure
Index] i kameraets panel for grunnleggende konfigurasjon eller [Shooting] > [ISO/Gain/EI] > [Base ISO] i
kameramenyen.

28.
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Informasjon som vises på skjermen under avspilling

Følgende informasjon vises over avspillingsbildet.

Hvis du vil ha mer informasjon om basisfølsomheten, se "Valg av basisfølsomhet".
Hvis du vil ha mer informasjon om Log shooting-moduser, se "Angi opptaksmodusen" i "Konfigurere
grunnleggende drift".

Indikator for overvåkingsutseende
I Log shooting-moduser viser den skjermens LUT-innstilling.

Hvis du vil ha mer informasjon om LUT-innstilling, se "Fotografering med utseendejustering i postproduksjon" og
tilknyttede emner.
Hvis du vil ha mer informasjon om Log shooting-moduser, se "Angi opptaksmodusen" i "Konfigurere
grunnleggende drift".

29.

Indikator for basisutseende/opptaksutseende
Viser innstillingen for basisutseende.
I Log shooting-moduser viser den videosignalet som skal tas opp på minnekortene.

Hvis du vil ha mer informasjon om basisutseendet, se "Oversikt over utseende" i "Ta bilder med ønsket
utseende".
Hvis du vil ha mer informasjon om Log shooting-moduser, se "Angi opptaksmodusen" i "Konfigurere
grunnleggende drift".

30.

Proksystatusindikator31.

Indikator for opptaksformat (kodek)
Viser navnet på formatet for opptak på minnekort.
Angi opptaksformatet (kodek) ved hjelp av [Project] > [Rec Format] > [Codec] i nettmenyen eller kameramenyen.

32.

Indikator for opptaksformat (bildefrekvens og skannemetode)33.

Indikator for opptaksformat (bildestørrelse)
Viser bildestørrelsen for opptak på minnekort.
Angi opptaksformatet (bildestørrelse) ved hjelp av [Project] > [Rec Format] > [Codec] i nettmenyen eller
kameramenyen.

34.

Telleindikator
Viser en rød ramme eller grønn ramme rundt bildet i henhold til det mottatte eksterne tellesignalet.

35.
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Beslektet emne

Om filoverføring

Justere automatisk ved hjelp av Web App

Opptak av video med jevne mellomrom (intervallopptak)

Konfigurere grunnleggende drift

Hvordan ta opp RAW-video

Sakte og rask bevegelse

Indikator for opplasting / indikator for gjenværende filer1.

Klippnummer2.

Avspillingsstatus, indikator3.

Indikator for avspillingsformat (bildefrekvens og skannemetode)4.

Indikator for avspillingsformat (bildestørrelse)5.

Indikator for avspillingsformat (kodek)6.

Medieindikator
Det vises et  (beskyttelses)-ikon hvis minnekortet er skrivebeskyttet.

7.

Visning av tidsdata8.

Visning av klippnavn9.

Indikator for gammaskjermhjelp10.

Lydnivåmåler
Viser lydnivået for avspilling.

11.

Indikator for basisutseende/opptaksutseende12.

Telleindikator13.

62



Sporing med ansikts-/øyedeteksjon (Face/Eye Detection AF)

Angi zoomtype

Koble til eksterne skjermer og opptaksenheter

Bruke autofokus for enkeltbilde (Push Auto Focus (AF-S))

Angi tidsdata

Oversikt over utseende

Automatisk justering av iris

Manuell justering av iris

Automatisk justering av forsterkningen

Manuell justering av forsterkningen

Automatisk justering av lukkeren

Manuell justering av lukkeren

Stille inn målnivået for automatisk justering av lysstyrke

Videosignalskjerm

Fotografering med utseendejustering i postproduksjon

Clip Name Format

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montering oppreist på et fast sted

Dette emnet beskriver montering av enheten på et skrivebord eller stativ.

Installasjonsmerknad
For å beskytte objektivet og objektivkontaktblokken på enheten, må du holde hetten og dekselet på enheten festet til
du fester objektivet.
For å unngå feil på objektivet må du ikke holde objektivdelene mens du arbeider.
For å unngå feil på enheten må du ikke holde kamerahodet mens du arbeider.

Kontroller monteringsplassen.

Ved montering på et skrivebord
Monter denne enheten på et flatt underlag, og ta hensyn til plassen som kreves for å dreie objektivet og ledningene
på baksiden av enheten.

Merknad

Monter den på et stabilt sted som ikke utsettes for vibrasjoner. Steder som er utsatt for vibrasjoner, kan forårsake
vibrasjoner i bildet.

Hvis enheten må monteres på en skrå overflate, må den holdes innenfor ±15° for horisontalplanet og iverksette tiltak for å
forhindre at enheten faller.

Ved montering på et stativ
Fest stativet til skruehullet for stativmontering på bunnen.
Bruk en monteringsskrue for stativ med følgende mengde fremspring fra monteringsoverflaten, og stram den med
en håndskrutrekker.

A: Monteringsskruer for stativ 1/4-20 UNC, ISO 1222 (6,35 mm)

1
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Deretter fester du objektivet. Se "Hvordan sette på et objektiv", og ta hensyn til informasjonen i "Forsiktighetsregler når
du fester/fjerner et objektiv", "Kontrollere objektivbryterne" og "Forsiktighetsregler når du bruker et zoomobjektiv".

Beslektet emne

Forsiktighetsregler når du fester/fjerner et objektiv

Kontrollere objektivbryterne

Forsiktighetsregler når du bruker et zoomobjektiv

Hvordan sette på et objektiv

5-041-958-83(1) Copyright 2022 Sony Corporation

B: Fremspring (4,5 mm til 5,5 mm)

Ikke bruk stativskruer til å montere enheten på et høyt sted.

Merknad

Velg et stativ som ikke velter selv når objektivet dreies.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montering oppreist på et høyt, fast sted

Dette emnet beskriver fremgangsmåten for å montere enheten oppreist på et høyt sted ved hjelp av takbraketten (CIB-
PCM1 (alternativ)).

Spør en profesjonell entreprenør om å montere enheten på et høyt sted.
Når du monterer på et høyt sted, må du kontrollere at monteringsoverflaten og monteringsmaterialet (unntatt tilbehør)
kan støtte 200 kg (440 lb 15 oz) eller mer, og montere enheten som beskrevet i denne Hjelpveiledningen. Hvis
monteringen ikke er solid nok, kan enheten falle og forårsake alvorlig personskade.
Fest det medfølgende fallforebyggende ståltauet til CIB-PCM1-takbraketten (alternativ) for å hindre at enheten faller.
Når enheten er montert på et høyt sted, må du én gang i året kontrollere at monteringen ikke har løsnet. Forkort
inspeksjonsintervallet i henhold til bruksforholdene.

Installasjonsmerknad
For å beskytte objektivet og objektivkontaktblokken på enheten, må du holde objektivets hette og deksel på til
objektivet er festet.
For å unngå feil på objektivet må du ikke holde objektivdelene mens du arbeider.
For å unngå feil på enheten må du ikke holde kamerahodet mens du arbeider.

Kontroller monteringstilbehøret og monteringsplassen på stedet for montering høyt oppe.

CIB-PCM1-takbrakettsett (alternativ)
Før du starter, må du kontrollere at du har følgende deler.

Hovedenhetsbrakett (1)
Takbrakett (1)
Deksel til utløserknapp for objektivet (1)
Fallforebyggende ståltau (1)
+PSW M3×8-skruer (9)
+PSW M4×8-skrue i rustfritt stål til fallforebyggende ståltau (1)

1
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Merknad

Det fallforebyggende ståltauet er utformet for å støtte enheten når den er opphengt. Ikke bruk noen annen belastning på det
enn enhetens belastning.

Monteringsplass
Se følgende tegning når du bestemmer monteringsstedet og -retningen, og ta hensyn til plassen som kreves for å
dreie objektivet og ledningene på baksiden av enheten.

A: Kamerahodets bevegelsesområde (f.eks. SEL70200GM2 (med SEL20TC festet): Ø370)
B: Takbrakett (hull på monteringsflatens side (Ø150))
C: Innrettingshull for montering

Merknad

Monter den på et stabilt sted som ikke utsettes for vibrasjoner. Steder som er utsatt for vibrasjoner, kan forårsake
vibrasjoner i bildet.

Hvis enheten må monteres på en skrå overflate, må den holdes innenfor ±15° for horisontalplanet og iverksette tiltak for å
forhindre at enheten faller.

Skyv låsespaken for pan/tilt til LOCK-posisjon for å låse pan/tilt på kamerahodet.2
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Merknad

Hvis pan/tilt på kamerahodet ikke låses når låsespaken er i LOCK-posisjon, flytter du kamerahodet manuelt til det låses i
posisjon.

Fest hovedenhetsbraketten til bunnen av enheten ved hjelp av de seks medfølgende skruene (M3×8).3
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Bruk de medfølgende skruene. Bruk av andre skruer enn de medfølgende skruene kan skade innsiden av enheten.

Fest det fallforebyggende ståltauet til hovedenhetsbraketten.4
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A: Medfølgende ståltau 
B: Medfølgende stjerneskrue (M4×8)
C: Metalløkke til ståltau

Bruk den medfølgende skruen. Bruk av en annen skrue enn den medfølgende skruen kan redusere effekten av
ståltaufunksjonen.

Fest takbraketten til overflaten, for eksempel en hylle, der enheten skal monteres.5
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A: Vegg 
B: △-merke (kameraretning fremover)
C: Hull for tilkoblingskabler
D: Hylle eller annen monteringsflate

Fest det fallforebyggende ståltauet til et punkt nært monteringsflaten.

Bruk en M5 (3/16 tommer) hodeskrue med innvendig sekskant (alternativ) og fest den til en gjenstand nær hyllen
eller overflaten som takbraketten er festet til.

6
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A: Ståltau 
B: Hodeskrue med innvendig sekskant (M5, 3/16 tommer)

Innrett 〇-skruehullet foran på hovedenhetsbraketten med ◇-hullet på takbraketten, sett inn enheten, og
fest hovedenhetsbraketten midlertidig i takbraketten ved å vri enheten med klokken.

7
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A: 〇-hull
B: ◇-hull

Fest hovedenhetsbraketten og takbraketten ved hjelp av de tre medfølgende rotasjonslåseskruene (M3×8).8
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Deretter fester du objektivet. Se "Hvordan sette på et objektiv", og ta hensyn til informasjonen i "Forsiktighetsregler når
du fester/fjerner et objektiv", "Kontrollere objektivbryterne" og "Forsiktighetsregler når du bruker et zoomobjektiv".

Merknad

Når du har festet et objektiv, må du kontrollere at objektivet er ordentlig festet.
Objektivet har ingen beskyttelse mot fall. Sony kan ikke påta seg noe ansvar for at et objektiv faller fra enheten.

Beslektet emne

Forsiktighetsregler når du fester/fjerner et objektiv

Kontrollere objektivbryterne

Forsiktighetsregler når du bruker et zoomobjektiv

Hvordan sette på et objektiv

Kontroller monteringsstatusen.

Kontroller spesifikt følgende elementer. 

Monteringsskruene er riktig festet.
Fallforebyggende ståltau er riktig festet og er ikke vridd.
Enheten er montert i vater (uten tilt eller vingling).
Enheten snurrer ikke fritt når den dreies.

9
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montering i tak

Dette emnet beskriver fremgangsmåten for montering av enheten i et tak ved hjelp av takbraketten (CIB-PCM1
(alternativ)).

Spør en profesjonell entreprenør om å montere enheten i et tak.
Når du monterer i et tak, må du kontrollere at monteringsoverflaten og monteringsmaterialet (unntatt tilbehør) kan
støtte 200 kg (440 lb 15 oz) eller mer, og montere enheten som beskrevet i denne Hjelpveiledningen. Hvis
monteringen ikke er solid nok, kan enheten falle og forårsake alvorlig personskade.
Fest det medfølgende fallforebyggende ståltauet til CIB-PCM1-takbraketten (alternativ) for å hindre at enheten faller.
Når enheten er montert i et tak, må du én gang i året kontrollere at monteringen ikke har løsnet. Forkort
inspeksjonsintervallet i henhold til bruksforholdene.

Installasjonsmerknad
For å beskytte objektivet og objektivkontaktblokken på enheten, må du holde objektivets hette og deksel på til
objektivet er festet.
For å unngå feil på objektivet må du ikke holde objektivdelene mens du arbeider.
For å unngå feil på enheten må du ikke holde kamerahodet mens du arbeider.

Kontroller monteringstilbehøret og monteringsplassen i taket.

CIB-PCM1-takbrakettsett (alternativ)
Før du starter, må du kontrollere at du har følgende deler.

Hovedenhetsbrakett (1)
Takbrakett (1)
Deksel til utløserknapp for objektivet (1)
Fallforebyggende ståltau (1)
+PSW M3×8-skruer (9)
+PSW M4×8-skrue i rustfritt stål til fallforebyggende ståltau (1)

1
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Merknad

Det fallforebyggende ståltauet er utformet for å støtte enheten når den er opphengt. Ikke bruk noen annen belastning på det
enn enhetens belastning.

Monteringsplass
Se følgende tegning når du bestemmer monteringsstedet og -retningen, og ta hensyn til plassen som kreves for å
dreie objektivet og ledningene på baksiden av enheten.

A: Kamerahodets bevegelsesområde (f.eks. SEL70200GM2 (med SEL20TC festet): Ø370)
B: Takbrakett (hull på siden for taket (Ø150))
C: Innrettingshull for montering

Merknad

Monter i et tak (for eksempel betong) med tilstrekkelig styrke.

Hvis du vil montere enheten i et tak med utilstrekkelig styrke, må du sørge for tilstrekkelig forsterkning.

Monter den på et stabilt sted som ikke utsettes for vibrasjoner. Steder som er utsatt for vibrasjoner, kan forårsake
vibrasjoner i bildet.

Hvis enheten må monteres på en skrå overflate, må den holdes innenfor ±15° for horisontalplanet og iverksette tiltak for å
forhindre at enheten faller.

Siden på motsatt side av △-hullet på takbraketten er opptaksretningen (kameraets forside).

Skyv låsespaken for pan/tilt til UNLOCK-posisjon for å låse opp pan/tilt og drei kamerahodet 180° i
tilteretningen.

2

Skyv låsespaken for pan/tilt til LOCK-posisjon for å låse pan/tilt på kamerahodet.3
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Kamerahode dreid 180°

Merknad

Hvis pan/tilt på kamerahodet ikke låses når låsespaken er i LOCK-posisjon, flytter du kamerahodet manuelt til det låses i
posisjon.

Fest hovedenhetsbraketten til bunnen av enheten ved hjelp av de seks medfølgende skruene (M3×8).4
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Bruk de medfølgende skruene. Bruk av andre skruer enn de medfølgende skruene kan skade innsiden av enheten.

Fest takbraketten til en monteringsplate (alternativ), og fest deretter platen til taket.5
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A: Takbrakett
B: Tak
C: Monteringsplate
D: △-hull
Fest braketten i henhold til retningen på takbraketten
Merk deg at når det er montert i et tak, er forsiden av kameraet på motsatt side av takbraketten i forhold til en vanlig
oppreist montering. Monter riktig ved å referere til diagrammet som angir monteringsretningen.

A: Foran for oppreist montering (△-hullretning)
B: Foran for takmontering

Merknad

Overflatematerialet for montering er kundens ansvar.

Fest det fallforebyggende ståltauet i taket.6
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A: Takbrakett
B: Hodeskrue med innvendig sekskant (M5, 3/16 tommer)
C: Ståltau (følger med)
D: Monteringsplate
E: Tak

Trekk det fallforebyggende ståltauet gjennom hullet i midten av takbraketten, og fest det til
hovedenhetsbraketten.

Før det fallforebyggende ståltauet gjennom metalløkken for det fallforebyggende ståltauet på hovedenhetsbraketten
og fest det sikkert til braketten ved hjelp av den medfølgende skruen i rustfritt stål (M4×8).

A: Medfølgende ståltau
B: Medfølgende stjerneskrue (M4×8)
C: Metalløkke til ståltau

7
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Bruk den medfølgende skruen. Bruk av en annen skrue enn den medfølgende skruen kan redusere effekten av
ståltaufunksjonen.

Merknad

Det anbefales at én person holder enheten som vist i følgende diagram, mens en annen person monterer enheten.

Ikke hold kamerahodet eller objektivstøtten mens du monterer enheten. Det er fare for skade eller personskade hvis
enheten mistes eller faller ned.

Vær forsiktig ved arbeid med ledninger, slik at elektriske kontakter og kabler ikke kortsluttes av det fallforebyggende
ståltauet.

Monteringen kan støtte en opphengt masse på opptil 8,8 kg (inkludert objektivet). For å unngå at enheten faller, må du ikke
overskride maksimal forventet masse.

Innrett skruehullet (A) på hovedenhetsbraketten med hullet ◇ (B) på takbraketten, sett inn enheten og drei
den ca. 60 grader med klokken til skruehullet (A) og skruehullet (C) er på linje.

8
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A: Skruehull på hovedenhetsbraketten
A: Skruehull på takbraketten (◇-hull)
C: Skruehull
D: Tak
E: Monteringsplate

Fest hovedenhetsbraketten og takbraketten ved hjelp av de tre medfølgende rotasjonslåseskruene (M3×8).9
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Deretter fester du objektivet. Se "Hvordan sette på et objektiv", og ta hensyn til informasjonen i "Forsiktighetsregler når
du fester/fjerner et objektiv", "Kontrollere objektivbryterne" og "Forsiktighetsregler når du bruker et zoomobjektiv".

Merknad

For å betjene pan/til på riktig måte når enheten er montert i taket, setter du [Pan-Tilt] > [Direction] > [Ceiling] til [On] i nettmenyen.

Når du har festet et objektiv, må du kontrollere at objektivet er ordentlig festet.
Objektivet har ingen beskyttelse mot fall. Sony kan ikke påta seg noe ansvar for at et objektiv faller fra enheten.

Beslektet emne

Forsiktighetsregler når du fester/fjerner et objektiv

Kontrollere objektivbryterne

Forsiktighetsregler når du bruker et zoomobjektiv

Kontroller monteringsstatusen.

Kontroller spesifikt følgende elementer.

Monteringsskruene er riktig festet.
Fallforebyggende ståltau er riktig festet og er ikke vridd.
Enheten er montert i vater (uten tilt eller vingling).
Enheten snurrer ikke fritt når den dreies.

10
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Hvordan sette på et objektiv

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Forsiktighetsregler når du fester/fjerner et objektiv

Ikke la objektivet vende mot solen. Direkte sollys kan komme inn gjennom objektivet og bli fokusert i enheten, slik at det
forårsaker en brann.

Merknad

Feste/fjerne et objektiv mens enheten er slått av.

Et objektiv er en presisjonskomponent. Ikke plasser objektivet på en overflate med objektivfestet vendt ned. Sett på det
medfølgende objektivdekselet.

Hint

Hvis du vil ha mer informasjon om objektiver som støttes av enheten, kontakt en servicerepresentant for Sony.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrollere objektivbryterne

Følgende kontroller og innstillinger kreves, avhengig av type objektiv.

For et objektiv med fokusmodusbryter

Sett bryteren til AF/MF eller AF.
Hvis bryteren er satt til MF eller Full MF, kan fokus bare justeres ved hjelp av objektivringen.

Merknad

Når du bruker et objektiv med A-feste, kan det hende at manuell justering fra en fjernkontroll ikke er tilgjengelig.

For et objektiv med zoombryter

Sett bryteren til SERVO.
Hvis bryteren er satt til MANUAL, kan zoomen bare justeres ved hjelp av zoomringen. Zoomkontroll fra enheten har
ingen virkning.

For et objektiv med Auto Iris-bryter

Sett bryteren til AUTO.
Når den ikke er satt til AUTO, kan iris bare justeres med objektivringen. Iris-betjening fra enheten har ingen virkning.

For et objektiv med bildestabiliseringsbryter

Sett bryteren til OFF.
Hvis bryteren er satt til ON, kan det oppstå uventet virkemåte under pan/tilt-betjening.

SELP28135G

A: Flytt fokusringen til foroverposisjon (AF/MF-modus).
B: Sett ZOOM-bryteren til SERVO-posisjonen.
C: Sett irisringen til "A" og IRIS LOCK-bryteren til LOCK-posisjonen.
D: Sett bildestabiliseringsbryteren til OFF.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Forsiktighetsregler når du bruker et zoomobjektiv

Når du bruker et annet zoomobjektiv enn et objektiv med elektrisk zoom, kan zoomposisjonen endres avhengig av
monteringsmiljøet. Fest zoomringen på plass ved hjelp av tape i henhold til bruksformålet.

Plastfilmbånd: 471 BLA 50 eller tilsvarende

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Hvordan sette på et objektiv

Dette emnet beskriver hvordan du fester et E-festeobjektiv eller et A-festeobjektiv.

Merknad

Ikke transporter enheten når objektivet fremdeles er festet.

Når du bruker et objektiv med A-feste, stilles iris manuelt inn og fokus settes på MF.

Skyv låsespaken for pan/tilt til LOCK-posisjon for å låse pan/tilt på kamerahodet.

Merknad

Hvis pan/tilt på kamerahodet ikke låses når låsespaken er i LOCK-posisjon, flytter du kamerahodet manuelt til det låses i
posisjon.

1

Drei klemmespaken for festeskruen for objektivstøttens sokkel mot klokken for å løsne låsen, og flytt
deretter festeskruen for objektivstøttens sokkel til en posisjon som ikke forstyrrer objektivet.

A: Riktig

2
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B: Feil

Drei låsespaken for kamerahodet i pilens retning for å låse opp kamerahodet.

Merknad

Inntil kamerahodet er låst igjen, er det fare for at kamerahodet kan bevege seg under sin egen vekt. Støtt kamerahodet med
hånden mens du utfører oppgaven.

3

Skyv kamerahodet til den fremste posisjonen.4

Drei låsespaken for kamerahodet i pilens retning for å låse kamerahodet.5
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Merknad

Sørg for at låsespaken til kamerahodet ikke kommer i kontakt med andre deler for å unngå å forstyrre vippeoperasjonen.

Fjern hetten og dekselet fra enheten og objektivet.6

Rett inn objektivmonteringsmerket (hvitt) etter enheten, sett objektivet forsiktig inn i kamerahodet, og drei
deretter objektivet med klokken til det klikker i låst posisjon.

A: Monteringsmerker (hvite)

Merknad

Hvis du vil bruke et objektiv med A-feste, fester du en objektivfesteadapter (alternativ) til enheten og fester deretter A-
festeobjektivet.

7

Drei låsespaken for kamerahodet i pilens retning for å låse opp kamerahodet.8
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Merknad

Inntil kamerahodet er låst igjen, er det fare for at kamerahodet kan bevege seg under sin egen vekt. Støtt kamerahodet med
hånden mens du utfører oppgaven.

Oppretthold balansen forover/bakover på kamerahodet slik at skyvebunnen er horisontal.

Hvis du bruker et av følgende objektiver, kan du grovt balansere enheten og objektivet ved å se på skalaen på
skyvebunnen.

9

Posisjon på skala Objektivnavn

0,5 SEL70200GM (med SEL20TC festet)

1,7 SEL70200GM

2,0 SEL70200GM2 (med SEL20TC festet)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G

93



Merknad

Bruk skalaen på skyvebunnen som referanse for grov balanse.

Når du fester objektivet, må du foreta egnede justeringer i balansen slik at enheten ikke vipper frem og tilbake.

Juster balansen på en horisontal overflate.

Fjern objektivstøtteenheten når du bruker SELC1635G.

Posisjon på skala Objektivnavn

5,0 eller høyere SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Drei låsespaken for kamerahodet i pilens retning for å låse kamerahodet.

Merknad

Sørg for at låsespaken til kamerahodet ikke kommer i kontakt med andre deler for å unngå å forstyrre vippeoperasjonen.
Bekreftelsesmetode: Skyv panorerings-/vippelåsen til UNLOCK-posisjon, vri kamerablokken for hånd til den vender
oppover, og bekreft visuelt at den ikke er i kontakt med andre deler. Hvis det er kontakt, drei låsespaken til kamerahodet i
pilens retning igjen.

10

Drei objektivstøttens klemmespaker mot klokken for å løsne objektivstøtteenheten.11
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A: Objektivstøttestangens klemmespak (2 steder)
B: Objektivstøtteenhet

Flytt objektivstøtteenheten slik at objektivstøttens sokkel er på linje med festeskruen for objektivstøttens
sokkel, og drei deretter skruen med klokken for å feste objektivstøttens sokkel.

Merknad

Kontroller at objektivstøttens sokkel står vinkelrett på festeskruen for objektivstøttens sokkel, og stram deretter til.

12

Drei klemmespaken for festeskruen for objektivstøttens sokkel med klokken for å låse festeskruen for
objektivstøttens sokkel.

A: Festeskrue for objektivstøttens sokkel
B: Festeskruehull
C: Klemmespak for festeskrue for objektivstøttens sokkel

Hint

Hvis en klemmespak er i en posisjon som gjør den vanskelig å dreie, løsner du klemmespaken og roterer den til en vinkel
som gjør betjeningen enklere. Når den er i ønsket posisjon, fester du klemmespaken.

13
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Beslektet emne

Kalibrere et E-festeobjektiv

5-041-958-83(1) Copyright 2022 Sony Corporation

A: Klemmespak for festeskrue for objektivstøttens sokkel
B: Objektivstøttestangens klemmespak

Drei objektivstøttestangens to klemmespaker med klokken for å feste objektivstøtteenheten.14

Kontroller at begge spakene er strammet og ikke løse, at objektivet er riktig festet, og at objektivbryterne er
riktig innstilt.

Hvis en spak er løs eller objektivet ikke er riktig festet, kan objektivet falle og bli skadet.
Når du bruker et E-festeobjektiv med elektrisk zoom, må objektivet også kalibreres separat for nøyaktig å
gjenopprette zoomposisjonene som er lagret i kameraet som forhåndsinnstilte posisjoner. Hvis du vil ha mer
informasjon, se "Kalibrere et E-festeobjektiv".

15
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Fjerne et objektiv

Fjern et objektiv ved hjelp av omvendt fremgangsmåte for å feste objektivet.

Merknad

Hold objektivet fast i hånden for å hindre at det faller ned.

Hvis et annet objektiv ikke settes på med én gang, må du alltid sette lokket på huset.

Beslektet emne

Hvordan sette på et objektiv

5-041-958-83(1) Copyright 2022 Sony Corporation

Kontroller at pan/tilt er låst.1

Drei klemmespaken for festeskruen for objektivstøttens sokkel mot klokken for å løsne låsen.2

Fjern festeskruen for objektivstøttens sokkel på objektivstøtteenheten og flytt den til en posisjon som ikke
forstyrrer objektivet.

3

Lås opp kamerahodet og skyv kamerahodet til den fremste posisjonen.

Hvis du vil ha mer informasjon, se trinn 3 til 5 i "Hvordan sette på et objektiv".

4

Trykk og hold nede utløserknappen for objektivet, og vri objektivet mot urviseren mens du holder objektivet
oppe.

5

Når monteringsmerkene (hvite) på kameraet og objektivet er på linje, trekker du objektivet ut mot fronten.6
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Tilkoblingskabler

Dette emnet beskriver kabeltilkoblinger.

5-041-958-83(1) Copyright 2022 Sony Corporation

Koble de nødvendige kablene til kontaktene på bakpanelet.

For å unngå at HDMI-kabelen fjernes, fjerner du monteringsskruen for HDMI-kabelens festeplate (M2.6×6, svart) fra
kontaktblokken og fester den medfølgende HDMI-kabelens festeplate ved hjelp av monteringsskruen. Fest HDMI-
kabelen til HDMI-kabelens festeplate ved hjelp av en/et kommersielt tilgjengelig kabelstropp eller -bånd.

A: Monteringsskrue for HDMI-kabelens festeplate (M2.6×6, svart)
B: Kommersielt tilgjengelig kabelstropp eller -bånd
C: HDMI-kabelens festeplate (følger med)

1
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Koble enheten til en nettverksenhet via kablet tilkobling

Dette emnet beskriver hvordan du kobler enheten til en nettverksenhet via en kablet tilkobling.

5-041-958-83(1) Copyright 2022 Sony Corporation

Koble enheten til en nettverksenhet (for eksempel et Wi-Fi-tilgangspunkt eller en vekslehub) ved hjelp av en
LAN-kabel i kategori 5e eller høyere.

1
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Bruk av nettstrøm

Dette emnet beskriver fremgangsmåten for å drive enheten ved hjelp av nettstrøm.

Skyv låsespaken for pan/tilt til LOCK-posisjon for å låse pan/tilt på kamerahodet.1

Koble strømadapteren (følger med) til DC IN-kontakten på enheten, og koble strømledningen (følger med) til
en strømkilde.

A: DC IN-kontakt
B: Strømledning
C: Strømadapter

2

Fest strømadapterledningen ved hjelp av ledningsklemmen hvis du vil hindre at ledningen kobles fra.

Lås opp ledningsklemmen, før ledningen gjennom klemmen som vist nedenfor, og lås klemmen.

3
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Merknad

Ikke bruk andre strømadaptere eller strømledninger enn de som følger med enheten. Tilkobling av en annen adapter eller
strømledning kan forårsake brann eller funksjonsfeil.

Ikke koble til eller bruk en strømadapter på steder med begrenset plass, for eksempel mellom en vegg og et møbel.

Ikke kortslutt metalldelene på støpselet til strømadapteren. Det kan føre til funksjonsfeil.

Koble strømadapteren til nærmeste stikkontakt. Hvis det oppstår et problem under bruk, må du umiddelbart koble strømledningen
fra nettstrømkilden.

A: Ledningsklemme
B: Ledningsklemmelås
C: Strømadapterledning

Kontroller at POWER-lampen foran på enheten skifter fra å blinke grønt til konstant grønt, og at oppstarten
er ferdig.

Når enheten har startet normalt og koblet til nettverket, lyser NETWORK-lampen grønt.

Når du bruker et objektiv som ikke støtter pan/tilt-betjening, låser du pan/tilt-låsespaken og hopper over
følgende trinn. Hvis du vil ha mer informasjon om objektiver som støtter pan/tilt, kontakt forhandleren din eller en
servicerepresentant for Sony.

4

Skyv låsespaken for pan/tilt til UNLOCK-posisjon for å låse opp pan/tilt på kamerahodet.5

Tilbakestill pan/tilt.

Hvis du vil ha mer informasjon, se "Tilbakestille Pan/Tilt".

6
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Når strømadapteren kobles fra enheten, ta tak i pluggen og trekk den rett ut. Hvis du trekker i kabelen, kan det føre til
funksjonsfeil.

Beslektet emne

Tilbakestille Pan/Tilt

5-041-958-83(1) Copyright 2022 Sony Corporation
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Bruke PoE++-strøm

Når enheten er koblet til en PoE++-kompatibel strømforsyningsenhet, forsynes enheten med strøm via en kommersielt
tilgjengelig nettverkskabel.
Denne metoden gjør det mulig å forsyne enheten med strøm uten at det er behov for strømforsyningsledninger i miljøer
der det ikke er strømuttak i nærheten av monteringsstedet.

Skyv låsespaken for pan/tilt til LOCK-posisjon for å låse pan/tilt på kamerahodet.1

Koble enheten til en PoE++-kompatibel strømforsyningsenhet ved hjelp av en kommersielt tilgjengelig
nettverkskabel.

A: Nettverkskabel
B: PoE++-kompatibel strømforsyningsenhet

2

Kontroller at POWER-lampen foran på enheten skifter fra å blinke grønt til konstant grønt, og at oppstarten
er ferdig.

Når enheten har startet normalt og koblet til nettverket, lyser NETWORK-lampen grønt.

Merknad

3
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Merknad

Enheten er i samsvar med IEEE802.3bt type 4, klasse 8. Hvis du vil ha mer informasjon om bekreftet kompatible PoE++-
strømforsyningsenheter, kontakt forhandleren din eller en servicerepresentant for Sony.

Enheten er kompatibel med myk godkjenning (LLDP), men det kan være nødvendig å konfigurere nettverksenheter
(IEEE802.3bt-kompatible).

Ikke koble til en strømadapter når du bruker PoE++-strømforsyning med myk godkjenning (LLDP) aktivert.

Hvis en strømadapter og PoE++-strømforsyningsenhet er koblet til samtidig, leveres strøm fra strømadapteren.

Bruk en nettverkskabel i kategori 5e eller høyere ved strømforsyning via PoE++.

Vent i ca. 10 sekunder etter at du har slått på enheten igjen når den drives via PoE++.

Koble jordingsterminalen til jord når du bruker PoE++-strømforsyning.

Når du kobler til via PoE++-strømforsyning, må du ikke bruke ledninger utendørs.

Beslektet emne

Tilbakestille Pan/Tilt

5-041-958-83(1) Copyright 2022 Sony Corporation

Når strømmen leveres av PoE++, utføres første godkjenning i løpet av intervallet til oppstarten er fullført.

Når du bruker et objektiv som ikke støtter pan/tilt-betjening, låser du pan/tilt-låsespaken og hopper over følgende trinn. Hvis
du vil ha mer informasjon om objektiver som støtter pan/tilt, kontakt forhandleren din eller en servicerepresentant for Sony.

Skyv låsespaken for pan/tilt til UNLOCK-posisjon for å låse opp pan/tilt på kamerahodet.4

Tilbakestill pan/tilt.

Hvis du vil ha mer informasjon, se "Tilbakestille Pan/Tilt".

5
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Tilbakestille Pan/Tilt

Du kan for eksempel tilbakestille pan/tilt når du skifter ut objektivet, ved hjelp av følgende fremgangsmåte.

5-041-958-83(1) Copyright 2022 Sony Corporation

Skyv låsespaken for pan/tilt til UNLOCK-posisjon og kontroller at pan/tilt på kamerahodet er låst opp.1

Utfør funksjonen for tilbakestilling av pan/tilt.

Pan/tilt-tilbakestilling kan utføres fra den infrarød-fjernkontrollen, Web App eller RM-IP500-fjernkontrollen
(alternativ).

Betjening ved hjelp av infrarød-fjernkontrollen: Trykk på P/T RESET-knappen.
Betjening ved hjelp av Web App: Trykk på  (Pan/tilt tilbakestill)-knappen på  (Others)-fanen i
kamerakontrollpanelet på skjermbildet for direkte betjening.
Betjening ved hjelp av RM-IP500: Se bruksanvisningen for RM-IP500.

Merknad

Å utføre pan/tilt-tilbakestilling får kamerahodet og objektivet til å dreie. Kontroller at objektivet ikke er blokkert før du utfører
dette.

Enheten har en funksjon som begrenser pan/tilt-området, men denne funksjonen deaktiveres når enheten slås på eller
pan/tilt-tilbakestilling utføres.

Hint

Når pan/tilt-tilbakestilling er fullført, går enheten tilbake til posisjonen den hadde før utførelsen.

2

105



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Få tilgang til Web App fra en nettleser

Ved å koble enheten til et nettbrett eller en datamaskin, kan du betjene og konfigurere enheten fra en nettleser.

Kontroller om nettbrettet eller datamaskinen støtter Web App-operasjoner.

Merknad

Hvis det nødvendige miljøet ikke er oppfylt, eller avhengig av bruken av nettbrettet/datamaskinen, kan videovisning i en
nettleser bli negativt påvirket.

Web App for denne enheten bruker JavaScript. Hvis du bruker antivirusprogramvare på nettbrettet/datamaskinen, kan det
hende at nettsiden ikke vises riktig.

1

Element Krav

Skjerm
1080×810 piksler eller høyere anbefales
Skjermstørrelse på nettbrett: 10-tommers eller større
anbefales

Operativsystem og nettleser som
støttes

Windows
OS Windows 10 eller nyere

Nettleser Google Chrome

Mac

OS macOS 10.15 eller nyere

Nettleser
Google Chrome
Safari

iPad

OS iPadOS 15 eller nyere

Nettleser
Google Chrome
Safari

Android
OS Android 12 eller nyere

Nettleser Google Chrome

Kontroller at enheten, nettbrettet eller datamaskinen og eksterne enheter er slått på.2

Kontroller at enheten og nettbrettet eller datamaskinen er koblet til via Wi-Fi eller kablet lokal LAN-
nettilkobling.

3

Koble til enheten fra nettleseren på nettbrettet eller datamaskinen.

Koble til ved hjelp av an QR-kode
Skann QR-koden som er trykt på mediedekselet på siden av enheten ved hjelp av kameraet til nettbrettet.

4
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Merknad

Hvis HTTP-portnummeret ble endret fra verdien 80, skriver du inn "http://IP-adressen til enheten:Portnummer" i adresselinjen.

Når du kobler til ved hjelp av en QR-kode eller ved å skrive inn URL-adressen i adresselinjen i en nettleser, bruker du en enhet
som støtter mDNS*.

Hint

Du kan deretter få rask tilgang til enheten ved hjelp av bokmerkefunksjonen i nettleseren.

5-041-958-83(1) Copyright 2022 Sony Corporation

Åpne lenken som vises på nettbrettet.
Nettleseren på nettbrettet starter opp og viser Web App-skjermbildet for enheten.

Koble til ved å skrive inn en URL-adresse i adresselinjen i en nettleser
Start en nettleser på nettbrettet eller datamaskinen, og skriv inn URL-adressen som er trykt på mediedekselet på
siden av enheten.
Nettleseren skal vise Web App-skjermbildet for enheten.

Koble til ved å skrive inn IP-adressen til enheten i adresselinjen i en nettleser
Start en nettleser på nettbrettet eller datamaskinen, og skriv inn "http://IP-adressen til enheten" i adresselinjen.
Nettleseren skal vise Web App-skjermbildet for enheten.

mDNS: En kommunikasjonsprotokoll som brukes til å bestemme IP-adressen fra et vertsnavn på et lokalt nettverk.*
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Initialisere enheten

Pass på at du konfigurerer enheten ved hjelp av følgende fremgangsmåte når du bruker enheten for første gang.

Hint

Hvis reservebatteriet blir helt utladet, må du konfigurere det første oppsettet på nytt.

Koble til enheten fra et nettbrett eller en datamaskin, og start Web App.

Når enheten brukes for første gang, blir du bedt om å angi brukernavn og passord i nettleseren. Angi følgende
innstillinger.

Brukernavn: admin
Passord: (la stå tomt)

Følg anvisningene på skjermen for å konfigurere det første oppsettet.

1

Angi brukernavn og passord for administrator (Administrator), og trykk på [OK]-knappen.

1: Angi brukernavnet for administrator.
2: Lag ditt administrator-passord.
3: Angi det samme passordet igjen for å bekrefte.

Merknad

Følgende tegn kan brukes i brukernavnet og passordet. Passordet må inneholde minst én stor bokstav, én liten bokstav, ett
tall, og være fra 8 til 64 tegn langt.

Alfanumeriske tegn

2
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Direkteskjermbildet for opptaksoperasjoner vises. Fortsett å konfigurere den grunnleggende driften av enheten i henhold
til operasjonsmodus.

Hint

I noen tilfeller, som f.eks. ved bruk av enheten med et nettbrett som et par, kan det være enklere å bruke en fast IP-adresse for
enheten.

Symboler (!$%`*+-./<=>?@[]^_{|}~)

Nettleseren lastes inn på nytt, og du blir bedt om å angi brukernavn og passord.

Angi brukernavnet og passordet som ble konfigurert i trinn 2.

Oppsettskjermen for språk og klokke vises.

3

Angi følgende elementer og trykk på [OK]-knappen.

[Language]
Velg språket som skal brukes for Web App-en og kameraets skjermvisning. Endring av språket vil også endre Web
App-ens skjermspråk.
[Date & Time Format]
Velg visningsformatet for dato og tid fra følgende alternativer.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
"yyyy" angir året, "mm" angir måneden, "dd" angir dagen, "hh" angir timen, "mm" angir minuttet, og "ss" angir
sekundet, henholdsvis.
[12 h/24 h]
Velg [12 h] (12-timersklokke) eller [24 h] (24-timersklokke) for tidsvisningen.
[Time Setting]
Velg metode for innstilling av dato/tid.
[Synchronize with PC]: Synkroniser med datoen/tiden for datamaskinen eller nettbrettet.
[Manual setting]: Angi manuelt. Når denne metoden er valgt, vises oppføringsfelt for dato og tid.
[Time Zone]
Velg tidssone.

4
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For å angi en fast IP-adresse skal du først slå av [Network] > [Wired LAN] > [IPv4] > [DHCP] (skyvebryter i venstre posisjon) i
nettmenyen.

Oppsettelementene som gjelder for en fast IP-adresse vises. Konfigurer elementene og trykk deretter [OK]-knappen på skjermen.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Konfigurere grunnleggende drift

Dette emnet beskriver hvordan du konfigurerer enheten for grunnleggende drift.

Angi opptaksmodus

Du kan velge den opptaksmodusen for enheten som passer til arbeidsflyten.

Custom-modus: Fleksibel oppretting av bilder under opptak.
Log shooting-moduser: Tar opp S-Log-innhold.

Flexible ISO-modus: Eksponeringsinnstillinger settes med ISO-verdijusteringer som matcher scenen som blir tatt
opp.
Cine EI modus/Cine EI Quick modus: Bruk enheten på samme måte som et filmkamera (uten fullstendig
oppretting av bilder under opptak), med opptak som fremkalles i postproduksjon.

I Cine EI Quick-modus, velges automatisk en basis-sensitivitet som egner seg for den innstilte eksponeringsindeksen.
Bytt opptaksmodus ved hjelp av [Project] > [Base Setting] > [Shooting Mode] i nettmenyen eller kameramenyen.

Custom-modus
Du kan velge videostandarden.
Bytt ved hjelp av [Project] > [Base Setting] > [Target Display] i nettmenyen eller kameramenyen.

[SDR(BT.709)]: Opptak i henhold til standarden for HD-kringkasting
[HDR(HLG)]: Opptak i henhold til standarden for neste generasjons 4K-kringkasting

Hvis du vil ha mer informasjon, se "Oversikt over utseende" og andre emner i "Ta bilder med ønsket utseende".

Moduser for Log shooting
(Flexible ISO-modus/Cine EI-modus/Cine EI Quick-modus)
I Log shooting-opptaksmoduser, velger du basisfargerommet for opptakssignalene og utgangssignalene. Fargeområdet
som velges her, er fargeområdet for videoutgangen når [LUT On/Off]-innstillingene er satt til [MLUT Off].
Du kan skifte fargeområdet ved hjelp av [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] i kameramenyen.

[S-Gamut3.Cine/SLog3]: Enkelt justerbar fargeområde for digital kino (DCI-P3).
[S-Gamut3/SLog3]: Sonys brede fargeområdet som dekker fargeområdet ITU-R BT.2020.

Hvis du vil ha mer informasjon, se "Fotografering med utseendejustering i postproduksjon".
 
Støttede funksjoner for hver opptaksmodus er angitt i følgende tabell.
●: Støttet, –: Ikke støttet

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (koblet til EI)
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Hint

I Cine EI Quick-modus og Cine EI-modus skjer opptak ved en ISO-basisfølsomhet uten å bruke forsterkning for å maksimere
ytelsen til bildesensoren. Lysstyrken justeres ved hjelp av belysning og ND-filteret for å justere mengden lys som når
bildesensoren.

Angi systemfrekvensen

Bytt ved hjelp av [Project] > [Rec Format] > [Frequency] i nettmenyen eller kameramenyen. Enheten kan starte på nytt
automatisk etter veksling, avhengig av verdien som velges.

Merknad

Du kan ikke bytte systemfrekvens under opptak eller avspilling.

Angi bildeskannemodusen

Du kan angi den effektive bildestørrelsen og oppløsningen for bildesensoren.
Bytt ved hjelp av [Project] > [Rec Format] > [Imager Scan Mode] i nettmenyen eller kameramenyen.
[FF]: Full størrelse på rammen.
[S35]: Super 35mm størrelse.

Merknad

Du kan ikke bytte bildeskannermodus under opptak eller avspilling.

Når den settes til S35, blir videoformatet begrenset til 1920×1080.

Angi kodek

Du kan angi kodek for opptak.
Bytt ved hjelp av [Project] > [Rec Format] > [Codec] i nettmenyen eller kameramenyen.

Merknad

Du kan ikke bytte kodek under opptak eller avspilling.

Angi videoformatet

Du kan angi videoformatet for opptak og utdataformatet for utgang fra kameraet.

Bytt videoformatet for opptak ved hjelp av [Project] > [Rec Format] > [Video Format] i nettmenyen eller
kameramenyen.

Custom Flexible ISO Cine EI Cine EI Quick

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(unntatt Base Look)

● – – –
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Veksle utdataformatet fra SDI OUT- og HDMI OUT-kontaktene ved hjelp av [Monitoring] > [Output Format] i
nettmenyen eller kameramenyen.

Merknad

Du kan ikke bytte videoformat under opptak eller avspilling.

Begrensninger kan gjelde for signalet fra SDI OUT- og HDMI OUT-kontaktene, avhengig av videoformatinnstillingen.

Beslektet emne
Oversikt over utseende

Fotografering med utseendejustering i postproduksjon

5-041-958-83(1) Copyright 2022 Sony Corporation
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Minnekort som støttes

Enheten tar opp lyd og video på CFexpress type A-minnekort (tilgjengelig separat) eller SDXC-minnekort (tilgjengelig
separat) som er satt inn i kortsporet. Minnekortene brukes også til proxy-opptak.

CFexpress type A-minnekort

Bruk Sony CFexpress type A-minnekortene* som er oppført i "Anbefalt opptaksmedium" i enheten.
For mer informasjon om bruk av medier fra andre produsenter, se bruksanvisningen for mediet eller les produsentens
informasjon.

SDXC-minnekort

Bruk SDXC-minnekortene* som er oppført i "Anbefalt opptaksmedium" i enheten.

Anbefalt opptaksmedium

De garanterte driftsforholdene vil variere avhengig av innstillingene for Rec Format og Recording.

CFexpress type A
VPG400-kompatibel
Støttes for alle opptaksformater for enheten.

SDXC
Støttes i henhold til betingelsene i følgende tabell. "●" angir at driften er verifisert, og "–" angir at driften ikke garanteres.

RAW Out & XAVC-I, 4096×2160 klasse 300, normal modus

RAW Out & XAVC-I, 3840×2160 klasse 300, normal modus

Kalt "CFexpress-kort" i denne Hjelpveiledningen.*

Kalt "SD-kort" i denne Hjelpveiledningen.*

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●
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RAW Out & XAVC-I, 3840×2160 klasse 300, S&Q (60 fps eller lavere)

RAW Out & XAVC-I, 3840×2160 klasse 300, S&Q (100 fps, 120 fps)
Bekreftede medier er ikke tilgjengelige.

XAVC-I, 4096×2160 klasse 300, normal modus

XAVC-I, 4096×2160 klasse 300, S&Q (60 fps eller lavere)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●

115



XAVC-I, 3840×2160 klasse 300, normal modus

XAVC-I, 3840×2160 klasse 300, S&Q (60 fps eller lavere)

XAVC-I, 3840×2160 klasse 300, S&Q (100 fps, 120 fps)
Bekreftede medier er ikke tilgjengelige.

XAVC-I, 1920×1080 klasse 100, normal modus

XAVC-I, 1920×1080 klasse 100, S&Q (60 fps eller lavere)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 klasse 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 klasse 100, S&Q (150 fps, 180 fps)
Bekreftede medier er ikke tilgjengelige.

XAVC-I, 1920×1080 klasse 100, S&Q (200 fps, 240 fps)
Bekreftede medier er ikke tilgjengelige.

XAVC-L, 3840×2160 420, normal modus

XAVC-L, 3840×2160 420, S&Q (60 fps eller lavere)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, normal modus

XAVC-L, 1920×1080 HD50, S&Q (60 fps eller lavere)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, normal modus

XAVC-L, 1920×1080 HD35, S&Q (60 fps eller lavere)

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-958-83(1) Copyright 2022 Sony Corporation

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Klasse 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sette inn minnekort

Dette emnet beskriver forsiktighetsreglene når du setter inn minnekort.

Åpne mediedekslet i kortsporseksjonen.1

Sett inn et minnekort.

For CFexpress-kort vender etiketten opp.

Merknad

På en takmontert enhet vender etiketten ned.

For SD-kort vender etiketten ned.

Merknad

På en takmontert enhet vender etiketten opp.

Tilgangsindikatoren lyser rødt og skifter deretter til grønt hvis kortet kan brukes.

2
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Merknad

Minnekortet, minnekortsporet og bildedataene på minnekortet kan bli skadet hvis kortet tvinges inn i sporet mens det er
feilorientert.

Når du tar opp på medier som er satt inn i både CFexpress type A/SD-kortspor A og B, setter du inn medier i begge sporene som
anbefales for bruk med opptaksformatet.

5-041-958-83(1) Copyright 2022 Sony Corporation

Merknad

Hvis tilgangsindikatoren blinker rødt hele tiden og ikke endres til grønt, slår du av enheten et øyeblikk, fjerner minnekortet
og setter det inn igjen.

Lukk mediedekslet.3
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Løse ut et minnekort

Åpne mediedekslet i kortspordelen, og trykk minnekortet lett inn for å løse ut kortet.

Merknad

Hvis enheten slås av eller minnekortet fjernes mens minnekortet leses, kan det ikke garanteres at dataene på kortet ikke skades.
Alle data som er registrert på kortet kan bli slettet. Kontroller alltid at tilgangsindikatoren er grønn eller av før du slår av enheten
eller tar ut minnekortet.

Når du tar ut et minnekort rett etter at opptaket er ferdig, kan det hende at minnekortet er varmt, men dette betyr ikke at det er et
problem.

5-041-958-83(1) Copyright 2022 Sony Corporation

123



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Formatere (initialisere) minnekort

Hvis det settes inn et uformatert minnekort eller et minnekort som er formatert med en annen spesifikasjon, vises
meldingen "Media Needs to be Formatted" (mediet må formateres) i kamerabildepanelet.
Formatter kortet med følgende prosedyre.

Merknad

Hvis du formaterer et minnekort, slettes alle data, inkludert innspilte videodata og oppsettfiler.

Meldinger kan vises under utførelsen avhengig av hvor lenge formateringsprosessen tar.

Hvis formateringen mislykkes
Minnekort som ikke støttes av enheten kan ikke formateres.
Det vises en varselmelding. Følg instruksjonene for å bytte ut kortet med et minnekort som støttes.

Slik bruker du et kort som er formatert på enheten i sporet på en annen enhet
Ta først en sikkerhetskopi av kortet, og reformater deretter kortet i enheten som skal brukes.

5-041-958-83(1) Copyright 2022 Sony Corporation

Velg [TC/Media] > [Format Media] i kameramenyen.1

Velg Media(A) (spor A) eller Media(B) (spor B), og velg så formatteringsmetoden (Full Format eller Quick
Format).

Det vises en bekreftelsesmelding.
[Full Format]: Initialiserer mediet fullstendig, inkludert dataområdet og informasjonen om dataadministrasjon.
[Quick Format]: Initialiserer bare informasjonen om dataadministrasjon på mediet.

2

Velg [Execute].

Det vises en melding mens formateringen pågår, og tilgangsindikatoren lyser rødt.
Når formateringen avsluttes, vises en melding om at den er fullført.

3
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrollere gjenværende opptakstid

Når du tar bilder (opptak/standby), kan du overvåke gjenværende kapasitet for minnekortet i hvert spor ved hjelp av
indikatorene for gjenværende medier i spor A/B i kamerabildepanelet.
Den gjenværende opptakstiden beregnes ut fra gjenværende kapasitet på mediet i hvert spor og det gjeldende
opptaksformatet (bit-hastigheten for opptak), og vises i minutter.

Tidspunkt for å bytte minnekort
Når den totale gjenværende opptakstiden på de to minnekortene er mindre enn 5 minutter, vises meldingen "Media Near
Full" og opptaks-/tellelampen begynner å blinke for å gi deg et varsel.
Erstatt med medier som har ledig plass.
Hvis du fortsetter å ta opp til den totale gjenværende opptakstiden når null, endres meldingen til "Media Full" og opptaket
stopper.

Merknad

Du kan spille inn opp opptil 600 klipp på ett minnekort.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Gjenopprette minnekort

Hvis det skulle oppstå en feil på et minnekort av en eller annen grunn, må kortet gjenopprettes før bruk.
Når du laster inn et minnekort som må gjenopprettes, vises det en melding i kamerabildepanelet som spør om du vil
gjenopprette det.

Slik gjenoppretter du et kort
Velg [Execute] ved hjelp av pilknappene i GUI-kontrollpanelet og trykk på [Set]-knappen.
En melding og fremdriftsstatus (%) vises mens formateringen pågår, og tilgangsindikatoren lyser rødt.
Når gjenopprettingen er ferdig, vises en melding om at gjenopprettingen er fullført.

Hvis gjenopprettingen mislykkes
Minnekort med minnefeil kan ikke gjenopprettes. Det vises en varselmelding. Følg instruksjonene for å bytte
minnekortet.
Minnekort der det har oppstått minnefeil kan bli brukbare hvis de formateres på nytt.
I noen tilfeller kan noen klipp gjenopprettes, mens andre ikke kan det. De gjenopprettede klippene kan spilles av på
vanlig måte.

Merknad

Hvis du vil gjenopprette mediene som er tatt opp med denne enheten, må du bruke denne enheten.

Medier som er tatt opp med en annen enhet enn denne enheten eller med en annen enhet med en annen versjon (selv om det er
samme modell), kan ikke gjenopprettes ved hjelp av denne enheten.

Klipp som er kortere enn to sekunder, kan ikke gjenopprettes.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Starte/stoppe opptak

Dette emnet beskriver hvordan du starter/stopper opptak.

Fest de nødvendige enhetene, og kontroller at strømmen til enheten og eksterne enheter tilføres.1

Sett inn minnekort(ene).2

Kontroller strømstatusen til enheten øverst til venstre på Web App-skjermbildet.

Når strømforsyningen er på
Når enheten er slått på, vises [Power ON] på strømbryteren øverst på Web App-skjermbildet.

POWER-lampen lyser foran på enheten, og kamerabildet vises på skjermbildet for direkte betjening i Web App.

Merknad

Hvis administratorpassordet ikke er konfigurert, vises et skjermbilde der du blir bedt om å konfigurere passordet. Se
"Initialisere enheten".

Når strømforsyningen er i standby-modus
Når strømforsyningen til enheten er i standby-modus, vises [Power Standby] på strømbryteren i Web App.

Trykk på strømbryteren i denne tilstanden og velg [Power ON]. Enheten slås på, POWER-lampen lyser grønt foran
på enheten, og kamerabildet vises på skjermbildet for direkte betjening i Web App.

Hint

Du kan også slå på enheten ved hjelp av strømknappen på den medfølgende infrarød-fjernkontrollen.

3
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Slik setter du strømforsyningen til enheten i standby-modus
Trykk på strømbryteren i Web App og velg [Power Standby] for å sette enhetens strømforsyning i standby-modus.

Hint

Du kan også sette strømforsyningen i standby-modus ved hjelp av strømknappen på den medfølgende infrarød-fjernkontrollen.

Beslektet emne
Initialisere enheten

Trykk på START/STOP-knappen for opptak.

Opptaket starter, og opptaks-/tellelampen (2 steder) på enheten lyser.
Under opptak lyser START/STOP-knappen for opptak. Et ikon for målopptaksmediet og [●Rec] vises også.

4

Trykk på START/STOP-knappen igjen for å stoppe opptaket.

Opptaket starter, og opptaks-/tellelampen (2 steder) på enheten slås av.
Under standby-tilstand for opptak lyser ikke START/STOP-knappen for opptak. Et ikon for målopptaksmediet og
[Stby] vises også.

Hint

Du kan også starte/stoppe opptaket ved hjelp av START/STOP-knappen for opptak på den medfølgende infrarød-
fjernkontrollen.

5
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bytte mellom minnekort

Når to minnekort er satt inn, kan du trykke på [Slot Select]-knappen på kontrollpanelet for avspilling i Web App for å bytte
minnekort.

Hint

Du kan også trykke på knappen SLOT SEL (valg av minnekortspor (A)/(B)) på den medfølgende infrarød-fjernkontrollen for å
bytte minnekort.

Om overføring av opptak

Under opptak bytter enheten automatisk til det andre minnekortet rett før den gjenværende kapasiteten på det første
kortet går ned til null (overføring av opptak). Du kan fortsette å ta opp kontinuerlig ved å bytte minnekort. Bytt ut
minnekortet som er fullt med et nytt minnekort.

Merknad

Du kan ikke bytte mellom minnekort i avspillingsmodus. Kontinuerlig avspilling av et klipp som ligger på media på tvers av spor A
og spor B støttes heller ikke.

Om registrerte data

Når du stopper opptaket, lagres video, lyd og tilhørende data fra begynnelsen til slutten av opptaket som ett enkelt "klipp"
på et minnekort.

Klippnavn for registrerte data

Navnet på hvert klipp som tas opp med enheten tilordnes automatisk ved hjelp av [TC/Media] > [Clip Name Format] i
kameramenyen.

Maksimal klippvarighet

Opptil 6 timer per klipp.
Maksimal lengde på et kontinuerlig opptak er den samme som maksimal varighet for et klipp. Hvis opptakstiden
overskrider maksimal varighet for et klipp, opprettes det automatisk et nytt klipp, og opptaket fortsetter. Det nye klippet
vises som et separat klipp på miniatyrbildeskjermen.
Flere klipp tas opp etter hverandre under overføring av opptak, men opptaket stopper automatisk etter ca. 24 timer.

Merknad

Ikke løs ut et minnekort mens det pågår opptak til det. Når du tar opp, må du bare bytte minnekort i sporene der
tilgangsindikatoren er slukket.

Når det er mindre enn ett minutt igjen av kapasiteten på minnekortet som det tas opp på, og det er satt inn et minnekort i det
andre sporet som kan brukes, vises meldingen "Will Switch Slots Soon" (Snart byttes minnespor). Meldingen forsvinner etter at
minnekortsporet er byttet.

Overføring av opptak fungerer kanskje ikke hvis opptaket startes når gjenværende kapasitet på minnekortet er mindre enn ett
minutt. Kontroller at den gjenværende minnekortkapasiteten er mer enn ett minutt før du starter opptaket for å få riktig overføring
av opptaket.

Video som er opprettet med enhetens funksjon for overføring av opptak kan ikke spilles av sømløst på enheten.
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Hvis du vil kombinere video som er opprettet ved hjelp av enhetens funksjon for overføring av opptak, må du bruke programvaren
"Catalyst Browse".

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kontrollere lyden

Lyd sendes ut fra SDI- og HDMI-kontaktene på enheten. Velg kombinasjonen av lydkanaler som sendes ut fra HDMI-
kontakten ved hjelp av [Audio] > [Audio Output] > [HDMI/Stream Output CH] i kameramenyen.
CH1/CH2: kombinasjon av CH1 og CH2
CH3/CH4: kombinasjon av CH3 og CH4
Når du overvåker lyden i Web App, bruker du måleren for lydnivå nederst til høyre i kamerabildet.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Angi tidsdata

Dette emnet beskriver hvordan du angir tidsdata.

Stille inn tidskode

Angi tidskode for opptak ved hjelp av [TC/Media] > [Timecode] i kameramenyen.

Stille inn bruker-bits

Du kan legge til et 8-sifret heksadesimalt tall i det innspilte bildet som bruker-bits. Du kan også sette brukerbits lik
gjeldende klokkeslett. Angi ved hjelp av [TC/Media] > [Users Bit] i kameramenyen.

Vise tidsdata

Angi tidskode for visning ved hjelp av [TC/Media] > [TC Display] > [Display Select] i kameramenyen.
Hvis du trykker på en knapp som er tilordnet med [DURATION/TC/U-BIT], skiftes visningen mellom tidskode, bruker-bits
og varighet i rekkefølge.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Gå gjennom opptaket (Rec Review)

Du kan se gjennom det sist innspilte klippet på skjermen (gjennomgang av opptak).

Merknad

Rec Review støttes ikke hvis videoformatet er endret etter at et klipp ble tatt opp.

Angi startposisjonen for Rec Review

Du kan angi startposisjonen for avspillingen til én av følgende ved hjelp av [Technical] > [Rec Review] i kameramenyen.

Siste 3 sekunder av klippet
Siste 10 sekunder av klippet
Starten av klippet

Hint

Hvis du vil gå gjennom et bestemt klipp etter at du har tatt opp flere klipp, trykker du på [Thumbnail]-knappen for å vise
miniatyrbildeskjermen, og velger klippet for å starte avspillingen.

Du kan også trykke på THUMBNAIL-knappen på den medfølgende infrarød-fjernkontrollen for å vise miniatyrbildeskjermen.

Rec Review-metoden

Tilordne Rec Review-funksjonen på forhånd til en av knappene som kan tilordnes på panelet for justering av
grunnleggende konfigurasjon.

Hvis du vil ha mer informasjon om tilordning, se "Knapper som kan tilordnes" i "Nyttige funksjoner".

Stopp opptaket. Trykk deretter på en knapp som er tilordnet med Rec Review-funksjonen for å starte avspillingen av
klippet som ble tatt opp tidligere.
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Klippet spilles helt gjennom, Rec Review avsluttes, og enheten går tilbake til Stby (standby)-modus.

For å stoppe gjennomgang av opptak
Trykk på en knapp som er tilordnet med Rec Review eller trykk på [Cancel/Back]-knappen.
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Hint

Du kan også trykke på [Cancel/Back]-knappen på den medfølgende infrarød-fjernkontrollen for å stoppe Rec Review-funksjonen.

Beslektet emne

Knapper som kan tilordnes

5-041-958-83(1) Copyright 2022 Sony Corporation
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Skjermbilde for justering av rammer

Rammene justeres ved hjelp av følgende deler av skjermbildet for direkte betjening.

Merknad

Avhengig av retningen på kameraet, objektivets brennvidde og zoomposisjonen, kan en del av enheten eller kablene som er
koblet til kontaktblokken være synlig. Før opptak må du kontrollere synsfeltet for objektivet og brennvidden du bruker. Du kan
også kontrollere pan/tilt-området ved hjelp av [Pan-Tilt] > [P/T Range Limit] i nettmenyen. Når enheten slås på eller tilbakestilling
av pan/tilt utføres, ignoreres denne innstillingen for områdegrense. For mer informasjon, se [Pan-Tilt] > [P/T Range Limit] i
nettmenyen.

Hint

Du kan også kontrollere rammene ved hjelp av den medfølgende infrarød-fjernkontrollen.

5-041-958-83(1) Copyright 2022 Sony Corporation

Kontrollpanel for forhåndsinnstilt posisjon1.

 (Main)-fane /  (Others)-fane2.

Kontrollpanel for rammer3.
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Justere opptaksretningen ved hjelp av Web App

Å flytte kameraet horisontalt kalles panorering, og å flytte kameraet vertikalt kalles tilting.
Du kan justere opptaksretningen ved hjelp av pan/tilt-betjening.

Hint

Hvis [Execute Pan-Tilt Reset] vises under styrespaken, har det oppstått en inkonsekvens i enhetens opprinnelsesinformasjon for
pan/tilt-kontroll. Utfør funksjonen for tilbakestilling av pan/tilt for å oppdatere opprinnelsesinformasjonen. Hvis du vil ha mer
informasjon, se "Tilbakestille Pan/Tilt".

Slik vender du kameraet tilbake til forsiden
Trykk på knappen  (Pan/tilt hjem) på  (Others)-fanen i kamerakontrollpanelet.

Merknad

Avhengig av retningen på kameraet, objektivets brennvidde og zoomposisjonen, kan en del av enheten eller kablene som er
koblet til kontaktblokken være synlig. Før opptak må du kontrollere synsfeltet for objektivet og brennvidden du bruker. Du kan
også kontrollere pan/tilt-området ved hjelp av [Pan-Tilt] > [P/T Range Limit] i nettmenyen. Når enheten slås på eller tilbakestilling
av pan/tilt utføres, ignoreres denne innstillingen for områdegrense. For mer informasjon, se [Pan-Tilt] > [P/T Range Limit] i
nettmenyen.

Beslektet emne
Tilbakestille Pan/Tilt
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Trykk på fanen  (Pan/tilt/zoom) i kontrollpanelet for rammer for å vise styrespaken.1

Dra midten av styrespaken i den retningen du vil vise mens du overvåker kamerabildepanelet.

Kameraets retning og hastighet endres som respons på draretningen og -nivået.
Du kan justere pan/tilt mer nøyaktig ved å trykke på de ytre områdene på styrespaken.

2
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Angi driftshastigheten for Pan/Tilt

Du kan endre driftshastigheten for pan/tilt ved hjelp av glidebryteren [Pan-Tilt Speed] i kamerakontrollpanelet ved å
betjene styrespaken i kontrollpanelet for rammer.

Merknad

Hvis det er en vegg eller annen hindring innenfor kameraets bevegelsesområde, må du passe på å ikke treffe kameraet eller
objektivet under pan/tilt-betjening.

Pan/tilt-akselerasjonen avhenger av fysiske egenskaper, for eksempel vektbalansen til objektivet. Du kan endre innstilling for
akselerasjon hjelp av [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] i nettmenyen eller kameramenyen.
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Trykk på  (Main)-fanen i kamerakontrollpanelet.1

Velg glidebryteren [Pan-Tilt Speed] fra listen.

Hvis glidebryteren [Pan-Tilt Speed] ikke vises, velger du en av de to knappene for valg av glidebryterfunksjon for å
vise glidebryteren.

2

Flytt glidebryterknappen til venstre eller høyre.

Hvis du flytter knappen mot venstre, reduseres driftshastigheten. Hvis du flytter knappen mot høyre, økes
driftshastigheten.

3
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Angi driftsakselerasjonen for Pan/Tilt

Du kan angi akselerasjonsdriften i ni graderinger ved hjelp av [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] i nettmenyen
eller kameramenyen. Øk verdien for raskere endringer i hastighet, eller reduser verdien for mer gradvise endringer i
hastighet.
Hvis du vil ha større reaksjonsevne når du betjener pan/tilt, velger du en verdi i området 7 til 9.
For større posisjonsnøyaktighet ved starten/slutten av bevegelsen til en forhåndsinnstilt posisjon, anbefales en verdi i
området 1 til 6.

Hvis du vil ha mer informasjon om forhåndsinnstilt posisjon, se "Lagre/gjenopprette pan/tilt og zoomposisjon".

Merknad

Når verdien er satt høyt, kan det hende at funksjonen ikke fungerer som den skal hvis et tungt objektiv er festet. Kontroller driften
før faktisk bruk.

Forhold mellom [Ramp Curve]-innstilling og pan/tilt-betjening

Når pan/tilt betjenes

Når en forhåndsinnstilt posisjon tilbakekalles
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Justere opptaksretningen ved hjelp av den medfølgende infrarød-fjernkontrollen

Du kan justere opptaksretningen ved hjelp av knappene for pan/tilt-betjening på den medfølgende infrarød-
fjernkontrollen.

Slik vender du kameraet tilbake til forsiden
Trykk på HOME-knappen.

Merknad

Avhengig av retningen på kameraet, objektivets brennvidde og zoomposisjonen, kan en del av enheten eller kablene som er
koblet til kontaktblokken være synlig. Før opptak må du kontrollere synsfeltet for objektivet og brennvidden du bruker. Du kan
også kontrollere pan/tilt-området ved hjelp av [Pan-Tilt] > [P/T Range Limit] i nettmenyen. Når enheten slås på eller tilbakestilling
av pan/tilt utføres, ignoreres denne innstillingen for områdegrense. For mer informasjon, se [Pan-Tilt] > [P/T Range Limit] i
nettmenyen.
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Trykk på pilknappene for å kontrollere pan/tilt.

Trykk pilknappen for retningen du vil vise mens du overvåker kamerabildet.
Hvis du vil flytte en kort avstand, trykker du kort på pilknappen.
Hvis du vil flytte en stor avstand, trykker du på pilknappen og holder den inne.
Hvis du vil flytte diagonalt, trykker du på og holder  (pil opp) inne eller  (pil ned) og trykker på  (venstre pil)
eller  (høyre pil).

1
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Angi zoomtype

Angi type zoom ved hjelp av [Technical] > [Zoom] > [Zoom Type] i kameramenyen.
Typen zoom varierer avhengig av hvilken objektivtype som er montert.

Merknad

Clear Image Zoom er ikke tilgjengelig i følgende tilfeller:

Når [Shooting] > [S&Q Motion] > [Setting] er satt til On og [Frame Rate]-innstillingen i kameramenyen er høyere enn 60 fps
Når [Project] > [Rec Format] > [Codec] i kameramenyen er satt til [RAW] eller et alternativ som inkluderer RAW

Betjening av velgerbryteren SERVO/MANUAL på et objektiv tilbakestiller forstørrelsen av Clear Image Zoom til 1×.

AF-S støttes ikke under Clear Image Zoom.

Clear Image Zoom

Enheten er utstyrt med en zoomfunksjon som bruker bildesignalbehandling med betegnelsen Clear Image Zoom. Når
Clear Image Zoom er aktivert, støttes zoom også for objektiver med fast fokus. Den kan også brukes til å utvide
rekkevidden utover det optiske området for et objektiv med elektrisk zoom.
Det maksimale zoomforholdet ved bruk av Clear Image Zoom varierer avhengig av opptaksoppløsningen.

For QFHD/4K-opptaksoppløsning: 1,5×
For HD-opptaksoppløsning: 2×
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Type objektiv som er festet
[Zoom Type]-innstilling

[Optical Zoom Only] [On(Clear Image Zoom)]

Objektiv med fast fokus / objektiv med manuell
zoom

Zoombetjening støttes
ikke.

Clear Image Zoom støttes.

Objektiv med elektrisk zoom Bare optisk zoom støttes.
Optisk zoom og Clear Image Zoom
støttes.
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Justere zoomen ved hjelp av Web App

Du kan justere zoomen på enheten ved hjelp av optisk zoom eller Clear Image Zoom. Dette emnet beskriver hvordan du
foretar justeringer ved hjelp av Web App. Hvis du vil ha mer informasjon om Clear Image Zoom, se "Angi zoomtype".

Merknad

Avhengig av retningen på kameraet, objektivets brennvidde og zoomposisjonen, kan en del av enheten eller kablene som er
koblet til kontaktblokken være synlig. Før opptak må du kontrollere synsfeltet for objektivet og brennvidden du bruker. Du kan
også kontrollere pan/tilt-området ved hjelp av [Pan-Tilt] > [P/T Range Limit] i nettmenyen. Når enheten slås på eller tilbakestilling
av pan/tilt utføres, ignoreres denne innstillingen for områdegrense. For mer informasjon, se [Pan-Tilt] > [P/T Range Limit] i
nettmenyen.

Den faktiske zoomhastigheten og -presisjonen vil variere avhengig av objektivet. Kontroller driften før bruk.

Hint

Du kan kontrollere zoomen for en manuell zoom-linse ved å bruke en objektivkontroller (valgfritt) som er kompatibel med denne
enheten. Hvis du vil ha mer informasjon, se "Koble til en objektivkontroller" og "Justering av zoom med objektivkontroller".

Beslektet emne

Angi zoomtype

Koble til en objektivkontroller

Justering av zoom med objektivkontroller

5-041-958-83(1) Copyright 2022 Sony Corporation

Trykk på fanen  (Pan/tilt/zoom) i kontrollpanelet for rammer for å vise kontrollpanelet for pan/tilt.1

Skyv glidebryteren [Zoom] i retningen [T] (Telephoto) eller [W] (Wide) for å justere zoomen.

Zoomhastigheten varierer med glidebryterens bevegelse.

2
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Angi driftshastigheten for zoom

Du kan endre driftshastigheten for zoom til glidebryteren [Zoom] i rammekontrollpanelet ved hjelp av glidebryteren [Zoom
Speed] i kamerakontrollpanelet.

Merknad

Den faktiske zoomhastigheten og -presisjonen vil variere avhengig av objektivet. Kontroller driften før bruk.
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Trykk på  (Main)-fanen i kamerakontrollpanelet.1

Velg glidebryteren [Zoom Speed] fra listen.

Hvis glidebryteren [Zoom Speed] ikke vises, velger du en av de to knappene for valg av glidebryterfunksjon for å
vise glidebryteren.

 

2

Flytt [Zoom Speed]-glidebryterknappen til venstre eller høyre.

Hvis du flytter knappen mot venstre, reduseres driftshastigheten. Hvis du flytter knappen mot høyre, økes
driftshastigheten.

3
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Justere zoomen ved hjelp av den medfølgende infrarød-fjernkontrollen

Du kan justere zoomen på enheten ved hjelp av optisk zoom eller Clear Image Zoom. Dette emnet beskriver hvordan du
foretar justeringer ved hjelp av den medfølgende infrarød-fjernkontrollen. Hvis du vil ha mer informasjon om Clear Image
Zoom, se "Angi zoomtype".

Merknad

Avhengig av retningen på kameraet, objektivets brennvidde og zoomposisjonen, kan en del av enheten eller kablene som er
koblet til kontaktblokken være synlig. Før opptak må du kontrollere synsfeltet for objektivet og brennvidden du bruker. Du kan
også kontrollere pan/tilt-området ved hjelp av [Pan-Tilt] > [P/T Range Limit] i nettmenyen. Når enheten slås på eller tilbakestilling
av pan/tilt utføres, ignoreres denne innstillingen for områdegrense. For mer informasjon, se [Pan-Tilt] > [P/T Range Limit] i
nettmenyen.

Hint

Du kan kontrollere zoomen for en manuell zoom-linse ved å bruke en objektivkontroller (valgfritt) som er kompatibel med denne
enheten. Hvis du vil ha mer informasjon, se "Koble til en objektivkontroller" og "Justering av zoom med objektivkontroller".

Beslektet emne
Angi zoomtype

Koble til en objektivkontroller

Justering av zoom med objektivkontroller
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Trykk zoomknappen for å justere zoomen.

Trykk på knappen T (Telephoto) eller W (Wide) mens du overvåker skjermbildet for å justere zoomen.
Trykk på T-knappen for å zoome inn.
Trykk på W-knappen for å zoome ut.

1
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Kalibrere et E-festeobjektiv

Kalibrering korrigerer for forskjeller i zoomposisjon på grunn av forskjeller i individuelle objektiver når du bruker et E-
festeobjektiv med elektrisk zoom.
Hvis du vil beregne zoomposisjonen nøyaktig, kalibrerer du objektivet for å korrigere for individuelle forskjeller i objektivet
ved hjelp av følgende fremgangsmåte.

Kalibreringsdata
Kalibreringsdata for opptil fem objektiver kan lagres i enheten. De eldste dataene overskrives når et sjette eller
etterfølgende objektiv kalibreres.
Du kan kontrollere om kalibreringsdata er tilgjengelige for det tilkoblede objektivet ved å trykke på knappen 
(Kamerastatus) i fellesområdet på Web App-skjermbildet og velge [Lens] > [Calibration Data].
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Hvis objektivet har en SERVO/MANUAL-bryter, setter du den i SERVO-posisjon.

Merknad

Objektivet vil ikke kunne motta zoominstruksjoner fra enheten hvis bryteren er satt til MANUAL.

1

Kjør kalibreringen ved hjelp av [Technical] > [Lens] > [Lens Calibration] i kameramenyen.

Under kalibrering beveger zoomobjektivet seg automatisk og måles.

2
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Lagre/gjenopprette pan/tilt, zoomposisjon og fokusinnstilling ved hjelp av Web App

Du kan lagre pan/tilt, zoomposisjonen og fokusinnstillingen og tilbakekalle dem ved behov ved hjelp av Web App
(funksjon for forhåndsinnstilt posisjon).

Hvis du vil ha mer informasjon om elementene som kan lagres/gjenopprettes, se "Lagrede elementer for
forhåndsinnstilt posisjon".

Merknad

En forhåndsinnstilt posisjon kan ikke lagres hvis Clear Image Zoom-forholdet overskrider 1×.

Hvis innstillingen [Pan-Tilt] > [P/T Direction] > [Ceiling] i nettmenyen endres, slettes alle forhåndsinnstilte posisjoner.

Sett PTZ Assist-modus til [Pos.] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.1

Bestem posisjonen du vil lagre ved hjelp av betjening av pan/tilt og zoom.2

Trykk på [+]-knappen i kontrollpanelet for forhåndsinnstilt posisjon.

Bildet med den lagrede posisjonen vises i kontrollpanelet for forhåndsinnstilt posisjon.

Hint

Hvis kontrollpanelet for forhåndsinnstilt posisjon ikke vises, trykker du på knappen  (Åpne) for å vise den.

Posisjoner lagres i rekkefølge fra [Preset1].

Hvis det finnes ubrukte forhåndsinnstillinger i en rekkefølge med forhåndsinnstillinger, lagres posisjoner i
forhåndsinnstillinger som starter med de ubrukte forhåndsinnstillingene. Hvis for eksempel forhåndsinnstilte posisjoner er
lagret i [Preset1] og [Preset3], men ikke i [Preset2], vil de neste forhåndsinnstilte posisjonene bli lagret i [Preset2] og
deretter i [Preset4].

3
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Avbryte driften av gjenoppretting av forhåndsinnstilt posisjon
Trykk på  (Avbryt gjenopprett)-knappen som vises på kontrollpanelet for forhåndsinntilt posisjon under driften av
gjenoppretting av forhåndsinnstilt posisjon for å avbryte gjenopprettingsdriften. Bruk styrespaken og [Zoom]-glidebryteren
for å justere rammen.

Opptil 100 forhåndsinnstilte posisjoner kan lagres.

Du kan gi nytt navn til hver forhåndsinnstilte posisjon. Hvis du vil ha mer informasjon, se "Gi nytt navn til forhåndsinnstilte
posisjoner ved hjelp av Web App".

Gjenopprette en lagret posisjon.

I kontrollpanelet for forhåndsinnstilt posisjon dobbeltklikker du på miniatyrbildet for posisjonen du vil gjenopprette,
for å gjenopprette den tilsvarende posisjonen.

Hint

Du kan også gjenopprette en posisjon ved å trykke på bildet, trykke på knappen  (Forhåndsinnstilt posisjon-meny) som
vises og velge [Recall].

Overgangshastigheten til en lagret posisjon bestemmes av innstillingen [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt
Speed for Common] i nettmenyen da posisjonen ble lagret. Du kan også endre overgangshastigheten etter lagring. Hvis du
vil ha mer informasjon, se "Endre overgangshastigheten (Pan-Tilt/Zoom/Focus) når du gjenoppretter en forhåndsinnstilt
posisjon."

Graden av endring i pan/tilt-posisjonen når du flytter til en forhåndsinnstilt posisjon, kan justeres ved hjelp av innstillingene
for overgangshastighet og [Ramp Curve]. Hvis du vil ha mer informasjon, se "Endre overgangshastigheten (Pan-
Tilt/Zoom/Focus) når du gjenoppretter en forhåndsinnstilt posisjon" og "Angi driftsakselerasjonen for Pan/Tilt".

Hvis en annen forhåndsinnstilling tilbakekalles under forhåndsinnstilt avspilling, stopper driften av den første tilbakekalte
forhåndsinnstillingen, og driften av den påfølgende tilbakekalte forhåndsinnstillingen starter.

Merknad

Hvis temperaturen i omgivelsene har endret seg vesentlig fra tidspunktet da en forhåndsinnstilt posisjon ble lagret, til
tidspunktet for avspilling, kan avvik for rammer.

Mens en forhåndsinnstilt posisjon blir lagret, kan du ikke utføre noen andre operasjoner enn gjenopprette eller avbryte den
forhåndsinnstilte posisjonen.

4
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Beslektet emne

Lagrede elementer for forhåndsinnstilt posisjon

Gi nytt navn til forhåndsinnstillinger for posisjoner ved hjelp av Web App

Endre overgangshastigheten (Pan-Tilt/Zoom/Focus) når du gjenoppretter en forhåndsinnstilt posisjon

Angi driftsakselerasjonen for Pan/Tilt

5-041-958-83(1) Copyright 2022 Sony Corporation
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Gi nytt navn til forhåndsinnstillinger for posisjoner ved hjelp av Web App

Du kan gi nytt navn til lagrede forhåndsinnstilte posisjoner.
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Sett PTZ Assist-modus til [Pos.] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.1

Trykk på forhåndsinnstillingen for posisjon du vil gi nytt navn til.

Knappen  (Forhåndsinnstilt posisjon-meny) vises øverst til høyre i bildet.

2

Trykk på knappen  (Forhåndsinnstilt posisjon-meny) og velg [Rename] fra menyen som vises.3

Skriv inn et nytt forhåndsinnstilt navn.4
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Erstatte en lagret forhåndsinnstilt posisjon med en ny posisjon ved hjelp av Web App

Du kan erstatte en lagret forhåndsinnstilt posisjon med en ny posisjon.
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Sett PTZ Assist-modus til [Pos.] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.1

Bestem posisjonen du vil lagre ved hjelp av betjening av pan/tilt og zoom.2

I kontrollpanelet for forhåndsinnstilt posisjon trykker du på posisjonsbildet du vil erstatte.

Knappen  (Forhåndsinnstilt posisjon-meny) vises øverst til høyre i bildet.

3

Trykk på knappen  (Forhåndsinnstilt posisjon-meny) og velg [Replace] fra menyen som vises.

Den nye posisjonen erstatter gjeldende innstilling.

4
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Slette en lagret forhåndsinnstilt posisjon ved hjelp av Web App

Du kan slette lagrede forhåndsinnstilte posisjoner.
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Sett PTZ Assist-modus til [Pos.] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.1

I kontrollpanelet for forhåndsinnstilt posisjon trykker du på posisjonsbildet du vil slette.

Knappen  (Forhåndsinnstilt posisjon-meny) vises øverst til høyre i bildet.

2

Trykk på knappen  (Forhåndsinnstilt posisjon-meny) og velg [Delete] fra menyen som vises.

Den lagrede posisjonen er slettet.

3
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Synkronisering av Pan/Tilt-drift og Zoom/Focus-drift ved gjenoppretting av en
forhåndsinnstilt en posisjon

Du kan synkronisere pan/tilt-drift og zoom-drift ved gjenoppretting av en forhåndsinnstilt posisjon for smidigere ramme-
funksjon.

Hint

Du kan angi innstillinger som brukes for registrering av en forhåndsinnstilt posisjon på forhånd. Angi [Pan-Tilt] > [P/T Preset] >
[Default] > [Zoom Sync] til [On] i nettmenyen.

Når [Pan-Tilt] > [P/T Preset] > [Speed Select] er satt til [Common], gjenopprettes alle forhåndsinnstilte posisjoner til hastigheten
som er innstilt ved hjelp av [Pan-Tilt] > [P/T Preset] > [Common Speed].

Når zoom-bevegelse er fullført, går kameraet til den lagrede fokusposisjonen.

Etter at bevegelsen er fullført, vil [AF Transition Speed] gå tilbake til sin opprinnelige innstilling.

Sett PTZ Assist-modus til [Pos.] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.1

Trykk på bildet for den forhåndsinnstilte posisjonen du vil endre overgangshastigheten for.

Knappen  (Forhåndsinnstilt posisjon-meny) vises øverst til høyre i bildet.

2

Trykk på knappen  (Forhåndsinnstilt posisjon-meny) og velg [Edit…] fra menyen som vises.

Oppsettskjermbildet for den valgte forhåndsinnstilte posisjonen vises.

3

Skyv [Zoom Sync]-bryteren til høyre for å slå funksjonen på, og trykk på [OK]-knappen.

Neste gang en lagret posisjon gjenopprettes, beveger kameraet seg med den konfigurerte hastigheten.

4
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Endre overgangshastigheten (Pan-Tilt/Zoom/Focus) når du gjenoppretter en
forhåndsinnstilt posisjon

Du kan endre overgangshastigheten (pan/tilt-drift, zoom-drift, focus-drift) når du gjenoppretter en lagret forhåndsinnstilt
posisjon.

Hint

Når [Pan-Tilt] > [P/T Preset] > [Speed Select] er satt til [Common], gjenopprettes alle posisjoner i angitt hastighet ved hjelp av
[Pan-Tilt] > [P/T Preset] > [Common Speed].

Når zoom-bevegelse er fullført, går kameraet til den lagrede fokusposisjonen.

Etter at bevegelsen er fullført, vil [AF Transition Speed] gå tilbake til sin opprinnelige innstilling.

Angi [Pan-Tilt] > [P/T Preset] > [Speed Select] til [Separate] i nettmenyen.1

Sett PTZ Assist-modus til [Pos.] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.2

Trykk på bildet for den forhåndsinnstilte posisjonen du vil endre overgangshastigheten for.

Knappen  (Forhåndsinnstilt posisjon-meny) vises øverst til høyre i bildet.

3

Trykk på knappen  (Forhåndsinnstilt posisjon-meny) og velg [Edit…] fra menyen som vises.

Oppsettskjermbildet for den valgte forhåndsinnstilte posisjonen vises.

4

Still inn de overgangshastighetene (Pan-Tilt/Zoom/Focus) som du ønsker å endre ved hjelp av
glidebryterne, eller legg inn verdier direkte og trykk på [OK]-knappen.

Neste gang en lagret posisjon gjenopprettes, beveger kameraet seg med den konfigurerte hastigheten.

5
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Lagre/gjenopprette pan/tilt og zoomposisjon ved hjelp av den medfølgende infrarød-
fjernkontrollen

Du kan lagre pan/tilt og zoomposisjonen og tilbakekalle dem ved behov ved hjelp av den medfølgende infrarød-
fjernkontrollen.

Beslektet emne

Endre overgangshastigheten (Pan-Tilt/Zoom/Focus) når du gjenoppretter en forhåndsinnstilt posisjon

Juster pan/tilt og zoomen på kameraet.1

Sett PTZ Assist-modus til [Pos.] i rullegardinmenyen overst i kontrollpanelet for forhåndsinnstilt posisjon i
Web App.

2

Trykk og hold inne PRESET-knappen og trykk på én av de 1 til 3 knappene.

Posisjonen er lagret.

3

Gjenopprette en lagret posisjon.

Trykk på en av knappene, 1 til 3, for å gjenopprette den forhåndsinnstilte posisjonen.

Hint

Overgangshastigheten ved gjenoppretting av en forhåndsinntilt posisjon bestemmes av den lagrede [Pan-Tilt] > [P/T Preset]
> [Pan-Tilt Speed]-verdien i nettmenyen. Du kan endre overgangshastigheten etter lagring. Hvis du vil ha mer informasjon,
se "Endre overgangshastigheten (Pan-Tilt/Zoom/Focus) når du gjenoppretter en forhåndsinnstilt posisjon."

4
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Opptak med funksjoner for kamera-framing med bruk av Web App

Du kan gjøre opptak med funksjoner for kamera-framing med bruk av Web App.

Juster startposisjon for kameraets funksjon.1

Sett PTZ Assist-modus til [Trace] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.2

Trykk på [+]-knappen i kontrollpanelet for forhåndsinnstilt posisjon.

Et miniatyrbilde legges til og kameraet skifter til standby-modus for opptak.

Hint

Du kan trykke på  (Lukk)-knappen på miniatyrbildet for å gå ut av standby-modus for opptak og gå tilbake til normal drift.

3
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Hint

Den gjenværende opptakstiden vises øverst i kamerabildepanelet under opptak.

Merknad

Framing-funksjonene som er tatt opp vil bli slettet hvis du skifter til takmontering.

Endring av systemfrekvensen kan føre til sletting av framing-funksjoner som er tatt opp.

Zoom-drift blir ikke tatt opp når en objektivkontroller er koblet til.

Den maksimale varigheten for opptak av én enkelt framing-funksjon er 3 minutter. Opptaket vil stoppe automatisk når opptakets
varighet når 3 minutter.

Opptak av en framing-funksjon kan ikke startes hvis Clear Image Zoom-forholdet er større enn 1×.

Hvis kameraet betjenes fra en annen enhet under opptak av en framing-funksjon, vil den andre enhetens funksjoner også bli tatt
opp. For mer informasjon om opptaksfunksjoner med bruk av tredjeparts fjernkontroll, kontakt den aktuelle produsenten.

Fokus- og bildekvalitetsinnstillinger blir ikke tatt opp med denne funksjonen.

Pan/tilt/zoom-drift som er tatt opp under et opptak av en rammefunksjon, kan ikke reproduseres nøyaktig under ramme-avspilling.

Hvis du, etter opptak av en rammefunksjon, stiller inn områdegrense for pan/tilt med [Pan-Tilt] > [P/T Range Limit] i nettmenyen,
vil områdegrensen for pan/tilt ikke bli brukt under framing-avspilling. Hvis du ønsker å bruke en framing-funksjon og pan/tilt-
områdegrense sammen, må du stille inn områdegrensen før opptak av framing-funksjonen.

Framing-funksjoner som er tatt opp kan ikke spilles av når RAW-videoavspilling er valgt.

Start framing-funksjonen med joystick-en og [Zoom]-glidebryteren.

Opptaket starter fra det øyeblikket framing-funksjonen starter.

4

Trykk på  (Stopp opptak)-knappen på miniatyrbildet for å stoppe opptaket.5
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Avspilling med funksjoner for kamera-framing med bruk av Web App

Du kan spille av et opptak med funksjoner for kamera-framing med bruk av Web App.

Sett PTZ Assist-modus til [Trace] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.1

Velg et miniatyrbilde med framing-funksjon som du ønsker å spille av.

 (Klargjør)-knappen vises på miniatyrbildet.

2

Trykk på  (Klargjør)-knappen.

Kameraet går til framing-funksjonens startposisjon og kobler over til avspilling standby-modus.

3

Trykk på  (Spill av)-knappen på miniatyrbildet.4
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Hint

I avspilling standby-modus og under avspilling, kan du avbryte avspilling og gå tilbake til normal drift med en av følgende
handlinger.

Trykk på  (Stop)-knappen på miniatyrbildet eller i kontrollpanelet for forhåndsinnstilt posisjon.
Bruke joystick.
Bruk [Zoom]-glidebryteren.

Den gjenværende avspillingstiden vises øverst i kamerabildepanelet under avspilling.

Merknad

Uventet oppførsel kan oppstå hvis Clear Image Zoom-innstillingen er forskjellig i opptak og avspilling av framing-funksjoner.

Avspilling av Zoom-drift støttes ikke når en objektivkontroller er koblet til. Betjening av zoom vil stoppe avspillingen av framing-
funksjoner.

Under avspilling av framing-funksjoner, vil endring av pan/tilt områdegrense med [Pan-Tilt] > [P/T Range Limit] i nettmenyen ikke
ha noen virkning. Still inn pan/tilt områdegrense før opptak av en framing-funksjon.

5-041-958-83(1) Copyright 2022 Sony Corporation

Framing-avspilling starter.
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Slette kameraopptak av framing-funksjoner ved hjelp av Web App

Du kan slette kameraopptak av framing-funksjoner ved hjelp av Web App.

5-041-958-83(1) Copyright 2022 Sony Corporation

Sett PTZ Assist-modus til [Trace] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.1

Velg et miniatyrbilde med den framing-funksjonen som du ønsker å slette.

 (Trace-meny)-knappen vises på miniatyrbildet.

2

Trykk på  (Trace-meny)-knappen.

Menyen vises.

3

Velg [Delete] fra menyen som vises.

Den valgte rammefunksjonen slettes.

4
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Opptak med funksjoner for kamera-framing med bruk av medfølgende infrarød-
fjernkontroll

Du kan ta opp funksjoner for kamera-framing ved hjelp av den medfølgende infrarød-fjernkontrollen.

For mer informasjon om avspilling av et opptak med framing-funksjon, se "Spille av funksjoner for kamera-framing ved
hjelp av den medfølgende infrarød-fjernkontrollen."

Merknad

Den maksimale varigheten for opptak av én enkelt framing-funksjon er 3 minutter. Opptaket vil stoppe automatisk når opptakets
varighet når 3 minutter.

Hvis kameraet betjenes fra en annen enhet under opptak av en framing-funksjon, vil den andre enhetens funksjon også bli tatt
opp som en del av framing-funksjonen.

Hvis bildekvaliteten justeres under opptak av en framing-funksjon, vil endringene ikke bli tatt opp.

Beslektet emne

Avspilling med funksjoner for kamera-framing med bruk av medfølgende infrarød-fjernkontroll
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Gå inn på skjermbildet for direkte betjening i Web App.1

Sett PTZ Assist-modus til [Trace] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.2

Juster startposisjon for kameraets funksjon med infrarød-fjernkontrollen.3

Trykk og hold inne PRESET-knappen og trykk på én av POSITION1 til 3-knappene.

Kameraet skifter til standby-modus for opptak.

4

Utfør framing-funksjonen du ønsker å ta opp.5

For å avslutte opptaket, trykk og hold PRESET-knappen og trykk på POSITION-knappen som er valgt i trinn
4.

6
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Avspilling med funksjoner for kamera-framing med bruk av medfølgende infrarød-
fjernkontroll

Du kan spille av et opptak med kamera-framing-funksjon ved hjelp av den medfølgende infrarød-fjernkontrollen.

Merknad

Pan/tilt/zoom på kameraet vil stoppe avspilling.

Beslektet emne

Opptak med funksjoner for kamera-framing med bruk av medfølgende infrarød-fjernkontroll
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Gå inn på skjermbildet for direkte betjening i Web App.1

Sett PTZ Assist-modus til [Trace] i rullegardinmenyen øverst i kontrollpanelet for forhåndsinnstilt posisjon.2

Velg og trykk på en av POSITION1 til 3-knappene for en framing-funksjon som ble tatt opp.

Pan/tilt/zoom på kameraet kan gå til avspillingens startposisjon.

3

Når kameraet har gått til avspillingens startposisjon,, trykk på samme POSITION-knapp igjen.

Avspilling starter.

4
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Skjermbilde for justering av fokus

Fokuset justeres ved hjelp av følgende deler av skjermbildet for direkte betjening.

5-041-958-83(1) Copyright 2022 Sony Corporation

Kameraets bildepanel
Du kan justere fokuset ved å berøre kamerabildet. Du kan deaktivere berøringsfunksjonen i Web App ved å slå av
bryteren [Touch Focus] i  (Focus)-fanen i kamerakontrollpanelet.

1.

Kameraets kontrollpanel –  (Focus)-fanen2.

GUI-kontrollpanel3.
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Justere manuelt ved hjelp av Web App

Du kan justere fokus manuelt, for eksempel i følgende tilfeller.

Motiver delvis skjult av vanndråper
Motiver med lav kontrast mot bakgrunnen
Motiver som er lenger unna enn motiver i nærheten

Merknad

Manuell fokus kan ikke kontrolleres fra Web App-en mens zoom-drift er i gang.

Hint

Du kan også bruke autofokus når manuell justering er hovedmetoden for betjening. Hvis du vil ha mer informasjon, se "Angi
autofokusmålet manuelt (AF Assist) ved hjelp av Web App".

Beslektet emne

Kontrollere objektivbryterne

Angi autofokusmålet manuelt (AF Assist) ved hjelp av Web App
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Hvis objektivet er utstyrt med en fokusvelgerbryter, sett bryteren til "AF/MF-" eller "AF"-posisjon.

Merknad

Hvis bryteren er satt til posisjonen "Full MF" eller "MF", kan ikke fokuseringen på objektivet betjenes fra enheten. Se "For et
objektiv med fokusmodusbryterr" i "Kontrollere objektivbryterne".

1

Skyv bryteren [Auto Focus] til venstre posisjon i kamerakontrollpanelet for å slå av autofokus.

Manuell fokusmodus er aktivert.

 (MF)

2

Juster ved hjelp av glidebryteren nederst på  (Focus)-fanen.3
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Justere manuelt ved hjelp av den medfølgende infrarød-fjernkontrollen

Du kan justere fokuset manuelt ved hjelp av den medfølgende infrarød-fjernkontrollen.

Hint

Du kan også bruke autofokus når manuell justering er hovedmetoden for betjening. Hvis du vil ha mer informasjon, se "Fokusere
manuelt under autofokus ved hjelp av den medfølgende infrarød-fjernkontrollen".

Beslektet emne

Fokusere manuelt under autofokus ved hjelp av den medfølgende infrarød-fjernkontrollen
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Trykk på MF-knappen på infrarød-fjernkontrollen.1

Juster fokuset manuelt ved hjelp av F (Far)-knappen og N (Near)-knappen.

Trykk på F-knappen for å fokusere på et fjernmotiv.
Trykk på N-knappen for å fokusere på et nærmotiv.

2
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Fokusering ved å angi en fokusposisjon (Spot Focus)

I manuell fokusmodus kan du angi posisjonen der du ønsker å justere fokus i kamerabildepanelet.

Merknad

Funksjonen Spot Focus virker ikke hvis objektivet er stilt inn for manuell fokusering.

Hint

I Spot Focus-modus kan du trykke på en knapp som er tilordnet med [Push AF/MF] for å stoppe punktfokus midlertidig og aktivere
autofokus mens knappen er trykket inn. Fokuseringen går tilbake til manuell fokus når du slipper knappen.
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Angi [Shooting] > [Focus] > [Touch Function in MF] til [Spot Focus] i nettmenyen eller kameramenyen.1

Skyv bryteren [Touch Focus] i  (Focus)-fanen til høyre posisjon for å slå den på.2

Skyv bryteren [Auto Focus] i  (Focus)-fanen til venstre posisjon for å slå den av.3

Angi fokusposisjonen.

Spot Focus-markøren vises, og bildet justeres slik at det er i fokus i denne posisjonen.

Eksempel på angivelse av posisjonen ved berøringsfunksjon

4
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Bruke autofokus midlertidig (Push Auto Focus (AF))

I manuell fokusmodus kan du justere fokuset midlertidig ved hjelp av autofokus ved å trykke på [Push AF/MF]-knappen
for å fokusere automatisk mens knappen er trykket inn.
Dette er nyttig når du vil flytte fokuset langsomt fra ett motiv til et annet mens du bruker manuell fokus.

Merknad

Funksjonen Push Auto Focus virker ikke hvis objektivet er stilt inn for manuell fokusering.

Hint

Den samme operasjonen støttes med en knapp som er tilordnet med [Push AF/MF].
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Angi [Shooting] > [Focus] > [Push AF Mode] til [AF] i kameramenyen.1

Skyv bryteren [Auto Focus] i  (Focus)-fanen til venstre posisjon for å slå den av.2

Trykk på [Push AF/MF]-knappen.

Autofokus er aktivt mens knappen er trykket inn.

Push Auto Focus frigjøres og autofokus går tilbake til manuell fokus når du slipper knappen.

3
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Bruke autofokus for enkeltbilde (Push Auto Focus (AF-S))

Du kan trykke på [Push AF/MF]-knappen i manuell fokusmodus for å fokusere automatisk med høy hastighet.
Denne funksjonen er praktisk når du fokuserer på et motiv før du tar bilder.

Merknad

Funksjonen Push Auto Focus virker ikke hvis objektivet er stilt inn for manuell fokusering.

Rammen for fokusområdet skjules ikke når du bruker [Display]-knappen.

Under bruk av Clear Image Zoom, er det ikke mulig å stille inn rammeposisjon for [Focus Area (AF-S)]. Under betjening av Push
Auto Focus vil AF-betjening også gi prioritet til den midtre delen.

Angi [Shooting] > [Focus] > [Push AF Mode] til [Single-shot AF(AF-S)] i nettmenyen eller kameramenyen.1

Angi posisjonen der du ønsker å justere fokus ved hjelp av [Shooting] > [Focus] > [Focus Area (AF-S)] i
kameramenyen.

Hint

Du kan endre posisjonen ved å trykke på en knapp som er tilordnet [Focus Setting] for å vise en oransje ramme rundt
fokusområdet til oransje og velge en posisjon ved hjelp av berøringsfunksjon.

2

Skyv bryteren [Auto Focus] i  (Focus)-fanen til venstre posisjon for å slå den av.3

Trykk på [Push AF/MF]-knappen.

Hvis du slipper knappen før fokuseringen er ferdig, stopper Push Auto Focus.

Under Push Auto Focus vises fokusstatusen av fokusindikatoren.
På: Fokus er fiksert i fokusposisjonen.
Blinker: Ute av fokus. Ettersom enheten ikke fokuserer automatisk, endrer du komposisjonen og fokusinnstillingene
for å oppnå fokus.
Fokuseringen går tilbake til manuell fokus når du slipper knappen.

4
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Hint

Den samme operasjonen støttes med en knapp som er tilordnet med [Push AF/MF].

Du kan også tilordne [Push AF Mode] til en knapp som kan tilordnes.

Du kan også tilordne [Focus Area (AF-S)] til en knapp som kan tilordnes.

Du kan vise/skjule fokusområderammen ved hjelp av [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] i kameramenyen.

5-041-958-83(1) Copyright 2022 Sony Corporation

174



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justere automatisk ved hjelp av Web App

Enheten bruker fasedeteksjon-AF for fokusering med høy hastighet og kontrast-AF for fokusering med høy nøyaktighet.
Kombinasjonen av disse to AF-metodene gir autofokus med både høy hastighet og høy nøyaktighet.

Merknad

Det kreves et objektiv som støtter autofokus.

Det kan hende dette ikke blir nøyaktig, avhengig av opptaksforholdene.

Fokus kan ikke justeres automatisk på et objektiv med A-feste.

Hint

Under autofokusmodus kan du justere fokus ved hjelp av glidebryteren Focus i kamerakontrollpanelet. Hvis du vil ha mer
informasjon, se "Angi autofokusmålet manuelt (AF Assist) ved hjelp av Web App".

Beslektet emne
Kontrollere objektivbryterne

Angi autofokusmålet manuelt (AF Assist) ved hjelp av Web App
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Hvis objektivet er utstyrt med en fokusvelgerbryter, sett bryteren til "AF/MF-" eller "AF"-posisjon.

Merknad

Hvis bryteren er satt til posisjonen "Full MF" eller "MF", kan ikke fokuseringen på objektivet betjenes fra enheten. Se "For et
objektiv med fokusmodusbryterr" i "Kontrollere objektivbryterne".

1

Skyv bryteren [Auto Focus] til høyre posisjon i kamerakontrollpanelet for å slå den på.

Autofokusmodus er aktivert.

 (AF)

2
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Justere automatisk ved hjelp av den medfølgende infrarød-fjernkontrollen

Du kan justere fokuset automatisk ved hjelp av den medfølgende infrarød-fjernkontrollen.

Merknad

Du kan også bruke autofokus når manuell justering er hovedmetoden for betjening. Hvis du vil ha mer informasjon, se "Fokusere
manuelt under autofokus ved hjelp av den medfølgende infrarød-fjernkontrollen".

Beslektet emne
Fokusere manuelt under autofokus ved hjelp av den medfølgende infrarød-fjernkontrollen

5-041-958-83(1) Copyright 2022 Sony Corporation

Trykk på AF-knappen på infrarød-fjernkontrollen.

Fokuset på et motiv justeres automatisk.

1
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Stille inn autofokusområde/-posisjon (Focus Area)

Du kan angi målområdet for autofokus og justere fokuset for området.

Trykk på GUI-kontrollpanelets [Menu]-knapp for å åpne kameramenyen.1

Angi målområdet for autofokus ved hjelp av [Shooting] > [Focus] > [Focus Area] i kameramenyen.

[Wide]:
Søker etter et motiv over en vid vinkel i bildet når du fokuserer. En ramme vises ikke.

[Zone]:
Søker automatisk etter en fokusposisjon innenfor den angitte sonen.
Etter valget angir du posisjonen ved hjelp av pilknappene i GUI-kontrollpanelet.

Du kan gå tilbake til midtposisjonen ved å trykke på [Set]-knappen og holde den inne.
[Flexible Spot]:
Fokuserer på en angitt posisjon i bildet.
Etter valget angir du posisjonen ved hjelp av pilknappene i GUI-kontrollpanelet.

2
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Merknad

Rammen for fokusområdet skjules ikke når du bruker [Display]-knappen i kamerabildepanelet.

Under Clear Image Zoom settes fokusområdet til [Wide] (fast).

Hint

Du kan vise/skjule fokusområderammen ved hjelp av [Monitoring] > [Display On/Off] > [Focus Area Indicator] i kameramenyen.

5-041-958-83(1) Copyright 2022 Sony Corporation

Du kan gå tilbake til midtposisjonen ved å trykke på [Set]-knappen og holde den inne.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Raskt skifte av fokusområde (Focus Setting)

Du kan raskt endre posisjonen og størrelsen på autofokusområdet under opptak ved å tilordne [Focus Setting] til en
knapp som kan tilordnes.

Hvis du vil ha mer informasjon om knapper som kan tilordnes, se "Knapper som kan tilordnes".

Bruken varierer avhengig av innstillingen av fokusområdet.

Når [Shooting] > [Focus] > [Focus Area] er satt til [Flexible Spot] eller [Zone] i kameramenyen

Du kan endre posisjonen for fokusområdet ved å trykke på en knapp som er tilordnet med [Focus Setting] og justere
ved hjelp av pilknappene i GUI-kontrollpanelet. Du kan flytte fokusområdet tilbake til midten mens du justerer
posisjonen ved å trykke på [Set]-knappen.
Du kan endre størrelsen på fokusområdet ved å trykke på og holde nede en knapp som er tilordnet med [Focus
Setting]. Når du har endret størrelsen, kan du endre posisjonen for fokusområdet ved å trykke på [Set]-knappen. Når
du er ferdig, trykker du på en knapp som er tilordnet med [Focus Setting] for å gå tilbake til det opprinnelige
skjermbildet.

Når [Shooting] > [Focus] > [Focus Area] er satt til [Wide] i kameramenyen

Du kan bare endre størrelsen på fokusområdet ved å trykke på og holde nede en knapp som er tilordnet med [Focus
Setting]. Posisjonen kan også endres ved først å endre typen til [Flexible Spot] eller [Zone].

Hint

Når både [Shooting] > [Focus] > [Push AF Mode] er satt til [Single-shot AF(AF-S)] i kameramenyen og bryteren [Auto Focus] er
satt til av-posisjon (manuell fokusmodus), kan du endre fokusområdeposisjonen for [Focus Area (AF-S)].

Rammen for fokusområdet vises oransje når fokuseringsområdet kan endres.

Beslektet emne

Knapper som kan tilordnes

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Flytte rammen for fokusområdet ved hjelp av berøringsfunksjon
(berøringsfokusområde)

Du kan endre posisjonen for fokusområdet ved å trykke på en knapp som er tilordnet med [Focus Setting] for å endre
visningen av fokusområdet til oransje, og deretter flytte rammen for fokusområdet ved hjelp av berøringsfunksjonen i
kamerabildepanelet.
Trykk på skjermen for å flytte fokusområdet, med fokusområdet sentrert på den berørte posisjonen. Dra på skjermen for
å flytte fokusområdet til posisjonen som følger fingeren.

Hint

Du kan aktivere/deaktivere berøringsfokusområdet på opptaksskjermen ved hjelp av en knapp som er tilordnet med [Focus
Setting].

Trykk på en hvilken som helst posisjon.

Posisjonen som trykkes på blir midtpunktet i fokusområdet.

1

Dra for å flytte fokusområdet, det følger fingerens posisjon.2
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Merknad

Hvis du trykker på en posisjon eller drar fokusområdet til en posisjon som overskrider innstillingsområdet, settes fokusområdet til
toppen/bunnen/venstre/høyre kant av innstillingsområdet.

Denne funksjonen er ikke tilgjengelig under følgende omstendigheter.

Når bryteren [Touch Focus] er slått av i kamerakontrollpanelet
Når fokusområderammen vises i grått eller ikke vises i det hele tatt

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justere autofokusfunksjonen (AF-overgangshastighet, AF-følsomhet for
motivendring)

Du kan justere autofokusfunksjonen ved å endre overgangshastigheten og følsomheten for motivendring.

Angi AF-overgangshastigheten

Du kan angi hastigheten på fokusmotoren for når motivet endres ved hjelp av knappen [AF Transition Speed] i
kamerakontrollpanelet.

Velg hastigheten fra området [Speed 1] (Slow) til [Speed 7] (Fast) i trinn på 1. Trykk på <-knappen for å redusere verdien
(langsommere) eller >-knappen for å øke verdien (raskere).
Når den er satt til lav hastighet, beveger fokuset seg sakte når motivet som fokuseres endrer seg, noe som gjør det mulig
å ta bilder med imponerende uttrykk.
Når den er satt til høy hastighet, veksler fokuset raskt mellom motiver. I eksemplet nedenfor endres fokuset raskt fra
bygningen i bakgrunnen til personen som går i forgrunnen. Motivet som kommer inn i bildet, blir umiddelbart fokusert,
noe som gjør denne innstillingen ideell for dokumentaropptak som krever rask fokusering.

AF-følsomhet for motivendring

Du kan angi følsomheten for endring av motiver ved hjelp av [AF Subj. Shift Sens.]-knappen i kamerakontrollpanelet.
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Velg følsomheten fra området [Sens 1] (Locked On) til [Sens 5] (Responsive) i trinn på 1. Trykk på <-knappen for å
redusere verdien (endre langsomt) eller >-knappen for å øke verdien (endre raskt).
Når den er satt til lav følsomhet, endres ikke fokuset så lett selv om et annet motiv beveger seg foran motivet som er i
fokus.

Når den er satt til høy følsomhet, endres fokuset for å gi prioritet til motivet som beveger seg foran.

Hint

Hvis [AF Speed/Sens.] er tilordnet en knapp som kan tilordnes, vises nivålinjene for justering av verdier i kamerabildepanelet i
følgende rekkefølge hver gang du trykker på knappen, slik at du kan endre innstillingene for AF-overgangshastighet og AF-
følsomhet for motivendring.
AF-overgangshastighet → AF-følsomhet for motivendring → Ingen visning …

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Angi autofokusmålet manuelt (AF Assist) ved hjelp av Web App

Etter å ha flyttet og justert fokus manuelt, kan du sende fokuskontrollen til autofokus for finjustering av fokus.

Merknad

I AF Assist-tilstanden blir endring av fokus vanskelig, uavhengig av innstillingen [Shooting] > [Focus] > [AF Subj. Shift Sens.] i
kameramenyen.

AF Assist-tilstanden avbrytes av følgende:

Når motivet som ble fokusert på ved hjelp av glidebryteren [Focus] ikke lenger er synlig
Når det skiftes til manuell fokusering
Når sanntidssporing i AF-modus er startet

Hint

AF Assist-tilstanden kan avbrytes raskt ved å bruke en knapp som er tilordnet med [Push AF/MF].

Sanntidssporing i AF-modus stopper når [Focus]-glidebryteren betjenes.

I Face/Eye Only AF-modus fokuserer autofokus på ansiktet som er nærmest posisjonen til glidebryteren [Focus].

Angi [Shooting] > [Focus] > [AF Assist] til [On] i kameramenyen.1

Angi [Shooting] > [Focus] > [AF Assist Control] til [On] i nettmenyen.2

Skyv bryteren [Auto Focus] til høyre posisjon i kamerakontrollpanelet for å slå den på.

Autofokusmodus er aktivert.

3

Angi fokusmålet ved hjelp av glidebryteren [Focus] i kamerakontrollpanelet.

[Near]: Fokusere på et nærmotiv.
[Far]: Fokusere på et fjernmotiv.

I AF Assist-tilstanden blir et motiv fokusert på automatisk på avstanden som er angitt med glidebryteren [Focus].

4
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fokusere manuelt under autofokus ved hjelp av den medfølgende infrarød-
fjernkontrollen

Når [Shooting] > [Focus] > [AF Assist] er satt til [On] i kameramenyen, kan du bruke knappene F (Far) og N (Near) på
den medfølgende infrarød-fjernkontrollen også under autofokus for å justere fokuset på et motiv.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bruke manuell fokus midlertidig under autofokus (Push Manual Focus)

Trykk på knappen [Push AF/MF] når du er i autofokusmodus, for å fokusere manuelt mens knappen er trykket inn.
Fokuseringen går tilbake til autofokus når du slipper knappen.
Dette gjør at du kan stoppe autofokus midlertidig og fokusere manuelt når noe som ikke er motivet i opptaket, krysser
foran motivet.

Hint

Den samme operasjonen støttes med en knapp som er tilordnet med [Push AF/MF].

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sporing med ansikts-/øyedeteksjon (Face/Eye Detection AF)

Enheten kan registrere ansikter og øyne som mål for sporing, og deretter justere fokuset på ansikter og øyne innenfor
fokusområdet.
Når ansikter detekteres, vises grå bilderammer for ansikt-/øyedeteksjon. Når automatisk fokusering er mulig, blir
rammene hvite og sporing starter. Når øyne detekteres og fokus justeres, vises rammen for ansikt-/øyedeteksjon på
øynene. Når flere personer oppdages, bestemmes hovedmotivet automatisk.
Denne funksjonen er bare tilgjengelig når fokusmodus er AF-modus eller i push-autofokus.

Hint

Når fokusområdet er satt til [Zone] eller [Flexible Spot] og ansikter eller øyne overlapper innenfor det angitte fokusområdet,
endres rammene for ansikts-/øyedeteksjon til hvite rammer, og enheten fokuserer automatisk på disse ansiktene/øynene.

Når Push Auto Focus (AF-S) brukes, endres rammene for ansikts-/øyedeteksjon for ansikter/øyne som er i fokus, til grønne
rammer.

Innstilling ved hjelp av knappen [Face/Eye Detection AF] i kamerakontrollpanelet

Trykk på knappen [Face/Eye Detection AF] og angi betjening av AF for ansikts-/øyedeteksjon.

[Face/Eye Only AF]: Kameraet registrerer ansikter/øyne for motiver (personer) og fokuserer og sporer bare på
ansiktene/øynene deres. Når et ansikt eller et øye ikke registreres, stoppes AF midlertidig, og ikonet  (Face/Eye Only
AF-modus autofokus er satt på pause) blir vist. Denne modusen er effektiv når du bare vil autofokusere og spore på
ansikter/øyne.
[Face/Eye Priority AF]: Kameraet registrerer ansikter/øyne for motiver (personer) og prioriterer fokusering/sporing av
ansikter/øyne. Når et ansikt eller et øye ikke detekteres, er fokusering i AF-modus (standardinnstilling).
[AF]: AF-funksjonen for ansikts-/øyedeteksjon er deaktivert.

Merknad

Under betjening av Push Auto Focus aktiveres [Face/Eye Priority AF] selv om [Face/Eye Only AF] er valgt for øyeblikket.

Når bryteren [Auto Focus] er satt til av-posisjonen, deaktiveres AF for ansikts-/øyedeteksjon (unntatt under betjening av Push
Auto Focus).

Hvis du slår av videokameraet mens [Face/Eye Only AF] er valgt, skifter modusen automatisk til [Face/Eye Priority AF] neste
gang videokameraet slås på.
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Hint

Du kan angi betjening av AF for ansikts-/øyedeteksjon ved hjelp av [Shooting] > [Focus] > [Face/Eye Detection AF] i
kameramenyen.

Slik skjuler du deteksjonsrammene for ansikts-/øyedeteksjon
Du kan vise/skjule deteksjonsrammer for ansikts-/øyedeteksjon ved hjelp av [Monitoring] > [Display On/Off] > [Face/Eye
Detection Frame] i kameramenyen.

Merknad

Grønne rammer for ansikts-/øyedeteksjon vises for ansikter og øyne som er i fokus ved hjelp av Push Auto Focus (AF-S), og de
skjules ikke ved hjelp av [Display]-knappen eller når [Face/Eye Detection Frame] er satt til [Off].

Slik bytter du AF-funksjon for ansikts-/øyedeteksjon ved hjelp av en knapp som kan tilordnes
Tilordne [Face/Eye Detection AF] til en knapp som kan tilordnes. Deretter kan du bytte betjening av AF for ansikts-/
øyedeteksjon i rekkefølgen [Face/Eye Priority AF], [Face/Eye Only AF] og [AF] hver gang du trykker på knappen.

Innstilling ved hjelp av hurtigmenyen

Du kan også angi betjening av AF for ansikts-/øyedeteksjon ved hjelp av hurtigmenyen.

Hvis du vil ha mer informasjon om hurtigmenyen, se "Bruk av hurtigmenyen".

Beslektet emne
Bruk av hurtigmenyen

5-041-958-83(1) Copyright 2022 Sony Corporation
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sporing av et spesifisert motiv (Realtime Tracking AF)

Du kan opprettholde fokus på et motiv ved å spesifisere motivet med berøringsfunksjon eller ved å velge en
ansiktsdeteksjonsramme i kamerakontrollpanelet.
Når et motiv er valgt vises en hvit sporingsramme og sporingen starter.

Hint

Sporingen utføres over hele bildeområdet, uavhengig av fokusområdeinnstilling.

Når [Shooting] > [Focus] > [Touch Function in MF] er satt til [Tracking AF] i nettmenyen eller kameramenyen, støttes
sanntidssporing i AF også når fokusmodus er MF-modus.

Følgende handlinger inntreffer for sporingsmålet, avhengig av modusinnstilling for betjening av AF for ansikts-/
øyedeteksjon.

[Face/Eye Only AF] eller [Face/Eye Priority AF]: Fokusering og sporing av det angitte motivet.
Hvis sporingsmålet er en person og ansikt/øye detekteres, fokuserer kameraet på dette ansiktet/øyet.
Når et sporingsmål som ansikt/øye detekteres, lagres ansiktet som er sporingsmål. Når det er lagret, vises et  (ikon for
lagret sporingsansikt).

Merknad

Hvis Tracking AF startes under manuell fokus, vil ansiktet som er sporingsmål ikke bli lagret.

[AF]: Brukes til fokusering og sporing av et angitt motiv. Detektering av ansikt/øye utføres ikke, selv om sporingsmålet er
en person.

Merknad

Funksjonen for sanntidssporing i AF virker ikke hvis objektivet er angitt for manuell fokusering.

Starte Realtime Tracking AF

Når et bestemt motiv spesifiseres som sporingsmål, starter sporingen av dette målet.

Spesifisere med berøringsfunksjon
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Skyv bryteren [Touch Focus] i  (Focus)-fanen i kamerakontrollpanelet til høyre posisjon for å slå den på, og trykk
deretter på målmotivet for å spore i en av følgende tilstander.

Under manuelt fokus eller under manuelt push-fokus, og når [Shooting] > [Focus] > [Touch Function in MF] er satt til
[Tracking AF] i nettmenyen eller kameramenyen.
I autofokus eller i Push Auto Focus (AF)

Slik spesifiserer du med valg av ansiktsdeteksjonsramme
Flytt markøren for ansiktsvalg (oransje understreking) til målmotivet for å spore ved hjelp av pilknappene i GUI-
kontrollpanelet, og trykk på [Set]-knappen.

A: Ansiktsdeteksjonsrammer (grå)
B: Sporingsramme
C: Markør for ansiktsvalg (oransje)

Merknad

Under manuell fokus er det ikke mulig å starte ansiktsgjenkjenning med valg av ramme.

Hint

Du kan også endre målet som skal spores under sanntidssporing i AF.

Stoppe Realtime Tracking AF

Trykk på knappen  (stoppe sanntidssporing i AF).

Hint

Realtime tracking AF vil stoppe i følgende tilfeller:

Når [Auto Focus]-bryteren eller AUTO/MANUAL-kontrollen på objektivet betjenes
Når fokusmodus endres
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Når AF Assist utføres
Når fokusområdeinnstillingen eller ansikt/øye-gjenkjenning i AF-handling endres
Når en knapp som er tilordnet med [Push AF/MF] trykkes på
Når sporingsmålet ikke er innenfor opptaksskjermen eller når motivet er ute av fokus i noen sekunder

Når et sporingsansikt er lagret (når  (ikon for lagret sporingsansikt) vises), blir sanntidssporing i AF gjenopptatt når det lagrede
sporingsansiktet kommer inn i bildeområdet. For å slette sporingsansiktet, stopp Realtime tracking AF som beskrevet ovenfor.

5-041-958-83(1) Copyright 2022 Sony Corporation

192



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Skjermbilde for justering av lysstyrke

Du kan justere lysstyrken ved å justere iris, forsterkning, lukkerhastighet og ved å justere lysnivået ved hjelp av ND-filtre i
følgende kontrollpaneler på Web App-skjermbildet for direkte betjening. Du kan også justere lysstyrken automatisk.

Merknad

Forsterkningen kan ikke justeres når [Shooting Mode] er satt til [Cine EI Quick] eller [Cine EI]. I tillegg kan lysstyrken ikke justeres
automatisk ved bruk av lukkerhastigheten når den er satt til [Cine EI Quick] eller [Cine EI]. Automatisk justering av lysstyrke ved
hjelp av iris og ND-filter støttes.

Hint

Cine EI-modus er en modus for opptak ved en basisfølsomhet uten å bruke forsterkning for å maksimere ytelsen til
bildesensoren. Lysstyrken justeres ved hjelp av belysning og ND-filteret for å justere mengden lys som når bildesensoren. Hvis du

Kameraets kontrollpanel –  (Main)-fanen1.

Kameraets panel for grunnleggende konfigurasjon
Viser innstillingsstatusen for grunnleggende funksjoner som kreves for opptak via knapper. Trykk på en knapp for å
vise det tilsvarende oppsettskjermbildet for hver funksjon i kameraets panel for justering av grunnleggende
konfigurasjon.

2.

Kameraets panel for justering av grunnleggende konfigurasjon
Viser justeringspanelet for oppsettelementet som er valgt i kameraets panel for grunnleggende konfigurasjon.

3.
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vil ha mer informasjon om Exposure Index (EI), se "Endre fordelingen av mørke og lyse områder i bildet som er tatt".

Beslektet emne
Endre fordelingen av mørke og lyse områder i bildet som er tatt

5-041-958-83(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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Angi basisfølsomheten

Du kan angi basisfølsomheten før du begynner å justere lysstyrken.

Når [Shooting Mode] er satt til [Custom]

Trykk på knappen [ISO/Gain/] i kameraets rute for grunnleggende konfigurasjon og sett [Base Sensitivity] i ISO/gain-
justeringspanelet til [High] eller [Low].
Velg [Low] under normale lysforhold og velg [High] under dårlige lysforhold.
Skjermbildet når [AGC] er slått av

Skjermbildet når [AGC] er slått på

Når [Shooting Mode] er satt til [Flexible ISO] eller [Cine EI]

Trykk på knappen [Base ISO/Exposure Index] i kameraets rute for grunnleggende konfigurasjon og sett [Base ISO] i
Base ISO/Exposure Index-justeringspanelet til [ISO 12800] eller [ISO 800].
Velg [ISO 800] under normale lysforhold og velg [ISO 12800] under dårlige lysforhold.

Hint
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Du kan også angi dette i  (Main)-fanen i kamerakontrollpanelet.

Kan også angis ved hjelp av [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] eller [Base ISO] i kameramenyen.

Du kan også tilordne [Base ISO/Sensitivity] til en knapp som kan tilordnes.

I opptaksmodus [Cine EI Quick] stilles basisfølsomheten inn automatisk ifølge den innstilte eksponeringsindeksen.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Interchangeable Lens Digital Camera
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Stille inn målnivået for automatisk justering av lysstyrke

Målnivået for automatisk justering av lysstyrke angis ved hjelp av glidebryteren [AE Level] i kamerakontrollpanelet.

5-041-958-83(1) Copyright 2022 Sony Corporation

Trykk på  (Main)-fanen i kamerakontrollpanelet.

Hvis glidebryteren [AE Level] ikke vises, velger du en av de to knappene for valg av funksjon og velger
glidebryteren [AE Level] i listen.

Glidebryteren [AE Level] vises.

1

Angi målnivået ved hjelp av glidebryteren.

Flytt glidebryterknappen mot venstre for å gjøre bildet mørkere. Flytt glidebryterknappen mot høyre for å gjøre bildet
lysere.

Hint

Kan også angis ved hjelp av [Shooting] > [Auto Exposure] > [Level] i kameramenyen.

2
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Interchangeable Lens Digital Camera
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Automatisk justering av iris

Du kan justere lysstyrken automatisk i henhold til motivet. Et kompatibelt objektiv kreves.

Merknad

Iris kan ikke justeres automatisk på et objektiv med A-feste.

Hint

Du kan også tilordne [Auto Iris] til en knapp som kan tilordnes.

5-041-958-83(1) Copyright 2022 Sony Corporation

Hvis et objektiv med en bryter for Auto Iris er montert, setter du bryteren til AUTO.1

Trykk på [Iris]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [Iris]-knappen endres til oransje.

Iris-justeringspanelet vises.

2

Skyv bryteren [Auto] til høyre posisjon for å slå den på.

Iris bytter til modus for automatisk justering. Den automatisk justerte irisverdien vises på høyre side av bryteren.

3
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Manuell justering av iris

Du kan justere lysstyrken manuelt.

Slik kan du midlertidig justere iris automatisk
Du kan også trykke på [Push Auto]-knappen på Iris-justeringspanelet for å justere iris automatisk mens knappen er
trykket inn.

Hvis et objektiv med en bryter for Auto Iris er montert, setter du bryteren til AUTO.

Merknad

Når objektivets bryter for Auto Iris er satt til MANUAL, har funksjonene [Auto Iris] og [Push Auto Iris] på enheten ingen
effekt. Manuelle irisjusteringer på enheten har heller ingen effekt.

1

Trykk på [Iris]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [Iris]-knappen endres til oransje.

Iris-justeringspanelet vises.

2

Skyv bryteren [Auto] til venstre posisjon for å slå den av.

Iris bytter til modus for manuell justering.

3

Juster iris ved hjelp av glidebryteren [Iris] eller [Iris]-justeringsknappene.

Hint

Innstillingene for glidebryteren og justeringsknappene er koblet sammen.

Du kan også tilordne iris til glidebryteren i  (Main)-fanen i kamerakontrollpanelet.

4
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Hint

Trykk på en knapp som er tilordnet med funksjonen [Push Auto Iris] for å justere iris automatisk mens knappen er trykket inn.
Iris går tilbake til manuell modus når du slipper knappen.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Automatisk justering av forsterkningen

Du kan justere lysstyrken automatisk ved hjelp av forsterkningsinnstillingen når [Shooting Mode] er satt til [Custom] eller
[Flexible ISO].

5-041-958-83(1) Copyright 2022 Sony Corporation

Angi [Project] > [Shooting Mode] til [Custom] i nettmenyen eller kameramenyen.1

Trykk på [ISO/Gain]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [ISO/Gain]-knappen endres til oransje.

ISO/Gain-justeringspanelet vises.

2

Skyv bryteren [AGC] til høyre posisjon for å slå den på.

Forsterkningen bytter til modus for automatisk justering. Den automatisk justerte forsterkningsverdien vises på
høyre side av bryteren.

Hint

Du kan også utføre den samme handlingen ved å sette [Shooting] > [Auto Exposure] > [AGC] til [On] i kameramenyen.

Du kan også tilordne [AGC] til en knapp som kan tilordnes.

3
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Manuell justering av forsterkningen

Du kan justere lysstyrken manuelt ved hjelp av forsterkningsinnstillingen når [Shooting Mode] er satt til [Custom] eller
[Flexible ISO].
Du kan kontrollere forsterkningen når du vil justere eksponeringen mens du bruker en fast irisinnstilling, eller når du vil
forhindre at forsterkningen øker på grunn av AGC.

Slik kan du midlertidig justere forsterkningen manuelt
Du kan også midlertidig justere forsterkningen ved å tilordne [ISO/Gain] til en knapp for valg av glidebryterfunksjon i 
(Main)-fanen i kamerakontrollpanelet og bruke glidebryteren.
Dette er nyttig når du vil justere eksponeringen med ett trinn uten å endre dybdeskarpheten.
Justeringsresultatet går tilbake til den forhåndsinnstilte verdien som er konfigurert ved hjelp av [ISO/Gain<L>] etter at du
har utført en av følgende operasjoner.

Angi [Project] > [Shooting Mode] til [Custom] i nettmenyen eller kameramenyen.1

Trykk på [ISO/Gain]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [ISO/Gain]-knappen endres til oransje.

ISO/Gain-justeringspanelet vises.

2

Skyv bryteren [AGC] til venstre posisjon for å slå den av.

Forsterkningen bytter til modus for manuell justering.

3

Juster forsterkningen ved hjelp av glidebryteren [ISO/Gain] eller [ISO/Gain]-justeringsknappene.

Hint

Innstillingene for glidebryteren og justeringsknappene er koblet sammen.

4
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Endre ISO/Gain-justeringselementer
Bytte basisfølsomheten
Sette AGC-bryteren i på-posisjon
Sette strømforsyningen til enheten i standby

Slik kan du midlertidig justere forsterkningen automatisk ved hjelp av en knapp som kan tilordnes
Trykk på en knapp som er tilordnet med funksjonen [Push AGC] for å justere forsterkningen automatisk mens knappen er
trykket inn.
Forsterkningen går tilbake til manuell modus når du slipper knappen.
Justeringsresultatet går tilbake til den forhåndsinnstilte verdien som er konfigurert ved hjelp av [ISO/Gain<L>] etter at du
har utført en av følgende operasjoner.

Endre ISO/Gain-justeringselementer
Bytte basisfølsomheten
Sette AGC-bryteren i på-posisjon
Sette strømforsyningen til enheten i standby

Merknad

Denne funksjonen kan ikke utføres når [Shooting] > [Iris] > [Bokeh Control] er satt til [On] i kameramenyen.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Automatisk justering av lukkeren

Du kan justere lukkeren automatisk som respons på lysstyrken i bildet.

5-041-958-83(1) Copyright 2022 Sony Corporation

Trykk på [Shutter]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [Shutter]-knappen endres til oransje.

Shutter-justeringspanelet vises.

1

Trykk på [Shutter Type]-knappen og velg [Auto] fra listen.

Hint

Du kan også utføre den samme handlingen ved å sette [Shooting] > [Auto Exposure] > [Auto Shutter] til [On] i
kameramenyen.

Du kan også tilordne [Auto Shutter] til en knapp som kan tilordnes.

2
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Manuell justering av lukkeren

Du kan justere lukkeren manuelt.

Trykk på [Shutter]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [Shutter]-knappen endres til oransje.

Shutter-justeringspanelet vises.

1

Trykk på [Shutter Type]-knappen og velg [Speed] fra listen.2

Juster lukkeren ved hjelp av glidebryteren [Speed] eller [Speed]-justeringsknappene.

Hvis du vil justere eksponeringstiden slik at den samsvarer med rammeintervallet, velger du [Off] i trinn 2. Du kan
også angi en fast verdi ved hjelp av [ECS] (frekvens) eller justere den automatisk ved hjelp av [Auto].
Eksempel: Angi ved hjelp av [ECS] (frekvens)

Hint

Innstillingene for glidebryteren og justeringsknappene er koblet sammen.

Hvis du vil bruke [Angle] i stedet for [Speed] eller [Off], angir du [Shooting] > [Shutter] > [Mode] til [Angle] i kameramenyen.

3
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Om ND-filteret

Under forhold der lyset er for skarpt, kan du angi riktig lysstyrke ved å endre ND-filteret.
Når du tar bilder av et motiv som er sterkt belyst, kan det at iris lukkes for mye føre til diffraksjonsutydelighet og gi et bilde
som begynner å gli ut av fokus (typisk fenomen i kameraer). Du kan undertrykke denne effekten for å få bedre
opptaksresultater ved hjelp av ND-filteret.
Enheten har følgende ND-filtermoduser.
Forhåndsinnstilt modus

Se "Justering i forhåndsinnstilt modus".

Variabel modus (automatisk justering)

See "Justere automatisk i variabel modus".

Variabel modus (manuell justering)

See "Justere manuelt i variabel modus".

Beslektet emne

Justering i forhåndsinnstilt modus

Justere automatisk i variabel modus

Justere manuelt i variabel modus

5-041-958-83(1) Copyright 2022 Sony Corporation
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Justering i forhåndsinnstilt modus

Du kan velge tre verdier for ND-filteroverføring på forhånd og raskt bytte mellom dem når du tar bilder.

Hint

Når en knapp tilordnet med [ND Filter Position] trykkes på, endres ND-filteret i rekkefølgen [Clear] → [Preset1] → [Preset2] →
[Preset3] → [Clear].

5-041-958-83(1) Copyright 2022 Sony Corporation

Angi [Shooting] > [ND Filter] > [Mode] til [Preset] i kameramenyen.1

Trykk på [ND Filter]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [ND Filter]-knappen endres til oransje.

ND Filter-justeringspanelet vises.

2

Trykk på [ND Filter]-knappen og velg ett av følgende fra listen.

[Clear]: Ingen ND-filter.
[Preset1]: Overføring angitt av [Shooting] > [ND Filter] > [Preset1] i kameramenyen.
[Preset2]: Overføring angitt av [Shooting] > [ND Filter] > [Preset2] i kameramenyen.
[Preset3]: Overføring angitt av [Shooting] > [ND Filter] > [Preset3] i kameramenyen.

Når en av [Preset1] til [Preset3] er valgt for ND-filteret, vises overføringsverdien ved siden av ND-filternavnet.

3
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Justere automatisk i variabel modus

Du kan aktivere automatisk eksponeringsjustering ved hjelp av ND-filteret.

Merknad

Når ND-filteret byttes til eller fra [Clear] under opptak, vises ND-filterrammen på bildet og driftslyden avgis.

Hint

Du kan også tilordne [Auto ND Filter] til en knapp som kan tilordnes, og trykke knappen for å bytte mellom [Auto] og [Manual].

5-041-958-83(1) Copyright 2022 Sony Corporation

Angi [Shooting] > [ND Filter] > [Mode] til [Variable] i kameramenyen.1

Trykk på [ND Filter]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [ND Filter]-knappen endres til oransje.

ND Filter-justeringspanelet vises.

2

Trykk på [ND Filter]-knappen og velg [Auto] fra listen.

Den automatisk justerte ND-filteroverføringsverdien vises ved siden av [ND Filter]-knappen.

3
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Justere manuelt i variabel modus

Du kan utføre manuell eksponeringsjustering ved hjelp av ND-filteret.

Slik kan du midlertidig justere automatisk
Du kan tilordne [Push Auto ND] til en knapp som kan tilordnes, og sette auto ND-filter midlertidig til On mens knappen er
trykket inn. Når du slipper knappen, settes auto ND-filter tilbake til Off.
Sett ND-filteret til [Manual].

Merknad

Når ND-filteret byttes til eller fra [Clear] under opptak, vises ND-filterrammen på bildet og driftslyden avgis.

Hint

Angi [Shooting] > [ND Filter] > [Mode] til [Variable] i kameramenyen.1

Trykk på [ND Filter]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [ND Filter]-knappen endres til oransje.

ND Filter-justeringspanelet vises.

2

Trykk på [ND Filter]-knappen og velg [Manual] fra listen.3

Juster overføringen av ND-filteret ved hjelp av glidebryteren [ND Filter] eller [ND Filter]-justeringsknappene.

Hint

Innstillingene for glidebryteren og justeringsknappene er koblet sammen.

Du kan også justere ND-filteret i  (Main)-fanen i kamerakontrollpanelet.

4
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Du kan også tilordne [ND Filter Position] til en knapp som kan tilordnes, og trykke knappen for å bytte mellom [Manual] og [Clear].

Du kan også trykke på [Push Auto]-knappen på ND Filter-justeringspanelet for å slå på auto ND-filter mens knappen er trykket
inn.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Skjermbilde for justering av hvitbalanse

Du kan justere hvitbalansen ved hjelp av skjermbildet for direkte betjening i Web App for å få en hvitbalanse som får
bildet til å se mer naturlig ut.

5-041-958-83(1) Copyright 2022 Sony Corporation

Kameraets panel for grunnleggende konfigurasjon1.

Kameraets panel for justering av grunnleggende konfigurasjon
Viser justeringspanelet for oppsettelementet som er valgt i kameraets panel for grunnleggende konfigurasjon.

2.
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Justere hvitbalansen automatisk

Du kan til enhver tid få en riktig justert hvitbalanse ved hjelp av ATW (automatisk sporing av hvitbalanse).
Når ATW er aktivert, justeres hvitbalansen automatisk etter hvert som fargetemperaturen til lyskilden endres.

Merknad

ATW kan ikke brukes når [Shooting Mode] er satt til [Cine EI] eller [Cine EI Quick].

Det kan hende at det ikke er mulig å justere til riktig farge ved hjelp av ATW, avhengig av forholdene rundt lys og motiv.
Eksempler:

Når én enkelt farge dominerer motivet, for eksempel himmel, hav, jord eller blomster.
Når fargetemperaturen er ekstremt høy eller ekstremt lav.

Hvis ATW-hastigheten for automatisk sporing er langsom eller riktig effekt ikke kan oppnås, trykker du på [WB SET]-knappen for å
kjøre automatisk hvitbalanse.

Hint

I ATW-modus kan du velge responshastigheten fra fem trinn (1, 2, 3, 4, 5) ved hjelp av [Shooting] > [White Setting] > [ATW
Speed] i kameramenyen. Jo lavere tall, jo raskere blir responshastigheten.

Du kan fryse den gjeldende hvitbalanseinnstillingen ved å tilordne [ATW Hold]-funksjonen til en knapp som kan tilordnes, og
trykke på knappen som kan tilordnes for å sette ATW midlertidig på pause i ATW-modus.

5-041-958-83(1) Copyright 2022 Sony Corporation

Trykk på [White Balance]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [White Balance]-knappen endres til oransje.

White Balance-justeringspanelet vises.

1

Trykk på [White Mode]-knappen og velg [ATW] fra listen.2
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Justere hvitbalansen manuelt

Du kan justere hvitbalansen manuelt.

Trykk på [White Balance]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [White Balance]-knappen endres til oransje.

White Balance-justeringspanelet vises.

1

Trykk på [White Mode]-knappen og velg ett av følgende fra listen.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Juster hvitbalansen ved hjelp av glidebryterne eller justeringsknappene.

Hint

Innstillingene for glidebryteren og justeringsknappene er koblet sammen.

Forskjellen mellom [Memory A(T/T)] og [Memory A(R/B)] er at justeringsaksen er forskjellig, men justeringsresultatene er
koblet sammen.

For [Memory A(T/T)]
Denne modusen justerer hvitbalansen som er lagret i minne A ved å justere fargetemperaturen (Temp) og Tint.
Du kan stille inn fargetemperaturen i trinn på 20 K i området 2000 K til 5600 K. Verdier over 5600 K kan stilles inn
med intervaller som tilsvarer graden av fargeendring (mired) fra 5580 K til 5600 K.

3
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Hvis du trykker på knappen [Reset] på høyre side av [Temp] eller [Tint], gjenopprettes den tilsvarende innstillingen
til standardverdien.
For [Memory A(R/B)]
Denne modusen justerer hvitbalansen som er lagret i minne A ved å justere R Gain og B Gain.
Hvis du trykker på [Reset], gjenopprettes den tilsvarende forsterkningsinnstillingen til standardverdien.
For [Preset]
Denne modusen justerer fargetemperaturen til en forhåndsinnstilt verdi.
Du kan angi verdien i trinn på 100 K.
I forhåndsinnstilt modus kan du også tilordne [Preset White Select] til en knapp som kan tilordnes, og trykke
knappen for å endre til en forhåndskonfigurert forhåndsinnstillingsverdi.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Kjøre automatisk hvitbalanse

I minne A-modus blir hvitbalansen som skal lagres justert automatisk.

Trykk på [White Balance]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [White Balance]-knappen endres til oransje.

White Balance-justeringspanelet vises.

1

Trykk på [White Mode]-knappen og velg [Memory A(T/T)] eller [Memory A(R/B)] fra listen.

[Memory A(T/T)]

[Memory A(R/B)]

2

Legg hvitt papir (eller andre objekter) på et sted med samme lyskilde og under samme forhold som motivet,
og zoom deretter inn på papiret for å vise hvitt på skjermen.

3

Justere lysstyrken.

Juster iris ved hjelp av prosedyren i "Manuell justering av iris".

4

Trykk på [WB SET]-knappen i justeringspanelet for hvitbalansen.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Merknad

Hvis justeringen ikke er vellykket, vises det en feilmelding på skjermen i ca. tre sekunder. Hvis feilmeldingen vedvarer etter
gjentatte forsøk på å stille inn hvitbalanse, kontakt en servicerepresentant for Sony.

Hint

Du kan også kjøre den i ATW-modus. Du kan bruke dette når du raskt vil justere hvitbalansen under ATW-betjening. Etter
justering går modusen tilbake til normal ATW-betjening.

Beslektet emne

Manuell justering av iris

5-041-958-83(1) Copyright 2022 Sony Corporation

Hvis automatisk hvitbalanse kjøres i minnemodus, lagres resultatet av automatisk justering i minne A.

217



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Skjermbilde for lydkonfigurasjon

Du kan justere lydnivået som skal tas opp av enheten på skjermbildet for direkte betjening i Web App. Konfigurer
bryterne på kontaktblokken på enheten og konfigurer lyden ved hjelp av kameramenyen eller nettmenyen.

5-041-958-83(1) Copyright 2022 Sony Corporation

Kameraets kontrollpanel –  (Audio)-fanen1.
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Velge enheten for lydinngang

Angi følgende brytere i henhold til enheten som er koblet til AUDIO IN-kontakten.

Merknad

Lyd tas ikke opp i intervallopptaksmodus eller sakte og hurtig film.

5-041-958-83(1) Copyright 2022 Sony Corporation

Når en mikrofon er koblet til, angir du SETUP-bryter 2 på kontaktblokken på baksiden av enheten.

CH-1 og CH-2 har felles innstillinger.

1

Innstilling Beskrivelse

OFF
(standard)

Velges når du bruker en dynamisk mikrofon eller batteridrevet mikrofon. Dette slår av +48 V-
fantomstrømforsyningen og angir LINE- eller MIC-inngangen som CH-1- og CH-2-lydkilden.

ON
Velg når du bruker en mikrofon som er kompatibel med +48 V-fantomstrøm. Dette slår på +48 V-
fantomstrømforsyningen og angir mikrofonen som er kompatibel med +48 V-fantomstrøm som
CH-1- og CH-2-lydkilden.

Angi type tilkoblet enhet ved hjelp av [Audio] > [Audio Input] > [AUDIO IN Select] i kameramenyen.2

Velg lydinngang ved hjelp av [Audio] > [Audio Input] > [CH1 Input Select] til [CH4 Input Select] i nettmenyen
eller kameramenyen.

3
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Justere nivået for lydopptak automatisk

Sett kanalen du vil justere nivået for lydopptak automatisk for til [Auto] på siden [Audio] i nettmenyen, eller sett [Audio] >
[Audio Input] > [CH1 Level Control] til [CH4 Level Control] i kameramenyen.
Kanalene som er angitt for automatisk justering, angis med et  (Auto)-ikon ved siden av de tilsvarende kanalene i 
(Audio)-fanen på skjermbildet for direkte betjening.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Justere nivået for lydopptak manuelt

Du kan justere nivået for lydopptak manuelt.

5-041-958-83(1) Copyright 2022 Sony Corporation

Sett kanalen du vil justere nivået for lydopptak manuelt for til [Manual] på siden [Audio] i nettmenyen, eller
sett [Audio] > [Audio Input] > [CH1 Level Control] til [CH4 Level Control] i kameramenyen.

1

Trykk på  (Audio)-fanen i kamerakontrollpanelet.2

På skjermbildet [Audio] i kamerakontrollpanelet stiller du inn nivået for lydopptak ved hjelp av glidebryteren
eller justeringsknappene for kanalen du vil angi nivået for lydopptak for manuelt.

Merknad

Kanaler som ikonet  (Auto) vises for, justeres automatisk. Endringer i verdier ved hjelp av glidebryteren eller knappene,
brukes ikke på opptakslyden.

Hint

Innstillingene for glidebryteren og justeringsknappene i hver rad er koblet sammen.

Du kan kontrollere lydinngangsnivået i sanntid ved hjelp av lydnivåmålerskjermen på opptaksskjermbildet.

3
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Bruk av hurtigmenyen

Du kan kontrollere enhetens status og innstillinger som vises lagt over kamerabildet, og velge og endre innstillingene ved
hjelp av GUI-kontrollknappene på infrarød-fjernkontrollen.
Følgende elementer kan konfigureres.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
[ND Filter]-verdi
[Auto Iris]
[Iris]-verdi
[AGC]
[Gain]-verdi
[ISO]-verdi
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter]-verdi
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] og [Frame Rate]

Hint

Du kan også utføre den samme funksjonen ved hjelp av en knapp som kan tilordnes og GUI-kontrollpanelet i Web App.

Trykk på en knapp som er tilordnet med [Direct Menu] på infrarød-fjernkontrollen.

[Direct Menu]-knappen er tilordnet knapp 1 som fabrikkstandard.
Bare elementer på skjermen som kan konfigureres ved hjelp av hurtigmenyen, kan velges med den oransje
markøren.

1

Flytt markøren til elementet du vil angi ved hjelp av pilknappene i GUI-kontrollpanelet, og trykk på [Set]-
knappen.

Det vises en meny, eller elementet vises på hvit bakgrunn.

2

Velg en innstilling ved hjelp av pilknappene, og trykk på [Set]-knappen.

Menyen eller den hvite bakgrunnen forsvinner, og den nye innstillingen vises med en oransje markør.
Trykk på en knapp som er tilordnet med [Direct Menu] igjen, eller vent i 3 sekunder uten å utføre noen handling for
å avslutte hurtigmenyen.

3
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Knapper som kan tilordnes

Det finnes ti knapper som kan tilordnes i enhetens Web App som du kan tilordne funksjoner til.
Knappene som kan tilordnes vises i skjermbildet for direkte betjening og skjermbildet for betjening av avspilling.

Merknad

Listen over tilordnede knapper vises ikke når du konfigurerer innstillinger i kamerapanelet for grunnleggende drift i skjermbildet for
direkte betjening. For å avslutte operasjonen trykker du på [X]-knappen øverst til høyre i justeringspanelet.

Følgende funksjoner tilordnes knappene som fabrikkstandard.
Knapp 1: [Direct Menu]
Knapp 2: [Focus Setting]
Knapp 3: [Rec Review]

Knappene 1 til 3 tilsvarer knappene med samme tall på den medfølgende infrarød-fjernkontrollen.

Knapp 4: [Push Auto ND]
Knapp 5: [Crop Select]
Knapp 6: [Marker]
Knapp 7: [Video Signal Monitor]
Knapp 8: [Clip Flag OK]
Knapp 9: [Color Bars]
Focus Hold-knapp: [Focus Hold]

Focus Hold-knappen tilsvarer Focus Hold-knappen på et E-festeobjektiv.

Slik endrer du en knappefunksjon
Bruk [Project] > [Assignable Button] i kameramenyen.
Når du endrer en tilordning, endres visningen av listen over knapper som kan tilordnes.
Hvis du vil ha mer informasjon om knapper som kan tilordnes, se "Assignable Button" i "Kamerameny og detaljerte
innstillinger".

Beslektet emne

Assignable Button
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Sakte og rask bevegelse

Når opptaksformatet er satt til følgende verdier, kan du angi forskjellige verdier for rammefrekvensen ved opptak og
rammefrekvensen for avspilling.
Tabellen nedenfor viser de konfigurerbare rammefrekvensene.

Systemfrekvens: 59.94/50/29.97/25/23.98, Bildeskannemodus: FF

Systemfrekvens: 59.94/50/29.97/25/23.98, Bildeskannemodus: S35

Systemfrekvens: 24, Bildeskannemodus: FF

Merknad

Sakte og rask bevegelse kan ikke angis under opptak, avspilling eller mens miniatyrbildeskjermen vises.

Lydopptak støttes ikke i sakte- og rask bevegelsesmodus.

Den automatiske irisfunksjonen og den automatiske lukkerfunksjonen er deaktivert i sakte og rask bevegelsesmodus.

Autofokusfunksjonen har følgende begrensninger i sakte og rask bevegelsesmodus.

Begrensninger på grunn av objektivmodell, systemfrekvens og opptaksrammehastighet

Kodek Videoformat Konfigurerbare rammefrekvenser

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Kodek Videoformat Konfigurerbare rammefrekvenser

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Kodek Videoformat Konfigurerbare rammefrekvenser

XAVC-I 4096×2160P 1–60
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Autofokusfunksjonen er midlertidig deaktivert hvis iris er satt til F18 eller høyere.

Hvis du vil ha mer informasjon om hvordan du bruker RAW-utdata, se "Hvordan ta opp RAW-video".

Beslektet emne

Hvordan ta opp RAW-video
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Sony-linse Systemfrekvens AF-tilgjengelighet

Annen enn SEL16F28 – 7 fps eller høyere støttes

SEL16F28

59,94/29,97/23,98 30, 60, 120, 240 fps støttes

50,00/25,00 25, 50, 100, 200 fps støttes

24,00 Støttes ikke
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Opptak av video med jevne mellomrom (intervallopptak)

Interval Rec-funksjonen lar deg ta opp video periodisk til enhetens interne minne. Denne funksjonen er en effektiv måte å
ta bilder av motiver i sakte film på.
Når du starter opptaket, tar enheten automatisk opp et angitt antall rammer (Number of Frames) med et angitt
tidsintervall (Interval Time).

A: Opptaksintervall (Interval Time)
B: Antall bilder i ett opptak (Number of Frames)

Merknad

Bare én spesiell opptaksfunksjon, for eksempel intervallopptak, kan brukes om gangen.

Hvis en annen spesiell opptaksmodus er aktivert mens Interval Rec er i bruk, frigjøres Interval Rec automatisk.

Modusen for intervallopptak frigis automatisk når du har endret systeminnstillinger, for eksempel videoformatet.

Innstillinger for intervallopptak kan ikke endres under opptak eller avspilling, eller når miniatyrbildeskjermen vises.

Begrensninger under opptak
Lyd tas ikke opp.
Det er ikke mulig å gå gjennom opptaket (Rec Review).

Hvis enheten slås av under opptak
Når strømtilførselen til enheten settes i standby-modus, holdes mediene åpne i flere sekunder for å registrere bildene
som lagres i minnet frem til det øyeblikket, og deretter settes enheten i standby-modus automatisk.
Hvis likestrømledningen kobles fra, strømmen slås av i strømadapteren, eller PoE ++-strømforsyningen kobles fra,
kan bildene som ble tatt frem til det punktet gå tapt (maksimalt 10 sekunder). Utvis forsiktighet.

Angi antall rammer og intervallet mellom opptak

Angi [Project] > [Interval Rec] > [Setting] til [On] i nettmenyen, og angi [Number of Frames] og [Interval Time].
Enheten går ut av Interval Rec-modusen når den slås av, men innstillingene for [Number of Frames] og [Interval Time]
opprettholdes. Du trenger ikke å angi dem igjen neste gang du tar bilder i Interval Rec-modus.
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Hint

Kan også angis ved hjelp av [Project] > [Interval Rec] i kameramenyen.

Starte opptak

Trykk knappen opptak START/STOP for å begynne å ta opp. "Int●Rec" og "Int●Stby" vises vekselvis.

Stoppe opptak

Avslutt opptaket.
Når opptaket er ferdig, skrives videodataene som er lagret i minnet så langt til mediet.
Gjør ett av følgende for å gå ut av Interval Rec-modus.

Sett strømforsyningen til enheten i standby.
I standby-modus for opptak angir du [Project] > [Interval Rec] > [Setting] til [Off].

Interval Rec-modus frigis også automatisk når enheten startes på nytt.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Opptak av cachet-bilder (Picture Cache Rec)

Funksjonen Picture Cache Rec lar deg ta opp video retroaktivt når du starter opptak ved å opprettholde et internt cache-
minne av en spesifisert varighet under opptak.

Angi cache-størrelsen

Angi [Project] > [Picture Cache Rec] > [Setting] til [On] i nettmenyen, og angi cache-størrelse ved hjelp av [Cache Size].

Merknad

Picture Cache Rec kan ikke brukes i kombinasjon med Interval Rec, 2-spors samtidig opptaksfunksjon eller Proxy-opptak. Når
Picture Cache Rec er satt til On, settes disse andre spesielle opptaksmodiene automatisk til Off.

Picture Cache Rec-modus kan ikke velges under opptak eller når Rec Review er aktiv.

Når Picture Cache Rec er satt til On, registreres tidskoden i [Free Run]-modus selv om den er satt til [Regen] eller [Rec Run].

Innstillingen for [Output Format] er kanskje ikke konfigurerbar i Picture Cache Rec-modus. Hvis dette skjer skal du midlertidig
sette Picture Cache Rec til Off, og så endre innstillingen.

Hint

Cache-tiden kan være kortere, avhengig av opptaksformatet. Kontroller tiden som vises i [Project] > [Picture Cache Rec] >
[Cache Rec Time] i nettmenyen.

Kan også angis ved hjelp av [Project] > [Picture Cache Rec] i kameramenyen.

Du kan også veksle [Picture Cache Rec] mellom On og Off ved hjelp av en knapp som kan tilordnes.

Starte Picture Cache Rec

Når [Picture Cache Rec] er satt til On, vises "●Cache" (● er grønn).
Når du trykker på START/STOP-knappen for opptak, starter opptaket og video lagres på minnekort, med start fra video
som er lagret i cache-minnet.

Merknad

Endring av opptaksformatet eller det grunnleggende utseendet sletter videoen i cache-minnet som er lagret frem til dette
tidspunktet, og starter cache-lagring av ny video. Konsekvensen er at bildeopptak til cache av bilder før endring av format ikke er
mulig, heller ikke hvis du starter opptak umiddelbart etter endring av format.

Hvis Picture Cache Rec er satt til On eller Off umiddelbart etter innsetting av minnekort, kan det hende at cache-data ikke blir tatt
opp på kortet.

[Cache Size]-innstilling Cache-tid (cirka)

[Short] 5 sekunder

[Medium] 10 sekunder

[Long] 20 sekunder

[Max] Maksimumsverdi for hvert opptaksformat
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Video lagres i cache-minnet når Picture Cache Rec-funksjonen er satt til On. Video fra før funksjonen blir satt til On lagres ikke i
cache.

Video lagres ikke i cache-minnet mens et minnekort brukes, som f.eks. under avspilling, Rec Review eller visning av
miniatyrbildeskjermen. Bildeopptak til cache av video i dette tidsintervallet er ikke er mulig.

Avbryte Picture Cache Rec

Angi [Project] > [Picture Cache Rec] > [Setting] til [Off] i nettmenyen, eller trykk på en knapp som er tilordnet med
[Picture Cache Rec]-funksjonen.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Ta opp på minnekort A og B samtidig (opptak med to spor)

Du kan ta opp til både minnekort A og minnekort B samtidig ved å sette [Project] > [Simul Rec] > [Setting] til [On] i
nettmenyen eller kameramenyen.

Separat opptak til minnekort A og minnekort B

Du kan starte/stoppe opptaket til hvert minnekort uavhengig av hverandre ved hjelp av START/STOP-knappen for opptak
eller [2nd Rec START/STOP]-knappen i  (Others)-fanen.
Med fabrikkinnstilling er begge knappene satt for samtidig å starte/stoppe opptak til begge minnekort, A og B.
Når knappene er angitt for å kontrollere opptak for forskjellige minnekort, vil start/stopp-kontrollen for [SDI/HDMI Rec
Control]-opptak følge opptaksmodusen for spor A.

Endre innstillingen

Angi følgende ved hjelp av [Project] > [Simul Rec] > [Rec Button Set] i kameramenyen.
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[Rec Button Set]-
innstilling Knapper og minnekort

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:<Slot
A> <Slot B>

Starter/stopper simultant opptak til minnekort A og B ved bruk av en av knappene.

Rec Button:<Slot A>
2nd Rec Button:<Slot
B>

START/STOP-knappen for opptak starter/stopper opptak til minnekort A, og [2nd Rec
START/STOP]-knappen i  (Others)-fanen starter/stopper opptak til minnekort B.

Rec Button:<Slot B>
2nd Rec Button:<Slot
A>

START/STOP-knappen for opptak starter/stopper opptak til minnekort B, og [2nd Rec
START/STOP]-knappen i  (Others)-fanen starter/stopper opptak til minnekort A.
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Videosignalskjerm

Du kan angi typen videosignal som vises i kamerabildepanelet til kurve, vektorskop eller histogram ved hjelp av
[Monitoring] > [Video Signal Monitor] > [Setting] i kameramenyen.
Den oransje linjen viser innstillingsverdiene for [Level Marker 1] og [Level Marker 2].
Du kan også tilordne [Video Signal Monitor]-funksjonen til en knapp som kan tilordnes.

Visning av overvåkningsmål
I Log shooting-moduser vises informasjon om fargerominnstillingen eller skjermens LUT-innstillingsinformasjon øverst til
høyre i videosignalskjermen for å indikere skjermmålet.
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Klippflagg

Du kan legge til et [OK]-klippflagg for et klipp ved å trykke på en knapp som er tilordnet med [Clip Flag OK]-funksjonen
og velge [Add OK].
Du kan slette et [OK]-klippflagg ved å trykke to ganger på knappen og velge [Delete Clip Flag].

Hint

Du kan også legge til et klippflagg ved hjelp av [Thumbnail] > [Set Clip Flag] i kameramenyen.

Miniatyrbildeskjermen kan vises som sortert på Klippflagg-type (miniatyrbildebildeskjerm med filtrerte klipp). Hvis du vil ha mer
informasjon, kan du se "Betjening av innspilte klipp" i "Miniatyrbildeskjerm".

Beslektet emne

Betjening av innspilte klipp
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Pust-kompensering

Du kan angi om det skal utføres pust-kompensering for objektivet ved hjelp av [Technical] > [Lens] > [Breathing
Compensation] i kameramenyen.
Denne funksjonen korrigerer for fenomenet der endringer i synsvinkelen inntreffer når fokusposisjonen varierer.
Når pust-kompensering utføres, blir en del av bildet beskåret elektronisk for å opprettholde en konstant synsvinkel slik at
pust-fenomenet ikke vises.

Merknad

Når pust-kompensering er aktivert kan synsvinkelen og bildekvaliteten endre seg litt.

Avhengig av objektivet vil det kanskje ikke være mulig å korrigere endringen i synsvinkel når pust-kompensering er aktivert.

Kompensering er ikke mulig når et objektiv som ikke støtter pust-kompensering er montert.

Denne funksjonen er satt til Off (fast) i følgende tilfeller.

Når [Technical] > [Lens] > [Distortion Comp.] er satt til [Off] i kameramenyen
Når [Shooting] > [S&Q Motion] > [Setting] er satt til [On] i nettmenyen eller kameramenyen
Når [Project] > [Rec Format] > [Codec] er satt til [RAW] eller [RAW & XAVC-I] i nettmenyen eller kameramenyen

5-041-958-83(1) Copyright 2022 Sony Corporation
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Oversikt over proxy-opptak

Med denne funksjonen kan du ta opp proxy-data med lav oppløsning samtidig som du tar opp original video med høy
oppløsning.

Hvis du vil ha mer informasjon om minnekort som støttes, formatering av minnekort og kontroll av gjenværende
kapasitet, se "Minnekort som støttes" i "Klargjøre minnekort".

Om opptaksfilen
Filtypen er ".mp4".
Tidskoden registreres også samtidig.

Lagringsmål for opptaksfilen
Den innspilte filen lagres i følgende katalog.

Om filnavnet
Filnavnet består av navnet på klippet som er registrert på minnekortet, og et "S03"-suffiks.
For klippnavn, se [TC/Media] > [Clip Name Format] i kameramenyen.

Beslektet emne

Minnekort som støttes
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Opptaksmedie Mappebane

SDXC /PRIVATE/XDROOT/Sub

CFexpress type A /XDROOT/Sub
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Spille inn en proxy

Du kan starte opptaket når proxy-opptak er aktivert.

For å stoppe opptaket
Avslutt opptaket.

Slik angir du lydkanal for proxy-opptak
Angi lydkanalen for proxy-dataopptak ved hjelp av [Project] > [Proxy Rec] > [Audio Channel] i kameramenyen.
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Angi [Project] > [Proxy Rec] > [Setting] til [On] i nettmenyen eller kameramenyen.1

Sett inn et minnekort i et CFexpress type A/SD-kortspor.

Sett inn CFexpress-kort med etiketten vendt opp.
Sett inn SD-kort med etiketten vendt ned.

Merknad

Proxy Rec kan ikke settes til On samtidig som S&Q Motion eller Interval Rec. Når Proxy Rec er satt til On, settes disse
andre opptaksmodiene automatisk til Off.

2

Trykk på START/STOP-knappen for opptak.

Proxy-opptak starter.

Merknad

Hvis enheten slås av eller minnekortet fjernes mens minnekortet leses, kan det ikke garanteres at dataene på kortet ikke
skades.
Alle data som er registrert på kortet, kan bli kassert. Kontroller alltid at tilgangsindikatoren er av før du slår av enheten eller
tar ut minnekortet.

Pass på at minnekortet ikke spretter ut når du setter det inn eller tar det ut.

3
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Oversikt over utseende

Når enheten er i Custom-modus, kan du legge til justeringer i svart, matrise og andre parametere for å opprette et
"utseende" basert på basisutseendet.

Du kan også raskt velge et annet utseende ved å lagre ulike innstillingskombinasjoner i scenefiler.
Enheten leveres med totalt sju forhåndsinnstilte utseender.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Velge et utseende

Dette emnet beskriver hvordan du velger et utseende.

Kontroller at [Project] > [Base Setting] > [Shooting Mode] er satt til [Custom] i nettmenyen eller
kameramenyen.

Hint

I modusen [Custom] vises [ISO/Gain]-knappen og [Scene File]-knappen i kameraets panel for grunnleggende
konfigurasjon.

1

Trykk på [Scene File]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [Scene File]-knappen endres til oransje.

Scene File-justeringspanelet vises.

2

Trykk på [Scene File]-knappen på justeringspanelet og velg en scenefil med ønsket utseende fra listen.

Følgende forhåndsinnstillinger konfigureres som standard fra fabrikken.

Hint

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Scenefil 1 [S-Cinetone] [HLG Live]

Scenefil 2 [Standard] [HLG Natural]

Scenefil 3 [Still] (Ikke registrert)

Scenefil 4 [ITU709] (Ikke registrert)

Scenefil 5 [709tone] (Ikke registrert)

Scenefilene 6 til 16 (Ikke registrert) (Ikke registrert)
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Du kan også velge et utseende ved hjelp av [Paint/Look] > [Scene File] > [Recall] i kameramenyen. Du kan også hente frem
en forhåndsinnstilt fremstilling ved hjelp av [Scene File] > [Preset Recall].

Merknad

Scene-fil 5 forhåndsinnstilling er satt til [709tone] med programvareversjon 2.0 eller nyere. Den vises når [Maintenance]>
[Reset] > [Factory Default] i nettmenyen utføres.
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Importere et ønsket basisutseende

Du kan importere en 3D LUT-fil som er opprettet på en datamaskin eller en annen enhet, som et basisutseende. Opptil
16 filer kan importeres.
Filformatet: CUBE-fil (*.cube) for en 17-grid eller 33-grid 3D LUT opprettet ved hjelp av Catalyst Browse, RAW Viewer
eller DaVinci Resolve* (fra Blackmagic Design Pty. Ltd.).

Fargerom/gamma for inndata: [S-Gamut3.Cine/S-Log3] eller [S-Gamut3/S-Log3]

Slik justerer du for undereksponering

Verifisert med Resolve V9.0, V10.0 og V11.0.*

Lagre 3D LUT-filen på enheten som kjører Web App.1

Åpne [Paint/Look] > [Base Look] i nettmenyen.

En liste over registrerte basisutseender vises.

2

Trykk på [Import]-knappen i raden der du vil importere filen.

Dialogboksen for filvalg vises.

3

Velg den klargjorte 3D LUT-filen.

Den importerte 3D LUT-filen blir enhetens basisutseende.

4

Velg den importerte 3D LUT-filen ved hjelp av [Paint/Look] > [Base Look] > [Select] i kameramenyen.5

Konfigurer [Paint/Look] > [Base Look] > [Input] og [Output] i kameramenyen slik at de samsvarer med
attributtene til den importerte 3D LUT-filen.

6
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Hvis det er en tendens til undereksponering når automatisk eksponering er valgt når du bruker det importerte
basisutseendet, justerer du utseende ved hjelp av [Paint/Look] > [Base Look] > [AE Level Offset] i nettmenyen.

Merknad

Å bare importere en 3D LUT-fil påvirker ikke bildet. Last inn den importerte 3D LUT-filen ved hjelp av [Paint/Look] > [Base Look] >
[Select] i kameramenyen.

Hvis [Input] ikke er riktig angitt, får du ikke riktig utseende.

Innstillingene for menyelementene [Input], [Output] og [AE Level Offset] brukes på basisutseendet som velges ved hjelp av
[Select]. Hvis flere 3D LUT-filer importeres, velger du hver 3D LUT-fil ved hjelp av [Select], og konfigurerer [Input], [Output] og [AE
Level Offset] individuelt for hver fil.

De konfigurerte innstillingene for [Input], [Output] og [AE Level Offset] lagres for hver 3D LUT-fil.

Alternativene for å velge basisutseende/LUT for importerte 3D LUT-filer er felles for modusene [SDR(BT.709)], [HDR(HLG)] og
Log shooting-moduser, men konvertering av fargerom og gamma utføres ikke i henhold til disse modusene.

3D LUT-filer slettes ikke når [Maintenance] > [Reset] > [All Reset (except for Network Settings)] utføres i nettmenyen.

En  (3D LUT filvedleggfeil) som vises foran [Base Look Name]-visningen, indikerer at 3D LUT-filene ikke kan legges ved klipp
som er tatt opp i Log shooting-moduser. Importer 3D LUT-filen igjen.
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Tilpasse et utseende

Du kan tilpasse utseendet basert på basisutseendet ved hjelp av glidebryterne [Master Black], [R Black], og [B Black]
Scene File-justeringspanelet i kameraets rute for grunnleggende konfigurasjon og [Paint/Look] > [Matrix] og andre
oppsettelementer i kameramenyen.
Koble enheten til en TV eller skjerm, og juster bildekvaliteten samtidig som du ser på bildet på TV-en eller skjermen.

1: [R Black]-glidebryter/justeringsknapper
2: [B Black]-glidebryter/justeringsknapper
3: [Master Black]-glidebryter/justeringsknapper

Merknad

Når du importerer en 3D LUT-fil og bruker den på bildet, vil ikke det ønskede utseendet som er definert i 3D LUT-filen oppnås hvis
[Paint/Look] > [Matrix] og andre innstillinger enn innstillingene for basisutseende i kameramenyen endres.

Du kan tilbakestille alle tilpassede innstillinger ved hjelp av [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look] i
kameramenyen.
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Lagre et utseende

Du kan lagre det gjeldende utseendet som en scenefil i det interne minnet ved hjelp av [Paint/Look] > [Scene File] >
[Store] i kameramenyen.
Du kan raskt kalle tilbake et lagret utseende ved hjelp av Scene File-justeringspanelet eller ved hjelp av betjening av
hurtigmenyen.

Merknad

Hvis du velger et annet utseende uten å lagre det gjeldende utseendet, kasseres det gjeldende utseendet.

Hint

Du kan overskrive de forhåndsinnstilte scenefilene. Hvis du vil gjenopprette en forhåndsinnstilt scenefil, laster du inn utseendet
som skal gjenopprettes ved hjelp av [Paint/Look] > [Scene File] > [Preset Recall] i kameramenyen. Deretter lagrer du scenefilen
ved hjelp av [Scene File] > [Store].

Slik sletter du et lagret utseende
Du kan slette en scenefil i det interne minnet ved hjelp av [Paint/Look] > [Scene File] > [Delete] i kameramenyen.

Hint

Når den er slettet, vises den ikke lenger i Scene File-justeringspanelet eller hurtigmenyen.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Slette et basisutseende

Du kan slette importerte 3D LUT-filer individuelt ved hjelp av [Paint/Look] > [Base Look] > [Delete] i kameramenyen.
Du kan slette alle importerte 3D LUT-filer ved hjelp av [Paint/Look] > [Base Look] > [Delete All] i kameramenyen.

Merknad

Før du sletter, må du kontrollere at basisutseendet ikke brukes i noen scenefiler. Hvis et basisutseende som brukes blir slettet, vil
utseendet til de tilsvarende scenefilene bli feil.

Importerte 3D LUT-filer slettes ikke når [Maintenance] > [Reset] > [All Reset (except for Network Settings)] utføres i nettmenyen.

Et slettet basisutseende kan ikke lenger brukes som LUT i Log shooting-moduser.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Fotografering med utseendejustering i postproduksjon

Ved å bruke enheten i Log shooting-moduser*1 og fotografere graderinger likt fra mørke områder til lyse områder, kan du
foreta finjusteringer, for eksempel lokalt gjenopprette graderingen av mørke områder og lyse områder, i
postproduksjonen.
Når du ser på bildene som er tatt på en vanlig skjerm, vil imidlertid den generelle kontrasten synes lav, slik at det blir
vanskelig å justere fokus og eksponering.
Du kan bruke en LUT på skjermmålet på enheten for å gjøre det enklere å justere kameraet under opptak. Du kan også
bruke LUT-en, når du gjør opptak automatisk, ved avspilling for en rask kontroll av det ferdige resultatet.
LUT-er brukes av følgende systemer. Du kan imidlertid bare bruke én LUT.

SDI-utgang
HDMI-utgang og -strømming
Proxy-klipp tatt opp på opptaksmedier
Klipp med høy oppløsning (Main) på opptaksmedier

5-041-958-83(1) Copyright 2022 Sony Corporation

Generell term for Flexible ISO-modus/Cine EI-modus/Cine EI Quick-modus*1
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Bruke en LUT på HDMI-utgang og -strømming

Du kan bruke en LUT på HDMI-utgang og -strømming.

Merknad

Bildet i Web App-kamerabildepanelet er også inkludert i strømmebildet.

Hint

Dette kan også angis ved hjelp av [Shooting] > [LUT On/Off] > [HDMI/Stream] i kameramenyen.

SDI-utgang kan angis på samme måte.

For video på opptaksmedier kan du angi dette ved hjelp av [Shooting] > [LUT On/Off] > [Internal Rec] og [Proxy] i kameramenyen.

En  (3D LUT filvedleggfeil) som vises foran [Base Look/LUT]-visningen, indikerer at 3D LUT-filene ikke kan legges ved klipp
som er tatt opp i Log shooting-moduser. Importer 3D LUT-filen igjen.
Dette ikonet vises også når vedlegg mislykkes på grunn av midlertidig kø i signalbehandlingen.

Kontroller at [Project] > [Base Setting] > [Shooting Mode] er satt til [Flexible ISO], [Cine EI], eller [Cine EI
Quick] i nettmenyen eller kameramenyen.

Hint

I Log shooting-modusene vises [Base ISO/Exposure Index]-knappen og [Base Look/LUT]-knappen i kameraets panel for
grunnleggende konfigurasjon.

1

Trykk på [Base Look/LUT]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [Base Look/LUT]-knappen endres til oransje.

Base Look/LUT-justeringspanelet vises.

2

Velg [HDMI/Stream] > [MLUT].3
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Bytte LUT

Du kan endre LUT som skal brukes.

Hint

Enheten har [s709], [709(800%)], og [S-Log3] som forhåndsinnstilte LUT-er.

Du kan også importere og bruke en 3D LUT-fil. Hvis du vil ha mer informasjon, se "Importere et ønsket basisutseende" og "Slette
et basisutseende".

Dette kan også angis ved hjelp av [Paint/Look] > [Base Look] > [Select] i kameramenyen.

Beslektet emne
Importere et ønsket basisutseende

Slette et basisutseende
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Trykk på [Base Look/LUT]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [Base Look/LUT]-knappen endres til oransje.

Base Look/LUT-justeringspanelet vises.

1

Trykk på [Base Look/LUT]-knappen, og velg basisutseendet som skal brukes.2
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Endre fordelingen av mørke og lyse områder i bildet som er tatt

I opptaksmodusene Cine EI- og Cine EI Quick kan du endre fordelingen av mørke områder og lyse områder, for
eksempel hvis du vil prioritere tonen i mørke områder fremfor lyse områder, ved å endre Exposure Index fra
basisfølsomheten.

Trykk på [Base Look/LUT]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [Base Look/LUT]-knappen endres til oransje.

Base Look/LUT-justeringspanelet vises.

1

Velg [HDMI/Stream] > [MLUT].

Det brukes en LUT på HDMI-utgang og -strømming.

2

Trykk på [Base ISO/Exposure Index]-knappen i kameraets panel for grunnleggende konfigurasjon.

Rammen på [Base ISO/Exposure Index]-knappen endres til oransje.

Base ISO/Exposure Index-justeringspanelet vises.

3

Juster eksponeringsindeksen i henhold til ønsket fordeling av mørke og lyse områder ved hjelp av
glidebryteren [Exposure Index] eller [Exposure Index]-justeringsknappene.

For [Cine EI]

For [Cine EI Quick]
Basisfølsomheten stilles inn automatisk ifølge den angitte eksponeringsindeksen.

4
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Hint

Dette kan også angis ved hjelp av [Shooting] > [ISO/Gain/EI] > [Exposure Index] i kameramenyen.

SDI-utgang kan brukes på samme måte.

Den andre tallverdien i innstillingen angir hvor mange trinn lysstyrkeinformasjon som er tildelt for lyse områder (lysstyrke som er
høyere enn 18% grå). Områder som er lysere enn disse blir overeksponerte.
Eksempel: I "400EI/5.0E" tilordnes 5,0 trinn til den lyse siden.

Du kan også bruke dette som en veiledning for å kontrollere tonen i mørke og lyse områder under fotograferingen. Husk å gå
tilbake til opprinnelig EI-verdi etter at du har kontrollert eksponeringen. I tillegg, i Cine EI Quick-modus, må du være forsiktig for å
unngå negativ påvirkning på basisfølsomheten.

5-041-958-83(1) Copyright 2022 Sony Corporation

Juster belysningen og/eller ND-filteret slik at kamerabildet som sendes fra [HDMI/Stream] har riktig
eksponering.

5
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Hvordan ta opp RAW-video

Du kan spille inn RAW-videosignalet fra SDI OUT-kontakten på enheten til en støttet ekstern opptaker.
De støttede RAW-formatene vises nedenfor.

Systemfrekvens [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Koble til en ekstern RAW-opptaker til enhetens SDI OUT-kontakt.1

Angi [Project] > [Base Setting] > [Shooting Mode] til [Cine EI], [Cine EI Quick], eller [Flexible ISO] i
nettmenyen eller kameramenyen.

2

Sett synsvinkel til (kun FF) ved hjelp av [Project] > [Rec Format] > [Imager Scan Mode] i nettmenyen eller
kameramenyen.

3

Angi [Project] > [Rec Format] > [Codec] til [RAW] i nettmenyen eller kameramenyen.

Hvis du velger [RAW & XAVC-I], tar du samtidig opp video til den eksterne RAW-opptakeren og video til
minnekortene i enheten.

4

Angi oppløsningen ved hjelp av [Project] > [Rec Format] > [RAW Output Format] i nettmenyen eller
kameramenyen.

5

Kontroller at den eksterne opptakeren er slått på, og trykk deretter på START/STOP-knappen for opptak på
skjermbildet for direkte betjening.

Statusen for RAW-videoopptak angis av et ikon i kamerabildepanelet.

6
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Merknad

Når opptaket startes på en ekstern opptaker uten at du bruker START/STOP-knappen for opptak på skjermbildet for direkte
betjening, er det ikke sikkert at klippene blir tatt opp på riktig måte.

5-041-958-83(1) Copyright 2022 Sony Corporation

Merknad

Kontrollsignalet for opptak sendes ut fra SDI OUT-kontakten på enheten, men det er ikke mulig å få statusen til den
eksterne opptakeren. Enheten kan derfor indikere at RAW-videoopptak pågår når den eksterne opptakeren faktisk ikke tar
opp. Kontroller indikatoren på den eksterne opptakeren for å få riktig driftsstatus.
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Ta opp RAW-video i modus for sakte og rask bevegelse

Du kan ta opp RAW-video i modus for sakte og rask bevegelse.

For informasjon om støttede rammefrekvenser for opptak, se "Sakte og rask bevegelse".

Beslektet emne

Sakte og rask bevegelse
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Slå Bokeh-kontrollfunksjonen av/på

Du kan enkelt justere graden av Bokeh ved å lenke ND-filteret og Gain til bruk av Iris.

Slå Bokeh-kontrollfunksjonen av/på

Denne funksjonen kan kun aktiveres når eksponering justeres manuelt. Sett ND-filteret til variabel modus, og sett
deretter Iris-, Gain-, Lukker- og ND-filter til manuell justering.
Du kan slå Bokeh-kontrollfunksjonen av/på ved hjelp av [Shooting] > [Iris] > [Bokeh Control] i kameramenyen.
Når Bokeh-kontrollfunksjonen er satt til On, vises et  (B)-ikon på ND-filteret og forsterkningsindikatorene.

Merknad

Denne funksjonen er kun aktivert på objektiv med E-fatning som kan kommunisere med enheten.

Den maksimale effekten av denne funksjonen kan oppnås ved hjelp av et objektiv med Sony E-feste.

Bokeh-kontrollfunksjonen er satt til Off når en av følgende operasjoner utføres.

Når enheten er slått av
Når Iris-, Gain-, Shutter- eller ND-filter er satt til Auto
Når opptaksmodus endres
Når ND-filteret er satt til Klart- eller Forhåndsinnstilt-modus
Når objektivet fjernes
Når enheten startes på nytt, for eksempel etter skifte av frekvens

Hint

Du kan også tilordne [Bokeh Control]-funksjonen til en knapp som kan tilordnes, og skifte Bokeh-kontrollfunksjonen mellom On og
Off ved hjelp av knappen.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Justere graden av Bokeh

Juster innstillingene i trinn 2 til 4 etter behov.

Merknad

Utseendet kan variere avhengig av benyttet hastighet, objektiv, opptaksinnstillinger og motiv, og lysstyrken kan også endre seg. Å
utføre en kameratest før opptak anbefales på det sterkeste.

Lysstyrken kan endre seg når benyttet retning for Iris endres, som f.eks. ved åpning av Iris etter at den er lukket, eller ved lukking
av Iris etter at den er åpnet. I dette tilfellet skal man justere litt mer enn påkrevd på forhånd, og så justere litt tilbake, sjekke
lysstyrken og så starte opptak. Hvis du f.eks. vil åpne Iris til blenderåpning F8 og gjøre bakgrunnen uklar, skal du først lukke
blenderåpningen forbi F8 og så gå tilbake til F8, sjekke lysstyrken og starte opptak.

Utfør bokeh-kontrollhandlinger sakte. Hvis du trenger å gjøre raske endringer, prøv å justere gradvis mens du sjekker endringer
på bildet.

Hint

Når Bokeh-kontrollfunksjonen er satt til On, vil ND-filteret og forsterkningen fungere sammen for å kompensere endringer i
eksponering på grunn av Iris-justering, og gi deg mulighet til å endre graden av Bokeh.

Bokeh-kontrollen er først lenket til ND-filteret som respons til bruk av Iris. Når ND-filteret ikke lenger kan endres, lenkes det til
Gain.

I MF-modus anbefales det at du først åpner Iris og så justerer fokuset.

Hvis du bruker auto ND-filteret istedenfor Bokeh-kontrollfunksjonen, vil ND-filteret følge endringen i lysstyrke på motivet.

Display under bruk av Gain link
Når Bokeh-kontrollfunksjonen er satt til On, kan forsterkningen endre seg når Iris justeres.
Når Gain Link er aktivert og forsterkningen endres, vises en melding øverst i skjermen og  (B)-ikonet på
forsterkningsindikatoren blinker.

Sett Bokeh-kontrollfunksjonen til On.1

Åpne iris helt.2

Sett ND-filteret til 1/128.3

Sett forsterkningen til 0 dB og bruk belysning for å få egnet eksponering.4

Juster fokuset.5

Juster iris.

Graden av Bokeh endres.

6
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Oversikt over lagring og innlasting av konfigurasjonsdata

Du kan lagre innstillingene for enheten som konfigurasjonsdata ved hjelp av Web App. Dette gjør at du raskt kan
tilbakekalle et passende sett med menyinnstillinger for den gjeldende situasjonen.
Med denne enheten kan du lagre nesten alle innstillinger relatert til kamerafunksjoner, bortsett fra følgende notat, som en
ALL File (fil med alle innstillinger).

Merknad

Innstillinger for nettverksfunksjoner og godkjenningsinformasjon lagres ikke. Hvis du vil ha mer informasjon om lagrede
elementer, se "Liste over menyelementer".

Beslektet emne

Liste over menyelementer
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Lagre en ALL-fil

Dette menet beskriver hvordan du lagrer en ALL-fil.
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Åpne [Project] > [All File] i nettmenyen.1

Trykk på [Save All File] > [Save]-knappen.

Nettleseren laster umiddelbart ned en fil kalt all-file.ALL.

2

Angi en plassering og et filnavn for den nedlastede filen all-file.ALL, og lagre filen.

Hvis du vil ha mer informasjon om filoperasjoner, se bruksanvisningen for enheten.

3
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Laste inn en ALL-fil

Dette menet beskriver hvordan du laster inn en ALL-fil.

Merknad

Enheten startes automatisk på nytt etter innlasting av konfigurasjonsdata. Etter ny oppstart, laster du inn siden på nytt i
nettleseren.
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Åpne [Project] > [All File] i nettmenyen.1

Trykk på [Load All File] > [Load]-knappen.

Dialogboksen for å åpne filer vises på enheten som kjører Web App.

2

Åpne filen du vil laste inn.

Hvis du vil ha mer informasjon om filoperasjoner, se bruksanvisningen for enheten.

3

Når bekreftelsesskjermbildet for innlasting av filnavn vises, trykker du på [OK]-knappen.4

Når skjermbildet for kjøringsresultat vises, trykker du på [OK]-knappen.5

Vent til enheten starter på nytt, og koble deretter til Web App på nytt.6
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Om filoverføring

Du kan laste opp en proxy-fil eller originalfil som er tatt opp på enheten til en server på Internett eller en server på et
lokalt nettverk.

Merknad

Når strømforsyningen er satt i standby-modus, settes filoverføringer på vent selv om enheten fortsatt er slått på.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Registrere en filoverføringsdestinasjon

Du kan registrere en filoverføringsdestinasjon før du starter en filoverføring.

Velg [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (eller [Server Settings2],
[Server Settings3]) i nettmenyen.

Hint

Navnet på valgalternativet endres i henhold til [Display Name] som er konfigurert i neste trinn.

1

Konfigurer følgende elementer for [Network] > [FTP Server 1] til [FTP Server 3] i nettmenyen.

[Display Name]
Skriv inn navnet på serveren som skal vises i listen over overføringsjobber når du velger en målserver for
overføringen.
[Service]
Viser servertypen.
[FTP]: FTP-server
[Host Name]
Skriv inn adressen eller vertsnavnet til serveren.
[Port]
Angi portnummeret til serveren som skal kobles til.
[User Name]
Skriv inn brukernavn.
[Password]
Skriv inn passordet.
[Passive Mode]
Slå passiv modus av/på.
[Destination Directory]
Skriv inn navnet på målserveren.

Merknad

Hvis tegn som er ugyldige på målserveren, angis i [Destination Directory], overføres filene til brukerens startkatalog.
Ugyldige tegn vil variere avhengig av serveren.

[Using Secure Protocol]
Angi om du vil bruke sikker FTP-overføring.
[Root Certificate]
Laste inn/slett et sertifikat.
[Load]: Laste inn et CA-sertifikat. Laster inn PEM-formatsertifikater.
[Clear]: Slette CA-sertifikatet.
[None]: Ikke last inn eller slett et sertifikat.

Merknad

Still klokken på enheten til riktig klokkeslett før du laster inn et CA-sertifikat.

Når du tar opp i XAVC-I 4096×2160P/3840×2160P 59.94/50P, kan ikke [Load] være valgt.

2
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[Root Certificate Status]: Viser innlastingsstatus for sertifikatet.
[Reset]: Tilbakestiller Server Settings-innstillingene til standardinnstillingene.
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Laste opp en proxy-fil på et minnekort fra miniatyrbildeskjermen

Du kan laste opp en proxy-fil på et minnekort fra miniatyrbildeskjermen.

Merknad

Opptil 200 overføringsjobber kan registreres.
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Trykk på [Thumbnail]-knappen i på skjermbildet for direkte betjening i Web App.

Visningen endres fra kamerabildet til miniatyrbildeskjermen.

1

Velg [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] i kameramenyen.

Hvis du vil overføre alle proxy-filer samtidig, velger du [Transfer Clip (Proxy)] > [All Clips].
Klipp kan overføres fra miniatyrbildeskjermen eller miniatyrbildeskjermen filtrert for klipp.

2

Velg klippet du vil overføre ved hjelp av [Set]-knappen og trykk på [Menu]-knappen.

Det vises et bekreftelsesskjermbilde for overføring.

3

Velg [Execute].

Proxy-filen som svarer til det valgte klippet registreres som en overføringsjobb, og opplastingen starter.
Når overføringsjobben er registrert, vises skjermbildet for overføringsresultat.

4

Trykk på [OK]-knappen.5
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Laste opp en originalfil på et minnekort fra miniatyrbildeskjermen

Du kan laste opp en originalfil på et minnekort fra miniatyrbildeskjermen.

Merknad

Opptil 200 overføringsjobber kan registreres.
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Trykk på [Thumbnail]-knappen i på skjermbildet for direkte betjening i Web App.

Visningen endres fra kamerabildet til miniatyrbildeskjermen.

1

Velg [Thumbnail] > [Transfer Clip] > [Select Clip] i kameramenyen.

Hvis du vil overføre alle originalfiler samtidig, velger du [Transfer Clip] > [All Clips].
Klipp kan overføres fra miniatyrbildeskjermen eller miniatyrbildeskjermen filtrert for klipp.

2

Velg klippet du vil overføre ved hjelp av [Set]-knappen og trykk på [Menu]-knappen.

Det vises et bekreftelsesskjermbilde for overføring.

3

Velg [Execute].

Originalfilen for valgte klippet registreres som en overføringsjobb, og opplastingen starter.
Når overføringsjobben er registrert, vises skjermbildet for overføringsresultat.

4

Trykk på [OK]-knappen.5
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Kontrollere filoverføringsstatusen

Du kan kontrollere filoverføringsstatusen ved å velge [Network] > [File Transfer] > [View Job List] i kameramenyen.

Merknad

Opptil 200 overføringsjobber kan registreres.

Overføringsjobbene beholdes når enheten setter i standby-modus, men opptil 10 minutter med nylig fremdriftsinformasjon kan gå
tapt hvis strømmen kobles fra på andre måter.

Hvis det oppstår en feil under filoverføring, kan overføringen av et klipp med samme navn som et overført klipp ikke gjenopptas,
avhengig av innstillingene og statusen til overføringsmålserveren. I så tilfelle kontrollerer du innstillingene og statusen for
målserveren for overføring.

Hint

Hvis [Network] > [File Transfer] > [Auto Upload (Proxy)] er satt til [On] i kameramenyen, og det finnes en nettverkstilkobling, lastes
proxy-filer automatisk opp til serveren som er spesifisert med [Default Upload Server] når opptaket avsluttes.
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Opplasting ved hjelp av sikker FTP

Du kan laste opp filer med kryptering ved hjelp av FTPS i eksplisitt modus (FTPES) for tilkoblingen til målfilserveren.
For sikker FTP-overføring setter du [Using Secure Protocol] til [On] i innstillingene for målfilserveren og laster inn et
sertifikat.

Hvis du vil ha mer informasjon om konfigurasjon, se "Registrere en filoverføringsdestinasjon".

Beslektet emne
Registrere en filoverføringsdestinasjon

5-041-958-83(1) Copyright 2022 Sony Corporation
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Om strømming

Enheten kan strømme videoen og lyd som sendes ut fra HDMI-kontakten samtidig.

Merknad

Hvis du vil bruke direkteavspilling som hovedvideo, setter du [Monitoring] > [Output Display] > [SDI] til [On] og [HDMI/Stream] til
[Off] i nettmenyen, og overvåker kamerastatusen på en SDI-skjerm.

Hvis det er koblet til HDMI-kontakten som ikke støtter HDMI-utdataformatet som er konfigurert ved hjelp av menyen [Monitoring] i
nettmenyen eller kameramenyen, sendes ikke kamerabildet til Web App. Strømming av video kan heller ikke sendes ut.

Strømmeoppløsningen kan ikke stilles høyere enn oppløsningen til HDMI-utgangssignalet.

Når bildet vises av flere brukere, kan det bli forvrengt, avhengig av kodekinnstillingene.

Enheten støtter følgende strømmemetoder. Videokodekene som er tilgjengelige for valg, vises i parentes.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Konfigurer innstillingen for strømmeformat, videokodek og lydkodek i den rekkefølgen.

●: Aktivert, –: Deaktivert

Hint

Bildet i Web App-kamerabildepanelet finnes også i strømmesystemet.

Strømmeformat
Codec-innstilling

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Web App – – ● –

RTMP kan velges når [Stream] > [Audio Stream] er satt til [On] i nettmenyen.*1

Når systemfrekvensen er 59,94 eller 50 og HDMI-utgangsformatet er 3840×2160 eller høyere, er ikke video 2-utgang tilgjengelig.*2
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Angi strømmeformatet

Angi strømmeformatet ved hjelp av [Stream] > [Stream] > [Stream Setting] > [Setting] i nettmenyen.

Når [Setting] er satt til [RTSP]

I RTSP-strømming kan bildet fra ett enkelt kamera vises samtidig av opptil fem brukere.
Du kan angi opptil to moduser for videokodek.
[Port Number]
Angir portnummeret som skal brukes til RTSP-strømming. Standardverdien er 554.
Hvis du endrer innstillingen, startes RTSP-serveren på nytt.
[Time Out]
Angir tiden for tidsavbrudd for Keep-Alive-kommandoen for RTSP-strømming. Tiden for tidsavbrudd kan angis i området
0 sekunder til 600 sekunder. Standardverdien er 60 sekunder.
Når den er satt til 0 sekunder, oppstår ikke tidsavbrudd på grunn av Keep-Alive-kommandoen.
[Authentication]
Angir om godkjenning er nødvendig.
[Video Port Number 1], [Video Port Number 2]
Angir portnummeret for bildedatakommunikasjon som skal brukes til strømming av RTSP-unikasting. Den fabrikkinnstilte
standardverdien for Video Port Number 1 er 51000. Den fabrikkinnstilte standardverdien for Video Port Number 2 er
53000. Angi et partall i området 1024 til 65534. Tallet som er angitt her og det etterfølgende oddetallet, oppnådd ved å
legge til 1, blir de to portnumrene som brukes til kommunikasjon og kontroll av bildedata.
[Video Port Number 1] og [Video Port Number 2] tilsvarer [Stream] > [Video Stream] > [Video Stream 1] og [Video Stream
2].
[Audio Port Number]
Angir portnummeret for lyddatakommunikasjon brukt til strømming av RTSP-unikasting. Standardverdien er 57000. Angi
et partall i området 1024 til 65534. Tallet som er angitt her og det etterfølgende oddetallet, oppnådd ved å legge til 1, blir
de to portnumrene som brukes til kommunikasjon og kontroll av lyddata.

Når [Setting] er satt til [RTMP]

Videokodekmodusen som kan brukes for RTMP er kun H.264. For å bruke RTMP, må [Stream] > [Audio Stream] settes til
[On] i nettmenyen.
[Server URL]
Angir URL-adressen for opplastingsmålet. Angi en tegnstreng som starter med "rtmp://" eller "rtmps://".
[Stream Key]
Legg inn strømmekoden du får fra det nettstedet du bruker. Hvis du trykker på [Clear]-knappen, slettes det du har lagt
inn.

Merknad

Utvis forsiktighet når du håndterer strømmekoden. Hvis strømmekoden blir kjent for en tredjepart, er det risiko for spoofing av
strømmingen.

[Root Certificate]
Importerer rotsertifikatet som kreves for strømming med bruk av RTMPS-protokoll. For å importere rotsertifikatet, trykk på
[Load]-knappen og velg et rotsertifikat. Trykk på [OK]-knappen i dialogboksen for filvalg for å importere den valgte filen til
enheten. Hvis det finnes et importert rotsertifikat i enheten, blir rotsertifikatet lastet opp. For å slette et importert
rotsertifikat, trykk på [Delete]-knappen på oppsettskjermen. Rotsertifikatets status vises i [Root Certificate Status].

Merknad
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Importer rotsertifikatet som kreves av strømmetjenesten.

Når [Setting] er satt til [SRT-Caller] eller [SRT-Listener]

Videokodekmodusen er kun H.264.
[Destination]
Vises når strømmemodus er satt til [SRT-Caller]. Angir URL-adressen for tilkoblingsmål.
[Port Number]
Vises når strømmemodus er satt til [SRT-Listener]. Angir portnummeret det skal lyttes på. Standardverdien er 4201.
[Latency]
Angir ventetiden i området 20 ms til 8000 ms. Standardverdien er 120.
[TTL]
Angir TTL-verdien i området 1 til 255. Standardverdien er 64.
[Encryption]
Velger krypteringsmetoden. Velg Off, AES128 eller AES256. Standardverdien er Off.
[Passphrase]
Angir passordfrasen som brukes til kryptering. Hvis du trykker på [Clear], tilbakestilles den konfigurerte passordfrasen.
[ARC]
Hvis du vil aktivere funksjonen Adaptiv hastighetskontroll, setter du den til On.
Når funksjonen Adaptiv hastighetskontroll er aktivert, kan avbrudd i bildet forårsaket av overbelastning i
kommunikasjonslinjen reduseres.

Når [Setting] er satt til [NDI|HX]

Enheten er i samsvar med NDI|HX-versjon 2 fra NewTek.
Hvis du vil bruke NDI|HX, må du kjøpe en lisensnøkkel.
Kjøpe en lisensnøkkel
Kjøp på følgende URL-adresse for NewTek.
https://www.newtek.com/ndihx/products/upgrade/

Merknad

Last ned den nyeste NDI|HX-driveren og installer den i et NewTek-produkt.

Hvis du vil ha mer informasjon om NDI|HX-registrering og -drift, se bruksanvisningen for NewTek-produktet.

[License]
Viser lisensinformasjonen for en aktivert lisens.
[Source Name]
Viser kildenavnet.
[Group]
Hvis du vil aktivere NDI-grupperingsfunksjonen, setter du den til On.
[Group Name]: Angir NDI-gruppenavnet. Flere innstillinger kan konfigureres, atskilt med komma.
[Discovery Server 1], [Discovery Server 2]
Angir NDI Discovery Server 1 og NDI Discovery Server 2.
[Reliable UDP Mode]
Hvis du vil aktivere Reliable UDP-modus, setter du den til On.
[Multicast Mode]
Hvis du vil aktivere strømming av multikasting, setter du den til On.
[Multicast Prefix]: Angir prefikset som skal brukes for strømming av multikasting.
[Multicast Netmask]: Angir nettverksmasken som bestemmer adresseområdet for multikasting.
[Multicast TTL]: Angir TTL-verdien for strømming av multikasting i området 1 til 256. Standardverdien er 3.
[Multi-TCP Mode]
Hvis du vil aktivere Multi-TCP-modus, setter du den til On.
[Unicast UDP Mode]
Hvis du vil aktivere Unicast UDP-modus, setter du den til On.

Om tredjepartstjenester og -programvare
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Ulike bruksvilkår kan gjelde.

Levering av tjenester og programvareoppdateringer kan bli avbrutt eller avsluttet uten varsel.
Beskrivelsen av tjenester og programvare kan endres uten varsel.
Separat registrering og abonnement kan være nødvendig.

Sony vil ikke være ansvarlig for krav fra brukere eller en tredjepart på grunn av bruk av tjenester og programvare fra
andre selskaper.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Angi videokodek for strømming

Angi videokodeken ved hjelp av [Stream] > [Video Stream] i nettmenyen.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Du kan angi opptil tre moduser for bildekodek. Konfigurer følgende innstillinger separat for hver bildemodus.
[Video Stream 3] brukes til visning av kamerabildepanelet i Web App.

Merknad

Når [Stream] > [Stream Setting] > [Setting] er satt til [RTMP], [SRT-Caller], eller [SRT-Listener], vil noen av [Video Stream 1],
[Video Stream 2], og [Video Stream 3]-innstillingene ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode]) ha
standardverdier.

[Codec 1], [Codec 2], [Codec 3]
Velg [H.264], [H.265], eller [Off]. Merk deg at [Codec 1] ikke kan settes til [Off]. I tillegg er [Codec 3] satt til [JPEG] (fast).

Merknad

Følgende symptomer kan oppstå avhengig av kombinasjonen av ulike innstillinger, for eksempel bildestørrelse, rammefrekvens
og bit-hastighet for [Codec 1], [Codec 2] og [Codec 3].

Økt videoventetid.
Det hoppes over rammer under videoavspilling.
Uregelmessig lyd.
Treg kamerarespons på forskjellige kommandoer.
Treg kamerarespons på betjening fra en fjernkontroll.
Treg skjermbildevisning og konfigurasjonsbetjening.

Hvis du opplever disse symptomene, reduserer du verdiene for parameterne bildestørrelsen, bildefrekvensen og bit-hastigheten,
eller endrer verdiene for andre oppsettparametere for å løse problemet.

Når [Stream] > [Stream Setting] > [Setting] er satt til [RTMP], [SRT-Caller], eller [SRT-Listener], [Codec 1] er satt til [H.264] (fast).
[Codec 2] er satt til [Off] (fast).

Når bildestørrelsen eller systemfrekvensen for HDMI-utgangen endres, settes [Codec 2] til [Off].

[Size 1], [Size 2], [Size 3]
Velger bildestørrelsen som skal strømmes fra kameraet.
Alternativene for tilgjengelig bildestørrelse varierer avhengig av bildestørrelsen på HDMI-utgangen.

Merknad

Når bildestørrelsen eller systemfrekvensen for HDMI-utgangen endres, velges maksimal bildestørrelse.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Angir rammefrekvensen for bildet.
"fps"-enheter angir antall rammer som strømmes per sekund.
Alternativene for tilgjengelig rammefrekvens varierer avhengig av bildestørrelsen på HDMI-utgangen.

Merknad

Når bildestørrelsen eller systemfrekvensen for HDMI-utgangen endres, velges maksimal rammefrekvens.
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[I-Picture Mode 1], [I-Picture Mode 2]
Angir metoden for å angi innsettingsintervallet for I-bilder for H.264 og H.265 til [Time] eller [Frame].
Kan ikke angis for [Codec 3].
[Time]: Angir innsettingsintervallet for I-bilder som en tid.
[Frame]: Angir innsettingsintervallet for I-bilder som et antall rammer.
[I-Picture Interval 1], [I-Picture Interval 2]
Angir innsettingsintervallet for I-bilder i sekundenheter. Angir en verdi i området 1 sekund til 5 sekunder. Standardverdien
er 1 sekund.
Kan ikke angis for [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Angir innsettingsintervallet for I-bilder for H.264 og H.265 som et antall rammer i området 15 til 300. Standardverdien er
300 rammer.
Kan ikke angis for [Codec 3].
[Profile 1], [Profile 2]
Angir bildekodekprofilen for H.264 eller H.265.
[H.264]: Velg [high], [main], eller [baseline]-profil.
[H.265]: Velg [main]- eller [main10]-profil. Når to videokodeker er aktivert, er bare profilvalgalternativet [main] tilgjengelig.
Bildekomprimeringens effektivitet øker i rekkefølgen [high], [main], og [baseline]. Velg en profil som støttes av systemet
ditt.
Når [H.265] er satt til [main10] er driften i [main10] når HDMI-utgangen er YCrCb eller [main] når HDMI-utgangen er
RGB.
Kan ikke angis for [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Velg [CBR] eller [VBR].
Hvis du vil beholde en konstant bit-hastighet, velger du [CBR]. Hvis du vil beholde bildekvaliteten, velger du [VBR].
Kan ikke angis for [Codec 3].

Merknad

Rammefrekvensen og bit-hastigheten som faktisk strømmes, kan avvike fra de angitte verdiene, avhengig av bildestørrelse,
opptaksscene, nettverksmiljø og andre faktorer.

Når [Stream] > [Stream Setting] > [Setting] er satt til [RTMP], [SRT-Caller], eller [SRT-Listener], [Bit Rate Compression Mode 1] er
satt til [CBR] (fast).

[Bit Rate 1], [Bit Rate 2]
Du kan angi bit-hastigheten per videostrøm når [Bit Rate Compression Mode] er satt til [CBR]. Ved å angi en høy bit-
hastighet kan du strømme video med høy bildekvalitet.
Kan ikke angis for [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Angir bildekvaliteten i området 1 til 10. Verdien 10 angir den høyeste bildekvaliteten. Standardverdien er 6.
For [Quality 1] og [Quality 2] kan du angi H.264-bildekvalitet ved å sette [Bit Rate Compression Mode] til [VBR] og
[Codec] til [H.264]. Du kan angi H.265-bildekvalitet ved å sette [Bit Rate Compression Mode] til [VBR] og [Codec] til
[H.265].
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Angi lydkodek for strømming

Angi lydkodeken ved hjelp av [Stream] > [Audio Stream] i nettmenyen.
[Setting]
Hvis du vil aktivere lydstrømming, setter du den til On.

Merknad

For å velge RTMP, sett alltid i On på forhånd.

[Codec]
Velger hvilken type kodek som skal brukes til strømming av lyd.
[AAC (256kbps)]: Velg for å prioritere lydkvaliteten.
[AAC (128kbps)]: Velg for å prioritere datakapasiteten.
Denne innstillingen har ingen innvirkning på klippet som er tatt opp av enheten eller lydsignalet som er innebygd i
HDMI/SDI-signalet.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Starte/stoppe strømming

For [RTSP], [SRT-Listener], og [NDI|HX]

Enheten venter på en forespørsel om levering av strømming.
Start en klientapplikasjon for å vise strømming og få tilgang til URL-adressen som vises i tabellen nedenfor.
Angi verdiene for brukernavnet og passordet som er konfigurert på enheten.

<camera_address>: IP-adressen til enheten
<Port>: Lytteport konfigurert ved hjelp av [Port Number]

Merknad

Avspilling i alle applikasjoner eller enheter garanteres ikke.

For [RTMP] og [SRT-Caller]

Trykk på [Stream now]-knappen i fanen  (Stream) på skjermbildet for direkte betjening for å starte strømming.
Knappen endres til [Stop stream], og ikonet [Stream] vises øverst i kamerabildepanelet.
Trykk på [Stop stream]-knappen under strømming for å stoppe strømmingen. Knappen endres tilbake til [Stream now], og
ikonet [Stream] vises øverst i kamerabildepanelet.

Merknad

Avspilling i alle applikasjoner eller enheter garanteres ikke.

5-041-958-83(1) Copyright 2022 Sony Corporation

Strømmeformat URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX Se bruksanvisningen for den NDI|HX-kompatible klientenheten.
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Miniatyrbildeskjerm

Når du trykker på [Thumbnail]-knappen på skjermbildet for betjening av avspilling eller THUMBNAIL-knappen på
infrarød-fjernkontrollen, vises klipp som er tatt opp på minnekortet i kamerabildepanelet. Denne visningen i
kamerabildepanelet kalles miniatyrbildeskjermen.
Du kan velge et klipp på miniatyrbildeskjermen og starte avspillingen av klippet.
Når du trykker på [Thumbnail]-knappen under visning av miniatyrbildeskjermen, lukkes miniatyrbildeskjermen og går
tilbake til opptaksbildevisningen.

Merknad

Bare klippene som er tatt opp i det gjeldende opptaksformatet, vises på miniatyrbildeskjermen. Hvis et forventet opptak ikke
vises, kontroller opptaksformatet. Vær spesielt oppmerksom på dette før du formaterer (initialiserer) medier.

Skjermoppsett

Miniatyrbildet av et valgt klipp vises med oransje bakgrunn.
Informasjon om det valgte klippet vises nederst på skjermen.
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Valgt minnekort
Det vises et låseikon til høyre hvis minnekortet er skrivebeskyttet.

1.

Klippnummer / totalt antall klipp2.

Miniatyrbilde (indeksbilde)
Viser indeksbildet for et klipp. Når et klipp tas opp, angis det første bildet automatisk som indeksbilde.
Klipp/bilde-informasjon vises under miniatyrbildet. Du kan endre informasjonen som vises ved hjelp av [Thumbnail] >
[Customize View] > [Thumbnail Caption] i kameramenyen.

3.

Navn på klipp
Viser navnet til det valgte klippet.

4.

Opptaksformat
Viser filformatet til det valgte klippet.

5.

Spesiell opptaksinformasjon
Viser opptaksmodusen bare hvis klippet ble tatt opp med en spesiell opptaksmodus.
For klipp med sakte og rask bevegelse vises bildehastigheten til høyre.

6.

Klippvarighet7.

Opprettelsesdato8.
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Spille av innspilte klipp

Du kan spille av innspilte klipp når enheten er i standby-modus (Stby) for opptak.
Dette emnet beskriver hvordan du spiller av innspilte klipp ved hjelp av GUI-kontrollpanelet.

Sett inn minnekortet som skal spilles av.1

Trykk på [Thumbnail]-knappen.

Miniatyrbildene for klipp vises.

2

Bruk pilknappene i GUI-kontrollpanelet til å flytte markøren til miniatyrbildet for klippet du vil spille av.3
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Merknad

Det kan hende at det er korte bildebrudd eller visning av stillbilder på overgangen mellom klippene. Du kan ikke betjene enheten i
denne perioden.

Når du velger et klipp på miniatyrbildeskjermen og begynner avspillingen, kan det hende opptaket på begynnelsen av klippet har
bildeforvrengning en kort stund. Hvis du vil vise starten på klippet uten forvrengning, setter du avspillingen på pause, setter den
på pause, trykker på  (Forrige)-knappen for å gå tilbake til starten av klippet og starter avspillingen på nytt.
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Merknad

Klipp kan ikke velges ved berøringsfunksjon.

Trykk på [Set]-knappen i GUI-kontrollpanelet.

Avspillingen begynner fra begynnelsen av det valgte klippet.

4

Betjen kontrollpanelet for avspilling etter behov.

Hint

Du kan også kontrollere driften ved hjelp av GUI-kontrollpanelet.

Spill av: Trykk på [Set]-knappen.
Avspillingspause: Trykk på [Set]-knappen under avspilling. Trykk en gang til for å gå tilbake til normal avspilling.
Hopp til starten av klippet / starten av neste klipp: Trykk på venstre knapp / høyre knapp.
Spol fremover/bakover: Trykk og hold inne venstre knapp / høyre knapp. Avspillingen går tilbake til normal hastighet når
du slipper knappen.
Stopp avspilling: Trykk på [Cancel/Back]-knappen.

5

Knapp Funksjon

 (Spill av / Pause)-knapp Spiller av et klipp. Setter klippet på pause under avspilling.

 (Spol fremover)-knapp, 
(Spol bakover)-knapp

Spiller av et klipp i høy hastighet. Når du trykker på knappen, endres
avspillingshastigheten i tre trinn.

 (Forrige)-knapp,  (Neste)-
knapp

Hopper til starten av klippet eller det forrige/neste klippet.

 (Stop)-knapp Stopper avspillingen og bytter til opptaksskjermen.
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Betjening av innspilte klipp

På miniatyrbildeskjermen kan du betjene klippene eller kontrollere egenskaper for klipp ved hjelp av [Thumbnail]-menyen
i kameramenyen.
Trykk på [Menu]-knappen på skjermbildet for betjening av avspilling for å vise kameramenyen i kamerabildepanelet.
Du kan utføre følgende betjening ved hjelp av [Thumbnail]-menyen i kameramenyen.
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Hint

Du kan også trykke på [Menu]-knappen på skjermbildet for direkte betjening for å vise kameramenyen.

Betjening ved hjelp av [Thumbnail]-menyen i kameramenyen.
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Velg en funksjon som skal betjenes ved hjelp av pilknappene i GUI-kontrollpanelet og trykk på [Set]-knappen.
Trykk på [Cancel/Back]-knappen for å gå til forrige skjermbilde.

Merknad

Noen elementer kan ikke velges, avhengig av statusen da menyen ble vist.

Menyelementer for betjening av klipp

[Thumbnail]-menyen i kameramenyen har følgende menyelementer som gjelder betjening av klipp.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Hvis du vil ha mer informasjon om hvert menyelement, kan du se "[Thumbnail]-menyen".

Slik viser du skjermbildet for klippegenskaper
Select [Thumbnail] > [Display Clip Properties] i kameramenyen for å vise skjermbildet for klippegenskaper.
Trykk på  (Forrige)-knappen  (Neste)-knappen for å hoppe til forrige/neste klipp.

Slik legger du til klippflagg
Du kan legge klippflagg (merker OK, NG eller KP) til klipp for å filtrere visningen av klipp basert på klippflaggene.
Velg miniatyrbildet for klippet du vil legge til et klippflagg på, og velg deretter klippflagget ved hjelp av [Thumbnail] > [Set
Clip Flag] i kameramenyen.

Hint

Du kan også bruke en knapp som er tilordnet med klippflagg-funksjonen for å legge til klippflagg.

Slik viser du miniatyrbildeskjermen med filtrerte klipp
Velg [Thumbnail] > [Filter Clips] i kameramenyen, og velg en klippflaggtype for å vise bare de klippene som har det
angitte flagget.
Hvis du vil vise alle klippene, velger du [All].
Du kan også trykke på [Display]-knappen for å sortere miniatyrvisningen etter flagg.

Slik sletter du klipp
Du kan slette klipp fra minnekort.
Velg [Thumbnail] > [Delete Clip] > [Select Clip] eller [All Clips] i kameramenyen.
[Select Clip]: Sletter det valgte klippet. Valget av flere klipp støttes.
[All Clips]: Sletter alle viste klipp.

Slik endrer du informasjonen som vises på miniatyrbildeskjermen
Du kan endre informasjonen om klipp/bilde som vises under miniatyrbildet.

Innstilling Klippflagg som legges til

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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Velg [Thumbnail] > [Customize View] > [Thumbnail Caption] i kameramenyen, og velg informasjonen som skal vises.
[Date Time]: Viser datoen og klokkeslettet da klippet ble opprettet og sist endret.
[Time Code]: Viser tidskoden.
[Duration]: Viser varigheten av klippet.
[Sequential Number]: Viser et sekvensnummer for hvert miniatyrbilde.
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Konfigurasjon av kameramenyen

Når [Menu]-knappen i GUI-kontrollpanelet eller MENU-knappen på infrarød-fjernkontrollen trykkes, vises kameramenyen
for å konfigurere de forskjellige nødvendige innstillingene for opptak og avspilling i kamerabildepanelet.

Menyen inneholder følgende menyer.

Menykonfigurasjon

[User]-meny
Inneholder menyelementer som er konfigurert av brukeren.
Kan redigeres ved hjelp av [Edit User Menu].
[Edit User]-meny
Inneholder menyelementer for redigering av [User]-menyen.
[Shooting]-meny
Inneholder innstillinger som gjelder fotografering.
[Project]-meny
Inneholder grunnleggende prosjektinnstillinger.
[Paint/Look]-meny
Inneholder innstillinger som gjelder bildekvaliteten.
[Pan-Tilt]-meny
Inneholder innstillinger som gjelder pan/tilt.
[TC/Media]-meny
Inneholder innstillinger som gjelder tidskoder og opptaksmedier.

284



[Monitoring]-meny
Inneholder innstillinger som gjelder videoutgang og skjermbildevisning.
[Audio]-meny
Inneholder innstillinger som gjelder lyd.
[Thumbnail]-meny
Inneholder innstillinger som gjelder miniatyrbildevisning.
[Technical]-meny
Inneholder innstillinger for tekniske punkter.
[Network]-meny
Inneholder innstillinger som gjelder nettverk.
[Maintenance]-meny
Inneholder enhetsinnstillinger, for eksempel klokke og språk.

Konfigurasjon og hierarki for kameramenyen

Nivå 1 Nivå 2

User
(Fabrikkinnstillinger)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Nivå 1 Nivå 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Nivå 1 Nivå 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Nivå 1 Nivå 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Betjene kameramenyen

Når [Menu]-knappen i GUI-kontrollpanelet eller MENU-knappen på infrarød-fjernkontrollen trykkes, vises kameramenyen
for å konfigurere de forskjellige nødvendige innstillingene for opptak og avspilling i kamerabildepanelet.
Menyen betjenes ved hjelp av knapper i GUI-kontrollpanelet.

[Menu]-knapp: Trykk for å vise kameramenyen. Trykk en gang til mens kameramenyen vises for å skjule menyen.
Pilknapper: Trykk på pilknappene for å flytte markøren opp/ned/venstre/høyre i kameramenyen for å velge
menyelementer eller innstillinger.
[Set]-knapp: Trykk for å bruke det valgte elementet.
[Cancel/Back]-knapp: Trykk for å gå tilbake til forrige meny. En ufullført endring annulleres.

Merknad

Noen elementer kan ikke velges, avhengig av statusen da menyen ble vist.

Stille inn menyelementer

Flytt markøren til elementet du vil angi ved hjelp av pilknappene i GUI-kontrollpanelet, og trykk på [Set]-knappen for å
bruke innstillingen.

Valgområdet for menyelementet viser opptil åtte linjer. Hvis de tilgjengelige alternativene for et element ikke kan vises
samtidig, blar du i displayet ved å flytte markøren opp/ned.
For underpunkter med stort innstillingsområde (for eksempel −99 til +99) vises ikke innstillingsområdet. Den
gjeldende innstillingen er markert for å angi at verdien kan endres.
Hvis du velger [Execute] for en funksjon, utføres den tilsvarende funksjonen.
Hvis du velger et element som må bekreftes før utførelsen, skjules menyen midlertidig, og det vises en
bekreftelsesmelding. Kontroller meldingen, og velg deretter om funksjonen skal utføres eller avbrytes.
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Skrive inn en tegnstreng

Når du velger et element, for eksempel et filnavn som krever at det skrives noe, vises skjermbildet for tekst.

5-041-958-83(1) Copyright 2022 Sony Corporation

Trykk pilknappene i GUI-kontrollpanelet for å velge tegntype og bruke innstillingen.

[ABC]: Store bokstaver
[abc]: Små bokstaver
[123]: Tall
[!#$]: Spesialtegn

1

Velg et tegn, og trykk på [Set]-knappen for å bruke innstillingen.

Markøren flyttes til neste felt.
[Space]: Setter inn et mellomrom ved markørposisjonen.
[←] [→]: Flytter posisjonen til markøren.
[BS]: Sletter tegnet til venstre for markøren (tilbake).

2

Når du er ferdig trykker du på [Done]-knappen for å bruke innstillingen.

Tegnstrengen bekreftes, og tekstskjermen forsvinner.

3
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User

Dette emnet beskriver funksjonen og innstillingene for hvert menyelement.

Merknad

Du kan legge til og fjerne menyelementer i [User]-menyen ved hjelp av [Edit User]-menyen. Opptil 20 elementer kan konfigureres.

5-041-958-83(1) Copyright 2022 Sony Corporation

Element Beskrivelse

Base Setting Project > Base Setting-element

Focus Shooting > Focus-element

S&Q Motion Shooting > S&Q Motion-element

LUT On/Off Shooting > LUT On/Off-element

Simul Rec Project > Simul Rec-element

Proxy Rec Project > Proxy Rec-element

Interval Rec Project > Interval Rec-element

Picture Cache Rec Project > Picture Cache Rec-element

Assignable Button Project > Assignable Button-element

Scene File Project > Scene File-element

Base Look Paint/Look > Base Look-element

P/T Acceleration Pan-Tilt > P/T Acceleration-element

Clip Name Format TC/Media > Clip Name Format-element

Format Media TC/Media > Format Media-element

Video Signal Monitor Monitoring > Video Signal Monitor-element

Marker Monitoring > Marker-element

Zoom Technical > Zoom-element

Lens Technical > Lens-element

Edit User Menu Viser Edit User-menyen.
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Edit User

[Edit User]-menyen vises på øverste nivå når [Edit User Menu] er valgt i [User]-menyen.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Add Item
Legg til et element i
[User]-menyen

– –
Legger til et element på nivå 2 i [User]-
menyen.

Customize Reset
Tilbakestiller elementene
i [User]-menyen

– –
Gjenoppretter menyelementene som er
registrert i [User]-menyen til
fabrikkinnstillingene.

Menyelement på nivå 2
valgt under redigering

Delete –
Sletter det registrerte menyelementet for nivå
2 fra [User]-menyen.

Move –
Omorganiserer de registrerte
menyelementene i [User]-menyen.

Edit Sub Item –
Redigerer (registrerer/sletter) underelement
på nivå 3 registrert i [User]-menyen.
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ISO/Gain/EI

Angir forsterkningsinnstillinger.

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Mode ISO/dB dB
Velger modus for
forsterkningsinnstilling.

ISO/Gain<L>

Hvis du vil ha mer informasjon om
innstillinger, se "ISO/Gain-
innstillinger og standardverdier".

– Angir den forhåndsinnstilte
verdien for <L> forsterkning.

Exposure
Index<L>

Når Base ISO er satt til ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Når Base ISO er satt til ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Når Base ISO er satt til
ISO 800: 800EI / 6.0E
Når Base ISO er satt til
ISO 12800: 12800EI /
6.0E

Angir Exposure Index<L>-
verdien.

Shockless
Gain

On / Off Off
Slår funksjonen for forsterkning
uten støt av/på.

Base
Sensitivity

High / Low Low
Angir basisfølsomheten for
Custom-modus.

Base ISO ISO 12800 / ISO 800 ISO 800
Angir basis ISO-følsomhet for
Cine EI/Flexible ISO-modus.
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Beslektet emne
ISO/Gain-innstillinger og standardverdier
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ND Filter

Angir de forhåndsinnstilte verdiene for ND-filteret.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Mode Preset / Variable Variable Velger ND-filtermodus.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Angir forhåndsinnstilt verdi 1 for ND-filteret.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Angir forhåndsinnstilt verdi 2 for ND-filteret.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Angir forhåndsinnstilt verdi 3 for ND-filteret.
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Shutter

Stille inn funksjonen for elektronisk lukker.
Brukes til å ta klare bilder av motiver i rask bevegelse.

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Mode Speed / Angle Speed

Velger modus for innstilling av
lukkerhastigheten i sekunder
(Speed) eller som en lukkervinkel
(Angle).

Shutter
Speed
On/Off

On / Off Off

Angir om eksponeringstiden, når
Speed-modus er valgt, følger
verdien for [Shutter Speed] eller om
den er stilt inn for full eksponering.

Shutter
Speed

64F til 1/8000
De tilgjengelige innstillingene varierer
avhengig av rammefrekvensen til det valgte
videoformatet.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F
/ 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125
/ 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100
/ 1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F
/ 3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 /
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P: 1/24

Angir lukkerhastigheten når Speed-
modus er valgt.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 360.0° / 300.0° / 270.0° / 240.0° /
216.0° / 210.0° / 180.0° / 172.8° / 150.0° /
144.0° / 120.0° / 90.0° / 86.4° / 72.0° / 45.0°
/ 30.0° / 22.5° / 11.25° / 5.6°

180.0°
Angir lukkervinkelen når Angle-
modus er valgt.

ECS On/Off On / Off Off Slår funksjonen ECS (utvidet klar
skanning) av/på.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

ECS
Frequency

23.99 til 8000
De tilgjengelige innstillingene varierer
avhengig av rammefrekvensen til det valgte
opptaksformatet.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Angir ECS-frekvensen når Mode er
satt til ECS.
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Iris

Angir irisinnstillinger.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Bokeh Control On / Off Off Slår Bokeh-kontrollfunksjonen av/på.
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Auto Exposure

Angir innstillinger for justering av automatisk eksponering.

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75
/ +1.5 / +1.25 / +1.0 / +0.75 / +0.5 /
+0.25 / ±0 / −0.25 / −0.5 / −0.75 / −1.0 /
−1.25 / −1.5 / −1.75 / −2.0 / −2.25 / −2.5
/ −2.75 / −3.0

±0
Angir lysstyrkenivået for den automatisk
registrerte eksponeringen.

Mode Backlight / Standard / Spotlight Standard

Angir driftsmodusen for automatisk
eksponeringsjustering.
Backlight: Baklysmodus (modus for
redusert mørkfarging av et motiv når
motivet er bakgrunnsbelyst)
Standard: Standard modus
Spotlight: Lyskastermodus (modus for
redusert antall beskårne hvite felter når
motivet er punktvis opplyst)

Speed −99 til +99 ±0 Angir justeringshastigheten for
automatisk eksponeringsjustering.

AGC On / Off Off
Slår funksjonen AGC (automatisk
forsterkningskontroll) av/på.

AGC Limit

Hvis du vil ha mer informasjon om
innstillinger, se "AGC Limit-
innstillinger og standardverdier".

– Angir maksimal forsterkning for AGC-
funksjonen.

AGC Point F2.8 / F4 / F5.6 F2.8
Angir F-stoppverdien for irisen der
AGC-operasjonen starter når AGC-
funksjonen er On.

Auto
Shutter

On / Off Off
Slår funksjonen automatisk
lukkerkontroll av/på.

A.SHT
Limit

1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Angir den raskeste lukkerhastigheten
for den automatiske lukkerfunksjonen.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Angir F-stoppverdien for irisen der den
automatiske lukkeroperasjonen starter.

Clip High
light On / Off Off

Slår funksjonen som ignorerer lyseste
områder for å gi en flatere respons ved
høy luminans av/på.
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Beslektet emne

AGC Limit -innstillinger og standardverdier
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Angir lysmålingsområdet for automatisk
justering av eksponeringen i henhold til
motivets lysstyrke. (Ikke tilgjengelig ved
manuell justering av eksponering)

Detect
Window
Indication

On / Off Off
Slår indikasjonen av lysmålingsområdet
av/på.

Custom
Width

40 til 999 500 Angir bredden på lysmålingsområdet.

Custom
Height

70 til 999 500 Angir høyden på lysmålingsområdet.

Custom H
Position

−479 til +479 ±0
Angir den horisontale posisjonen på
lysmålingsområdet.

Custom V
Position

−464 til +464 ±0
Angir den vertikale posisjonen på
lysmålingsområdet.
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White

Setter innstillinger for hvitbalanse.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Preset
White

2000K til 15000K 3200K Angir den forhåndsinnstilte verdien for hvitbalanse.

Color
Temp <A>

2000K til 15000K 3200K

Stiller inn fargetemperaturen for hvitbalanse som lagres i
minne A.

Merknad

Siden Color Temp kuttes ved 2000K og 15000K når R Gain/B
Gain brukes, kan det hende at det ikke er mulig å vise riktig
Color Temp-verdi for R Gain/B Gain-verdien.

Tint<A> −99 til +99 ±0

Stiller inn fargetonen for hvitbalanse som lagres i minne A.

Merknad

Siden Tint kuttes ved ±99 når R Gain/B Gain brukes, kan det
hende at det ikke er mulig å vise riktig fargetoneverdi for R
Gain/B Gain-verdien.

R Gain
<A>

−99.0 til +99.0 ±0.0
Stiller inn hvitbalanse R forsterkningsverdi som lagres i minne
A.

B Gain
<A>

−99.0 til +99.0 ±0.0
Stiller inn hvitbalanse B forsterkningsverdi som lagres i minne
A.
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White Setting

Justerer innstillinger for hvitbalanse.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Shockless
White

Off / 1 / 2 / 3 2

Angir responshastigheten for hvitbalanse ved skifte av
hvitbalansemodus.
Off: Skifter umiddelbart.
1 til 3: Skifter saktere jo høyere tall.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Angir responshastigheten for ATW-modus.
Den raskeste responshastigheten er 1, og den laveste
responshastigheten er 5.
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Offset White

Setter innstillinger for hvitbalanseforskyvning.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Offset White <A> On / Off Off
Velger om du vil legge til (On) eller ikke legge til (Off)
en forskyvningsverdi til hvitbalansen i minne A.

Offset Color
Temp<A>

−99 til +99 ±0
Angir forskyvning av fargetemperatur som skal legges
til hvitbalansen i minne A når [Offset White <A>] er
satt til On.

Offset Tint<A> −99 til +99 ±0
Angir forskyvning av fargetoneverdi som skal legges
til hvitbalansen i minne A når [Offset White <A>] er
satt til On.

Offset
White<ATW>

On / Off On
Velger om du vil legge til (On) eller ikke legge til (Off)
en forskyvningsverdi i ATW-hvitbalanse.

Offset Color
Temp<ATW>

−99 til +99 ±0
Angir forskyvning av fargetemperatur som skal legges
til ATW-hvitbalansen når [Offset White<ATW>] er satt
til On.

Offset Tint<ATW> −99 til +99 ±0
Angir forskyvning av fargetoneverdi som skal legges
til ATW-hvitbalansen når [Offset White<ATW>] er satt
til On.
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Focus

Angir fokusinnstillinger.

Beslektet emne

Stille inn autofokusområde/-posisjon (Focus Area)

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 / 5
/ 6 / 7(Fast)

5
Angir hastigheten på fokusmotoren for når motivet endres
under autofokusering.

AF Subj.
Shift Sens.

1(Locked On) / 2 / 3
/ 4 / 5(Responsive)

5(Responsive)
Angir følsomheten for endring av fokus på motiv under
autofokus.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Angir målområdet for autofokus og Push Auto Focus (AF).
Se "Justere fokus automatisk (autofokus)" og "Stille
inn autofokusområde/-posisjon (Focus Area)".

Wide: Søker etter et motiv over en vid vinkel i bildet når
du fokuserer.
Zone: Søker automatisk etter et fokuspunkt innenfor den
angitte sonen.
Flexible Spot: Fokuserer på en angitt posisjon i bildet.

Focus Area
(AF-S)

Flexible Spot Flexible Spot
Angir målområdet for autofokus med push autofokus (AF-
S).

Face/Eye
Detection AF

Face/Eye Only AF /
Face/Eye Priority AF
/ Off

Face/Eye Priority
AF

Aktiverer/deaktiverer ansiktsdeteksjon AF.

Se "Sporing med ansikts-/øyedeteksjon (Face/Eye
Detection AF)".

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Angir modus for push-autofokus.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Angir operasjonen når kamerabildet berøres på Web App-
ens skjermbildet for direkte betjening i MF-modus.

AF Assist On / Off On

Når den er satt til On, kan du midlertidig overstyre
autofokus og sette fokus manuelt.

Se "Angi autofokusmålet manuelt (AF Assist) ved
hjelp av Web App" og "Fokusere manuelt under
autofokus ved hjelp av den medfølgende infrarød-
fjernkontrollen".
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Sporing med ansikts-/øyedeteksjon (Face/Eye Detection AF)

Angi autofokusmålet manuelt (AF Assist) ved hjelp av Web App

Fokusere manuelt under autofokus ved hjelp av den medfølgende infrarød-fjernkontrollen
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S&Q Motion

Angir innstillinger for sakte og hurtig bevegelse (se "Sakte og rask bevegelse").

Beslektet emne
Sakte og rask bevegelse
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off Slår sakte og hurtig modus av/på.

Frame
Rate

1fps til 60fps / 100fps / 120fps /
150fps / 180fps / 200fps /
240fps

–

Angir bildehastigheten for opptak av sakte og
rask bevegelse.

Merknad

De tilgjengelige innstillingene varierer avhengig
av den valgte bildefrekvensen, kodeken og
videoformatet.
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LUT On/Off

Angir LUT-innstillinger.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

SDI MLUT On / MLUT Off MLUT Off
Velger om Monitor LUT skal brukes på SDI-
utgangsvideoen.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Velger om Monitor LUT skal brukes på HDMI-
og strømmeutgangsvideoen.

Proxy MLUT On / MLUT Off MLUT Off
Velger om Monitor LUT skal brukes på proxy-
opptaksvideoen.

Internal Rec MLUT On / MLUT Off MLUT Off
Velger om Monitor LUT skal brukes på
hovedopptaksvideoen.

LUT On/Off
Button Target

SDI / HDMI/Stream / SDI
og HDMI/Stream

HDMI/Stream
Angir målutgangen som kontrolleres av en
knapp som er tilordnet med LUT On/Off.
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Noise Suppression

Angir innstillinger for støydemping.

Hint

Innstillingene for [Setting(Custom)] og [Level(Custom)] vises i [Target Display]-innstillingen .
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting(Custom) On / Off On
Slår støydempingsfunksjonen av/på i
Custom-modus.

Level(Custom) Low / Mid / High Mid Angir støydempingsnivået i Custom-modus.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Slår støydempingsfunksjonen av/på i Log
shooting-modus.

Level (Cine EI/Flex.
ISO) Low / Mid / High Mid

Stiller inn støydempingsnivået i Log shooting-
modus.
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Flicker Reduce

Angir innstillinger for flimmerkorrigering.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Mode Auto / On / Off Off Angir modusen for flimmerkorrigering.

Frequency 50Hz / 60Hz 60Hz
Angir frekvensen til strømkilden som leverer belysningen
som forårsaker flimringen.
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SteadyShot

Angir innstillinger for bildestabilisering.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting Active / Standard / Off Off

Angir funksjonen for bildestabilisering.

Merknad

Aktivert når et kompatibelt objektiv er koblet til.

Når den er satt til Active eller Standard, kan det oppstå
uventet virkemåte under pan/tilt-betjening.
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Base Setting

Angir grunninnstillinger.

Beslektet emne

Konfigurere grunnleggende drift
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Angir opptaksmodusen.

Se "Angi opptaksmodus" i "Konfigurere
grunnleggende drift".

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Angir fargerommet for opptak/utdata i
Custom-modus.
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Rec Format

Angir innstillinger for opptaksformat.

[RAW Output Format]-innstillinger

Standardverdier vises med fet skrift.
Betingelsene som [RAW Output Format] ikke kan angis under, er utelatt.

[Video Format]-innstillinger

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Velger systemfrekvens.

Imager Scan
Mode

FF / S35 FF Velger Imager-størrelse.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Angir codec for opptak/avspilling av
klippet.

Merknad

Når [Imager Scan Mode] er satt til
[S35], kan ikke [RAW] og [RAW &
XAVC-I] ikke velges.

RAW Output
Format

De tilgjengelige innstillingene varierer
avhengig av [Frequency]-innstillingen.

Se "[RAW Output Format]-
innstillinger" nedenfor.

–

Angir størrelsen på RAW-bildet som skal
sendes ut til en ekstern RAW-opptaker.

Merknad

Når [Codec] er satt til [RAW & XAVC-
I], skiftes [Video Format]-innstillingen i
samsvar med [RAW Output Format]-
innstillingen.

Video
Format

De tilgjengelige innstillingene varierer
avhengig av innstillingene
[Frequency], [Imager Scan Mode] og
[Codec].

Se "[Video Format]-innstillinger"
nedenfor.

– Stiller inn bildestørrelsen og bithastighet.

Frequency Imager Scan Mode Codec Innstilling

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Standardverdier vises med fet skrift.
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Frequency Imager Scan Mode Codec Innstilling

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Angir innstillinger for Log shooting-modus (se "Angi shooting-modus" i "Konfigurere grunnleggende drift").

Beslektet emne

Konfigurere grunnleggende drift
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Stiller inn fargerommet for Log shooting-
moduser ([Flexible ISO], [Cine EI Quick], [Cine
EI]).

Embed LUT
File

On / Off On
Slår av/på 3D LUT-fil (CUBE-fil) metadata-
opptak.
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Simul Rec

Angir innstillinger for modus for samtidig opptak med to spor (se "Ta opp på minnekort A og B samtidig (opptak med to
spor)").
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off
Slår samtidig 2-spors
opptaksfunksjon av/på.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec
Button:<Slot A> <Slot B> / Rec Button:
<Slot A> 2nd Rec Button:<Slot B> / Rec
Button:<Slot B> 2nd Rec Button:<Slot A>

Rec Button:<Slot A> <Slot
B> 2nd Rec Button:<Slot
A> <Slot B>

Tilordner opptaksknappene
som brukes til å styre hvert
enkelt av opptaksmediene.
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Proxy Rec

Angir innstillinger for proxy-opptaksmodus (se "Proxy-opptak").
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off Slår proxy-opptaksmodus av/på.

Audio
Channel

CH1/CH2 / CH3/CH4 CH1/CH2
Velger lydkanalen som skal tas opp til proxy-
data.
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Interval Rec

Angir innstillinger for intervallopptaksmodus (se "Opptak av video med jevne mellomrom (intervallopptak)").

5-041-958-83(1) Copyright 2022 Sony Corporation

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off

Slår intervallopptaksmodus av/på.
(Hvis du setter denne modusen til
On, settes alle andre spesialmoduser
til Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (sek)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (time)

1
Angir intervallet mellom opptak i
opptaksmodusen Interval Rec (når
Interval Rec er satt til On).

Number
of Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
De tilgjengelige innstillingene
varierer avhengig av
rammefrekvensen til det valgte
videoformatet.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Angir antall rammer som skal tas per
opptak i opptaksmodusen Interval
Rec (når Interval Rec er satt til On).
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Picture Cache Rec

Stiller inn bildets cache-opptaksmodus (se "Opptak av cachet-bilder (Picture Cache Rec)").

Beslektet emne

Opptak av cachet-bilder (Picture Cache Rec)
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off Slår bildets cache-funksjon av/på.

Cache Size
Short / Medium / Long /
Max

Max
Stiller inn tiden for akkumulering av bilder i cache-
minnet (opptakstid for bilde-cache).

Cache Rec
Time

– –
Viser tiden for akkumulering av bilder i cache-minnet
(opptakstid for bilde-cache).
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SDI/HDMI Rec Control

Angir innstillinger for SDI/HDMI-opptakskontroll.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting
Off / SDI/HDMI
Remote I/F / Parallel
Rec

Off

Angir start/stopp-kontroll av opptak i en ekstern tilkoblet enhet
via SDI/HDMI-utgangssignalet.
Off: Ikke bruk fjernkontroll.
SDI/HDMI Remote I/F: Stopp/start-kontroll av opptak i en
ekstern tilkoblet enhet, når det ikke er satt inn noe medium i
enheten. Ikke synkronisert med rammenøyaktighet til medier i
enheten.
Parallel Rec: Stopp/start-kontroll av opptak i en ekstern
tilkoblet enhet, når det er satt inn medium i enheten.
Synkronisert med rammenøyaktighet til medier i enheten.

Merknad

For å kontrollere HDMI-utgangssignalet, sett [TC/Media] >
[HDMI TC Out] > [Setting] til [On] i kameramenyen.
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Assignable Button

Angir funksjonstilordninger til knapper som kan tilordnes (<1> til <9>) og [Focus Hold Button].
Følgende funksjoner kan tilordnes.
[Off]: Ingen funksjonstilordning.
[Base ISO/Sensitivity]: Endrer bildesensorens basisfølsomhet.
[AGC]: Slår AGC-funksjonen av/på.
[Push AGC]: Aktiverer AGC-funksjonen mens knappen trykkes inn.
[ND Filter]

I variabel modus: Justerer ND-filteroverføringen. Trykk og hold for å veksle mellom Clear/Manual/Auto.
I forhåndsinnstilt modus: Trykk og hold for å bytte forhåndsinnstillinger.

[ND Filter Position]: Skifter ND-filtre.
[Auto ND Filter]: Slår auto ND-filterfunksjonen av/på.
[Push Auto ND]: Aktiverer funksjonen auto ND-filter mens knappen trykkes inn.
[Auto Iris]: Slår irisfunksjonen av/på.
[Push Auto Iris]: Aktiverer automatisk irisfunksjon mens knappen trykkes inn.
[Bokeh Control]: Slår Bokeh-kontrollfunksjonen av/på.
[Auto Shutter]: Slår funksjonen automatisk lukkerkontroll av/på.
[AE Level/Mode]: Justerer AE-nivået. Trykk og hold for å bytte AE-modus.
[Backlight]: Veksler mellom Backlight og Standard.
[Spotlight]: Veksler mellom Spotlight og Standard.
[Preset White Select]: Endrer verdien for forhåndsinnstilt hvitbalansemodus.
[ATW]: Slår ATW-funksjonen av/på.
[ATW Hold]: Stanser ATW-funksjonen midlertidig.
[AF Speed/Sens.]: Endrer innstillingen for AF-overgangshastighet og innstillingen for AF-motivets følsomhet.
[Focus Setting]: Angir fokusområdet.
[Face/Eye Detection AF]: Endrer AF-innstillingene for ansiktsdeteksjon.
[Push AF Mode]: Endrer innstillingen for Push AF-modus.
[Push AF/MF]: I MF-fokusmodus aktiveres AF mens knappen trykkes inn. I AF-fokuseringsmodus aktiveres MF mens
knappen trykkes inn.
[Focus Hold]: I AF-fokuseringsmodus er fokus låst mens knappen trykkes inn.
[S&Q Motion]: Slår funksjonen for sakte og rask bevegelse av/på. Angir bildehastigheten hvis du trykker og holder inne.
[LUT On/Off]: Slår LUT-funksjonen av/på. Vekslingsmålet angis ved hjelp av [Shooting] > [LUT On/Off] > [LUT On/Off
Button Target].
[SteadyShot]: Veksler mellom Active, Standard og Off.
[Crop Select]: Veksler Imager Scan Mode. Veksling er aktivert innenfor området uten å endre innspillingsformatet.
[Rec]:Starter/stopper opptak.
[Picture Cache Rec]: Slår bildets cache-opptaksmodus av/på.
[Rec Review]: Slår funksjonen opptaksgjennomgang av/på.
[Clip Flag OK]: Utfører Add OK. Trykk to ganger for å utføre Delete Clip Flag.
[Clip Flag NG]: Utfører Add NG. Trykk to ganger for å utføre Delete Clip Flag.
[Clip Flag Keep]: Utfører Add KEEP. Trykk to ganger for å utføre Delete Clip Flag.
[Slot Select]: Veksler mellom minnespor (A) og (B).
[Color Bars]: Slår fargestolpene av/på.
[DURATION/TC/U-BIT]: Veksler mellom Time Code, Users Bit og Duration.
[Display]: Slår skjermindikatorene av/på.
[Lens Info]: Skifter dybdeskarphetsindikatoren.
[Video Signal Monitor]: Skifter videosignalskjermen (for eksempel en kurveskjerm).
[Marker]: Slår markørfunksjonen av/på.
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[Thumbnail]: Viser/lukker miniatyrbildeskjermen.
[Auto Upload (Proxy)]: Slår automatisk overføring av proxy-fil av/på.
[Direct Menu]: Viser/lukker hurtigmenyen.
[User Menu]: Viser/lukker User-menyen.
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Scene File

Angir innstillinger som gjelder scenefiler (se "Ta bilder med ønsket utseende").
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Recall – –
Laster inn en scenefil som er lagret i det
interne minnet, og bruker innstillingene som
de gjeldende innstillingene for bildekvalitet.

Store – –
Lagrer gjeldende bildekvalitetsstatus som en
scenefil i det interne minnet.

Delete – –
Sletter en scenefil som er lagret i
internminnet.

Preset
Recall

Når Shooting Mode er satt til
Custom og Target Display er satt til
SDR(BT.709): S-Cinetone / Standard
/ Still / ITU709/ 709tone
Når Shooting Modeer satt til
Custom og Target Display er satt til
HDR(HLG): HLG Live / HLG Natural

–
Bruker forhåndsinnstilte
bildekvalitetsinnstillinger (ikke-overskrivbare)
som gjeldende innstillinger for bildekvalitet.
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Base Look

Angir innstillinger som gjelder basisutseende.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Select

Når Shooting Mode er satt til
Custom og Target Display er satt
til SDR(BT.709): S-Cinetone /
Standard / Still / ITU709 / 709tone /
User1 til User16
Når Shooting Mode er satt til
Custom og Target Display er satt
til HDR(HLG): HLG Live / HLG
Natural / User1 til User16
Når Shooting Mode er satt til
Log shooting: s709 / 709(800) /
S-Log3 / User1 til User16

Når Shooting Mode er satt
til Custom og Target
Display er satt til
SDR(BT.709): S-Cinetone
Når Shooting Mode er satt
til Custom og Target
Display er satt til
HDR(HLG): HLG Live
Når Shooting Mode er satt
til Log shooting: s709

Velger et basisutseende.

Delete – – Sletter det valgte basisutseendet.

Delete All – – Sletter alle basisutseender.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Angir inndataområdet for
basisutseendet som er valgt ved
hjelp av [Select].

Output BT.709 / HLG BT.709
Angir utgangsfargeområdet for
basisutseendet som er valgt ved
hjelp av [Select].

AE Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV
/ 5/3EV / 2EV

0EV
Angir eksponeringsreferanseverdien
for basisutseendet som er valgt ved
hjelp av [Select].
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Reset Paint Settings

Tilbakestiller innstillingene for [Paint/Look]-menyen, unntatt basisutseende.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Reset without
Base Look

Execute / Cancel –
Tilbakestiller innstillingene for [Paint/Look]-
menyen, unntatt basisutseende.
Execute: Utfør funksjon.
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Black

Angir sorte innstillinger.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Master Black −99.0 til +99.0 ±0.0 Angir nivået for hoved-sort.

R Black −99.0 til +99.0 ±0.0 Angir nivået for R-sort.

B Black −99.0 til +99.0 ±0.0 Angir nivået for B-sort.
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Knee

Angir innstillinger for knekorrigering.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting

Når Target Display er satt
til SDR(BT.709): On / Off / -
--
Når Target Display er satt
til HDR(HLG): On / Off / ---

Når Target Display er satt
til SDR(BT.709):Off
Når Target Display er satt
til HDR(HLG): Off

Slår funksjonen for knekorreksjon av/på.

Merknad

Aktivert kun når [Base Look] > [Select] er
satt til [Standard], [ITU709], [709tone],
[HLG Live], eller [HLG Natural].

Auto
Knee

Når Target Display er satt
til SDR(BT.709): On / Off / -
--
Når Target Display er satt
til HDR(HLG): On / Off / ---

Når Target Display er satt
til SDR(BT.709):On
Når Target Display er satt
til HDR(HLG): Off

Slår den automatiske knefunksjonen av/på.

Merknad

Aktivert kun når [Base Look] > [Select] er
satt til [Standard], [ITU709], eller [709tone].

Point 75% til 109% 90% Angir knepunktet.

Slope −99 til +99 ±0 Angir hellingen for kneet.
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Detail

Angir innstillinger for detaljjustering.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting On / Off On Slår den detaljfunksjonen av/på.

Level −7 til +7 ±0 Angir detaljnivået.

Manual
Setting

On / Off / --- Off Slår funksjonen for manuell justering av detaljer av/på.

H/V Ratio −2 til +2 ±0

Stiller inn balansen mellom horisontale (H) og vertikale (V)
detaljer for manuell justering av detaljer.

Merknad

Dette elementet varierer, avhengig av

programvareversjonen.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Angir balansen mellom de svarte (B) detaljene for områder
med lav lystetthet og de hvite (W) detaljene for områder
med høy lystetthet for manuell justering av detaljer.

Limit 0 til 7 7 Angir detaljnivå for manuell justering av detaljer.

Crispening 0 til 7 0 Angir konturforsterkningen for manuell justering av detaljer.

High Light
Detail

0 til 4 0
Angir detaljnivået for områder med høy lysstyrke for manuell
justering av detaljer.

I programvareversjon 1.00 er menyelementet [V/H Balance]. I programvareversjon 1.10 eller nyere er menyelementet [H/V Ratio].
Innstillingsområdet er uendret fra −2 til 0 til +2, men effekten på bildekvaliteten er forskjellig.
Programvareversjon 1.00: Jo høyere innstilt verdi, jo høyere horisontale (H) detaljer.
Programvareversjon 1.10 eller nyere: Jo høyere innstilt verdi, jo høyere vertikale (V) detaljer.
Etter oppdatering fra programvareversjon 1.00 til 1.10 eller nyere, arves [All File], [Scene File] og andre innstillinger, men med invertert polaritet
(bildekvaliteten opprettholdes).
Hvis du har registrert [V/H Balance]-menyelementet i [User]-menyen, vil det automatisk erstattes med [H/V Ratio]-menyelementet i [User]-
menyen etter oppdatering av programvaren.

*1
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Matrix

Angir innstillinger for matrisekorrigering.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

User Matrix On / Off Off
Slår funksjonen for korreksjon av
brukermatrisen av/på.

User Matrix
Level

−99 til +99 ±0 Justerer fargemetningen for hele bildet.

User Matrix
Phase

−99 til +99 ±0 Justerer fargetonen (fasen) i hele bildet.

User Matrix R-G −99 til +99 ±0 Angir en brukerdefinert R-G-brukermatrise.

User Matrix R-B −99 til +99 ±0 Angir en brukerdefinert R-B-brukermatrise.

User Matrix G-R −99 til +99 ±0 Angir en brukerdefinert G-R-brukermatrise.

User Matrix G-B −99 til +99 ±0 Angir en brukerdefinert G-B-brukermatrise.

User Matrix B-R −99 til +99 ±0 Angir en brukerdefinert B-R-brukermatrise.

User Matrix B-G −99 til +99 ±0 Angir en brukerdefinert B-G-brukermatrise.
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Multi Matrix

Angir innstillinger for multimatrisekorrigering.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off
Slår funksjonen for
multimatrisekorrigering av/på.

Reset Execute / Cancel –
Tilbakestiller nyanse og metning for hver
aksefarge til standardverdiene.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL−
/ YL / YL+ / G− / G / G+ / CY / CY+ / B−

B Velger aksen.

Hue −99 til +99 ±0 Angir fargetonen til fargen som brukes til
multimatrisekorreksjon.

Saturation −99 til +99 ±0
Angir fargemetningen som brukes til
multimatrisekorreksjon.
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P/T Acceleration

Angir innstillinger som gjelder akselerasjon for pan/tilt-betjening.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Ramp
Curve

1 til 9 8
Velger akselerasjon/retardasjon for pan/tilt-betjening. Jo
større tall, jo høyere akselerasjon.
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Timecode

Angir tidskodeinnstillinger.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Mode Preset / Regen / Clock Preset

Angir kjøremodusen for tidskoder.
Preset: Begynner å kjøre fra en forhåndsinnstilt verdi.
Regen: Begynner å kjøre fra tidskoden på slutten av
forrige klipp.
Clock: Bruker den interne klokken som tidskode.

Run Rec Run / Free Run Rec Run
Rec Run: Kjører bare under opptak.
Free Run: Kjører alltid, uavhengig av
opptaksbetjening.

Setting – –
Setter tidskoden til en vilkårlig verdi.
Set: Angi verdien.

Reset Execute / Cancel –
Tilbakestiller tidskoden til 00:00:00:00.
Execute: Utfør funksjon.

TC
Format DF / NDF DF

Angir tidskodeformatet.
DF: Drop Frame
NDF: Non-Drop Frame
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TC Display

Angir innstillinger for visning av tidsdata.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Display Select Timecode / Users Bit / Duration Timecode Skifter visning av tidsdata.
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Users Bit

Angir innstillinger som gjelder brukerbits.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Mode Fix / Time Fix

Angir brukerbitsmodus.
Fix: Bruker en vilkårlig fast verdi i brukerbits.
Time: Bruker gjeldende time, minutt og sekund
brukerbits.

Setting – – Setter brukerbits til en vilkårlig verdi.
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HDMI TC Out

Angir innstillinger som gjelder tidskodeutgangen ved bruk av HDMI.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off
Angir om tidskode skal sendes til enheter for andre formål
ved hjelp av HDMI.
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Clip Name Format

Angir innstillinger som gjelder navn og sletting av klipp.
Når [Auto Naming] er satt til [Cam ID + Reel#], fastsettes de fire første tegnene i klippnavn for hvert opptaksmedium. Når
nye opptaksmedier settes inn, eller når det siste klippet på opptaksmediet ikke matcher [Camera ID]- eller [Reel
Number]-innstillinger, blinker klippnavnet for å varsle deg.
Når [Auto Naming] er satt til [Title], kan du bruke en vilkårlig tegnstreng som den første delen av klippnavn.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Auto
Naming

Cam ID + Reel# / Title

Velger klippnavnformatet.
Cam ID + Reel#: Camera ID + Reel Number + Shot
Number + dato + vilkårlig streng
Title: Vilkårlig streng angitt av [Title Prefix] +
klippnummer

Camera
ID

A til Z A

Setter kamera-ID som brukes ved generering av
klippnavn.

Merknad

Konfigurerbart kun når [Auto Naming] er satt til [Cam ID
+ Reel#].

Reel
Number

001 til 999 001

Setter rullnummerdel som brukes ved generering av
klippnavn.

Merknad

Konfigurerbart kun når [Auto Naming] er satt til [Cam ID
+ Reel#].

Camera
Position

C / L / R C

Setter den første tegndelen av Shot Number som bruke
ved generering av klippnavn.

Merknad

Konfigurerbart kun når [Auto Naming] er satt til [Cam ID
+ Reel#].

Title Prefix
nnn_(nnn er de siste tre
sifrene i serienummeret)
(Maks. 7-sifret visning)

nnn

Angir titteldelen (4 til 46 tegn) for klippnavnet.
Åpner et skjermbilde der du kan angi tegnstrenger.

Hvis du vil ha mer informasjon om hvordan du angir
titler og skjermbildet for tegnangivelse, se "Slik angir
du tittelen" nedenfor og "Skrive inn en tegnstreng".

Merknad

Konfigurerbart kun når [Auto Naming] er satt til [Title].
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Angi [Title Prefix]

Beslektet emne
Skrive inn en tegnstreng
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Number
Set

0001 til 9999 0001

Angir 4-sifret tallsuffiks for klippnavnet.

Merknad

Konfigurerbart kun når [Auto Naming] er satt til [Title].

Velg tegnet som skal settes inn ved markørposisjonen i [Title Prefix]-området fra tegnvalgområdet ved hjelp
av pilknappene i GUI-kontrollpanelet (tegnet er uthevet), og trykk på [Set]-knappen i GUI-kontrollpanelet.

Det valgte tegnet settes inn, og markøren flyttes mot høyre.

1

Gjenta trinn 1 for å angi tittelen.

Bruk [BS] ved behov.

2

Når tittelen er lagt inn, trykk på [Done]-knappen for å lukke skjermen for innlegging av tegn.

Hvis du vil ha mer informasjon om hvordan du bruker operasjonen på skjermbildet for tegnangivelse, se "Skrive
inn en tegnstreng".

Følgende tegn kan velges.
!#$%()+,-.;=@[ ]^_~ mellomrom
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Oppdaterer administrasjonsfilen på minnekort (se "Gjenopprette minnekort").

Beslektet emne

Gjenopprette minnekort
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Media(A) Execute / Cancel –
Oppdaterer administrasjonsfilen på minnekortet i spor
A.
Execute: Utfør funksjon.

Media(B) Execute / Cancel –
Oppdaterer administrasjonsfilen på minnekortet i spor
B.
Execute: Utfør funksjon.
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Format Media

Formatere (initialisere) minnekort (se "Formatere (initialisere) minnekort)".

Beslektet emne
Formatere (initialisere) minnekort
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Media(A) Full Format / Quick Format / Cancel – Formaterer minnekortet i spor A.

Media(B) Full Format / Quick Format / Cancel – Formaterer minnekortet i spor B.
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Media Life

Viser gjenværende levetid for minnekortene.

Merknad

Krever minnekort som støtter visning av gjenværende medielevetid.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Media(A) – – Viser gjenværende levetid for minnekortet i spor A.

Media(B) – – Viser gjenværende levetid for minnekortet i spor B.
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Output Format

Angir innstillinger for utdataformat.

Beslektet emne
Utdataformater og -begrensninger
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

SDI Hvis du vil ha mer informasjon om innstillinger, se
"Utdataformater og -begrensninger".

– Angir oppløsningen for SDI- og
HDMI-utgangene.HDMI –
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Display On/Off

Angir innstillinger for skjermelementer.
Hvis du vil vise et visningselement, velger du On. Hvis du vil skjule et visningselement, velger du Off.

Element Innstilling for underelement Fabrikkinnstilling

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Element Innstilling for underelement Fabrikkinnstilling

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Angir innstillinger for videosignalskjerm.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting
Off / Waveform / Vector /
Histogram

Off Angir typen videosignalskjerm.

Level Marker
1

0% til 109% 70%
Angir nivået for nivåmarkør 1 for
lystetthet.

Level Marker
2

0% til 109% 100%
Angir nivået for nivåmarkør 2 for
lystetthet.
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Marker

Angir innstillinger for markørvisning.

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off On Slår visningen av alle markører av/på.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Velger fargen på markørsignalet.

Center
Marker

1 / 2 / 3 / 4 / Off Off Velger sentermarkøren.

Safety Zone On / Off Off Slår sikkerhetssonemarkøren av/på.

Safety Area 80% / 90% / 92.5% / 95% 90% Velger størrelsen på sikkerhetssonemarkøren
(i prosent av total skjermstørrelse).

Aspect
Marker

Line / Mask / Off Off Velger typen aspektmarkør.

Aspect
Mask

0 til 15 12
Angir nivået for videosignalet utenfor
markøren.

Aspect
Safety Zone

On / Off Off
Slår indikatoren for aspektsikkerhetssonen
av/på.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Velger størrelsen på markøren for
aspektsikkerhetssonen (som prosent av total
skjermstørrelse).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9
/ 17:9 / 1.66:1 / 1.85:1 / 2.35:1 /
2.39:1 / Custom

2.39:1 Angir modus for visning av aspektmarkøren.

Custom
Aspect
Ratio

Angi en vilkårlig verdi. 01.00:01.00

Setter aspektforholdet til en vilkårlig verdi.

Merknad

Aktivert når [Aspect Select] er satt til
[Custom].

Guide
Frame

On / Off Off Slår visningen av føringsrammen av/på.

100%
Marker

On / Off Off Slår markøren for 100% av/på.

User Box On / Off Off Slår visningen av brukerboksen av/på.

User Box
Width

3 til 479 240
Angir bredden på brukerboksmarkøren
(avstanden fra midten til venstre og høyre
kant).
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

User Box
Height

3 til 269 135
Angir høyden på brukerboksmarkøren
(avstand fra midten til øvre og nedre kant).

User Box H
Position

−476 til +476 0
Angir den horisontale posisjonen til midten av
brukerboksmarkøren.

User Box V
Position

−266 til +266 0
Angir den vertikale posisjonen til midten av
brukerboksmarkøren.
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Audio Input

Innstillinger for lydinnganger.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

AUDIO IN
Select

MIC / LINE MIC
Velger enhetstypen som er koblet til AUDIO IN-
kontakten.

Phantom
Power +48V

On / Off Off Viser statusen for +48 V-fantomstrømforsyningen.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1 Viser inngangskilde for opptak på kanal 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 Bytter inngangskilde for opptak på kanal 2.

CH3 Input
Select

Off / AUDIO IN CH1 AUDIO IN CH1 Bytter inngangskilde for opptak på kanal 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 Bytter inngangskilde for opptak på kanal 4.

AUDIO IN
CH1 MIC
Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Angir referanseopptaksnivået for XLR-
mikrofoninngangen fra AUDIO IN CH1.

AUDIO IN
CH2 MIC
Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Angir referanseopptaksnivået for XLR-
mikrofoninngangen fra AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Velger referanseinngangsnivået når [AUDIO IN Select]
er satt til LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB Velger opptaksnivået for 1 kHz-referansetonesignalet.

CH1 Wind
Filter

On / Off Off
Aktiverer/deaktiverer vindreduksjonsfilteret for kanal 1-
opptak.

CH2 Wind
Filter

On / Off Off
Aktiverer/deaktiverer vindreduksjonsfilteret for kanal 2-
opptak.

CH3 Wind
Filter

On / Off Off
Aktiverer/deaktiverer vindreduksjonsfilteret for kanal 3-
opptak.

CH4 Wind
Filter

On / Off Off Aktiverer/deaktiverer vindreduksjonsfilteret for kanal 4-
opptak.

CH1 Level
Control

Auto / Manual Auto
Velger automatisk justering av inngangslydnivå eller
manuell justering av opptakskanal 1.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

CH2 Level
Control

Auto / Manual Auto
Velger automatisk justering av inngangslydnivå eller
manuell justering av opptakskanal 2.

CH3 Level
Control

Auto / Manual Auto
Velger automatisk justering av inngangslydnivå eller
manuell justering av opptakskanal 3.

CH4 Level
Control

Auto / Manual Auto
Velger automatisk justering av inngangslydnivå eller
manuell justering av opptakskanal 4.

CH1 Input
Level

0 til 99 49 Stiller inn inngangsnivå for opptakskanal 1.

CH2 Input
Level

0 til 99 49 Stiller inn inngangsnivå for opptakskanal 2.

CH3 Input
Level

0 til 99 49 Stiller inn inngangsnivå for opptakskanal 3.

CH4 Input
Level

0 til 99 49 Stiller inn inngangsnivå for opptakskanal 4.

Master Input
Level

0 til 99 99 Angir hovedlydinngangsnivået.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Velger begrensningskarakteristikken for store
inngangssignaler ved manuell justering av
lydinngangsnivået.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Angir modusen for automatisk nivåjustering av
opptakskanal 1 og kanal 2. Når AGC er satt til Stereo,
er den koblet sammen mellom kanalene.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Angir modusen for automatisk nivåjustering av
opptakskanal 3 og kanal 4. Når AGC er satt til Stereo,
er den koblet sammen mellom kanalene.

AGC Spec
−6dB / −9dB / −12dB /
−15dB / −17dB

−6dB Velger AGC-karakteristikken.

1kHz Tone on
Color Bars

On / Off Off

Slår av/på 1 kHz-referansetonesignalet ved visning av
fargefelt.

Merknad

Når det er satt til [On], settes 1 kHz-
referansetonesignalet for opptak på kanal 3 og kanal
4, selv om [CH3 Input Select] og [CH4 Input Select] er
satt til [Off].
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Audio Output

Innstillinger for lydutganger.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

HDMI/Stream
Output CH

CH1/CH2 / CH3/CH4 CH1/CH2
Angir kombinasjonen av lydkanaler for
HDMI-/strømmeutgangen.
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Display Clip Properties

Viser skjermbildet for klippegenskaper.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Display Clip Properties – – Viser skjermbildet for klippegenskaper.
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Set Clip Flag

Angir klippflagginnstillinger.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Add OK – – Legger til et OK-flagg.

Add NG – – Legger til et NG-flagg.

Add KEEP – – Legger til et KEEP-flagg.

Delete Clip Flag – – Sletter alle flagg.
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Lock/Unlock Clip

Angir innstillinger for klippflaggbeskyttelse.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Select Clip – – Velger og låser / låser opp et klipp.

Lock All Clips – – Låser alle klipp.

Unlock All Clips – – Låser opp alle klipp.
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Delete Clip

Sletter klipp.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Select Clip – – Sletter det valgte klippet.

All Clips – – Sletter alle klipp.
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Transfer Clip

Overfører klipp.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Select Clip – – Overfører valgte klipp.

All Clips – –

Overfører alle klipp.

Merknad

Opptil 200 overføringsjobber kan registreres.
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Transfer Clip (Proxy)

Overfører proxy-klipp.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Select
Clip

– –
Overfører proxy-klipp som svarer til de valgte
klippene.

All Clips – –

Overfører proxy-klipp som svarer til alle klippene.

Merknad

Opptil 200 overføringsjobber kan registreres.
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Filter Clips

Angir innstillingene for klippene som skal vises.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

OK – – Vis bare klipp som har et OK-flagg.

NG – – Vis bare klipp som har et NG-flagg.

KEEP – – Vis bare klipp som har et KEEP-flagg.

None – – Vis bare klipp som ikke har et flagg.

All – – Viser alle klippene, uansett om det er noen flagg.
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Customize View

Bytter miniatyrbildevisning.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Skifter informasjon som vises under
miniatyrbilder.
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Color Bars

Angir innstillinger for fargestolper.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off Slår fargestolpene av/på.

Type ARIB / 100% / 75% / SMPTE ARIB Velger fargestolpetype.
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Genlock

Konfigurerer statusvisningen for genlock (se "Synkronisere fasen av videosignalet (Genlock))".

Beslektet emne
Synkronisere fasen av videosignalet (Genlock)
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Reference Internal / External(HD) / External(SD) – Viser typen genlock-referansesignal.

358



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Angir innstillinger for opptaks-/tellelampe (se "Koble til et tellesignal").

Beslektet emne

Koble til et tellesignal
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Tally Lamp
Brightness

High / Low / Off High Angir lysstyrken på opptaks-/tellelampen.

G Tally Lamp Enable / Disable Enable Aktiverer/deaktiverer G-tellelampen.

Tally Control External / Internal Internal

Velger målet for godkjenning av kontrollinformasjon for
opptaks-/tellelampe for enheten.
External: Tellekontroll fra utsiden av kameraet.
Internal: Kontroll via kameraopptaksbetjening.
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Rec Review

Angir innstillinger for opptaksgjennomgang (se "Gå gjennom opptaket (Rec Review)").

Beslektet emne

Gå gjennom opptaket (Rec Review)
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting 3s / 10s / Clip 3s
Angir tid for avspilling av klipp som nettopp er tatt opp for
gjennomgang av opptak.
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Zoom

Angir zoominnstillingene ("Justere zoomen").
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Angir typen zoom.
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Lens

Angir innstillinger som gjelder objektiver.

Beslektet emne

Pust-kompensering
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Lens Calibration Execute / Cancel –
Utfører funksjonen som korrigerer for forskjeller i
zoomposisjonen på grunn av forskjeller i individuelle
objektiver når du bruker et objektiv med elektrisk zoom.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Angir retningen for bruk av zoomringen.

Merknad

Denne funksjonen er bare aktivert når du bruker et
objektiv med E-feste som støtter veksling av
zoomringens retning.

Shading
Compensation

Auto / Off Auto Angir automatisk skyggekompensering.

Chroma
Aberration
Comp.

Auto / Off Auto Angir automatisk kromatisk aberrasjon-kompensering.

Distortion Comp. Auto / Off Auto Angir automatisk forvrengningskompensering.

Breathing
Compensation

Auto / Off Off
Angi objektivets pust-kompensering.

Se "Pust-kompensering".

Distance Display Meter / Feet Meter
Angir visningsenhetene for objektinformasjon og
fokusposisjon.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length Angir visningsformatet for zoomposisjonen.
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APR

Utfører APR.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

APR Execute / Cancel –

Kjører APR (Automatic Pixel Restoration) for automatisk
justering av bildesensor.
Execute: Utfør funksjon.

Merknad

Sett alltid på linsedekselet før du kjører APR.
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Wired LAN

Angir innstillinger som gjelder kablede LAN-tilkoblinger.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

HTTP Port – 80 Viser HTTP-tilgangsporten.

Detail
Settings

– – Viser egenskapene til den kablede LAN-tilkoblingen.

DHCP
On / Off

On Viser om DHCP er aktivert (On) eller deaktivert (Off).

IP Address –
Viser IP-adressen til enheten når [DHCP] er satt til
[Off].

Subnet Mask –
Viser videokameraets nettverksmaske når [DHCP] er
satt til [Off].

Gateway – Viser standard gateway når [DHCP] er satt til [Off].

DNS Auto
On / Off

On Viser innstillingen for automatisk DNS-innhenting.
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File Transfer

Angir innstillinger som gjelder filoverføringer (se "Om filoverføring").

Beslektet emne

Om filoverføring

5-041-958-83(1) Copyright 2022 Sony Corporation

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Auto Upload
(Proxy)

On / Off Off Slår av/på automatisk opplasting av proxy-fil.

Default
Upload
Server

Server Settings1 til
3 > Display Name

–

Velger opplastingsserveren for filer. Serveren som velges
her, blir målet for automatisk opplasting av proxy-filer, og
målet for opplasting av filer fra miniatyrbildeskjermen.
Viser innstillingene for [Display Name] som er konfigurert i
[Server Settings1 til 3].

Clear
Completed
Jobs

Execute / Cancel –
Fjerner fullførte overføringsjobber fra listen.
Execute: Utfør funksjon.

Clear All
Jobs

Execute / Cancel –
Fjerner alle overføringsjobber fra listen.
Execute: Utfør funksjon.

View Job List – – Viser listen over overføringsjobber.
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Language

Angir skjermspråket.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Select – –
Angir skjermspråket.
Set: Angi verdien.
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Clock Set

Angir interne klokkeinnstillinger.

Merknad

Når denne innstillingen endres fra kameramenyen, slå av strømtilførselen til enheten og start enheten på nytt. Uventet oppførsel
kan oppstå hvis standby for strøm initieres ved hjelp av den infrarøde fjernkontrollen eller nettappen.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Time Zone UTC − 12:00 til UTC + 14:00 –
Angir tidsforskjellen fra UTC i 30-minutters
enheter.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY YYMMDD

Velger visningsformat for datoer.
YYMMDD: År, måned, dag
MMDDYY: Måned, dag, år
DDMMYY: Dag, måned, år

12H/24H 12H / 24H 24H
Velger visningsformat for klokken.
12H: 12-timers modus
24H: 24-timers modus

Date – –
Angir gjeldende dato.
Set: Angi verdien.

Time – –
Angir gjeldende klokkeslett.
Set: Angi verdien.
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Hours Meter

Viser akkumulert driftstid.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Hours(System) – –
Viser de akkumulerte brukstimene (kan ikke
tilbakestilles).

Hours(Reset) – –
Viser de akkumulerte brukstimene (kan
tilbakestilles).

Reset Execute / Cancel –
Tilbakestiller den akkumulerte kjøretiden til 0.
Execute: Utfør funksjon.
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ISO/Gain-innstillinger og standardverdier

Området for innstillingene og standardverdiene for [ISO/Gain<L>] varierer, avhengig av innstillingene for [Mode], [Base
Look] > [Select] og [Base Sensitivity].
Standardverdier i nettbrett vises med fet skrift.

Når [Mode] er satt til [ISO]

Når [Base Look] > [Select] er satt til [S-Cinetone], [Standard], [ITU709], [709tone], eller [Still]

Når [Base Look] > [Select] er satt til [HLG Live] eller [HLG Natural]

Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [Low] Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Når [Base Look] > [Select] er satt til [User1] til [User16]

Når [Mode] er satt til [dB]

En verdi i området −3dB til +30dB i trinn på 1dB kan konfigureres.
Standardverdien er 0dB.
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Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [Low] Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [Low] Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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AGC Limit -innstillinger og standardverdier

Området for menyinnstillingene og standardverdiene for [AGC Limit] varierer, avhengig av innstillingene for [Mode], [Base
Look] > [Select] og [Base Sensitivity].
Standardverdier i nettbrett vises med fet skrift.

Når [Mode] er satt til [ISO]

Når [Base Look] > [Select] er satt til [S-Cinetone], [Standard], [ITU709], [709tone], eller [Still]

Når [Base Look] > [Select] er satt til [HLG Live] eller [HLG Natural]

Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [Low] Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [Low] Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Når [Base Look] > [Select] er satt til [User1] til [User16]

Når [Mode] er satt til [dB]

Velg fra 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Standardverdien er 15dB.
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Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [Low] Når [ISO/Gain/EI] > [Base Sensitivity] er satt til [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Bildekvalitetsinnstillinger lagres for hver opptaksmodus

Gjeldende status på konfigurasjonselementer som er knyttet til bildekvalitet, lagres for hver av de følgende
opptaksmodusene. Når du endrer opptaksmodus, blir de tilsvarende lagrede innstillingene for målopptaksmodusen brukt.

Custom-modus SDR(BT.709)-målvisning
Custom-modus HDR(HLG)-målvisning
Log shooting (Cine EI, Cine EI Quick, Flexible ISO)

Konfigurasjonselementer som er knyttet til bildekvalitet og som lagres for hver opptaksmodus vises i følgende tabeller.
"Ja" angir en innstilling som er lagret, og "Nei" angir en innstilling som ikke er lagret. "Ja" som strekker seg over flere
kolonner, angir felles innstillinger.

Element

Opptaksmodus

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Shooting-
meny

ISO/Gain/EI

ISO/Gain Ja1) Ja Nei

Exposure Index Nei Nei Ja Ja

Base Sensitivity Ja Nei

Base ISO Nei Ja4) Nei3) Ja4)

White

Preset White Ja Ja

Annet enn
ovenstående

Ja

White Setting Ja

Offset White Ja Nei

LUT On/Off Nei Ja

Noise
Suppression

Setting(Custom) Ja Ja Nei

Level(Custom) Ja Ja Nei

Setting (Cine
EI/Flex. ISO) Nei Ja

Level (Cine EI/Flex.
ISO)

Nei Ja
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Element

Opptaksmodus

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Paint/Look-
meny

Base Look

Select Ja Ja Ja

Input2) Ja

Output2) Ja

AE-nivåforskyvning2) Ja

Black Ja Ja Nei

Knee

Auto Knee Ja Nei Nei

Annet enn
ovenstående

Ja Ja Nei

Detail Ja Ja Nei

Matrix Ja Ja Nei

Multi Matrix Ja Ja Nei

Egne innstillinger for ISO-følsomhet lagres for begge Custom-modusene SDR(BT.709) og HDR(HLG).1)

Innstillinger lagres for hver Base Look og avhenger ikke av opptaksmodusen.2)

Basis ISO-følsomhet endres i samsvar med eksponeringsindeksen.3)

Felles innstillingsverdier i Flexible ISO og Cine EI opptaksmoduser.4)
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Konfigurasjon av nettmeny

Trykk på vekslefanen for skjermbildet for betjening av [Settings] for å vise skjermbildet for innstillinger.
Bruk skjermbildet for innstillinger til å konfigurere de forskjellige oppsettelementene til enheten, inkludert innledende
innstillinger, nettverksinnstillinger og opptaks-/avspillingsinnstillinger, ved hjelp av nettmenyen.

Menyen inneholder følgende menyer.

Menykonfigurasjon og -hierarki

Nivå 1 Beskrivelse av nivå 1 Nivå 2

Shooting Inneholder innstillinger som gjelder fotografering. Focus
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Nivå 1 Beskrivelse av nivå 1 Nivå 2

Project Inneholder grunnleggende prosjektinnstillinger.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Inneholder innstillinger som gjelder bildekvaliteten. Base Look

Pan-Tilt Inneholder innstillinger som gjelder pan/tilt.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring Inneholder innstillinger som gjelder videoutgang og skjermbildevisning.
Output Format

Output Display

Audio Inneholder innstillinger som gjelder lyd. Audio

Technical Inneholder innstillinger for tekniske punkter.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Inneholder innstillinger som gjelder nettverk.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack Protection
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Merknad

[Accessibility] er kun tilgjengelig på modeller for Nord-Amerika.
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Nivå 1 Beskrivelse av nivå 1 Nivå 2

Stream Inneholder innstillinger som gjelder strømming.

Stream

Video Stream

Audio Stream

Maintenance Inneholder enhetsinnstillinger, for eksempel klokke og språk.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Betjening av nettmeny

Trykk på vekslefanen for skjermbildet for betjening av [Settings] for å vise skjermbildet for innstillinger for å konfigurere
de forskjellige oppsettelementene for enheten, inkludert innledende innstillinger, nettverksinnstillinger, opptaks- /
avspillingsinnstillinger, ved hjelp av nettmenyen.
Konfigurer innstillinger i nettmenyen på et nettbrett ved hjelp av berøringsfunksjon eller på en datamaskin ved hjelp av
musebetjening.
Trykk på menyen for elementene du vil konfigurere for å vise oppsettelementene og innstillingene i den menyen.

Konfigurasjonsmetode

Verdivalg

Meny (nivå 1)1.

Meny (nivå 2)2.

Innstillinger3.
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Trykk på alternativknappen for et element. Alternativknappen for et valgt element vises i oransje.

Element av/på

Trykk på bryteren for å slå elementet av/på. Bryteren er oransje når elementet er slått på, og hvit når det er slått av.

Verdivalg fra en liste

Trykk på rullegardinmenyen og velg et element fra listen som vises.

Valg av tallverdi

Trykk på < eller > for å endre tallverdien. Hvis tallverdien er understreket, kan du også angi en tallverdi direkte.

Oppføring av tegn/tall

Konfigurasjon på et separat skjermbilde
Trykk på knappen for å utføre oppsettsoperasjoner på et eget skjermbilde.

Veiledningsmelding

Det vises informasjon som hjelper deg med å konfigurere enkelte innstillinger og meldinger som retter oppmerksomheten
mot brukeren.

Lagre en innstilling

Når du er ferdig med å konfigurere en innstilling, trykker du på [OK]-knappen for å lagre innstillingen.
Trykk på [Cancel]-knappen for å forkaste endringer i en innstilling og gå tilbake til forrige innstilling.
Trykk på [Reload]-knappen for å oppdatere skjermvisningen.

Merknad

Hvis du trykker på [Reload]-knappen på nytt før du lagrer en innstilling, forkastes endringer i innstillingen.

Hvis du flytter til en annen side før du lagrer en innstilling, forkastes endringer i innstillingen.
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Focus

Angir fokusinnstillinger.

Beslektet emne

Angi autofokusmålet manuelt (AF Assist) ved hjelp av Web App
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Angir modus for push-autofokus.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Angir operasjonen når kamerabildeskjermen berøres i MF-
modus.

AF Assist
Control

On / Off On

Når den er satt til [On], kan du bruke glidebryteren for
fokus i Web App under automatisk fokusering for å justere
fokusposisjonen.

Hvis du vil ha mer informasjon, se "Angi
autofokusmålet manuelt (AF Assist) ved hjelp av Web
App".

Merknad

Dette elementet aktiveres bare når [AF Assist] er satt til
[On] i kameramenyen.
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Base Setting

Angir grunninnstillinger.

Beslektet emne

Konfigurere grunnleggende drift
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Angir opptaksmodusen.

Se "Opptaksmodus" i "Konfigurere
grunnleggende drift".

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Angir fargerommet for opptak/utdata i
Custom-modus.
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Rec Format

Angir innstillinger for opptaksformat.

[RAW Output Format]-innstillinger

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Velger systemfrekvens.

Merknad

Hvis frekvensen endres, starter
kameraet på nytt. Etter ny oppstart,
laster du inn siden på nytt i
nettleseren.

Imager Scan
Mode

FF / S35 FF Velger Imager-størrelse.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Angir codec for opptak/avspilling av
klippet.

Merknad

Når [Imager Scan Mode] er satt til
[S35], kan ikke [RAW] og [RAW &
XAVC-I] ikke velges.

RAW Output
Format

De tilgjengelige innstillingene varierer
avhengig av [Frequency]-innstillingen.

Se "[RAW Output Format]-
innstillinger" nedenfor.

–

Angir størrelsen på RAW-bildet som skal
sendes ut til en ekstern RAW-opptaker.

Merknad

Når [Codec] er satt til [RAW & XAVC-
I], skiftes [Video Format]-innstillingen i
samsvar med [RAW Output Format]-
innstillingen.

Video
Format

De tilgjengelige innstillingene varierer
avhengig av innstillingene
[Frequency], [Imager Scan Mode] og
[Codec].

Se "[Video Format]-innstillinger"
nedenfor.

– Stiller inn bildestørrelsen.

Frequency Imager Scan Mode Codec Innstilling

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160
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Standardverdier vises med fet skrift.
Betingelsene som [RAW Output Format] ikke kan angis under, er utelatt.

[Video Format]-innstillinger

Standardverdier vises med fet skrift.

5-041-958-83(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Innstilling

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Innstilling

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Angir innstillinger for modus for samtidig opptak med to spor (se "Ta opp på minnekort A og B samtidig (opptak med to
spor)").

Beslektet emne

Ta opp på minnekort A og B samtidig (opptak med to spor)
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off
Slår den samtidige opptaksfunksjonen av/på og angir
målmediet for opptak.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Viser tilordningen av opptaksknapper for hvert
opptaksmedium.
Angi [Project] > [Simul Rec] > [Rec Button Set] i
kameramenyen.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

Angir innstillinger for proxy-opptaksmodus (se "Proxy-opptak").
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off Slår proxy-opptaksmodus av/på.
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Interval Rec

Angir innstillinger for intervallopptaksmodus (se "Opptak av video med jevne mellomrom (intervallopptak)").

Beslektet emne

Opptak av video med jevne mellomrom (intervallopptak)
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off

Slår intervallopptaksmodus av/på.
(Hvis du setter denne modusen til
On, settes alle andre spesialmoduser
til Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (sek)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (time)

1
Angir intervallet mellom opptak i
opptaksmodusen Interval Rec (når
Interval Rec er satt til On).

Number
of Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
De tilgjengelige innstillingene
varierer avhengig av
rammefrekvensen til det valgte
videoformatet.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Angir antall rammer som skal tas per
opptak i opptaksmodusen Interval
Rec (når Interval Rec er satt til On).

387



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Picture Cache Rec

Stiller inn bildets cache-opptaksmodus (se "Opptak av cachet-bilder (Picture Cache Rec)").

Beslektet emne

Opptak av cachet-bilder (Picture Cache Rec)
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off Slår bildets cache-funksjon av/på.

Cache Size
Short / Medium / Long /
Max

Max
Stiller inn tiden for akkumulering av bilder i cache-
minnet (opptakstid for bilde-cache).

Cache Rec
Time

– –
Viser tiden for akkumulering av bilder i cache-minnet
(opptakstid for bilde-cache).
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All File

Utfører ALL-fil-operasjoner (se "Lagre og laste inn konfigurasjonsdata").
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Load All
File

– –

Last inn en ALL-fil i enheten fra enheten som kjører Web
App.

Merknad

Når en ALL-fil lastes inn i enheten, starter enheten på nytt.
Etter ny oppstart, laster du inn siden på nytt i nettleseren.

Save All
File – –

Lagre innstillingene for enheten som en ALL-fil på enheten
som kjører Web App.
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Base Look

Du kan laste inn et basisutseende i enheten.
En liste over tilgjengelige basisutseender vises på skjermen. Basisutseendet som brukes angis med en ●-markør til
venstre for tallet for basisutseende.

[No.]: Basisutseende-nummer
[Base Look Name]: Navn på basisutseende
[Input]: Inngangssignal for basisutseende
[Output]: Utgangssignal for basisutseende
[AE Level Offset]: Forskyvning av referanseverdi for eksponering for basisutseende

Slik legger du til et basisutseende
Trykk på [Import]-knappen for å importere et nytt basisutseende. Følg instruksjonene på skjermen.
Når du har importert, angir du riktige verdier for [Input], [Output] og [AE Level Offset]. Hvis du vil ha mer informasjon, se
"Importere et ønsket basisutseende".

Beslektet emne
Importere et ønsket basisutseende
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P/T Speed

Angir innstillinger som gjelder pan/tilt-hastigheten.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Speed
Step

Normal / Extended Extended

Angir antall hastighetstrinn for pan/tilt-driveren.
Normal: Hastighet kan spesifiseres ved hjelp av et 24-trinns
område. Bruk denne innstillingen for kompatibilitet med
eksisterende eksterne Sony-kameraer.
Extended: Hastighet kan spesifiseres ved hjelp av et 50-trinns
område.

Speed
Mode

Normal / Slow Normal

Angir hastighetsmodus for pan/tilt-driveren.
Aktivert kun når [Speed Step] er satt til [Normal].
Normal: Fungerer i normalhastighetsområde (minimum til
maksimum (60 grader/sekund)).
Slow: Fungerer i lavhastighetsområde (minimum til maksimum
(40 grader/sekund)).
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P/T Acceleration

Angir innstillinger som gjelder pan/tilt-hastigheten.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Acceleration 1 til 9 8
Velger akselerasjon/retardasjon for pan/tilt-betjening. Jo
større tall, jo høyere akselerasjon.
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P/T Range Limit

Angir innstillinger som gjelder begrensning av område for pan/tilt-betjening.
Angi områdegrensene for pan/tilt-betjening ved hjelp av følgende skjermbilde.

Merknad

Når enheten slås på eller tilbakestilling av pan/tilt utføres, ignoreres denne innstillingen for områdegrense. Denne funksjonen kan
ikke brukes til å unngå hindringer i nærheten av enheten.

Sett [Setting]-bryteren i On-posisjon.

Funksjonen for områdegrense for pan/tilt-betjening aktiveres.

1

Kontroller bildet ved hjelp av pan/tilt-kontrollene på kameraet.2

Hvis du vil angi posisjonene for å begrense driften, trykker du på knappen [Left], [Right], [Up], [Down] >
[Set Current Value] ved de posisjonene.

[Left]: Venstre side av kamera
[Right]: Høyre side av kamera
[Up]: Overside av kamera

3
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Merknad

Kameraposisjoner utenfor grenseposisjonene kan ikke lagres som en forhåndsinnstilling.

Hvis innstillingen [Pan-Tilt] > [P/T Direction] > [Ceiling] endres, returneres de konfigurerte innstillingene for grenseposisjon til
fabrikkinnstillingene.

Innstillingen kan ikke endres under avspilling, under miniatyrbildevisning, når det oppstår en pan/tilt-feil, når pan/tilt ikke er
initialisert, og når pan/tilt er låst.
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[Down]: Undersiden av kameraet

Grenseposisjonene angis og vises som tallverdier (vinkel).
Hvis du vil avbryte en grense, trykker du på [Reset]-knappen for de enkelte posisjonene.

Trykk på [OK]-knappen.

Pan/tilt-betjeningen er begrenset til å være innenfor de konfigurerte grenseposisjonene.

4
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P/T Direction

Angir innstillinger som gjelder pan/tilt-retningen.

Merknad

Når en endret [Ceiling]-innstilling brukes, slettes alle forhåndsinnstilte posisjoner siden pan/tilt-koordinatene blir invertert.

Pan/tilt-driverområdet endres som vist følgende diagrammet, avhengig av [Ceiling]-innstillingen.

A: Når [Ceiling] er satt til [Off]
B: Når [Ceiling] er satt til [On]
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Ceiling On / Off Off

Når enheten er montert på et skrivebord, angir du den til [Off].
Når enheten er montert i et tak, angir du den til [On]. Når
[Ceiling] er satt til [On], blir [Pan Direction] automatisk satt til
[Opposite].

Pan
Direction

Normal / Opposite Normal
Angir pan-driverretningen. Når innstillingen endres, reverseres
kjøreretningen.

Tilt
Direction

Normal / Opposite Normal
Angir tilt-driverretningen. Når innstillingen endres, reverseres
kjøreretningen.
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P/T Preset

Angir innstillinger som gjelder forhåndsinnstillinger for kamera.

Pan-Tilt
Angir hastigheten for forhåndsinnstillinger.

Default
Angir standardverdiene som konfigureres når en forhåndsinnstilt posisjon lagres.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Angir om forhåndsinnstilte hastigheter skal konfigureres
separat eller bruke en felles innstilling.

Pan-Tilt Speed
for Common

1 til 50 50

Angir felles hastighet for forhåndsinnstillinger.

Merknad

En maksimal kjørehastighet på 24 brukes hvis en verdi
på 25 eller høyere angis når [Pan-Tilt] > [P/T Speed] >
[Speed Step] er satt til [Normal].

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Pan-Tilt Speed
for Separate

1 til 50 50
Angir hastigheten for forhåndsinnstillinger når
valgmetoden for forhåndsinnstilt hastighet er satt til
[Separate].

Zoom Sync On / Off On
Angir om pan/tilt -drift og zoom-drift synkroniseres ved
gjenoppretting av en forhåndsinnstilt posisjon.

Zoom Speed 0 til 32767 32767 Angir zoom-hastigheten.

Focus Recall On / Off On Angir om fokusinnstillinger blir gjenopprettet.

MF Speed 0 til 32767 32767 Angir fokushastigheten for manuell fokus.
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Output Format

Angir innstillinger for utdataformat.

Beslektet emne
Utdataformater og -begrensninger
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

SDI Hvis du vil ha mer informasjon om innstillinger, se
"Utdataformater og -begrensninger".

– Angir oppløsningen for SDI- og
HDMI-utgangene.HDMI –
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Output Display

Angir innstillinger som gjelder utgangssignaler.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

SDI On / Off Off
Stiller inn om menyen og status er innebygd i SDI-
utgangssignalet.

HDMI/Stream On / Off On

Stiller inn om menyen og status er innebygd i HDMI-
utgangssignalet.

Merknad

Denne innstillingen brukes også på HDMI-
utgangssignalbildet, utgangsbildet for strømming og bildet
i Web App-kamerabildepanelet.
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Audio Input

Angir innstillinger som CH1- til CH4-lydinngang.

Angir hovedlydinngangsnivået. Hovednivået for lydinngang brukes for alle kanalene 1 til 4.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Level
Control

Auto / Manual Auto
Velger automatisk justering av inngangslydnivå eller
manuell justering av opptakskanal.

Level 0 til 99 49 Angir inndatanivået.

Input
Select

AUDIO IN CH1 / AUDIO
IN CH2 / Off

CH1 og CH3: AUDIO
IN CH1
CH2 og CH4: AUDIO
IN CH2

Angir lydinngangskilden.

Merknad

CH1 er satt til [AUDIO IN CH1] (fast).

Wind
Filter

On / Off Off Slår vindstøyreduksjonsfilteret av/på.

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Master 0 til 99 99 Angir hovedinngangsnivået.
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Audio Output

Angir innstillinger som gjelder lydutgang.

Merknad

Denne innstillingen brukes også på utgangslyd for strømming.

5-041-958-83(1) Copyright 2022 Sony Corporation

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

HDMI/Stream
Output CH

CH1/CH2 / CH3/CH4 CH1/CH2
Angir kombinasjonen av lydkanaler for
HDMI-/strømmeutgangen.
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Tracking Data Output

Legger inn innstillinger i forhold til utgangssignaler for tracking-informasjon (i samsvar med protokollen free-d).
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Transfer
Mode

Off / Always / On
Demand

Off Velger utgangssignalmetode for tracking-informasjon.

Camera ID 0 til 255 255 Legger inn ID for enheten.

Destination
Address

IPv4-adresse –
Når [Transfer Mode] er satt til [Always], fastsettes
tracking-informasjonens destinasjon i form av en IP-
adresse.

Destination
Port

1024 til 65534 40000
Når [Transfer Mode] er satt til [Always], fastsettes
tracking-informasjonens destinasjon i form av et
portnummer.

Listen Port 1024 til 65534 40000
Når [Transfer Mode] er satt til [On Demand], fastsettes
portnummeret på enheten for listing av forespørsler fra
klienter.
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Tally

Angir innstillinger for opptaks-/tellelampe (se "Koble til et tellesignal").

Beslektet emne

Koble til et tellesignal
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Tally Lamp
Brightness

High / Low / Off High Angir lysstyrken på opptaks-/tellelampen.

G Tally Lamp Enable / Disable Enable Aktiverer/deaktiverer G-tellelampen.

Tally Control External / Internal Internal
Velger målet for godkjenning av kontrollinformasjon
for opptaks-/tellelampe for enheten.
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IR Remote

Angir innstillinger som gjelder infrarød-fjernkontrollen.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting On / Off On
Aktiverer/deaktiverer betjening av enheten fra infrarød-
fjernkontrollen.
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RCP/MSU

Konfigurerer innstillingen når en RCP/MSU (valgfritt) er tilkoblet.
Hvis du vil ha mer informasjon, se "Koble til en RCP/MSU (valgfritt)".

Merknad

Konfigurer innstillingene på RCP/MSU etter behov.

En MSU kreves for et multikamerasystem.

Når du bruker flere MSU-enheter, sett en MSU-enhet som hovedenhet og sett alle andre MSU-enheter som klienter.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

CNS Mode
Off / Bridge / MCS /
PC Control

Off Angir tilkoblingsmodus for RCP/MSU.

Master IP
Address

IPv4-adresse 0.0.0.0
Angir IP-adressen til hovedenheten når du bygger et
LAN-basert multikamerasystem.

Camera No. Camera No. (1 til 96) 1 Angir et unikt kameranummer i systemet når du bygger
et LAN-basert multikamerasystem.
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Lens Controller

Fastsetter innstillinger for en tilkoblet objektivkontroller (valgfritt).
Hvis du vil ha mer informasjon, se "Koble til en objektivkontroller".

Merknad

Når [Setting] endres, starter enheten på nytt. Last inn siden på nytt i nettleseren.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off Fastsetter om objektivkontrolleren skal brukes (valgfritt).

Mode 0 til 15 0

Fastsetter driftsmodus for objektivkontrolleren (valgfritt).
Verdier i området 0 til 15 er tilgjengelig, men de faktiske verdiene
som kan velges, vil variere avhengig av objektivkontrolleren
(valgfritt). For mer informasjon, se i bruksanvisningen for
objektivkontrolleren.

Reverse On / Off Off Reverserer rotasjonsretningen for objektivkontrolleren (valgfritt).

Initialize – – Initialiserer objektivkontrolleren (valgfritt).
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Camera Name

Angir innstillinger som gjelder kameranavnet (enhetsnavnet).

Opptil åtte (0 til 8) av følgende tegn kan skrives inn for Camera Name.
Alfanumeriske tegn
Symboler (mellomrom !#$`*+-./;<=>?@[\]^_`{|})
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Camera Name – FR7 Angir kameranavnet.
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User

Angir innstillinger som gjelder brukertilgang til enheten.

Innstillinger som gjelder administratorbrukere (Administrator) (obligatorisk)

Innstillinger som gjelder generelle brukere (User 1 til User 9) (valgfritt)
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

User Name – admin Angir brukernavnet.

Current
Password

– –
Når du endrer passordet, skriver du inn
gjeldende passord.

New Password – – Skriv inn det nye passordet.

Re-Type
Password

– –
Skriv inn det nye passordet på nytt for
bekreftelse.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

User Name – – Angir brukernavnet.

Current
Password

– –
Når du endrer passordet, skriver du inn
gjeldende passord.

New Password – – Skriv inn det nye passordet.

Re-Type
Password – –

Skriv inn det nye passordet på nytt for
bekreftelse.
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Wired LAN

Status
Viser nettverksstatusen.

IPv4
Angir innstillinger som gjelder IPv4-nettverket.

IPv6

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Host Name – – Viser vertsnavnet.

MAC Address – – Viser MAC-adressen til enheten.

Ethernet Status – – Viser gjeldende kommunikasjonshastighet.

IP Address – – Viser enhetens IP-adresse.

Subnet Mask – – Viser enhetens nettverksmaske.

Gateway – – Viser standard IPv4-gateway for enheten.

Primary DNS
Server

– –
Viser den primære DNS-serveren for
enheten.

Secondary DNS
Server

– –
Viser den sekundære DNS-serveren for
enheten.

IPv6 Address 1 – – Viser IPv6-adresse 1 for enheten.

IPv6 Address 2 – – Viser IPv6-adresse 2 for enheten.

IPv6 Gateway – – Viser standard IPv6-gateway for enheten.

Link-local IPv6
Address

– –
Viser den lokale IPv6-koblingsadressen for
enheten.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

DHCP On / Off On Slår [DHCP]-funksjonen av/på.

IP Address – – Angir IPv4-adressen når [DHCP] er satt til Off.

Subnet
Mask

– – Angir subnettmaske når [DHCP] er satt til Off.

Gateway – –
Angir standard IPv4-gateway når [DHCP] er satt til
Off.
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Angir innstillinger som gjelder IPv6-nettverket.

Common
Angir innstillinger som er felles for IPv4/IPv6-nettverk.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Obtain an IP Address
Automatically

On / Off On
Slår automatisk innhenting av IPv6-adresse
av/på.

IP Address – –
Angir IPv6-adressen når [Obtain an IP
Address Automatically] er satt til Off.

Prefix Length – –
Angir prefikset når [Obtain an IP Address
Automatically] er satt til Off.

Gateway – –
Angir standard IPv6-gateway når [Obtain an IP
Address Automatically] er satt til Off.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

HTTP Port 80, 1024 til 65534 80 Angir HTTP-portnummeret.

DNS Auto On / Off On
Angir om DNS-adressene skal hentes fra
DHCP-serveren.

Primary DNS
Server

IPv4/IPv6-adresse –
Angir den primære DNS-serveren når [DNS
Auto] er satt til Off.

Secondary DNS
Server

IPv4/IPv6-adresse –
Angir den sekundære DNS-serveren når [DNS
Auto] er satt til Off.
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File Transfer

Angir innstillinger som gjelder filoverføringer.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Auto
Upload
(Proxy)

On / Off Off Slår av/på automatisk opplasting av proxy-fil.

Default
Upload
Server

Server Settings1 til
3 > Display Name Server Settings1

Velger opplastingsserveren for filer. Serveren som velges
her, blir målet for automatisk opplasting av proxy-filer, og
målet for opplasting av filer fra miniatyrbildeskjermen.
Viser innstillingene for [Display Name] som er konfigurert i
[Server Settings1 til 3].
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FTP Server 1 til 3

Angir innstillinger som gjelder FTP-overføringer.
Innstillingene er felles for FTP Server 1 til 3.

5-041-958-83(1) Copyright 2022 Sony Corporation

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Display Name – –
Angir visningsnavnet som vises i overføringsmålenes
oppsettmeny.

Service – – Viser typen server.

Host Name – – Angir vertsnavnet for overføringsmålserveren.

Port 21, 990, 1024 til
65534

21 Angir portnummeret til serveren for overføringsmålet.

User Name – –
Angir brukernavnet for godkjenning av forbindelsen
med serveren for overføringsmålet.

Password – –
Angir godkjenningspassordet for tilkoblingen
overføringsmålserveren.

Passive Mode On / Off Off Slår passiv modus av/på.

Destination
Directory

– – Angir navnet på overføringens målmappe.

Using Secure
Protocol

On / Off Off
Angir om sikker FTP-overføring skal brukes (On) eller
ikke (Off).

Root Certificate – –

Laster inn rotsertifikatet for sikker FTP-overføring.
Trykk på [Load]-knappen og velg et rotsertifikat på
skjermbildet som vises.
Klikk på [Delete]-knappen for å slette det innlastede
rotsertifikatet.

Root Certificate
Status

– – Viser innlastingsstatusen for rotsertifikatet.

Reset – –
Tilbakestiller [Server Settings]-innstillingene til
standardinnstillingene.
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SSL

Angir innstillinger som gjelder SSL.

SSL
Aktiver/deaktiver SSL-funksjonen.

SSL Server Authentication
Angir innstillinger som gjelder SSL-servergodkjenning.

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Function
Disable / Enable / Enable (Allow HTTP connection for
some clients)

Disable
Aktiver/deaktiver SSL-
funksjonen.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external
certificate

–
Angir installasjonsmetoden for SSL-
serversertifikatet.

Status – –
Viser den gyldigheten til SSL-serversertifikatet når
[Certificate Options] er satt til [Use a self-signed
certificate (For test use)].

Issuer DN – –
Viser det unike navnet på utstederen av SSL-
serversertifikatet når [Certificate Options] er satt til
[Use a self-signed certificate (For test use)].

Subject DN – –
Viser det unike navnet på emnet for SSL-
serversertifikatet når [Certificate Options] er satt til
[Use a self-signed certificate (For test use)].

Available
Period

– –
Viser den gyldige perioden for SSL-
serversertifikatet når [Certificate Options] er satt til
[Use a self-signed certificate (For test use)].

Extended Key
Usage

– –
Viser metoden for utvidet nøkkelbruk når
[Certificate Options] er satt til [Use a self-signed
certificate (For test use)].

Delete – –
Denne knappen vises når [Certificate Options] er
satt til [Use a self-signed certificate (For test use)].
Sletter det installerte SSL-serversertifikatet.

Import – –
Installerer et eksternt SSL-serversertifikat fra en
liste når [Certificate Options] er satt til [Use an
external certificate].
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Private Key
Password

– –
Angir passordet for privatnøkkelinformasjonen for
SSL-serversertifikatet når [Certificate Options] er
satt til [Use an external certificate].

Reset – –
Denne knappen fjerner passordvisningen for
privatnøkkelen for registrering av et nytt passord.

Self-Signed
Certificate
Generation

– –
Trykk på [Generate]-knappen for å generere et
selvsignert sertifikat når [Certificate Options] er
satt til [Use a self-signed certificate (For test use)].
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Hjelpveiledning

Interchangeable Lens Digital Camera
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Referer Check

Angir innstillinger som gjelder referansekontroller.

Exception List
Angir innstillinger som gjelder unntakslisten for referansekontroll.

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off On Aktiverer/deaktiverer funksjonen for referansekontroll.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

No. 1 til 10 – Angir unntaksnummeret fra listen.

Host
Name

– – Angir vertsnavnet for unntaket.

Port
Number

– – Angir portnummeret for unntaket.

Set – –
Trykk for å registrere det konfigurerte unntaket i
unntakslisten.

Delete – –
Velg et unntak du vil slette, og trykk på knappen for å slette
det registrerte unntaket fra unntakslisten.
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Brute Force Attack Protection

Angir innstillinger som gjelder forebygging av angrep med rå kraft.

Når en angriper oppdages, vises listeinformasjonen om angriperen.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Setting On / Off On Slår [Brute Force Attack Protection]-funksjonen av/på.

Count 3 til 100 8
Angir antall forsøk som vil bli ansett som et angrep.
Aktivert når [Setting] er satt til On.

Release
Mode Always / Timer Timer

Angir utgivelsesvilkåret.
Aktivert når [Setting] er satt til On.
Always: Ikke slett fra angriperliste.
Timer: Slett fra angriperliste etter utgivelsestiden som er
angitt ved hjelp av [Release Time] er utløpt.

Release
Time

30 til 86400 s 60

Angir utgivelsestidspunktet.
Aktivert når [Setting] er satt til On.
Når Release Mode er satt til [Timer], slettes oppføringer fra
angriperlisten etter at utgivelsestiden er utløpt.

416



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Stream

Angi innstillinger for strømming (se "Om strømming").

Stream Setting
Angir innstillinger som gjelder strømmeprotokollen.

Merknad

For å bruke RTMP, sett [Stream] > [Audio Stream] > [Setting] til [On] på forhånd.

RTSP
Følgende elementer vises når [Stream Setting] er satt til [RTSP].
Angir innstillinger som gjelder RTSP-strømming.

RTMP
Følgende elementer vises når [Stream Setting] er satt til [RTMP].
Angir innstillinger som gjelder RTMP-strømming.

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX /
Off

RTSP
Velger
strømmeprotokollen.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Port Number 554, 1024 til 65534 554 Angir RTSP-portnummeret.

Time Out 0 til 600 60
Angir tidsavbrudd for Keep Alive-kommandoen for
RTSP-strømming.

Authentication On / Off On Slår RTSP-autentiseringsfunksjonen av/på.

Video Port
Number 1

1024 til 65534 51000
Angir portnummeret for sending av video 1 for
strømming av RTSP-unikasting.

Video Port
Number 2

1024 til 65534 53000
Angir portnummeret for sending av video 2 for
strømming av RTSP-unikasting.

Audio Port
Number

1024 til 65534 57000
Angir portnummeret for sending av lyd for
strømming av RTSP-unikasting.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Server URL – –
Angir URL-adressen for RTMP- eller RTMPS-
tilkoblingsmålet.
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SRT
Følgende elementer vises når [Stream Setting] er satt til [SRT-Caller] eller [SRT-Listener].
Angir innstillinger som gjelder SRT-strømming.

NDI|HX
Følgende elementer vises når [Stream Setting] er satt til [NDI|HX].
Angir innstillinger som gjelder NDI|HX.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Stream Key – –
Angir strømmenøkkelen som er hentet fra RTMP-
serversiden.

Root
Certificate

– –

Laster inn rotsertifikatet som er påkrevd for tilkobling
med RTMP-serveren.
Trykk på [Load]-knappen og velg et rotsertifikat på
skjermbildet som vises.
Klikk på [Delete]-knappen for å slette det innlastede
rotsertifikatet.
Statusen vises i [Root Certificate Status].

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Destination – –
Angir URL-adressen for tilkoblingsmål når enheten
fungerer som oppkaller.

Port
Number

1024 til 65534 4201
Angir portnummeret for lytting når enheten fungerer
som lytter.

Latency 20 til 8000 ms 120 Angir ventetiden.

TTL 1 til 255 64 Angir TTL-verdien.

Encryption Off / AES128 / AES256 Off
Aktiverer/deaktiverer kryptering og angir
krypteringsmetoden.

Passphrase
0 eller streng på 10 til
79 tegn

0
Angir passordfrasen som brukes til kryptering.
Trykk på Reset for å fjerne den angitte passordfrasen.

ARC On / Off On Slår Adaptive Rate Control-funksjonen av/på.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

License – – Viser installasjonsstatusen for NDI-lisensnøkkelen.

Source Name – – Viser NDI-kildenavnet.

Group On / Off Off Slår NDI-grupperingsfunksjonen av/på.

Group Name – –
Vises når NDI-grupperingsfunksjonen er satt til On.
Angir gruppenavn.

Discovery
Server 1

– – Angir NDI Discovery Server 1.
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Beslektet emne

Om strømming
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Discovery
Server 2

– – Angir NDI Discovery Server 2.

Multicast Mode On / Off Off Slår strømming av multikasting av/på.

Multicast Prefix 239.255.0.0 239.255.0.0
Vises når [Multicast Mode] er satt til On.
Angir prefikset som skal brukes for strømming av
multikasting.

Multicast
Netmask

255.255.0.0 255.255.0.0
Vises når [Multicast Mode] er satt til On.
Angir nettverksmasken som bestemmer
adresseområdet for multikasting.

Multicast TTL 1 til 256 3
Vises når [Multicast Mode] er satt til On.
Angir TTL-verdien for strømming av multikasting.

Multi-TCP
Mode

On / Off Off Slår Multi-TCP-modus av/på.

Unicast UDP
Mode

On / Off On Slår Unicast UDP-modus av/på.
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Video Stream

Angir innstillinger som gjelder videokodeken for strømming.

Video Stream 1
Angir innstillinger som gjelder videokodek 1.

Video Stream 2

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Codec 1 H.264 / H.265 H.264 Angir kodeken for bilde 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080
/ 1920×1080 / 1280×720 / 640×360

1920×1080 Angir bildestørrelsen for bilde 1.

Frame Rate 1

Hvis du vil ha mer informasjon om
bildefrekvenser som støttes, se
"Angi videokodek for strømming".

– Angir rammefrekvensen for bilde 1.

I-Picture Mode 1 Time / Frame Time
Angir IDR-Frame-
innsettingsintervallet for bilde 1 som
en tid eller antall rammer.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Vises når [I-Picture Mode 1] er satt
til Time.
Angir innsettingsintervallet for IDR-
Frame for H.264 og H.265 som en
tid.

I-Picture Ratio 1 15 til 300 rammer 30

Vises når [I-Picture Mode 1] er satt
til Frame.
Angir innsettingsintervallet for IDR-
Frame for H.264 og H.265 som et
antall rammer.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Angir H.264- eller H.265-profilen.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Angir komprimeringsmodusen for
bit-hastighet for bilde 1.

Bit Rate 1

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

16000

Vises når [Bit Rate Compression
Mode 1] er satt til On.
Angir kildeverdi for bit-hastighet
komprimeringsmodusen for bit-
hastighet er satt til CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Angir H.264- eller H.265-kvaliteten.
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Angir innstillinger som gjelder videokodek 2.

Video Stream 3
Angir innstillinger som gjelder videokodek 3.

Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Codec 2 H.264 / H.265 / Off Off Angir kodeken for bilde 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080
/ 1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080 Angir bildestørrelsen for bilde 2.

Frame Rate 2

Hvis du vil ha mer informasjon om
bildefrekvenser som støttes, se
"Angi videokodek for strømming".

–
Vises når [Codec 2] ikke er satt til
Off.
Angir rammefrekvensen for bilde 2.

I-Picture Mode
2 Time / Frame Time

Vises når [Codec 2] ikke er satt til
Off.
Angir IDR-Frame-
innsettingsintervallet for bilde 2 som
en tid eller antall rammer.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Vises når begge [Codec 2] ikke er
satt til Off og [I-Picture Mode 2] er
satt til [Time].
Angir innsettingsintervallet for IDR-
Frame for H.264 og H.265 som en
tid.

I-Picture Ratio 2 15 til 300 rammer 30

Vises når begge [Codec 2] ikke er
satt til Off og [I-Picture Mode 2] er
satt til [Frame].
Angir innsettingsintervallet for IDR-
Frame for H.264 og H.265 som et
antall rammer.

Profile 2
H.264: high / main / baseline
H.265: main

– Angir H.264- eller H.265-profilen.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Vises når [Codec 2] ikke er satt til
Off.
Angir komprimeringsmodusen for bit-
hastighet for bilde 2.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 /
80000 kbps

8000

Vises når begge [Codec 2] ikke er
satt til Off og [Bit Rate Compression
Mode 2] er satt til [On].
Angir kildeverdi for bit-hastighet
komprimeringsmodusen for bit-
hastighet er satt til CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Vises når begge [Codec 2] er satt til
H.264 og [Bit Rate Compression
Mode 2] er satt til Off.
Angir H.264- eller H.265-kvaliteten.
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Angi videokodek for strømming
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Codec 3 JPEG JPEG
Angir kodeken for bilde
3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Angir bildestørrelsen for
bilde 3.

Frame
Rate 3

Hvis du vil ha mer informasjon om bildefrekvenser
som støttes, se "Angi videokodek for strømming". –

Angir rammefrekvensen
for bilde 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Angir kvaliteten.
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Audio Stream

Angir innstillinger som gjelder lydkodeken for strømming.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Setting On / Off Off Slår lydstrømmingsutgang av/på.

Codec AAC (128kbps) / AAC (256kbps) AAC (128kbps)
Vises når [Setting] er satt til On.
Angir lydkodeken for strømming.
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Language

Angir skjermspråket.

Merknad

Hvilke språk som er tilgjengelige, kan variere avhengig av land eller område.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Language – – Angir skjermspråket.
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Accessibility

Angir innstillinger som gjelder lydavlesing (tekst til tale).

Merknad

Denne funksjonen er bare tilgjengelig på modeller som selges i Nord-Amerika. Skjermleserfunksjonen kan bare brukes når
språket er satt til engelsk (fra utgivelsesdatoen).

Aktiver skjermleserfunksjonen i nettleseren på enheten som kjører Web App.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Screen
Reader

On / Off Off 
Slår skjermleserfunksjonen i
kamerabildepanelet i Web App av/på.

Speech
Rate

Slow2 / Slow1 / Normal / Fast1 /
Fast2 / Fast3 / Fast4

Normal
Angir hastigheten for skjermleserfunksjonen.
Et eksempelavsnitt leses høyt med den
konfigurerte hastigheten.

Speech
Volume

1 til 15 7

Angir volumet for skjermleserfunksjonen i
Web App.
Et eksempelavsnitt leses høyt med det
konfigurerte volumet.
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Clock Set

Angir interne klokkeinnstillinger.
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Element Innstilling for underelement Fabrikkinnstilling Beskrivelse

Current Date
& Time

– –
Viser gjeldende tid som er konfigurert på
enheten.

PC Clock – –
Viser gjeldende tid for nettbrettet eller
datamaskinen som brukes til konfigurasjon.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-
yyyy hh:mm:ss / dd-mm-yyyy
hh:mm:ss

yyyy-mm-dd Angir visningsformatet for dato og tid.

12 h / 24 h 12 h / 24 h 24 h
Setter tiden til 12-timers/24-timers
visningsformat.

Time Setting
Keep current setting / Synchronize
with PC / Manual setting /
Synchronize with NTP

–
Angir konfigurasjonsmetoden for dato og
tid.

yy-mm-dd
hh:mm:ss

yy: 19 til 37
mm: 01 til 12
dd: 01 til 31
hh: 00 til 23
mm: 00 til 59
ss: 00 til 59 (sekunder)

–
Vises når [Time Setting] er satt til Manual
setting.
Angir dato og tid manuelt.

NTP Auto On / Off Off

Vises når [Time Setting] er satt til
Synchronize with NTP.
Angir om IP-adressen til NTP-serveren skal
hentes fra DHCP-serveren.

NTP Server IPv4/IPv6-adresse eller vertsnavn –

Vises når begge [Time Setting] er satt til
[Synchronize with NTP] og [NTP Auto] er
satt til Off.
Angir NTP-serveren som brukes til
tidssynkronisering.

Time Zone UTC − 12:00 til UTC + 14:00 – Velger tidssonen.
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Reset

Initialiserer enheten.

Reboot
Start enheten på nytt.

Reset
Tilbakestiller innstillingene for enheten.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Reboot Execute –

Start enheten på nytt.
Execute: Utfør funksjon.

Merknad

Etter ny oppstart, laster du inn siden på nytt i
nettleseren.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

All Reset (except
for Network
Settings)

Execute –

Tilbakestiller innstillingene for enheten (unntatt
nettverksinnstillingene).
Execute: Utfør funksjon.

Merknad

Importerte basisutseender og LUT-filer slettes ikke.

Network Reset Execute –

Tilbakestiller nettverksinnstillingene for enheten.
Execute: Utfør funksjon.

Merknad

Når Network Reset er utført, starter enheten på
nytt. Etter ny oppstart, laster du inn siden på nytt i
nettleseren.

427



5-041-958-83(1) Copyright 2022 Sony Corporation

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Factory Default Execute –

Tilbakestiller innstillingene for enheten til standard
fabrikkinnstilling.
Execute: Utfør funksjon.

Merknad

Når Factory Default er utført, starter enheten på
nytt. Etter ny oppstart, laster du inn siden på nytt i
nettleseren.
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Information

Viser kamera- og objektivinformasjon. Brukes også til å oppdatere programvare.

Camera
Viser kamerainformasjon og oppdaterer programvare.

Lens
Viser objektivinformasjon og oppdaterer programvare.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Model
Name

– – Viser modellnavnet på kameraet.

Serial
Number

– – Viser kameraets serienummer.

Version
Number – – Viser kameraets programvareversjon.

Version Up – –

Trykk på [Choose File]-knappen og følg instruksjonene på
skjermbildet for å oppdatere kameraprogramvaren.

Merknad

Etter oppdatering vil enheten starte på nytt. Etter ny
oppstart, laster du inn siden på nytt i nettleseren.

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Model
Name

– – Viser modellnavnet på objektivet.

Serial
Number

– – Viser objektivets serienummer.

Version
Number

– – Viser objektivets programvareversjon.
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Beslektet emne

Oppdatere programvare for objektiv med E-fatning
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Version Up – –

Trykk på [Choose File]-knappen og følg instruksjonene på
skjermbildet for å oppdatere objektivprogramvaren.

Hvis du vil ha mer informasjon, se "Oppdatere
programvare for objektiv med E-fatning".

Merknad

Etter oppdatering av objektivet vil enheten på nytt. Etter ny
oppstart, laster du inn siden på nytt i nettleseren.
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System Log

Angir innstillinger som gjelder systemloggen.

Den innhentede loggen vises som vist nedenfor.

Beslektet emne

Oppdatere programvare for objektiv med E-fatning
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Angir nivået for å legge til en oppføring i
systemloggen.

Log Size 200 til 1024 1024
Angir størrelsen på loggen som skal lagres i
systemloggen.

Download
as File – –

Trykk på [Download]-knappen, og lagre
systemloggen på et nettbrett eller en datamaskin
fra skjermbildet som vises.
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HTTP Access Log

Angir innstillinger som gjelder HTTP-tilgangsloggen.
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Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Angir nivået for å legge til en oppføring i HTTP-
tilgangsloggen.

Log Size 200 til 1024 1024
Angir størrelsen på loggen som skal lagres i HTTP-
tilgangsloggen.

Download
as File – –

Trykk på [Download]-knappen, og lagre HTTP-
tilgangsloggen på et nettbrett eller en datamaskin
fra skjermbildet som vises.
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Service

Henter enhetsinformasjon om enheten. Brukes når du kontakter servicerepresentanten for Sony.

5-041-958-83(1) Copyright 2022 Sony Corporation

Element Innstilling for
underelement Fabrikkinnstilling Beskrivelse

I agree to
download device
information.

– –

Sett en hake her for å godta informasjon om enheten,
og trykk på [OK]-knappen.
Trykk på den viste [Download]-knappen. Nettleseren
laster umiddelbart ned en fil kalt deviceinformation.dat.

Merknad

Etter nedlasting vil enheten starte på nytt. Start på
nytt manuelt hvis enheten ikke starter på nytt
automatisk. Etter ny oppstart, laster du inn siden på
nytt i nettleseren.
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EULA

Viser Lisensavtale for sluttbrukere (EULA).

5-041-958-83(1) Copyright 2022 Sony Corporation
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Software

Viser programvarelisensen.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Koble til eksterne skjermer og opptaksenheter

Hvis du vil vise opptaks-/avspillingsbilder på en ekstern skjerm, angir du videoutgangstypen for den eksterne skjermen
og bruker en egnet kabel for å koble til skjermen.
Du kan også koble til en ekstern opptaker og ta opp utgangssignalet fra enheten.
Du kan vise den samme informasjonen som vises i kamerabildepanelet, for eksempel statusinformasjon og menyer, på
en ekstern skjerm. Angi ønsket systemtype for skjermvisning til On ved hjelp av [Monitoring] > [Output Display] i
nettmenyen.

Merknad

Hvis det er koblet til HDMI-kontakten som ikke støtter HDMI-utdataformatet som er konfigurert ved hjelp av menyen [Monitoring] i
nettmenyen eller kameramenyen, sendes ikke kamerabildet til Web App. Strømming av video kan heller ikke sendes ut.

Du kan sette både [Output Display] > [SDI] og [HDMI/Stream] til [Off], men det vil forhindre bruk av kameramenyen og funksjoner
som avhenger av skjermvisningen. I tillegg vil feilvarsler for enheten være begrenset til lampene (tent eller blinkende) på enheten
og visningen av varselmerket øverst til høyre i Web App. Hvis du vil se den detaljerte statusen, setter du [Output Display] til [On].

Hint

[Output Display] > [SDI] er satt til [Off] og [HDMI/Stream] er satt til [On] som fabrikkinnstilling. Hvis du vil bruke direkteavspilling
som hovedvideo, setter du [SDI] til [On] og [HDMI/Stream] til [Off] og overvåker kamerastatusen på en SDI-skjerm.

SDI OUT-kontakt (BNC-type)

Angi utgangsformatet ved hjelp av menyen [Monitoring] i nettmenyen eller kameramenyen.
Bruk en kommersielt tilgjengelig 75 Ω koaksialkabel for tilkoblingen.

Merknad

Kontroller at tilkoblingen mellom enheten og den eksterne enheten er jordet før du slår på enhetene.

Det anbefales at enheten og den eksterne enheten slås på etter at du har koblet til 75 Ω-koaksialkabelen.
Hvis den eksterne enheten må kobles til enheten mens videokameraet er på, kobler du først 75 Ω koaksialkabelen til den
eksterne enheten og deretter til enheten.

For å starte opptak på enheten og den eksterne enheten samtidig
Med SDI-signalutgangen er aktivert, setter du [Project] > [SDI/HDMI Rec Control] > [Setting] til [SDI/HDMI Remote I/F]
eller [Parallel Rec] i kameramenyen for å aktivere utsending av et REC-utløsersignal til den eksterne enheten som er
koblet til SDI OUT-kontakten. Dette synkroniserer opptaket på den eksterne enheten med enheten.

Merknad

Hvis en tilkoblet ekstern enhet ikke støtter et REC-utløsersignal, kan ikke enheten brukes.

Når [Project] > [SDI/HDMI Rec Control] > [Setting] er satt til [SDI/HDMI Remote I/F] i kameramenyen, vil REC-utløsersignalet kun
sendes ut når det ikke er satt inn noe opptaksmedium og START/STOP-knappen for opptak betjenes.

HDMI OUT-kontakt (type A-kontakt)

Angi On/Off-innstillingen for utgangen og utdataformatet i [Monitoring]-menyen i kameramenyen.
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For å starte opptak på enheten og den eksterne enheten samtidig
Med HDMI-signalutgangen er aktivert, setter du [TC/Media] > [HDMI TC Out] > [Setting] til [On] og [Project] > [SDI/HDMI
Rec Control] > [Setting] til [SDI/HDMI Remote I/F] eller [Parallel Rec] i kameramenyen for å aktivere utsending av et
REC-utløsersignal til den eksterne enheten som er koblet til HDMI OUT-kontakten. Dette synkroniserer opptaket på den
eksterne enheten med enheten.

Merknad

Hvis en tilkoblet ekstern enhet ikke støtter et REC-utløsersignal, kan ikke enheten brukes.

Når [Project] > [SDI/HDMI Rec Control] > [Setting] er satt til [SDI/HDMI Remote I/F] i kameramenyen, vil REC-utløsersignalet kun
sendes ut når det ikke er satt inn noe opptaksmedium og START/STOP-knappen for opptak betjenes.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Koble til en RCP/MSU

Enkelte av enhetens funksjoner kan fjernstyres ved å koble et fjernkontrollpanel (RCP) som RCP-3500/3501 eller en
hovedoppsettenhet (MSU) som MSU-3500 til enheten via en LAN-kabel.
Tilkoblingsmetoden vil variere avhengig av konfigurasjonen av relaterte enheter og applikasjonen.

For å få mer informasjon om én-til-én-tilkobling mellom enheten og en RCP, se "Én-til-én-tilkobling mellom enheten
og en RCP".
For å få mer informasjon om tilkobling av flere kameraer ved hjelp av en MSU eller programvare for kamerakontroll,
se "Bruke enheten i et multikameramiljø med en MSU/programvare for kamerafjernkontroll".

Beslektet emne

Én-til-én-tilkobling mellom enheten og en RCP

Bruke enheten i et multikameramiljø med en MSU/programvare for kamerafjernkontroll

5-041-958-83(1) Copyright 2022 Sony Corporation
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Én-til-én-tilkobling mellom enheten og en RCP

Merknad

Se "Liste over støttede funksjoner" og konfigurer enheten slik at den oppfyller driftsbetingelsene for funksjonene du ønsker å
bruke, og aktiver deretter tilkoblingen med en RCP ved å bruke følgende prosedyre.

Beslektet emne
Liste over støttede funksjoner
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Slå på hver enhet.1

Angi [Technical] > [RCP/MSU] > [CNS Mode] til [Bridge] i nettmenyen på kameraet.2

Konfigurer følgende innstillinger på RCP.

Du finner mer informasjon om konfigurasjon i bruksanvisningen til RCP.

3

Sett tilkoblingsmodusen til Bridge-modus.1.
Registrer kameraets IP-adresse.2.
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Bruke enheten i et multikameramiljø med en MSU/programvare for
kamerafjernkontroll

Du kan koble til flere kameraer ved å bruke en MSU eller programvare for kamerafjernkontroll.

Merknad

Se "Liste over støttede funksjoner" og konfigurer enheten slik at den oppfyller driftsbetingelsene for funksjonene du ønsker å
bruke, og aktiver deretter tilkoblingen med en MSU eller programvare for kamerafjernkontroll ved å bruke følgende prosedyre.

Beslektet emne
Liste over støttede funksjoner
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Slå på hver enhet.1

Konfigurer systemnettverksinnstillinger ved å bruke MSU eller programvaren for kamerafjernkontroll.

Du finner mer informasjon om konfigurasjon i bruksanvisningen til MSU eller programvaren for kamerafjernkontroll.

2

Konfigurer følgende innstillinger med [Technical] > [RCP/MSU] i kameraets nettmeny.3

Hvis du bruker en MSU, sett [CNS Mode] til [MCS]. Hvis du bruker programvaren for kamerafjernkontroll, sett
[CNS Mode] til [PC Control].

1.

Angi IP-adressen til hoved-MSU eller programvaren for kamerafjernkontroll [Master IP Address].2.
Angi kameranummeret som kameraet skal registreres for [Camera No.].3.
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Liste over støttede funksjoner

Tabellen nedenfor viser de støttede funksjonene og deres tilhørende driftsforhold.

Kontrollpanel Enhetens funksjoner Driftsforhold

IRIS Manuell justering av iris –

AUTO IRIS Slå Auto Iris på/av –

ND
Bytte ND-filterets forhåndsinnstilte posisjon
(Clear/Preset1 til Preset3)

Denne funksjonen er aktivert når [Shooting] >
[ND Filter] > [Mode] er satt til [Preset] i
kameramenyen.

MASTER GAIN
Manuell justering av forsterkningen (3 dB
enheter)

Aktivert når både opptaksmodus er satt til
Custom-modus og [Shooting] > [ISO/Gain/EI] >
[Mode] er satt til [dB] i kameramenyen.

WHITE (R/B) Justere hvitbalansen (R Gain/B Gain) manuelt

Aktivert når [White Mode] er satt til [Memory
A(R/B)] eller [Memory A(T/T)].WHITE (Color

Temp)

Justere hvitbalansen (fargetemperatur/-tone)
manuelt

RCP – [Color Temp]: Fargetemperatur for
hvitbalanse
RCP – [Balance]: Fargetoneverdi for
hvitbalanse

ATW
Slå ATW-funksjonen (automatisk sporende
hvitbalanse) på/av

Aktivert når fotograferingsmodus (foto) /
opptaksmodus (video) er satt til Custom-modus.

BLACK R/B Justere svartbalansen
Aktivert når fotograferingsmodus (foto) /
opptaksmodus (video) er satt til Custom-modus.
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Merknad

Konfigurer enheten slik at den oppfyller driftsbetingelsene for funksjonene du ønsker å bruke, og aktiver deretter tilkoblingen med
en RCP/MSU. Dersom driftsforholdene justeres etter at tilkoblingen er aktivert, kan det oppstå utilsiktet oppførsel.
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Kontrollpanel Enhetens funksjoner Driftsforhold

MASTER
BLACK

Justere hovedsortnivået

Aktivert når fotograferingsmodus (foto) /
opptaksmodus (video) er satt til Custom-
modus.
H/V Ratio og Crispening er aktivert når
[Paint/Look] > [Detail] > [Manual Setting] er
satt til [On] i kameramenyen.

DETAIL

Slå detaljfunksjonen på/av
Angi detaljnivået
Innstilling H/V Ratio
Innstilling Crispening

User Matrix

Slå funksjonen for korreksjon av
brukermatrisen av/på
Innstilling av matrisekorrigeringsverdier (R-
G/R-B/G-R/G-B/B-R/B-G)

Multi Matrix

Slå funksjonen for multimatrisekorrigering
av/på
Angi fargetonen og -metningen som brukes
til multimatrisekorreksjon

Knee
Slå knekorrigeringsfunksjonen på/av
Slå den automatiske knefunksjonen på/av
Innstilling av knepunkt og knehelling

BARS Slå fargestolpene av/på

SHUTTER

Slå lukkerfunksjonen på/av
Stille inn verdi for lukkerhastighet
(Slå automatisk lukker på/av, stille inn
lukkervinkel, stille inn sakte lukker, stille inn
ECS støttes ikke.)

Merknad

Lukkerinnstillingene for RCP vil kanskje
ikke vises, avhengig av den konfigurerte
lukkerhastighetsverdien.

Lukkerinnstillingene for RCP vil kanskje
ikke vises korrekt hvis lukkeren ikke kan
betjenes fra RCP-en.

Når auto-lukker er på, vil auto-lukker fortsette å
fungere selv om du slår lukkeren på/av eller
endrer lukkerhastighetsverdien fra RCP.
Når lukkeren er satt til [Angle], er det å slå
lukkeren på/av eller endrer
lukkerhastighetsverdien fra RCP ikke støttet.
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Om betjening ved hjelp av en RM-IP500-fjernkontroll (alternativ)

Du kan betjene enheten ved hjelp av en Sony RM-IP500-fjernkontroll som kjører programvareversjon 2.2 eller nyere.
Enhetene kommuniserer ved hjelp av VISCA over IP (LAN).
Avhengig av målelementet som skal betjenes, må du kanskje vise skjermen på enheten. Klargjør en skjerm som kan
brukes til å kontrollere skjermbildevisningen.
Følgende betjening støttes fra en RM-IP500-fjernkontroll.

Velge målkameraet
Justere rammene (pan, tilt, zoom)
Justere fokuset (ekskluderer berøringsfunksjon)
Registrere og tilbakekalle forhåndsinnstilte posisjoner
Betjene menyen til enheten (unntatt nettmenyen)
Justere lysstyrken
Justere hvitbalansen
Justere svartbalansen
Justere lydinngangsnivået
Starte/stoppe opptak
Utføre tilordnede knappefunksjoner for enheten

Hvis du vil ha mer informasjon om RM-IP500-betjening, kan du se bruksanvisningen for RM-IP500.

Hint

Når du bruker en RM-IP500, bruker du panelarket for denne enheten som følger med RM-IP500.

RM-IP500 (bruker panelark for denne enheten)
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Koble til en RM-IP500-fjernkontroll

Hvis du vil ha mer informasjon om tilordning av funksjoner, kan du se bruksanvisningen for RM-IP500.

5-041-958-83(1) Copyright 2022 Sony Corporation

Sett SETUP-bryter 3 på enheten i ON-posisjon for å aktivere VISCA over IP-kommunikasjon.

Merknad

Bryterinnstillingen brukes neste gang enheten slås på.

1

Koble RM-IP500 til samme nettverk som enheten.2

Følg fremgangsmåten i bruksanvisningen for RM-IP500 for å konfigurere VISCA over IP-tilkobling (LAN) på
RM-IP500.

Tilordne denne enheten ved hjelp av RM-meny > AUTO IP SETUP > ASSIGN CAM.

3

Tilordne funksjoner for denne enheten til knapper og knotter etter behov ved hjelp av følgende RM-
menyelementer i RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Om synkronisering med en ekstern enhet

Ved opptak med flere enheter kan enhetene synkroniseres med et bestemt referansesignal eller tidskode via enhetenes
GENLOCK-kontakt.

Hvis du vil ha mer informasjon om genlock, se "Synkronisere fasen av videosignalet (Genlock)".
Hvis du vil ha mer informasjon om synkronisering av tidskoder, se "Låse tidskoden til andre enheter".

Beslektet emne
Synkronisere fasen av videosignalet (Genlock)

Låse tidskoden til andre enheter

5-041-958-83(1) Copyright 2022 Sony Corporation
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Synkronisere fasen av videosignalet (Genlock)

Du kan angi et referansesignal til GENLOCK-kontakten for å aktivere genlock.
Inngangsreferansesignalene som kan brukes, varierer avhengig av systemfrekvensen for det valgte opptaksformatet.

Du kan kontrollere statusen for ekstern synkronisering ved hjelp av [Technical] > [Genlock] > [Reference] i
kameramenyen.

Merknad

Hvis referansesignalet er ustabilt, kan ikke genlock oppnås.

Underbæreren er ikke synkronisert.
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Systemfrekvens for opptaksformat Støttede referansesignaler for inndata

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Låse tidskoden til andre enheter

Still enheten som forsyner tidskoden til en modus der tidskodeutgangen fortsetter å gå, (for eksempel Free Run eller
Clock).

Merknad

Kontroller at den medfølgende referansetidskoden og referansevideosignalet er i et faseforhold som er i samsvar med SMPTE-
tidskodestandarden.

Når du bruker ekstern lås, låses tidskoden umiddelbart med den eksterne tidskoden, og den eksterne tidskodeverdien vises i
visningsområdet for tidsdata. Du må imidlertid ikke starte opptaket umiddelbart. Vent noen sekunder til tidskodegeneratoren
stabiliseres før du tar opp.

Hvis frekvensen til referansevideosignalet og bildefrekvensen på enheten ikke er den samme, kan ikke låsen innhentes, og
enheten vil ikke fungere som den skal. Hvis dette skjer, vil tidskoden ikke oppnå låsing med den eksterne tidskode.

Hvis den eksterne tidskodekilden kobles fra, kan tidskoden skifte med ett bilde per time med hensyn til referansetidskoden.

For å frigi den eksterne låsen
Endre innstillingen [TC/Media] > [Timecode] i kameramenyen.
Ekstern synkronisering frigis også hvis systemfrekvensen endres, og når du starter opptaket i en spesiell opptaksmodus
(Slow & Quick Motion eller Interval Rec).
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Angi følgende i [TC/Media] > [Timecode] i kameramenyen.

Angi [Mode] til [Preset].
Angi [Run] til [Free Run].

1

Trykk på en knapp som er tilordnet med [DURATION/TC/U-BIT]-funksjonen for å vise tidskoden på
skjermen.

2

Lever et HD- eller SD-referansevideosignal til GENLOCK-kontakten og referansetidskoden til TC IN-
kontakten.

Tidskodegeneratoren på enheten låser seg til den aktuelle referansekoden, og "EXT-LK" vises på skjermen.
Når det har gått ca. ti sekunder etter tidskodelåsingen, opprettholdes den eksterne låsestatusen selv om den
eksterne referansekodekilden kobles fra.

3
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Koble til en ekstern mikrofon eller ekstern lydenhet

Du kan legge inn signalet fra en ekstern mikrofon eller ekstern lydenhet og bygge inn lyden i videoopptaket eller
utgangsvideoen til enheten.

Koble til en ekstern mikrofon eller ekstern lydenhet ved hjelp av en XLR-kabel.

Når lyden er satt til [LINE] ved hjelp av [Audio] > [Audio Input] > [AUDIO IN Select] i kameramenyen, fungerer
AUDIO IN-kontakten som AUDIO IN CH-1-kontakt og AUDIO IN CH-2-kontakt.

1

Pinne nr. Funksjon

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Slå av enheten og koble XLR-kabelen til AUDIO IN-kontakten.2

Angi SETUP-bryter 2 for å aktivere fantomstrømforsyningen etter behov.

Bytt strømforsyningen på +48 V (fantomstrøm) som beskrevet nedenfor.
Bryter 2
Angir om strømforsyningen på +48 V (fantomstrøm) slås av/på når en enhet for lydinngang kobles til.

3

Innstilling Beskrivelse

OFF
(standard)

Dette slår av +48 V-fantomstrømforsyningen og angir LINE- eller MIC-inngangen som CH-1- og
CH-2-lydkilden.
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Merknad

Hvis du setter denne bryteren i ON-posisjon og kobler til en mikrofon som ikke er kompatibel med en +48 V-kilde, kan det
skade den tilkoblede enheten. Kontroller innstillingen før du kobler til enheten.

Innstilling Beskrivelse

ON
Dette slår på +48 V-fantomstrømforsyningen og angir mikrofonen som er kompatibel med +48 V-
fantomstrøm som CH-1- og CH-2-lydkilden.

Slå på enheten og angi type tilkoblet enhet ved hjelp av [Audio] > [Audio Input] > [AUDIO IN Select] i
kameramenyen.

4
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Administrere/redigere klipp ved hjelp av en datamaskin

Du kan administrere/redigere klipp ved hjelp av en datamaskin.

Importere klipp ved hjelp av en kortleser (alternativ)

Koble en CFexpress type A-kortleser eller SD-kortleser til datamaskinen, og bruk programvare som støtter
opptaksformatet for denne enheten, for eksempel Catalyst Browse, til å importere klippene.

Bruke et ikke-lineært redigeringssystem

I et ikke-lineært redigeringssystem kreves en redigeringsprogramvare (tilleggsutstyr) som støtter formatene som er tatt
opp med enheten.

5-041-958-83(1) Copyright 2022 Sony Corporation
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Sende ut et optisk fibersignal

Du kan sende et SDI-signal konvertert til et optisk signal ved å koble en SFP+-modul (alternativ) til enhetens OPTICAL-
kontakt. Bruk en SFP+-modul som samsvarer med signalbåndet for hvert format.
Signalbånd

4K (59.94p, 50p): 12G
4K (bortsett fra 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (bortsett fra 59.94p, 50p): 1.5G

Merknad

Bruk en modul som overholder følgende standarder.

SFF-standarder
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI-standarder
ST297/ST292/ST424/ST425/ST2081/ST2082

Det samme signalet som SDI-utgangskontakten sendes til SFP+-modulen.

Denne enheten støtter ikke optisk fibersignalinngang.

Bruk en SFP+-modul for optisk fibersignalutgang. Hvis du vil ha mer informasjon om bekreftede SFP+-moduler, kontakt
forhandleren din eller en servicerepresentant for Sony.
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* Strømnivå I (1,0 W)
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Koble til et tellesignal

Dette emnet beskriver tellesignalkontroll.

Tenne tellelampen ved hjelp av et signal fra en fjernkontroll

Du kan lyse opp tellelampen ved hjelp av en VISCA over IP-kommando fra en ekstern enhet, for eksempel RM-IP500.
Angi [Technical] > [Tally] > [Tally Control] til [External] i nettmenyen eller kameramenyen.

Tenne tellelampen fra en ekstern enhet

Du kan lyse opp tellelampen på enheten i rødt eller grønt fra en ekstern enhet, for eksempel RM-IP500 eller en bryter. Du
kan kontrollere tally ved hjelp av kommandoer som overføres over nettverket, eller ved hjelp av en tellesignalinngang på
OPTION-kontakten på enheten.
Angi [Technical] > [Tally] > [Tally Control] til [External] i nettmenyen eller kameramenyen.
Når du legger inn et tellesignal på OPTION-kontakten, festes kortslutningspinne 7 til GND (enten pinne 4 eller 5) for å
lyse opp tellelampen i grønt, eller pinne 8 til GND (enten pinne 4 eller 5) for å lyse opp tellelampen i rødt.

Merknad

Når [Tally Control] er satt til [External], angis ikke opptaksstatusen til enheten av tellelampen.

Når en rød tally og grønn tally legges inn samtidig, lyser tellelampen på enheten rødt.

Spesifikasjoner for OPTION-kontaktpinne

Pinne nr. Signalretning Signalspesifikasjoner

1 – RS-232C TX-signal (for objektivkontroller)

2 – RS-232C RX-signal (for objektivkontroller)

3 OUT

Grønn tellelampeutgang
Lavnivåutgang når grønn tellelampe lyser.
Hi-Z (åpen utgang) når grønn tellelampe ikke lyser.

4 – GND (jord)

5 – GND (jord)
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Tenne tellelampen på en ekstern enhet ved hjelp av et signal fra enheten

Du kan tenne tellelampen på en ekstern enhet ved hjelp av et signal fra enheten ved å koble pinne 3 og pinne 6 til
OPTION-kontakten som vist nedenfor.
Eksempel på tilkobling av OPTION-kontaktpinner 3 og 6

Merknad

Ikke bruk spenning på pinne 7 og 8.

Ikke koble til en ekstern enhet som kan påføre spenning på OPTION-kontakten.

Hvis en innkobling eller omvendt spenning som overskrider klassifiseringen påføres pinne 3 eller 6, kan det føre til funksjonsfeil,
røyk eller brann.

Angi utgangssignalet ved hjelp av [Technical] > [Tally] > [Tally Control] i nettmenyen eller kameramenyen.
[Internal]: Status for opptaksbetjening av enheten
[External]: Logical-AND fra røde/grønne tellesignaler mottatt av enheten via IN-signalet eller fjernkontrollen.
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Pinne nr. Signalretning Signalspesifikasjoner

6 OUT

Rød tellelampeutgang
Lavnivåutgang når rød tellelampe lyser.
Hi-Z (åpen utgang) når rød tellelampe ikke lyser.

7 IN
Grønn ekstern tellekontrollinngang
Kortslutning til jording (pinne 4 eller 5) fører til at enhetens tellelampe lyser grønt.

8 IN
Rød ekstern tellekontrollinngang
Kortslutning til jording (pinne 4 eller 5) fører til at enhetens tellelampe lyser rødt.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sende ut tracking-data (free-d)

Enheten kan sende ut tracking-informasjon for pan/tilt/zoom, fokus og iris, sykronisert med et sync-signal.
Utgangsdata er i samsvar med free-d-protokollen, som er en industristandard. Du kan velge utgangssignalmetoden, og
velge mellom konstant utgangssignal og utgangssignal ved forespørsel fra klienter. Velg utgangssignalmetode i samsvar
med ditt VR/AR-system.

Utdataformat

Hint

Teknisk informasjon er angitt i "Integrasjonshåndbok for free-d." Kontakt en Sony-salgsrepresentant.

Sporingsdata som sendes ut av enheten består av følgende data, i tråd med formatet som er angitt i Type D0/D1 i free-d-
protokollen.
Type D0 – poll/command

Kontroller at enheten er slått på.1

Velger utgangssignalmetode for tracking-data.

For konstant utgangssignal

For utgangssignal på forespørsel fra klienter

2

Angi [Technical] > [Tracking Data Output] > [Transfer Mode] til [Always] i nettmenyen.1.
Legg inn ID for enheten i [Camera ID].2.
Angi utgangsdestinasjonens IP-adresse i [Destination Address].3.
Angi utgangsdestinasjonens portnummer i [Destination Port].4.
Trykk på [OK]-knappen.5.

Angi [Technical] > [Tracking Data Output] > [Transfer Mode] til [On Demand] i nettmenyen.1.
Legg inn ID for enheten i [Camera ID].2.
Angi portnummeret for lytting etter forespørsler fra klienter [Listen Port].3.
Trykk på [OK]-knappen.4.

Symbol Innhold Beskrivelse

<D0> Message type

<CA> Camera ID

<CD> command

Støtter følgende kommandoer:

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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Type D1 – camera position/orientation data

Merknad

Sporingsdata kan være forsinket eller verdier blir kanskje ikke oppdatert i følgende situasjoner:

Ved utsending av RAW-video
Når S&Q Motion er på
Ved visning av kameramenyen
Ved visning av miniatyrbildeskjermen
Ved avspilling av innspilte klipp
Ved visning av nettmenyen
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Symbol Innhold Beskrivelse

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Pan angle (−170° til +170°)

<TH><TM><TL> Camera Tilt Angle Tilt angle (−30° til +195°)

<RH><RM><TL> Camera Roll Angle Ikke støttet (alltid 0)

<XH><XM><XL> Camera X-Position Ikke støttet (alltid 0)

<YH><YM><YL> Camera Y-Position Ikke støttet (alltid 0)

<HH><HM><HL> Camera Height Ikke støttet (alltid 0)

<ZH><ZM><ZL> Camera Zoom Brennvidde

<FH><FM><FL> Camera Focus Fokusavstand

<SH><SL> Spare/User Defined Irisposisjon

<CK> Checksum
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Koble til en objektivkontroller

Du kan betjene zoomen på en manuell zoom-linse fra Web App, RM-IP500 (valgfritt), eller fra infrarød-fjernkontrollen ved
å koble til en objektivkontroller, som er tilgjengelig i handelen (valgfritt), og som er kompatibel med denne enheten.
For mer informasjon om tilkobling av en objektivkontroller, se i bruksanvisningen for objektivkontrolleren.
Hvis du vil ha mer informasjon om justering av zoom med objektivkontroller, se "Justering av zoom med
objektivkontroller".

Merknad

Før du bruker objektivkontrolleren, les bruksanvisningen for objektivkontrolleren nøye og sørg for at du fullt ut forstår bruksmåten.
Sony vil ikke være ansvarlig for noe krav av noen type som er resultat av bruk av en objektivkontroller.

Clear Image Zoom er ikke tilgjengelig når en objektivkontroller er aktivert. Det anbefales at du setter Clear Image Zoom-forholdet
til 1.0× eller deaktiverer Clear Image Zoom.

Når objektivkontrolleren er aktivert, er det ikke mulig med opptak eller avspilling med kamera-framing-funksjoner.

Beslektet emne
Justering av zoom med objektivkontroller
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justering av zoom med objektivkontroller

Bruk følgende prosedyre for å feste en objektivkontroller (valgfritt) og justere zoomen.

Kontroll av objektivkontrollerens status
Trykk på  (kamerastatus)-knappen i fellesområdet på Web App-skjermen for å vise kamerastatusskjermen.

Koble til en objektivkontroller på OPTION-kontakten på enhetens kontaktblokk.

Du finner mer informasjon om festing i bruksanvisningen for objektivkontrolleren.

1

Sett opp objektivkontrolleren for ditt zoom-objektiv.

For mer informasjon, se i bruksanvisningen for objektivkontrolleren.

2

Lås pan/tilt på enheten og fest zoom-objektivet.

Hvis du vil ha mer informasjon, se "Hvordan sette på et objektiv".

3

Juster objektivkontrolleren slik at den kan betjene zoom-objektivet.4

Oppretthold balansen forover/bakover på kamerahodet slik at skyvebunnen er horisontal.

For mer informasjon, se i bruksanvisningen for objektivkontrolleren og "Hvordan sette på et objektiv".

5

Angi [Technical] > [Lens Controller] > [Setting] til [On] i nettmenyen og trykk på [OK]-knappen.

Enheten vil starte på nytt. Vent til tilbakestillingsoperasjonen for pan/tilt- er fullført.

6

Trykk på  (initialiser objektivkontroller)-knappen på  (Others)-fanen i
kamerakontrollpanelet på skjermbildet for direkte betjening i Web App.

Objektivkontrolleren beveger seg for å detektere zoom-området. For mer informasjon, se i bruksanvisningen for
objektivkontrolleren.
Når  (objektivkontrollerfeil)-indikasjonen skifter til  (objektivkontroller klar) øverst til venstre i
kamerabildepanelet, er klargjøringen fullført.

Merknad

Merk deg betjeningsområdet for objektivet når du initialiserer objektivkontrolleren.

7

Juster zoomen med [Zoom] glidebryteren i Web App eller zoom-kontrollknappene på infrarød-
fjernkontrollen.

8
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Du kan kontrollere objektivkontrollerens status i denne skjermen.

Merknad

Når du skifter objektiv, initialiser objektivkontrolleren.

Clear Image Zoom er ikke tilgjengelig når en objektivkontroller er aktivert. Det anbefales at du setter Clear Image Zoom-forholdet
til 1.0× eller deaktiverer Clear Image Zoom.
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Status Beskrivelse

Off Bruke elektrisk zoom i et objektiv med E-fatning.

Communication
Error

En kommunikasjonsfeil oppsto mellom enheten og objektivkontrolleren.
Kontroller tilkoblingen mellom enheten og objektivkontrolleren, se i brukerinstruksjonene for
objektivkontrolleren og initialiser objektivkontrolleren.

Uninitialized Utfør initialisering.

Initializing Vent til initialiseringen er fullført.

Initialization
Failed

Kontroller tilkoblingen mellom enheten og objektivkontrolleren, se i brukerinstruksjonene for
objektivkontrolleren og initialiser objektivkontrolleren.

Working Kontroller zoom med objektivkontrolleren.

Rotation Error
Det lagrede zoom-bevegelsesområdet og objektivets bevegelsesområde samsvarer ikke.
Initialiser objektivkontrolleren.

System Error Kontroller tilkoblingen mellom enheten og objektivkontrolleren, se i brukerinstruksjonene for
objektivkontrolleren og initialiser objektivkontrolleren, eller slå enheten og objektivkontrolleren av
og på igjen.Unknown Error
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Forsiktighetsregler ved bruk

Forsiktighetsregler ved transport og pakking
Ved transport og pakking av enheten, sørg for å opprettholde følgende forhold, og unngå å utsette den for kraftig
vibrasjon og støt.

Fjern objektivet og sett på husets lokk.
Etter å ha flyttet kamerahodet (A) til fronten, drei låsespaken for kamerahodet (B) i pilens retning for å låse
kamerahodet.

Orienter kamerahodet slik at det vender mot fronten og lås det med pan/tilt-låsespaken.

Fjern tilkoblingskabelene.

Kondens
Hvis enheten flyttes plutselig fra et kaldt til et varmt sted, eller hvis temperaturen i omgivelsene plutselig stiger, kan
fuktighet kondensere på overflaten og/eller inne i enheten. Dette kalles fuktighetskondens. Hvis kondens forekommer,
slår du av enheten og bruker den ikke før kondensen har fordampet. Bruk av enheten mens det er kondens kan skade
enheten.

CMOS bildesensorfenomen i kameraet

Merknad

De følgende fenomenene kan oppstå i bilder, og er spesifikke for bildesensorer. De indikerer ikke en feiltilstand.

Hvite flekker
Selv om bildesensorene produseres med svært presise teknologier, kan det en sjelden gang dannes små hvite
flekker på skjermen, og dette skjer på grunn av kosmisk stråling osv.
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Dette skyldes bildesensorens virkemåte og er ikke en feil. Utfør APR regelmessig.
De hvite flekkene har spesielt en tendens til å vises under følgende omstendigheter:

Når det jobbes med høye omgivelsestemperaturer
Når du har økt forsterkningen (følsomheten)

Flimmer
Når du tar bilder i lyst fra lysrør, natriumlamper, kvikksølvdamplamper eller LED-lys, kan skjermen flimre eller fargene
kan variere.

Objektiv- og pan/tilt-driverenheter
Hvis objektivet og pan/tilt-drivmekanismen ikke brukes over en lengre periode, kan viskositeten til fettet som påføres
innvendig øke, slik at mekanismen ikke beveger seg. Betjen objektivet og pan/tilt-mekanismen jevnlig.

På slitedeler
Viften og det innebygde oppladbare batteriet er forbruksmaterialer som må skiftes ut periodisk.
Ved bruk i romtemperatur, må de vanligvis skiftes ut etter omtrent fem år. Dette er derimot kun en generell veiledning
og antyder ikke at disse delenes forventet levetid er garantert.
For detaljer om utskifting av delen, kontakter du Sony service eller forhandleren.

Den forventede levetiden til AC-adapteren og elektrolyttkondensatoren er ca. 5 år under normale driftstemperaturer
og normal drift (8 timer per dag, 25 dager per måned). Hvis bruken overskrider den ovennevnte bruksfrekvensen, kan
den forventede levetiden reduseres tilsvarende.

Periodiske kontroller anbefales for å holde enheten i orden og forlenge levetiden. Kontakt en servicerepresentant for
Sony for å få mer informasjon om inspeksjoner.

Om det innebygde oppladbare batteriet
Enheten har et innebygd oppladbart batteri for lagring av dato, klokkeslett og andre innstillinger, selv når enheten er slått
av. Det innebygde oppladbare batteriet lades i løpet av 24 timer hvis enheten er koblet til en stikkontakt ved hjelp av
strømadapteren, eller får strøm via PoE++, uavhengig av om enheten er slått av eller på. Det oppladbare batteriet blir
helt utladet i løpet av cirka to måneder hvis strømadapteren ikke kobles til strømforsyning. Bruk enheten etter at batteriet
er ladet. Selv om det oppladbare batteriet ikke er ladet, påvirkes ikke driften av enheten så lenge du ikke trenger å
registrere datoen.

Bruks- og oppbevaringssteder
Oppbevares på et flatt, ventilert sted.
Unngå å bruke eller oppbevare enheten på følgende steder.

Steder utsatt for regn eller vann (inkludert under tak)
Utendørs og steder med mer enn 40 °C
Om sommeren og i varmt klima skal du huske på at temperaturen inne i en bil med lukkede vinduer lett overstiger 50
°C.
Steder kaldere enn 0 °C.
På fuktige eller støvete steder. Steder der enheten kan bli utsatt for regn
Steder utsatt for vibrasjon eller støt
Steder der stråling, røntgenstråler og sterke magnetiske felt genereres.
I nærheten av radio- eller TV-sendere som produserer sterke elektromagnetiske felt
Lange perioder i direkte sollys eller i nærheten av varmeovner

Merknad om laserstråler
Laserstråler kan skade CMOS-bildesensoren. Hvis du filmer et motiv som inneholder en laserstråle, må du være forsiktig
slik at laserstrålen ikke rettes inn i CMOS-bildesensoren på kameraet. Spesielt kan kraftige laserstråler fra medisinsk
utstyr eller annet utstyr forårsake skade på grunn av reflektert lys og spredt lys.

For å hindre elektromagnetisk forstyrrelse fra bærbart kommunikasjonsutstyr
Bruk av bærbare telefoner og andre kommunikasjonsenheter i nærheten av denne enheten kan føre til feil og
forstyrrelser i lyd- og bildesignaler. Det anbefales at de bærbare kommunikasjonsenhetene i nærheten av denne enheten
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slås av.

Dette produktet må ikke plasseres i nærheten av medisinske enheter
Dette produktet (inkludert tilbehør) inneholder magneter som kan påvirke pacemakere, programmerbare shuntventiler for
behandling av hydrocefalus eller andre medisinske enheter. Dette produktet må ikke plasseres i nærheten av personer
som bruker slike medisinske enheter. Hvis du bruker slike medisinske enheter, må du høre med legen din før du bruker
dette produktet.

Sikkerhetstiltak
SONY SKAL IKKE VÆRE ANSVARLIG FOR SKADER AV NOE SLAG SOM FØLGER AV UNNLATELSE AV Å
IMPLEMENTERE RIKTIGE SIKKERHETSTILTAK PÅ OVERFØRINGSENHETER, UUNNGÅELIGE
DATALEKKASJER PÅ GRUNN AV OVERFØRINGSSPESIFIKASJONER ELLER SIKKERHETSPROBLEMER AV
NOE SLAG.
Avhengig av driftsmiljøet, kan uautoriserte tredjeparter på nettverket være i stand til å få tilgang til enheten. Ved
tilkobling av enheten til nettverk må du sørge for å kontrollere at nettverket har sikker beskyttelse.
Utfra et sikkerhetsstandpunkt, når enheten brukes tilkoblet til nettverket, anbefaler vi sterkt å gå til Kontroll-vinduet via
en nettleser og endre innstillingene for tilgangsbegrensning bort fra de forhåndsinnstilte verdiene fra fabrikken. Det
anbefales også å angi et passord med en tilstrekkelig lang tegnstreng som er vanskelig å gjette for andre, og at du
oppbevarer denne på en sikker måte.
Ved tilkobling av dette produktet til et nettverk, koble til via et system som har en beskyttelsesfunksjon, som for
eksempel en ruter eller en brannvegg. Hvis produktet kobles til uten slik beskyttelse kan det medføre
sikkerhetsproblemer.

Strømforsyning
Enheten er ikke utstyrt med en strømbryter. For å slå av enheten må du kontrollere at alle operasjoner er avsluttet og
at enheten er i standby-modus for strøm, og deretter koble fra strømadapteren. Koble fra LAN-kabelen når du bruker
PoE++-strømforsyning.
Der det er mulig, bør du bruke en strømkilde fra et sted der det er enkelt å sette inn og fjerne strømpluggen.
Hvis du bruker et uttak på et støvete sted, må du rengjøre området rundt uttaket regelmessig for å unngå sporing.
Koble fra strømtilførselen når den ikke er i bruk.

Forsiktighetsregler for bevegelige deler
Pass på at fremmedlegemer ikke kommer inn i bevegelige deler.
Ikke bruk for mye belastning når du flytter deler for hånd. Det kan føre til funksjonsfeil.
Ikke forstyrr driften av bevegelige deler under bevegelse. Det kan føre til personskade eller funksjonsfeil.
Bevegelige deler fungerer kanskje ikke normalt hvis enheten ikke brukes over lengre tid. Betjen enhetens pan/tilt-
funksjoner regelmessig.

Forsiktighetsregler for kontinuerlig drift
Enheten kan være strømsatt 24 timer i døgnet, 365 dager i året (strømforsyning i standby-tilstand).
Utfør alltid en opptakstest og verifiser at enheten fungerer normalt.

Kontinuerlig opptak i perioder på over 24 timer er ikke garantert.
Ved opptak i en periode lengre enn 24 timer, sett enhetens strømforsyning i standby-tilstand og start enheten på
nytt.

Merk at Sony ikke vil være ansvarlig for kompensasjon av noe slag for bildeinnholdet hvis du ikke kan gjøre opptak
på grunn av en feil under bruk av denne enheten.
Kontroller alltid at enheten virker som den skal før bruk. SONY VIL IKKE VÆRE ANSVARLIG FOR SKADER AV NOE
SLAG INKLUDERT, MEN IKKE BEGRENSET TIL, ERSTATNING ELLER TILBAKEBETALING PÅ GRUNN AV TAP
AV EKSISTERENDE ELLER FREMTIDIG FORTJENESTE SOM SKYLDES SVIKT AV DENNE ENHETEN, ENTEN
UNDER GARANTIPERIODEN ELLER ETTER AT GARANTIEN HAR UTLØPT, ELLER FOR UANSETT ANNEN
ÅRSAK.
SONY VIL IKKE VÆRE ANSVARLIG FOR KRAV AV NOE SLAG, FREMSATT AV BRUKERE AV ENHETEN ELLER
FREMSATT AV TREDJEPARTER.
SONY VIL IKKE VÆRE ANSVARLIG FOR AVSLUTNING ELLER AVBRUDD I NOEN TJENESTE SOM ER
RELATERT TIL DENNE ENHETEN SOM MÅTTE OPPSTÅ PÅ GRUNN AV NOEN SOM HELST OMSTENDIGHET.
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Forsiktighetsregler for opptaksfunksjonen
Foreta alltid en testinnspilling og bekreft at innspillingen ble vellykket. SONY VIL IKKE VÆRE ANSVARLIG FOR
SKADE AV NOE SLAG INKLUDERT, MEN IKKE BEGRENSET TIL, ERSTATNING ELLER TILBAKEBETALING PÅ
GRUNN AV SVIKT AV DENNE ENHETEN ELLER DENS OPPTAKSMEDIA, ELLER NOEN ANDRE MEDIA ELLER
LAGRINGSSYSTEMER FOR OPPTAK AV ET HVILKET SOM HELST INNHOLD.
Kontroller alltid at enheten virker som den skal før bruk. SONY VIL IKKE VÆRE ANSVARLIG FOR SKADER AV NOE
SLAG INKLUDERT, MEN IKKE BEGRENSET TIL, ERSTATNING ELLER TILBAKEBETALING PÅ GRUNN AV TAP
AV EKSISTERENDE ELLER FREMTIDIG FORTJENESTE SOM SKYLDES SVIKT AV DENNE ENHETEN, ENTEN
UNDER GARANTIPERIODEN ELLER ETTER AT GARANTIEN HAR UTLØPT, ELLER FOR UANSETT ANNEN
ÅRSAK.
SONY VIL IKKE VÆRE ANSVARLIG FOR KRAV AV NOE SLAG, FREMSATT AV BRUKERE AV ENHETEN ELLER
FREMSATT AV TREDJEPARTER.
SONY VIL IKKE VÆRE ANSVARLIG FOR TAP, REPARASJONER ELLER REPRODUKSJON AV NOEN DATA SOM
ER TATT OPP PÅ DET INTERNE LAGRINGSSYSTEMET, OPPTAKSMEDIER, ELLER NOEN ANDRE MEDIER
ELLER LAGRINGSSYSTEMER.
SONY VIL IKKE VÆRE ANSVARLIG FOR AVSLUTNING ELLER AVBRUDD I NOEN TJENESTE SOM ER
RELATERT TIL DENNE ENHETEN SOM MÅTTE OPPSTÅ PÅ GRUNN AV NOEN SOM HELST OMSTENDIGHET.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Utdataformater og -begrensninger

Dette emnet beskriver utdataformater og -begrensninger.

Merknad

Oppløsningen på utdataformatet begrenses av innstillingene for [Project] > [Rec Format] > [Frequency], [Codec] og [Video
Format] i nettmenyen eller kameramenyen.

Oppløsningen på utdataformatet begrenses også av kombinasjonen med S&Q-bildefrekvensen. I tillegg til tabellen for SDI
OUT/HDMI OUT-kontaktutgangsformater nedenfor, endres HDMI-utgangen til Full HD eller lavere når alle følgende betingelser er
oppfylt.

[Shooting] > [S&Q Motion] > [Setting] er satt til [On]
[Shooting] > [S&Q Motion] > [Frame Rate] er høyere enn 60fps

Når betingelsene ovenfor blir oppfylt, blir valgalternativene HDMI-utgang 4096×2160P og 3840×2160P for [Monitoring] > [Output
Format] > [SDI/HDMI] nedtonet og kan ikke velges.

Bildet blir ikke sendt hvis en høyere oppløsning enn avspillingens bildeoppløsning konfigureres.

Utdataformater for kontakten SDI OUT/HDMI OUT

Når systemfrekvensen er 50/59.94 Hz

Innstilling Utdataformat som kan velges

Modus for
opptak/avspilling

Oppløsning for RAW-
utdata /

oppløsning for internt
opptak

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(standard)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(standard)
1920×1080i
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Når systemfrekvensen er 25/29.97 Hz

Innstilling Utdataformat som kan velges

Modus for
opptak/avspilling

Oppløsning for RAW-
utdata /

oppløsning for internt
opptak

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(standard)

1920×1080P
(standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(standard)

1920×1080P
(standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(standard)

1920×1080P
(standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Utgang stoppet)
720×480P2)

720×576P3)

Visningen på skjermen kan ha overlegg.1)

Når systemfrekvensen er 59.942)

Når systemfrekvensen er 503)
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Når systemfrekvensen er 23.98 Hz

Innstilling Output Format (utgangsoppløsning)

Modus for opptak/avspilling Oppløsning for RAW-utdata /
oppløsning for internt opptak SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (standard)

3840×2160
(RAW) (3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i (standard)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (standard) 1920×1080i (standard)

3840×2160

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (standard) 1920×1080i (standard)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Innstilling Output Format (utgangsoppløsning)

Modus for opptak/avspilling Oppløsning for RAW-utdata /
oppløsning for internt opptak SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P (standard)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (standard)
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Når systemfrekvensen er 24 Hz

5-041-958-83(1) Copyright 2022 Sony Corporation

Innstilling Output Format (utgangsoppløsning)

Modus for opptak/avspilling Oppløsning for RAW-utdata /
oppløsning for internt opptak SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (standard) 1920×1080P (standard)

3840×2160
3840×2160 (2SI) 3840×2160P

1920×1080P

1920×1080P (standard) 1920×1080P (standard)

1920×1080 1920×1080P (standard) 1920×1080P (standard)

Innstilling Output Format (utgangsoppløsning)

Modus for opptak/avspilling Oppløsning for RAW-utdata /
oppløsning for internt opptak SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (standard)

XAVC-I 4096×2160 4096×2160 (2SI)
1920×1080P (standard)

4096×2160P
1920×1080P (standard)
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Feilsøking

Strømforsyning

Bildeutdata

Symptom Årsak Løsning

Enheten slås
ikke på.

Strømadapteren er ikke koblet godt til DC IN-
kontakten.

Sett strømledningen godt inn så langt den går.

Strømledningen er ikke satt godt inn i
strømadapteren eller strømuttaket.

Sett strømledningen godt inn så langt den går.

LAN-kabelen er ikke godt koblet mellom PoE++-
strømforsyningsenheten og enheten.

Kontroller at kabelen er satt inn til den låses.

LAN-kabelen er koblet til OPTION-kontakten, men
ikke til LAN-kontakten.

Koble LAN-kabelen til LAN-kontakten på riktig
måte.

Enheten er koblet til en strømforsyningsenhet som
ikke støtter PoE++ (kompatibel med IEEE802.3bt,
type 4, klasse 8).

Koble til en strømleveringsenhet som støtter
PoE++ (kompatibel med IEEE802.3bt, type 4,
klasse 8).

Det totale strømforbruket overskrider maksimum
klassifisering for PoE++-strømforsyningsenheten.

Se bruksanvisningen for PoE++-
strømforsyningsenheten.

Det er koblet til en nettverkskabel med
kategoriklassifisering som ikke støtter PoE++-
strømforsyning.

Bruk en nettverkskabel i kategori 5e eller
høyere koblet til LAN-kontakten.

Kameraet, PoE++-strømforsyningsenheten og
eksterne enheter er ikke koblet til jord.

Koble kameraet, PoE++-
strømforsyningsenheten og eksterne enheter til
jord.

Symptom Årsak Løsning

Det sendes ikke noe
bilde.

Tilkoblede enheter er ikke riktig tilkoblet.
Koble til de tilkoblede enhetene
på riktig måte.

Det første oppsettet ble ikke fullført.
Fullfør det første oppsettet ved
hjelp av Web App.

Det sendes ikke noe
bilde fra HDMI-
kontakten.

Det konfigureres et signal som ikke støttes av HDMI-
utgangsmålenheten.

Endre innstillingen for HDMI-
utgangsformat, eller bruk en
enhet som støtter
utgangssignalet.

Det brukes en kabel som ikke støtter HDMI-
utgangsstandarden.

Bruk en kabel som støtter HDMI-
utgangsstandarden som er i
bruk.
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Fjernkontroll

Infrarød-fjernkontroll

Symptom Årsak Løsning

Det sendes ikke noe
bilde fra SDI-kontakten.

Det brukes en kabel som ikke støtter SDI-
utgangsstandarden.

Bruk en kabel som støtter SDI-
utgangsstandarden som er i
bruk.

Skjermen som er koblet til SDI-kontakten, støtter ikke
utgangssignalet.

Bruk en skjerm som støtter SDI-
utgangsstandarden.

Opptaksformatet er angitt for RAW-utdata.
Endre opptaksformatet til en
annen innstilling enn RAW-
utdata.

HDMI-utgangen er satt til SD-oppløsning.
Sett HDMI-utgangen til en annen
oppløsning enn SD.

Det sendes ikke noe
bilde fra den optiske
fiberen, eller bildet er
forvrengt.

Modulen som brukes overholder ikke SFF- eller
SMPTE-standardene, eller oppfyller ikke Strømnivå I
(1,0 W).

Se "Sende ut et optisk
fibersignal".

Det sendes ikke noe
bilde eller det
forvrenges når du
bruker ekstern
synkronisering.

Det blir ikke lagt inn et eksternt synkroniseringssignal
som passer for det konfigurerte videosignalformatet.

Legg inn et eksternt
synkroniseringssignal som
passer for det konfigurerte
videosignalformatet.

Det er støy i lyden.

Kameraet, PoE++-strømforsyningsenheten og eksterne
enheter er ikke koblet til jord.

Koble kameraet, PoE++
strømforsyningsenheten og
eksterne enheter til jord.

Enheten brukes i et miljø med enheter som genererer
sterke elektriske og magnetiske felt (for eksempel
TV/radiosender-antenner, amatørradiosendere,
klimaanleggsmotorer, strømforsyningstransformatorer).

Hold deg unna enheter som
genererer sterke elektriske og
magnetiske felt.

Objektivet, objektivstøtten og driverenheten er i kontakt
med enheten eller en gjenstand i omgivelsene, og det
avgis en unormal støy.

Fest objektivet på riktig måte.

Se etter hindringer i
nærheten av kameraet.

Symptom Årsak Løsning

Infrarød-fjernkontrollen fungerer
ikke når den trykkes på.

Betjening med infrarød-
fjernkontrollen er deaktivert.

Angi [Technical] > [IR Remote] > [Setting] til
[On] i nettmenyen.

Batteriet er utladet eller
batteripolariteten er feil.

Betjen infrarød-fjernkontrollen i nærheten av
IR-sensoren på enheten. Hvis Power LED
blinker, skifter du ut batteriet.

Det første oppsettet ble ikke fullført.
Fullfør det første oppsettet ved hjelp av Web
App.
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RM-IP500

Web App

Symptom Årsak Løsning

Pan/tilt-driftshastigheten er
langsom.

Pan/tilt-hastigheten fra infrarød-
fjernkontrollen er satt til normal
modus.

Sett SETUP-bryter 4 i ON-posisjon på
enhetens kontaktblokk.

Operasjonen var rettet mot et
annet kamera enn det tiltenkte
kameraet.

Det infrarøde signalet ble mottatt av
et annet kamera enn det tiltenkte
kameraet.

Angi [Technical] > [IR Remote] > [Setting] til
[Off] i nettmenyen til kameraet du ikke vil
kontrollere.

Symptom Årsak Løsning

Kameraet kan ikke betjenes fra
RM-IP500-fjernkontrollen.

Strømforsyningen til
kameraet er ikke tilkoblet.

Kontroller at POWER-lampen på enheten lyser
grønt eller oransje.

Kameraet eller
fjernkontrollen er ikke
koblet til nettverket.

Kontroller kameraets og fjernkontrollens
tilkoblinger.

Det første oppsettet av
kameraet ble ikke fullført.

Fullfør det første oppsettet ved hjelp av Web App.

VISCA over IP-
kommunikasjon er ikke
aktivert.

Sett SETUP-bryter 3 i ON-posisjon på enhetens
kamerakontaktpanel, og start enheten på nytt.

IP-adressen til kameraet er
endret.

Kontroller IP-adressen til kameraet ved hjelp av
[Network] > [Wired LAN] i nettmenyen eller
kameramenyen.

IP-adressen til kameraet ble
endret ved hjelp av AUTO IP
SETUP på RM-IP500-
fjernkontrollen.

Det har gått minst 20
minutter siden kameraet
ble startet.

Start enheten på nytt. IP-adressen kan endres ved
hjelp av AUTO IP SETUP i løpet av de første 20
minuttene etter at du har startet enheten.
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Symptom Årsak Løsning

Kan ikke koble til ved hjelp av en
nettleser.

En LAN-kabel i kategori 5e eller
høyere er ikke tilkoblet.

Koble til en LAN-kabel i kategori 5e eller
høyere.

Ikke koblet til LAN på riktig
måte, eller tilkoblet nettverk
fungerer ikke normalt.

Kontroller at Link LED-en for LAN-kontakten
lyser. Hvis Link LED-en ikke lyser, kontakter
du systemansvarlig.

Strømforsyningen til kameraet er
ikke tilkoblet.

Se avsnittet "Strømforsyning" ovenfor.

En gyldig IP-adresse er ikke
konfigurert for enheten.

Utfør en tilbakestilling av nettverket.

Den konfigurerte IP-adressen er
i bruk på en annen enhet.

Kontroller at IP-adressene til eksterne
enheter er unike.

Den konfigurerte subnettmasken
samsvarer ikke med
nettverkssubnettet som brukes.

Utfør en tilbakestilling av nettverket.

Du får tilgang til enheten på
samme lokale nettverk via en
proxyserver.

Endre konfigurasjonen slik at en proxy-server
ikke brukes.

Den konfigurerte standard
gatewayen for enheten er feil.

Utfør en tilbakestilling av nettverket.

Angitt URL-adresse er feil. Skriv inn riktig URL-adresse, og prøv på nytt.

HTTP-porten er feil.

Vis kameramenyen på en ekstern skjerm, og
kontroller innstillingen for [Network] > [Wired
LAN] > [HTTP Port]. Hvis en annen verdi enn
80 er konfigurert, legger du til HTTP-
portnummeret i vertsnavnet eller IP-adressen
som er angitt i nettleseren.
Eksempel: Hvis HTTP-port er satt til 8080,
skriver du inn http://<IP Address>:8080

HTTP-portnummeret til enheten
filtreres eller blokkeres.

Endre HTTP-portnummeret for enheten til en
port som ikke filtreres eller blokkeres.

Gammel cache av nettleseren
har en negativ effekt.

Slett cache fra nettleseren.

Kan ikke koble til Web App ved
hjelp av 2D-koden (QR-kode).

Enheten som brukes, støtter
ikke mDNS.

Bruk en enhet som støtter mDNS.
Hvis du bruker en enhet som ikke støtter
mDNS, skriver du inn IP-adressen direkte i
nettleseren.

Nettbrettet eller datamaskinen er
koblet til et annet nettverk enn
kameraet.

Koble nettbrettet eller datamaskinen til
samme nettverk som enheten.

Kan ikke koble til Web App ved å
skrive inn URL-adressen manuelt.

Enheten som brukes, støtter
ikke mDNS.

Bruk en enhet som støtter mDNS.

Nettbrettet eller datamaskinen er
koblet til et annet nettverk enn
kameraet.

Koble nettbrettet eller datamaskinen til
samme nettverk som enheten.
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Symptom Årsak Løsning

Skjermbildet for godkjenning vises
kontinuerlig.

Riktig brukernavn eller passord
ble ikke angitt.

Angi det registrerte brukernavnet og
passordet. Hvis du har glemt den registrerte
brukerinformasjonen, se "RESET-bryter" i
"Kontaktblokk" for å initialisere
brukerinformasjonen for nettverkstilkobling.

Brukernavnet og passordet kan
ha blitt endret av en bruker som
er logget på med en annen
nettleser.

Kontroller riktig brukernavn og passord med
enhetens administrator.

Kamerabilde vises ikke i Web App.

HDMI-utgangen på kameraet er
satt til 720×480 eller 720×576.

Endre oppløsningen for HDMI-utgangen på
enheten.

Det er koblet til en HDMI-skjerm
som ikke støtter HDMI-
utgangssignalet til kameraet.

Fjern HDMI-skjermen eller bruk en HDMI-
skjerm som støtter HDMI-
utgangsinnstillingene.

Enheten ble startet på nytt, og
økten ble frakoblet.

Vent i omtrent ett minutt og last inn
nettleseren på nytt.

Gammel cache av nettleseren
har en negativ effekt.

Slett cache fra nettleseren.

Oppløsningen på kamerabildet
som vises i Web App er lav.

Oppløsningen for videostrøm 3
som brukes av Web App, er lav.

Øk verdien ved hjelp av [Stream] > [Video
Stream] > [Size 3] i nettmenyen.

Kameramenyen vises ikke når du
trykker på [Menu]-knappen.

Kameramenyen er konfigurert
slik at den ikke bygges inn i
HDMI-utgangssignalet.

Angi [Monitoring] > [Output Display] >
[HDMI/Stream] til [On] i nettmenyen.

Verdien for en innstilling på
innstillingsskjermen
oppdateres/vises ikke riktig.

Innstillingsskjermbildet for Web
App gjenspeiler ikke automatisk
innstillingene som er endret i en
annen Web App.

Trykk på [Reload]-knappen nederst i
innstillingsskjermbildet i Web App. Verdiene
for innstillingene på installasjonsskjermbildet
som vises, lastes inn på nytt og oppdateres.

Innstillingene for midlertidige
Internett-filer har innvirkning.

Slett cache fra nettleseren.

Kan ikke laste ned konfigurasjonsfil
eller -logg.

Nedlastingsfilfunksjonen i
nettleseren er deaktivert.

Aktiver nedlastingsfilfunksjonen i nettleseren.

Innstillingsskjermbildet til Web App
er tilgjengelig, men kan ikke utføre
betjening av skjermbildet for
direkte betjening og skjermbildet
for betjening av avspilling.

Skjermbildet for Web App-
betjening er låst.

Sett låsbryteren for betjening øverst til høyre
i Web App til posisjonen  (Betjening Lås
opp).

Det tar litt tid å vise Web App-
skjermbildet.

Strømmebildet for enheten vises
av flere brukere samtidig.

Reduser antall brukere som har tilgang til
Web App samtidig.
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Opptak

Kamera

Pan/tilt

Symptom Årsak Løsning

Bildet er forvrengt eller det hopper.

Videoinformasjonen overføres
ikke riktig på grunn av
overbelastning i
kommunikasjonsbanen.

Reduser bit-hastigheten for direkteavspilling,
sett [Video Stream 3] > [Size] til det laveste
alternativet, eller reduser bit-hastigheten for
å oppnå en margin i kommunikasjonsbåndet.

Flere nettlesere kjører på
nettbrettet og tar opp
minnekapasitet.

Lukk eventuelle nettlesere som kjører i
bakgrunnen.

For mange nettleserfaner er
åpne, og sinker driften.

Lukk alle faner som ikke blir brukt.

For høy oppsamling av
nettleser-cache og -historikk
sinker driften.

Slett cache i nettleseren.

Symptom Årsak Løsning

Bildet ser forvrengt ut ved
starten og slutten av pan/tilt-
betjeningen.

Bildet kan bli forvrengt hvis
bildestabiliseringsfunksjonen til objektivet er
slått på.

Slå av
bildestabiliseringsfunksjonen til
objektivet.

Synsvinkel endret uten
brukerbetjening.

Objektiv-pust oppstod. Se "Pust-kompensering".

Kan ikke bruke fokus, zoom eller
iris.

Innstillingene for brytere på objektivet kan
være feil.

Se "Kontrollere objektivbryterne".

Symptom Årsak Løsning

Kan ikke tilbakestille
pan/tilt.

Låsespaken for pan/tilt er i LOCK-
posisjon.

Skyv låsespaken for pan/tilt til UNLOCK-posisjon.

Kameraet stopper
ikke i forventet
posisjon.

Kamerablokken er ute av balanse.
Flytt kamerablokken fremover/bakover til en
passende posisjon som beskrevet i "Hvordan sette på
et objektiv", og slå deretter enheten på igjen.

Et objektiv som ikke støtter pan/tilt er
festet.

Se informasjon om objektivkompatibilitet og fest et
objektiv som støtter pan/tilt, og slå deretter enheten
på igjen.

Kan ikke utføre tilbakestilling av
pan/tilt.

Utfør en pan/tilt-tilbakestilling som beskrevet i
"Tilbakestille Pan/Tilt".Det ble brukt en uventet kraft på

kamerahodet, noe som førte til en feil
i pan/tilt-kontrollen.
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Symptom Årsak Løsning

Kameraet går ikke
tilbake til fronten når

 (Pan/tilt
hjem)-knappen
trykkes.

Modus for takmontering er aktivert.

Angi [Pan-Tilt] > [P/T Direction] > [Ceiling] i
nettmenyen i henhold til den faktiske installasjonen,
og slå deretter enheten på igjen. Når den er montert i
et tak, vil koblingsblokken være foran på kameraet.

Pan/tilt-betjening er
begrenset.

Grense for pan/tilt-område er
konfigurert.

Fjern innstillingene for begrensning av pan/tilt-område
etter behov, som beskrevet i "P/T Range Limit".

Det ble brukt en uventet kraft på
kamerahodet, noe som førte til en feil
i pan/tilt.

Utfør en pan/tilt-tilbakestilling som beskrevet i
"Tilbakestille Pan/Tilt".

Pan/tilt-betjeningen
beveget seg i motsatt
retning.

Innstillingen for takmonteringsmodus
er forskjellig fra den faktiske
monteringstilstanden.

Angi [Pan-Tilt] > [P/T Direction] > [Ceiling] i
nettmenyen i henhold til den faktiske installasjonen.

Innstillinger som gjelder pan/tilt-
retningen ble endret.

Kontroller innstillingene for [Pan-Tilt] > [P/T Direction]
i nettmenyen.

Bildet beveger seg
ikke jevnt ved starten
og slutten av pan/tilt-
betjeningen.

Innstillingen for
akselerasjon/retardasjon for pan/tilt-
betjening er for høy.

Du kan endre innstillingen akselerasjon/retardasjon
for pan/tilt-betjening for å gjøre bevegelsen ved
starten og slutten av pan/tilt-betjeningen jevnere ved
hjelp av [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve]
i nettmenyen eller kameramenyen. Merk deg at dette
vil bety at objektivet bruker lengre tid å nå maksimal
hastighet.

Pan/tilt-betjeningen
stoppet.

Kamerablokken er ute av balanse.
Flytt kamerablokken fremover/bakover til en
passende posisjon som beskrevet i "Hvordan sette på
et objektiv", og slå deretter enheten på igjen.

Innstillingen av rampekurven
(akselerasjon/retardasjon) er for høy
for objektivet som er festet.

Hvis et stort objektiv er festet, reduserer du verdien av
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] i
nettmenyen eller kameramenyen.

Det brukes et stort objektiv. Kontakt støtterepresentanten for Sony.

Enheten er blokkert
når pan/tilt betjenes.

Klemmespaken for festeskrue for
objektivstøttens sokkel treffer
kameraet.

Snu klemmespaken for festeskruen for
objektivstøttens sokkel slik at den peker opp.

Objektivstøttens klemmespak treffer
kameraet.

Snu objektivstøttens klemmespak slik at den peker
opp.

Låsespaken for kamerahode treffer
kameraet.

Kontroller at låsespaken for kamerahodet er helt i
LOCK-posisjon.

Unormal støy oppstår
under pan/tilt-
betjening.

Kameraet er ute av balanse.
Flytt kamerahodet fremover/bakover til en passende
posisjon slik at skyvebunnen er vannrett.

Innstillingen av rampekurven
(akselerasjon/retardasjon) er for høy
for objektivet som er festet.

Hvis et stort objektiv er festet, reduserer du verdien av
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] i
nettmenyen eller kameramenyen.

Kamerahodet er ikke festet på plass,
og det er bevegelsesstøy under drift.

Sett låsespaken for kamerahodet i LOCK-posisjon.
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Opptak/avspilling

Symptom Årsak Løsning

Kan ikke lagre en
forhåndsinnstilt
posisjon.

En forhåndsinnstilt posisjon kan ikke
lagres hvis Clear Image Zoom er i
bruk.

Sett Clear Image Zoom-forholdet tilbake til 1×.
(tilstand der forholdet ikke vises til høyre for 
(Zoom-forhold))

Ramme er forskjøvet
ved avspilling av
forhåndsinnstilt
posisjon.

Temperaturen i omgivelsene kan ha
endret seg vesentlig fra tidspunktet
da en forhåndsinnstilt posisjon ble
lagret, til tidspunktet for avspilling.

Lagre den forhåndsinnstilte posisjonen igjen.

Objektivkalibrering er ikke utført. Kjør kalibreringen ved hjelp av [Technical] > [Lens] >
[Lens Calibration] i kameramenyen.

Det er montert et annet objektiv enn
det som var montert da
forhåndsinnstillingen ble lagret. Eller
zoom-posisjonen for manuell zoom er
forskjellig.

Lagre den forhåndsinnstilte posisjonen igjen.

Kontrollpanelet for
rammer i Web App er
nedtonet og kan ikke
betjenes.

Pan/tilt-betjeningen er ikke
tilgjengelig mens
miniatyrbildeskjermen vises og under
avspilling.

Vis skjermen for avspillingskontroll og avslutt
miniatyrskjermvisningen, eller stopp avspillingen.

Pan/tilt-betjeningen er ikke
tilgjengelig når kamerabildet ikke kan
vises i Web App.

Se "Web App" i "Feilsøking".

Låsespaken for pan/tilt er i LOCK-
posisjon.

Skyv låsespaken for pan/tilt til UNLOCK-posisjon.

"Execute Pan-Tilt
Reset" vises under
kontrollpanelet for
rammer i Web App.

Det ble brukt en uventet kraft på
kamerahodet, noe som førte til en feil
i pan/tilt.

Utfør en pan/tilt-tilbakestilling som beskrevet i
"Tilbakestille Pan/Tilt".

Symptom Årsak Løsning

Opptaket starter ikke når
du trykker på
START/STOP-knappen
for opptak.

Minnekortet er fullt. Bytt ut minnekortet med et som har nok plass.

Minnekortet må gjenopprettes.
Gjenopprett minnekortet som beskrevet i
"Gjenopprette minnekort".

Opptaks-/tellelampen er konfigurert
som tellelampe, slik at
opptaksstatusen ikke kan bestemmes
av lampen.

Konfigurer opptaks-/tellelampen til å fungere som
en opptakslampe som beskrevet i "Koble til et
tellesignal".

Lydopptak er ikke mulig.

En mikrofon er ikke koblet til.
Koble en mikrofon eller lydenhet til AUDIO IN-
kontakten på kontaktblokken.

[Master Input Level]-innstillingen er
på minimumsverdien. Juster [Master Input Level].
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Filoverføring

IP-strømming

Symptom Årsak Løsning

Innspilt lyd er forvrengt.
Innstillingen for lydinngangsnivå er for
høy.

Juster [CH1 Input Level] til [CH4 Input Level] og
[Master Input Level].

Ved bruk av mikrofon i et miljø med høye lyder,
som f.eks. et arrangement med live-musikk, skal
du først justere [AUDIO IN CH1 MIC Ref.] og
[AUDIO IN CH2 MIC Ref.].

Innspilt lyd har et høyt
støynivå.

Innstillingen for lydinngangsnivå er for
lav.

Juster [Audio Input Level] og [Audio] > [Audio] >
[Audio Input] > [AUDIO IN CH1 MIC Ref.] eller
[AUDIO IN CH2 MIC Ref.]-innstillingene.

Klipp kan ikke spilles av.

Klippet redigeres.
Klipp kan ikke spilles av hvis du har endret
filnavn eller mapper, eller hvis klippet er i bruk på
en datamaskin. Dette er ikke en feil.

Klippet ble tatt opp med et annet
kamera enn denne enheten.

Klipp som er tatt opp med et annet kamera enn
denne enheten, kan kanskje ikke spilles av eller
vises i feil størrelse. Dette er ikke en feil.

Symptom Årsak Løsning

Filopplastinger
mislykkes.

Brukernavnet og passordet på
serveren er ikke riktige.

Brukernavnet og passordet på serveren er kanskje ikke
riktig. Angi de riktige oppføringene.

Symptom Årsak Løsning

Strømming er ikke
tilgjengelig.

Brukernavnet eller passordet som
er angitt i klientapplikasjonen for å
vise strømming fra enheten, er feil.

Hvis strømmeformatet for enheten er satt til [RTSP],
[SRT-Listener], eller [NDI|HX], er det nødvendig å
skrive inn brukernavnet og passordet som er angitt
for denne enheten i klientapplikasjonen. Skriv inn
riktig brukernavn og passord.

Protokollen for strømming er ikke
innstilt.

Velg målprotokollen ved hjelp av [Stream] > [Stream
Setting] i nettmenyen.

Seks eller flere RTSP-økter er
angitt.

Sett antall økter til fem eller færre.

UDP-portnummeret er ikke riktig
angitt.

Angi portnummer og andre innstillinger for
målprotokollen ved hjelp av [Stream] > [Stream] >
[Stream Setting] i nettmenyen.

UDP-kommunikasjon er blokkert. Kontroller innstillingene for sikkerhetsprogramvaren.

Det strømmes ikke lyd.
Strømming av lydutgang er satt til
[Off].

Angi [Stream] > [Audio Stream] > [Setting] til [On] i
nettmenyen.

Strømmingen ble koblet
fra.

Protokollinnstillingen eller
innstillingene for strømming av
kodek ble endret under strømming.

Angi protokollinnstilling og innstillinger for
strømmekodek før du starter strømming.
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Tilkobling til eksterne enheter

Ekstern synkronisering

Tally

Symptom Årsak Løsning

Bildestørrelsen for
[Video Stream 1] kan
ikke settes til 4096×2160
eller 3840×2160.

Bildestørrelsen er 1920×1080 når
[Output Format] er satt til HDMI.

Bildestørrelsen for strømming kan ikke angis som
større enn HDMI-bildestørrelsen. Endre HDMI-
bildestørrelsen ved hjelp av [Monitoring] > [Output
Format] i nettmenyen.

Rammefrekvens for
[Video Stream 1] kan
ikke settes til 60 FPS
eller 50 FPS.

Rammefrekvensen for strømming
er satt til 29.97 eller lavere.

Rammefrekvensen som brukes til strømming er
begrenset av systemfrekvensen. Endre
systemfrekvens ved hjelp av [Rec Format] >
[Frequency] i nettmenyen.

[Video Stream 3] Ikke
tilgang til strømmen.

[Video Stream 3] støtter ikke
RTSP/SRT/NDI.

Bruk [Video Stream 1] eller [Video Stream 2].

RTSP/SRT-skjermen er
ikke oppdatert/vist på
riktig måte.

Portnummeret som brukes for
RTSP eller SRT filtreres eller
blokkeres.

Endre RTSP- eller SRT-portnummeret til en port
som ikke filtreres eller blokkeres av enheter som
mottar strømmen. Du kan også endre portnummeret
som brukes for RTSP eller SRT på enheten.

Bildet er forvrengt eller
det hopper.

Videoinformasjonen overføres ikke
riktig på grunn av overbelastning i
kommunikasjonsbanen.

Reduser bit-hastigheten for direkteavspilling, eller
sett [Video Stream 2]-kodek ([Codec 2]) til [Off] for å
opprette en margin i kommunikasjonsbåndet.

Rekkefølgen på videopakker er
endret i kommunikasjonskanalen.

Bruk samme Internett-leverandør både på
enhetsiden og mottakersiden.

Ikke oppdaget som NDI-
enhet.

Protokollen for strømming er ikke
satt til NDI|HX.

Protokollen for strømming må settes til NDI|HX for å
registrere enheten som en NDI-enhet. Angi [Stream]
> [Stream Setting] til [NDI|HX] i nettmenyen.

Kan ikke brukes som en
NDI-enhet.

Det er ikke installert en NDI|HX-
lisens.

Installer en NDI|HX-lisens. Du kan sjekke om det er
en NDI|HX-lisens ved hjelp av [Stream] > [Stream] >
[Stream Setting] > [NDI|HX] > [License] i
nettmenyen.

Symptom Årsak Løsning

Kan ikke
synkronisere til
ekstern kilde.

Det blir ikke lagt inn et eksternt
synkroniseringssignal som passer for det
konfigurerte videosignalformatet.

Legg inn et eksternt synkroniseringssignal som
passer for det konfigurerte videosignalformatet.

Enheten er dobbeltterminert.
Enheten har en innebygd 75 Ω-terminator.
Koble direkte til en signalkilde (en-til-en) eller
bruk en fordeler (splitter).
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Objektivkontroller

Beslektet emne

Sende ut et optisk fibersignal

Kontaktblokk

Pust-kompensering

Kontrollere objektivbryterne

Hvordan sette på et objektiv

Tilbakestille Pan/Tilt

P/T Range Limit

Gjenopprette minnekort

Koble til et tellesignal

Symptom Årsak Løsning

Tellelampen
lyser ikke.

Tellelampens lysstyrke er satt til Off.
Angi riktig lysstyrke ved hjelp av [Technical] > [Tally] >
[Tally Lamp Brightness] i nettmenyen.

Opptaks-/tellelampen er konfigurert som
opptakslampe.

Konfigurer opptaks-/tellelampen til å fungere som en
tellelampe som beskrevet i "Koble til et tellesignal".

RM-IP500 er koblet til, og VISCA over IP er
deaktivert.

Sett SETUP-bryter 3 i ON-posisjon på enhetens
kontaktblokk.

OPTION-kontakttilkoblingen er feil, eller
målpinnen er ikke kortsluttet til GND.

Kortslutningspinne 7 eller pinne 8 på OPTION-
kontakten til GND som beskrevet i "Koble til et
tellesignal".

Symptom Årsak Løsning

[Communication Error]
vises i 
(Kamerastatus).

Kameraet kan ikke
kommunisere med
objektivkontrolleren.

Kontroller tilkoblingen mellom enheten og
objektivkontrolleren, slå deretter enheten og
objektivkontrolleren av og på igjen.

[Rotation Error] vises i
 (Kamerastatus).

En rotasjonsfeil inntraff i
objektivkontrolleren.

Det lagrede zoom-bevegelsesområdet og objektivets
bevegelsesområde samsvarer ikke. Initialiser
objektivkontrolleren.
Hvis problemet vedvarer, kontakter du representanten for
produsenten av objektivkontrolleren.

[System Error] vises i
 (Kamerastatus).

En systemfeil inntraff i
objektivkontrolleren.

Kontroller tilkoblingen mellom enheten og
objektivkontrolleren, se i brukerinstruksjonene for
objektivkontrolleren og initialiser objektivkontrolleren, eller
slå enheten og objektivkontrolleren av og på igjen.
Hvis problemet vedvarer, kontakter du representanten for
produsenten av objektivkontrolleren.

[Unknown Error] vises i
 (Kamerastatus).

En ukjent feil inntraff i
objektivkontrolleren.

Kontroller tilkoblingen mellom enheten og
objektivkontrolleren, se i brukerinstruksjonene for
objektivkontrolleren og initialiser objektivkontrolleren, eller
slå enheten og objektivkontrolleren av og på igjen.
Hvis problemet vedvarer, kontakter du representanten for
produsenten av objektivkontrolleren.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Feil-/varselmeldinger

Hvis det vises en advarsel, et forsiktighetsvarsel eller driftstilstand som krever bekreftelse på enheten, vises det en
melding i kamerabildepanelet, og POWER-lampen og NETWORK-lampen på frontpanelet og opptaks-/tellelampen
begynner å blinke.

Merknad

Den blinkende opptaks-/tellelampeindikasjonen er bare aktivert når både [Technical] > [Tally] > [Tally Control] er satt til [Internal]
og [Tally Lamp Brightness] ikke er satt til [Off] i nettmenyen eller kameramenyen.

Feilmeldinger

Hvis POWER-lampen og NETWORK-lampen blinker som beskrevet nedenfor, må du iverksette følgende tiltak.

Enheten slutter å fungere når følgende visning forekommer.

Varselsmeldinger

Følg instruksjonene hvis følgende skjermvisning oppstår.

POWER-
lampe

NETWORK-
lampe Årsak og løsning

Blinker
oransje
sakte

Blinker grønt
sakte

Enheten kan ikke fungere normalt. For mer informasjon, se [Maintenance] > [System
Log] i nettmenyen. Hvis problemet vedvarer selv etter at du har satt enheten i standby-
modus eller slått av strømmen og deretter på igjen, kontakter du servicerepresentanten
for Sony.

Blinker
oransje
raskt

Blinker grønt
raskt

Det oppstod en feil på enheten. Kontakt servicerepresentanten for Sony.

Meldingsvisning Opptaks-/tellelampe Årsak og løsning

E + feilkode Hurtig blinkende

Indikerer en unormal tilstand i enheten. Opptaket stopper, selv om ●REC
vises i kamerabildepanelet.
Slå av enheten, og se etter eventuelle problemer med tilkoblede enheter,
kabler eller medier. Hvis feilen vedvarer når enheten slås på igjen, kontakt
en servicerepresentant for Sony. Avhengig av statusen til enheten kan det
hende at det ikke vises en feilvisning eller et advarselssignal.

Meldingsvisning Opptaks-/tellelampe Årsak og løsning

Temperature High Blinker
Den interne temperaturen er høy.
Slå av videokameraet, og la det avkjøles før du bruker det igjen.

Media Temperature
High

Blinker
Temperaturen på CFexpress-kortet er høy.
Bytt ut kortet eller la det avkjøles før du bruker det igjen.
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Forsiktig- og driftsmeldinger

Følgende forsiktig- og driftsmeldinger kan vises midt på skjermen. Følg instruksjonene for å løse problemet.

Meldingsvisning Opptaks-/tellelampe Årsak og løsning

Voltage Low Blinker DC IN-spenningen er lav (nivå 1). Sjekk strømkilden.

Insufficient Voltage Hurtig blinkende
DC IN-spenningen er for lav (nivå 2). Opptak er deaktivert.
Koble til en annen strømkilde.

Media Near Full Blinker
Gjenværende kapasitet i minnekortet er i ferd med å bli lav.
Skift ved første anledning.

Media Full Hurtig blinkende
Klipp kunne ikke tas opp eller kopieres fordi det ikke er mer kapasitet
igjen på minnekortet.
Bytt med en gang.

Clips Near Full Blinker
Antall ekstra klipp som kan tas opp på et minnekort, begynner å bli
lavt.
Skift ved første anledning.

Clips Full Hurtig blinkende
Det maksimale antallet klipp som kan tas opp på minnekortet, er
nådd.
Det er ikke mulig å ta opp eller kopiere flere klipp. Bytt med en gang.

Last Clip Recording Blinker
Klippet som tas opp i øyeblikket, er det siste klippet som kan tas opp,
siden det maksimale antallet klipp er nådd.
Klargjør et nytt minnekort.

Media(A) Life Near
End1) Blinker

Minnekortet nærmer seg slutten på levetiden. Skift ved første
anledning.

Media(A) Life End1) Hurtig blinkende Minnekortet har nådd slutten av levetiden. Bytt med en gang.

Media(A) Near Full1) Blinker Når du bruker funksjonen Simul Rec

Media(A) Full1) Hurtig blinkende Når du bruker funksjonen Simul Rec

Media(A) Clips Near
Full1) Blinker Når du bruker funksjonen Simul Rec

Media(A) Clips Full1) Hurtig blinkende Når du bruker funksjonen Simul Rec

Media(A) Last Clip
Rec1) Blinker Når du bruker funksjonen Simul Rec

(Ingen visning) Blinker
En ukjent feil inntraff i objektivkontrolleren.
Kontroller statusen i kamerastatusen i Web App-en.
For mer informasjon, sjekk systemloggen i Web App-en.

"(B)" vises for kortet i spor B.1)

Vist melding Årsak og løsning

Backup Battery End
Please Change

Gjenværende kapasitet i reservebatteriet er utilstrekkelig.
Koble enheten til en strømforsyning i minst 24 timer for å lade
backup-batteriet.
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Informasjon om RTMP strømmefeil

Følgende informasjon om feil kan bli vist på enheten. Utfør følgende handlinger, ved behov.

Vist melding Årsak og løsning

Unknown Media(A)1)

Please Change

Det ble satt inn et minnekort som er partisjonert eller et minnekort
som inneholder flere utklipp som kan håndteres av enheten.
Kortet kan ikke brukes i enheten og må byttes ut.

Cannot Use Media(A)1)

Unsupported File System

Et kort ble satt inn som bruker et annet filsystem eller et uformatert
kort.
Kortet kan ikke brukes i enheten, og må byttes ut eller formateres
ved hjelp av enheten.

Media Error
Media(A) Needs to be Restored1)

Det oppstod en feil på minnekortet, og kortet må gjenopprettes.
Gjenopprett minnekortet.

Media Error
Cannot Record to Media(A)1)

Minnekortet kan være skadet og kan ikke lenger brukes til opptak.
Avspilling er mulig, så det anbefales at du tar en kopi og bytter ut
minnekortet.

Media Error
Cannot Use Media(A)1)

Minnekortet kan være skadet og kan ikke lenger brukes til opptak
eller avspilling.
Kortet kan ikke brukes i enheten og må byttes ut.

Media(A) Error1)

Recording Halted
Playback Halted

Opptak og avspilling ble stoppet fordi det oppstod en feil under bruk
av minnekortet.
Hvis problemet vedvarer, bytt ut minnekortet.

Media Reached Rewriting Limit
Change Media(A)1)

Minnekortet har nådd slutten av levetiden.
Ta en sikkerhetskopi og skift kortet umiddelbart. Hvis du fortsetter å
bruke kortet, kan det hende at kortet ikke kan ta opp eller spille av.
For mer informasjon, se bruksanvisningen for minnekortet.

The specified address is invalid.
Den angitte adressen er ugyldig.
Kontroller at innstillingen er riktig.

Cannot Use Specified Port Number
Det angitte portnummeret er ugyldig.
Kontroller at innstillingen er riktig.

Lens I/F Error(xx:xx)

Det ble oppdaget en objektivfeil i objektivets I/F-kommunikasjonen
da et objektiv med E-fatning ble koblet til.
Kontroller statusen for tilkoblingen til objektivet med E-fatning.
Hvis problemet vedvarer, ta kontakt med en servicerepresentant for
Sony med feilkoden (fem tegn i parentes).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs was
reached.

Det maksimale antallet overføringsjobber er nådd.
Fjern alle uønskede jobber. Innstillingen for automatisk opplasting
av proxy-filer kan også være feil. Kontroller at innstillingen er riktig.

Fan Stopped

Viften har sluttet å kjøre.
Kontroller at det ikke er støv eller fremmedlegemer.
Hvis feilen vedvarer etter at støv og fremmedlegemer er fjernet,
kontakt en servicerepresentant for Sony.

"(B)" vises for kortet i spor B.1)
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Informasjon om SRT strømmefeil

Følgende informasjon om feil kan bli vist på enheten. Utfør følgende handlinger, ved behov.

Feilkode
Beskrivelse Løsning

RTMP RTMPS

1002
1004

2002
2004

Kan ikke koble til RTMP-server.
Kontroller at serverens URL-innstilling er riktig.
Kontroller nettverkstilkoblingen.

1003 2003
Kan ikke løse problem med
domenenavnet.

Kontroller at serverens URL-innstilling er riktig.
Kontroller DNS-serverens innstilling.

–
2005
2008

CRL-feil
Kontroller at serverens URL-innstilling er riktig.
Kontroller at tilkoblingens destinasjon er et pålitelig nettsted.

2006 CA-sertifikatfeil Kontroller at klokkeinnstillingen er riktig.
Kontroller at CA-sertifikatet er riktig.

– 2007
Et CA-sertifikat er ikke installert.
Autentiseringsfeil for
serversertifikat.

Installer et CA-sertifikat.
Kontroller at tilkoblingens destinasjon er et pålitelig nettsted.

4002 RTMP-sesjon ble koblet fra.
Enheten kan ha blitt koblet fra på RTMP-serversiden.
Kontroller at innstillingene stemmer med de anbefalte
kodekparametrene for tjenesten.

4003 Nettverkstilkoblingens kvalitet er
lav.

Kontroller nettverkstilkoblingen.

Annet Andre feil.

Feilkode

Beskrivelse LøsningSRT-
Caller

1001 Uventet feil
Enheten kan ikke fungere normalt. Slå enheten av
og på igjen.

1002
Kommunikasjon ble koblet fra på grunn av endring
i innstillingene

Kommunikasjon ble koblet fra fordi innstillingene
ble endret.
Opprett tilkoblingen på nytt.

5001 Uventet feil
Enheten kan ikke fungere normalt. Slå enheten av
og på igjen.

5005 Tilkoblingsfeil
Kontroller at innstillingen av tilkoblingens
destinasjon er riktig.

5006 Krypteringsfeil Kontroller at krypteringsinnstillingen er riktig.

5007 Uventet feil Enheten kan ikke fungere normalt. Slå enheten av
og på igjen.5008 Uventet feil

5009 Overføringsfeil
Enheten ble koblet fra under kommunikasjon.
Kontroller nettverkstilkoblingen.
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Liste over menyelementer

Følgende tabeller viser enhetens menyelementer.

Forklaring
"Kamerameny" og "nettmeny"
●: Tilgjengelig
▲: Noen elementer er tilgjengelige
–: Ikke tilgjengelig

"All File" og "Scene File"
Ja: Element lagret i en ALL-fil eller scene-fil
Nei: Elementet ble ikke lagret

"All Reset (except for Network Settings)"
Når [Reset]> [Reset] > [All Reset (except for Network Settings)] i nettmenyen utføres:
Ja: Initialisert element (ekskluderer nettverksinnstillinger)
Nei: Ikke aktuelt

"Network Reset"
Når [Reset]> [Reset] > [Network Reset] i nettmenyen utføres:
Ja: Initialisert element (nettverksinnstilling)
Nei: Ikke aktuelt

"Factory Default"
Ja: Element tilbakestilt til fabrikkstandard
Nei: Ikke aktuelt

Shooting

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

ISO/Gain/EI ● – Ja Ja Ja Ja Ja

ND Filter ● – Ja Ja*1 Ja Nei Ja

Shutter ● – Ja Ja Ja Nei Ja

Iris ● – Ja Ja Ja Nei Ja

Auto Exposure ● – Ja Ja*2 Ja Nei Ja

White ● – Ja Ja*3 Ja Nei Ja

White Setting ● – Ja Nei Ja Nei Ja

Offset White ● – Ja Nei Ja Nei Ja

Focus ● ▲ Ja Nei Ja Nei Ja

S&Q Motion ● – Ja Nei Ja Nei Ja
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Project

Paint/Look

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

LUT On/Off ● – Ja Nei Ja Nei Ja

Noise
Suppression

● – Ja Ja Ja Nei Ja

Flicker Reduce ● – Ja Nei Ja Nei Ja

SteadyShot ● – Ja Nei Ja Nei Ja

[Mode] ikke aktuelt*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] ikke aktuelt*2

[Preset White] ikke aktuelt*3

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Base Setting ● ● Ja Nei Ja Nei Ja

Rec Format ● ● Ja Nei Ja*1 Nei Ja

Cine
EI/Flex.ISO Set

● – Ja Nei Ja Nei Ja

Simul Rec ● ● Ja Nei Ja Nei Ja

Proxy Rec ● ▲ Ja Nei Ja Nei Ja

Interval Rec ● ● Ja*2 Nei Ja Nei Ja

Picture Cache
Rec

● ● Ja*2 Nei Ja Nei Ja

SDI/HDMI Rec
Control

● – Ja Nei Ja Nei Ja

Assignable
Button

● – Ja Nei Ja Nei Ja

All File – ● Nei Nei Nei Nei Nei

[Frequency] ikke aktuelt*1

[Setting] ikke aktuelt*2

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Scene File ● – Nei Nei Nei Nei Nei

Base Look ● ▲ Ja*1 Nei Ja*1 Nei Ja*1

Reset Paint
Settings

● – Nei Nei Nei Nei Nei
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Pan-Tilt

TC/Media

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Black ● – Ja Ja Ja Nei Ja

Knee ● – Ja Ja Ja Nei Ja

Detail ● – Ja Nei Ja Nei Ja

Matrix ● – Ja Ja Ja Nei Ja

Multi Matrix ● – Ja*2 Ja*2 Ja Nei Ja

LUT-data importert som basisutseende er ikke aktuelt*1

[Axis] ikke aktuelt*2

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

P/T Speed – ● Nei Nei Ja Nei Nei

P/T
Acceleration

● ● Nei Nei Ja Nei Nei

P/T Range
Limit

– ● Nei Nei Ja Nei Nei

P/T Direction – ● Nei Nei Ja Nei Nei

P/T Preset – ● Nei Nei Ja Nei Nei

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Timecode ● – Ja*1 Nei Ja Nei Ja

TC Display ● – Ja Nei Ja Nei Ja

Users Bit ● – Ja*1 Nei Ja Nei Ja

HDMI TC Out ● – Ja Nei Ja Nei Ja

Clip Name
Format

● – *2 Nei Ja Nei Ja

Update
Media

● – Nei Nei Nei Nei Nei

Format
Media

● – Nei Nei Nei Nei Nei

Media Life ● – Nei Nei Nei Nei Nei

[Setting] ikke aktuelt*1

[Auto Naming] aktuelt, [Camera ID] ikke aktuelt*2
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Monitoring

Audio

Thumbnail

Technical

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Output
Format

● ● Ja Nei Ja Nei Ja

Output
Display

– ● Ja Nei Ja Nei Ja

Display
On/Off ● – Ja Nei Ja Nei Ja

Video Signal
Monitor

● – Ja Nei Ja Nei Ja

Marker ● – Ja Nei Ja Nei Ja

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Audio
Input

● ▲ Ja Nei Ja Nei Ja

Audio
Output

● ▲ Ja Nei Ja Nei Ja

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Display Clip
Properties

● – Nei Nei Nei Nei Nei

Set Clip Flag ● – Nei Nei Nei Nei Nei

Lock/Unlock
Clip

● – Nei Nei Nei Nei Nei

Delete Clip ● – Nei Nei Nei Nei Nei

Transfer Clip ● – Nei Nei Nei Nei Nei

Transfer Clip
(Proxy)

● – Nei Nei Nei Nei Nei

Filter Clips ● – Nei Nei Nei Nei Nei

Customize View ● – Ja Nei Ja Nei Ja
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Network

Stream

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Color
Bars

● – *1 Nei *1 Nei Ja

Genlock ● – Nei Nei Nei Nei Nei

Tally ● ● Ja Nei Ja Nei Ja

Rec
Review

● – Ja Nei Ja Nei Ja

Zoom ● – Ja Nei Ja Nei Ja

IR
Remote

– ● Nei Nei Ja Nei Ja

Lens ● – Ja Nei Ja Nei Ja

APR ● – Nei Nei Nei Nei Nei

[Type] aktuelt, [Setting] ikke aktuelt*1

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Camera Name – ● Nei Nei Nei Nei Ja

User – ● Nei Nei Nei Ja Ja

Wired LAN*1 ▲ ● Nei Nei Nei Ja Nei

File Transfer ● ▲ Ja Nei Ja Ja Ja

FTP Server 1 – ● Nei Nei Ja Nei Ja

FTP Server 2 – ● Nei Nei Ja Nei Ja

FTP Server 3 – ● Nei Nei Ja Nei Ja

SSL – ● Nei Nei Nei Ja Ja

Referer Check – ● Nei Nei Nei Ja Ja

Brute Force
Attack Protection

– ● Nei Nei Nei Ja Ja

Kan ikke konfigureres ved hjelp av kameramenyen (bare visning)*1

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Stream
Setting

– ● Nei Nei Ja*1 Nei Ja*1
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Maintenance
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Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Video
Stream

– ● Ja Nei Ja Nei Ja

Audio
Stream

– ● Ja Nei Ja Nei Ja

[NDI|HX] > [License] ikke aktuelt*1

Element
(nivå 2) Kamerameny Nettmeny All

File
Scene

File
All Reset (except for

Network Settings)
Network

Reset
Factory
Default

Language ● ● Ja Nei Ja Nei Ja

Accessibility – ● Ja Nei Nei Nei Ja

Clock Set ● ● Ja*1 Nei Ja*2 Nei Ja

Reset – ● Nei Nei Nei Nei Nei

Hours Meter ● – Nei Nei Nei Nei Nei

Information – ● Nei Nei Nei Nei Nei

System Log – ● Nei Nei Nei Nei Ja

HTTP Access
Log

– ● Nei Nei Nei Nei Ja

Service – ● Nei Nei Nei Nei Nei

EULA – ● Nei Nei Nei Nei Nei

Software – ● Nei Nei Nei Nei Nei

Informasjon om dato og tid er ikke aktuelt*1

[Time Zone], informasjon om dato, og tid, er ikke aktuelt*2
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lagrede elementer for forhåndsinnstilt posisjon

"Ja" angir en innstilling som er lagret for den forhåndsinnstilte posisjonen, og "Nei" angir en innstilling som ikke er lagret.

Pan/tilt-elementer

Zoomelementer

Fokuselementer

Plassering på skjermen Element Lagre mål

Kontrollpanel for rammer på skjermbilde for direkte betjening
Pan/tilt-posisjon Ja

[Pan-Tilt Speed] Nei

[Pan-Tilt] i nettmenyen

[P/T Speed] Nei

[P/T Acceleration] Nei

[P/T Range Limit] Nei

[P/T Direction] Nei

[P/T Preset] > [Pan-Tilt] Nei

[P/T Preset] > [Default] > [Pan-Tilt Speed] Ja1)

Verdiene for innstillinger ved lagring av en forhåndsinnstilt posisjon, lagres som verdier for den aktuelle forhåndsinnstilte posisjonen. Når verdier
er lagret, kan verdiene endres for hver enkelt forhåndsinnstilt posisjon. Hvis du vil ha mer informasjon, se "Endre overgangshastigheten (Pan-
Tilt/Zoom/Focus) for forhåndsinnstilt posisjon ved bruk av Web App-en."

1)

Plassering på skjermen Element Lagre mål

Kontrollpanel for rammer på skjermbilde for direkte betjening
Zoomposisjon (fokusavstand) Ja

[Zoom Speed] Nei

[Pan-Tilt] > [P/T Preset] > [Default] i nettmenyen
[Zoom Sync] Ja1)

[Zoom Speed] Ja1)

[Technical] > [Zoom] i kameramenyen [Zoom Type] Nei

Verdiene for innstillinger ved lagring av en forhåndsinnstilt posisjon, lagres som verdier for den aktuelle forhåndsinnstilte posisjonen. Når verdier
er lagret, kan verdiene endres for hver enkelt forhåndsinnstilt posisjon. Hvis du vil ha mer informasjon, se "Endre overgangshastigheten (Pan-
Tilt/Zoom/Focus) for forhåndsinnstilt posisjon ved bruk av Web App-en."

1)
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Beslektet emne
Endre overgangshastigheten (Pan-Tilt/Zoom/Focus) når du gjenoppretter en forhåndsinnstilt posisjon

5-041-958-83(1) Copyright 2022 Sony Corporation

Plassering på skjermen Element Lagre
mål

Kameraets bildepanel på skjermbilde for
direkte betjening

Sporingsmål som er angitt for sanntidssporing i AF Nei

Angitte koordinater for Spot Focus Nei

 (Focus)-fane på skjermbildet for direkte
betjening

[Touch Focus]-bryter Nei

[Auto Focus]-bryter Ja

[Focus Hold]-knappstatus Nei

[Push AF/MF]-knappstatus Nei

[Face/Eye Detection AF] Ja

[AF Subj. Shift Sens.] Ja

[AF Transition Speed] Ja

Fokusposisjon Ja1)

[Shooting] > [Focus] i nettmenyen

[Push AF Mode] (inkludert innstillinger som bruker knapper
som kan tilordnes)

Nei

[Touch Function in MF] Nei

[AF Assist Control] Nei

[Pan-Tilt] > [P/T Preset] > [Default] i
nettmenyen

[Focus Recall] Ja2)

[MF Speed] Ja2)

[Shooting] > [Focus] i kameramenyen

Størrelse og posisjon til fokusområde satt ved hjelp av
[Focus Area]

Ja

Posisjon til fokusområde satt ved hjelp av [Focus Area (AF-
S)]

Ja

Ikke gjenopprettet når bryteren [Auto Focus]-bryteren er satt til posisjonen On. Gjenopprettet når den er satt til Off.1)

Verdiene for innstillinger ved lagring av en forhåndsinnstilt posisjon, lagres som verdier for den aktuelle forhåndsinnstilte posisjonen. Når verdier
er lagret, kan verdiene endres for hver enkelt forhåndsinnstilt posisjon. Hvis du vil ha mer informasjon, se "Endre overgangshastigheten (Pan-
Tilt/Zoom/Focus) når du gjenoppretter en forhåndsinnstilt posisjon."

2)
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Blokkdiagram

Audio Input

Audio Output

5-041-958-83(1) Copyright 2022 Sony Corporation

493



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Oppdatere programvare for objektiv med E-fatning

Du kan oppdatere programvaren til et objektiv med E-feste ved hjelp av enheten.
Se nettstedet for objektivet for objektiver som kan oppdateres og tilsvarende programvare.
Programvaren oppdateres ved hjelp av nettmenyen.

Merknad

Ikke utfør følgende handlinger før oppdateringen er fullført.

Koble fra nettverket
Fjerne et objektiv
Slå strømmen av

Hvis det vises en melding om at oppdateringen mislyktes, kontrollerer du beskrivelsen som vises, og prøver å oppdatere på nytt.

5-041-958-83(1) Copyright 2022 Sony Corporation

Fest et E-festeobjektiv til enheten.1

Kontroller [Maintenance] > [Information] > [Lens] > [Model Name] og [Version Number] i nettmenyen.

Programvareversjonen for et objektiv med E-fatning vises på siden.
Kontroller versjonsnummeret for programvaren, og oppdater deretter programvaren etter behov.

2

Last ned objektivets fil for programvareoppdatering for Windows (.exe-utvidelse) til enheten som kjører
Web App.

3

I [Maintenance] > [Information] > [Lens] > [Version Up] trykker du på [Choose File]-knappen og velger den
nedlastede oppdateringsfilen.

4

Følg instruksjonene på skjermen.5
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Feste dekselet til utløserknappen for objektivet

Du kan forhindre utilsiktet fjerning av objektivet ved å sette på dekselet til utløserknappen for objektivet som følger med
CIB-PCM1-takbraketten (alternativ) til utløserknappen for objektivet.

Merknad

Dette hindrer ikke at objektivet fjernes helt.

Beslektet emne

Hvordan sette på et objektiv

5-041-958-83(1) Copyright 2022 Sony Corporation

Feste et objektiv.

Hvis du vil ha mer informasjon å feste et objektiv, se "Hvordan sette på et objektiv".

1

Skyv låsespaken for pan/tilt til LOCK-posisjon for å låse pan/tilt på kamerahodet.2

Flytt kamerablokken til en posisjon slik at objektivutløserdekselet kan festes.3

Fest objektivutløserdekselet slik at det dekker dekselet til utløserknappen for objektivet.4

Fest objektivutløserdekselet ved hjelp av festeskruen for objektivutløserdekselet.5
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Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Lisenser

MPEG-4 AVC lisens for patentportefølje

DETTE PRODUKTET LISENSIERES UNDER AVC PATENTPORTEFØLJLISENSEN FOR PERSONLIG BRUK AV EN
FORBRUKER ELLER ANNEN BRUK SOM DET IKKE MOTTAS GODTGJØRELSE FOR
(i) KODING AV VIDEO I SAMSVAR MED AVC-STANDARDEN ("AVC-VIDEO") OG/ELLER
(ii) DEKODING AV AVC-VIDEO SOM BLE KODET AV EN FORBRUKER SOM DRIVER EN PERSONLIG AKTIVITET,
OG/ELLER SOM BLE INNHENTET FRA EN VIDEOLEVERANDØR SOM ER LISENSIERT FOR Å LEVERE AVC-
VIDEO.
INGEN LISENS GIS ELLER SKAL UNDERFORSTÅS FOR NOEN ANNEN BRUK. YTTERLIGERE INFORMASJON KAN
FÅS FRA MPEG LA, LLC. SE HTTP://WWW.MPEGLA.COM

Skaffe programvare under GPL/LGPL-lisens

Dette produktet bruker programvare som GPL/LGPL gjelder for. Dette er informasjon om at du har rett til å ha tilgang til,
endre og videredistribuere kildekode for disse programmene i henhold til vilkårene for GPL/LGPL.
Kildekoden er tilgjengelig på internett. Bruk følgende URL-adresse, og følg nedlastingsinstruksjonene.
https://oss.sony.net/Products/Linux/
Vi foretrekker at du ikke kontakter oss angående innholdet i kildekoden.

μT-kjernekildekode

Dette produktet bruker kildekoden for μT-kjerne under T-lisens 2.1 gitt av TRON Forum (www.tron.org).

5-041-958-83(1) Copyright 2022 Sony Corporation

496

https://oss.sony.net/Products/Linux/


Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Spesifikasjoner

Generelt

Vekt
Ca. 4,6 kg (bare hovedenhet)
Ca. 6,0 kg (inkludert SELP28135G-objektiv)

Dimensjoner
Se "Eksterne dimensjoner".

Krav til nettstrøm
19,5 V DC
PoE++ (IEEE802.3bt Type 4, Klasse 8-kompatibel)

Strømforbruk
19,5 V DC: 80,0 W (maks)
PoE++: 71,3 W (maks.) 

Driftstemperatur
0 °C til 40 °C

Lagringstemperatur
−20 °C til +60 °C

Opptaksformat (video)
XAVC Intra
XAVC-i 4K-/QFHD-modus: VBR, 600 Mbps (maks.) bit-hastighet, MPEG-4 AVC/H.264
XAVC-i HD-modus: CBG, 223 Mbps (maks.), MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD-modus: VBR, 150 Mbps (maks.) bit-hastighet, MPEG-4 H.264/AVC
XAVC-L HD 50-modus: VBR, 50 Mbps (maks.), MPEG-4 H.264/AVC
XAVC-L HD 35-modus: VBR, 35 Mbps (maks.), MPEG-4 H.264/AVC

Opptaksformat (lyd)
LPCM 24-bit, 48 kHz, 4-kanal

Bildefrekvens ved opptak

XAVC Intra
XAVC-I 4K-modus: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD-modus: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD-modus: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD-modus: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50-modus: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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XAVC-L HD 35-modus: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Opptaks-/avspillingstid
XAVC Intra
XAVC-I QFHD-modus: 59.94P, ca. 30 minutter (med CEA-G160T)
XAVC-I HD-modus: 59.94P, ca. 78 minutter (med CEA-G160T)

XAVC Long
XAVC-L QFHD-modus: 59.94P, ca. 115 minutter (med CEA-G160T)
XAVC-L HD 50-modus: 59.94P, ca. 155 minutter (med CEA-G80T)
XAVC-L HD 35-modus: 59.94P, ca. 210 minutter (med CEA-G80T)

Merknad

Opptaks-/avspillingstiden kan variere på grunn av bruksforhold og egenskaper ved minnet. Opptaks- og avspillingstidene er for et
kontinuerlig opptak som ett enkelt klipp. De faktiske tidene kan være kortere, avhengig av antall klipp som tas opp.

Pan/tilt-drivdelen

Minimum pan-hastighet: 0,02 gr./s
Minimum tilt-hastighet: 0,02 gr./s
Maksimal pan-hastighet: 60 gr./s
Maksimal tilt-hastighet: 60 gr./s
Pan-område: −170 gr. til +170 gr.
Tilt-område: −30 gr. til +195 gr.
Vurdering av støykriterium: NC35 eller lavere
Forhåndsinnstilte posisjoner: 100

Kameradelen

Avbildningsenhet
35 mm full ramme (35,6 × 23,8 mm), Exmor R CMOS-sensor

Antall piksler
Ca. 12,9 megapiksler (totalt antall piksler)
Ca. 10,3 megapiksler (effektive piksler)

Autofokus
Deteksjonsmetode: Fasedetektsjon/kontrastdeteksjon

Interne ND-filter
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Lineært variabel ND: 1/4ND til 1/128ND

ISO-følsomhet
ISO 800/12800 (Cine EI -modus, D55 lyskilde)

Objektivfatning
E-feste

Eksponeringsintervall
15+ stopp
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Lukkerhastighet
64F til 1/8000 sek (23.98P)

Lukkervinkel
5,6° til 360°, 2 til 64 rammer

Sakte og rask bevegelse
XAVC QFHD: 1 fps til 120 fps
XAVC HD: 1 fps til 240 fps
XAVC 4K: 1 fps til 60 fps
XAVC HD (S35): 1 fps til 120 fps

Hvitbalanse
2000 K til 15000 K

Forsterkning
−3 dB til +30 dB (i trinn på 1 dB)

Basisutseende
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Lyddelen

Samplingsfrekvens
48 kHz

Kvantifisering
24-biters

Frekvensrespons
XLR-inngang i MIC-modus: 20 Hz til 20 kHz (±3 dB eller mindre)
XLR-inngang i LINE-modus: 20 Hz til 20 kHz (±3 dB eller mindre)

Dynamisk område
XLR-inngang i MIC-modus: 80 dB (typisk)
XLR-inngang i LINE-modus: 90 dB (typisk)

Forvrengning
XLR-inngang i MIC-modus: 0,08% eller mindre (−40 dBu inngangsnivå)
XLR-inngang i LINE-modus: 0,08% eller mindre (+14 dBu inngangsnivå)

Inn-/ut-delen

Innganger
DC IN

EIAJ-kompatibel, 19,5 V DC

AUDIO IN

XLR-type, 5-pinners, hunn
LINE / MIC / MIC+48V svitsbar
MIC: Referanse −30 dBu til −80 dBu
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GENLOCK IN

BNC-kontakt, 1,0 Vp-p, 75 Ω

TC IN

BNC-kontakt

Utganger
SDI OUT

BNC-kontakt, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Type-A-kontakt

OPTICAL-utgangskontakt

SFP+ -kompatibel
* Denne enheten støtter ikke optisk signalinngang.

Inngang/utgang
LAN-kontakt

RJ-45, 1000BASE-T

OPTION-kontakt

RJ-45-tellekontakt for inn-/utdata

Mediespordelen

Kortspor for CFexpress type A/SD (2)

Leverte enheter

Strømadapter (1)
Strømledning (1)
Infrarød fjernkontroll (1)
Hovedenhetsdeksel (1) (festet på enheten)
HDMI-kabelens festeplate (1)
Før du bruker enheten (1)
Garantihefte (1)

Utvendige mål

Dimensjonene er omtrentlige verdier.
Enhet: mm

Kamerahus
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Takbrakett
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Utforming og spesifikasjoner er gjenstand for endringer uten videre varsel.

5-041-958-83(1) Copyright 2022 Sony Corporation

502



Hjelpveiledning

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Varemerker

 er et varemerke for Sony Group Corporation.
XAVC og  er registrerte varemerker for Sony Group Corporation.
Uttrykkene HDMI og HDMI High-Definition Multimedia Interface, og HDMI-logoen, er varemerker eller registrerte
varemerker som tilhører HDMI Licensing Administrator, Inc. i USA og andre land.
Microsoft og Windows er varemerker eller registrerte varemerker for Microsoft Corporation i USA og/eller andre land.
Mac og macOS er registrerte varemerker for Apple Inc. i USA og andre land.
Logoen "Catalyst Browse" er et varemerke eller registrert varemerke for Sony Group Corporation.
IOS er et varemerke eller registrert varemerke for Cisco i USA og andre land og brukes under lisens.
iPadOS, Safari og iPad er varemerker for Apple Inc., registrert i USA og andre land og regioner.
Android og Google Chrome er varemerker eller registrerte varemerker for Google LLC.
Wi-Fi er et registrert varemerke som tilhører Wi-Fi Alliance.
SDXC-logoen er et varemerke for SD-3C, LLC.
CFexpress og CFexpress type A-logoen er varemerker for CompactFlash Association.
NewTek™ og NDI® er varemerker eller registrerte varemerker som tilhører NewTek, Inc.
JavaScript er et registrert varemerke for Oracle og/eller dets tilknyttede selskaper.
Intel, Intel-logoen og Intel Core er varemerker for Intel Corporation eller dets datterselskaper.
QR Code er et varemerke for Denso Wave Inc.
Alle andre firmanavn og produktnavn er registrerte varemerker eller varemerker for sine respektive eierne.
Merkevareartikler er ikke angitt med ™- eller ® -symboler i dette dokumentet.
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